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Setting Public Access Profiles and Parameters

Public access parameters and profiles control general aspects of public access, and
specific functions related to Polaris PowerPAC, Polaris PowerPAC Children’s Edition,
and Polaris Mobile PAC. You can make most settings at the system, library, or branch
level. You can view and set public access profiles and parameters from the
Administration Explorer or an administration workform.

Note:
These System Administration permissions are required to modify profiles
and parameters: Access Administration: Allow, Libraries: Access,
Branches: Access, Modify parameters: Allow, Modify profiles: Allow,
System: Access, System: Modify.

Your library may use multiple Polaris public access applications:

l Polaris® PowerPAC™ provides responsive Web-based access to library searches
and services from remote computers, tablets, and smartphones, and from devices
in the library.

l Polaris® PowerPAC™ Children’s Edition is the Web-based application designed
specifically for children’s use.

l Polaris Mobile PAC is the Web-based PAC application designed for mobile
devices.

Note:
The Statistical Summary report provides detailed information about
system activity, including PAC activity such as patron logins, patron self-
registration, holds placed from PAC, and holds cancelled from PAC. To
access this report, select Utilities, Reports and Notices from the Polaris
Shortcut bar, and select System in the Polaris Reports dialog box.

See also:

l The PAC Customization PDF Guide, PAC Administration Profiles Reference topic.

© 2023 Innovative (Part of Clarivate)
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Review and set public access profiles and parameters

To review and set public access profiles and parameters:

1. In the Administration Explorer tree view, expand the organization for which you
want to set profiles or parameters.

2. Select Parameters or Profiles in the list under the expanded folder. The Para-
meters or Profiles tabs are displayed in the details view.

3. Select the appropriate tab:
l If you selected Parameters, click the PAC tab.

Note:
Search Agent Parameters is the only organization PAC
parameter. It controls the ability to set up and save automatic
searches in the PAC. See Setting Up Saved Searches in the
PAC.

l If you selected Profiles, click the PAC tab for general public access pro-
files; the PowerPAC tab for profiles specifically for Polaris PowerPAC;
the Children’s PAC tab for profiles specifically for Polaris PowerPAC
Children’s Edition; or the Mobile PAC tab for profiles specifically for
Polaris Mobile PAC.

The selected tabbed page appears.

4. Double-click the parameter or profile you want to set. The option value is high-
lighted for editing, or a dialog box appears.

Tip:
To get a setting from the next higher organizational level, right-click the
parameter or profile and select Inherit higher level values. To give a
setting to multiple lower organizations, right-click the parameter or profile
and select Transmit values to lower levels. Not all settings can be
inherited or transmitted.

5. Depending on the options, set the parameter or profile by typing text or selecting
an option, and click OK.

6. Select File > Save.
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Important:
To see the effects of your changes, you may need to update page caches.
See Updating Page Caches.

See also:

l PAC Profiles Reference
l Polaris PowerPAC Profiles Reference
l Children’s PAC Profiles Reference
l Mobile PAC Profiles Reference
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Setting Up Polaris PowerPAC - Overview

Many Polaris Administration settings control the features and behavior of the PAC in
general and affect both Polaris PowerPAC and Mobile PAC. However, specific Polaris
PowerPAC settings control the appearance and available features of Polaris PowerPAC.
You can also choose the overall appearance of Polaris PowerPAC pages from several
ready-made themes. In addition, you can customize most of the text that appears on
Polaris PowerPAC pages by editing the text strings in Polaris WebAdmin (Language
Editor).

Note:
For instructions on programmatic-level customization techniques, see the
Public Access Administration PDF Guide, PAC Customization.

You can customize Polaris PowerPAC to suit your library’s needs, from the home page
start-up to the features you choose to offer to patrons. For the home page, you can use
the Polaris PowerPAC portal page, including the dashboard lists, rotating book jackets
or content carousels, and custom content. Alternatively, you can use your own home
page. You can also offer events and hours pages. In general, you control what features
are available in Polaris PowerPAC with Polaris Administration settings that display or
suppress options.

Polaris PowerPAC settings for the organization to which the patron is connected
typically control the features and functions the patron sees. You can choose to allow
patrons to switch branches after they have connected to Polaris PowerPAC, by selecting
a branch in the Switch to another branch list. When the patron selects a different
branch, the settings for that branch become effective.

However, the system-level settings for the Patron Services parameter Consortium
Circulation determine what branch’s policies govern due date calculation, loan and
request limits, and fine calculation for renewals. Also, settings for the patron’s
registered branch control many patron account functions.

For general information about PowerPAC, see:

l Updating Page Caches
l Patron Privacy in the Library - Tips
l Polaris PowerPAC and JavaScript™
l Polaris PowerPAC Accessibility
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l Analyzing Polaris PowerPAC Use
l Customizing Language Strings

For instructions on setting PowerPAC profiles that control basic features, see:

l the Public Access Administration PDF Guide, Set up basic operating features for
Polaris PowerPAC.

For information about options for displaying, managing, and circulating eContent, see:

l Managing EContent in the PAC

For information about display and feature options for PowerPAC, see the following
topicsin the Public Administration Guide:

l "Set Polaris PowerPAC features on the menu bar"
l "Customize the page header"Customize the page header
l "Add text to the Events page"Add text to the Events page
l "Add text to the Policies page"
l "Setting Polaris PowerPAC Themes"
l "Customizing Portal Page Features"
l "Content Carousels on the PowerPAC Portal Page"
l "Defining Web Parts for Dashboards"
l "Setting Up RSS Feeds"
l "Setting Up Live Virtual Reference Services"
l "Polaris PowerPAC Help"
l "Prompting PowerPAC Users to Accept Cookies"

Updating Page Caches

When you change Polaris PowerPAC, Mobile PAC, and PowerPAC Children’s Edition
settings, you might need to update page caches to see the effects of your changes.
Most cached information is stored at the application level on the Web server. You can
update that information with the Reload tool in Polaris WebAdmin (Language Editor).
For more information, see the WebAdmin online help. Some information is stored at the
session level (one session for each currently connected client browser), and you cannot
reload each session’s cached data for security reasons. In these cases, restart the
Internet Information Server (IIS) to clear the cache and load any pages that have
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changed. Hosted customers should contact Customer Support to perform an IIS reset.
You might also need to close and re-open browsers. You might want to organize
changes to Polaris PowerPAC or Mobile PAC so that you do much of your planned work
in one session.

Patron Privacy in the Library - Tips

In Polaris PowerPAC, the browser Back button does not work past the log-in screen. For
example, if the patron does a search, then logs in to the patron account, then logs out,
the next patron cannot use the Back button to see the previous patron’s account pages
or search results.

You can also set an inactivity timeout for logged-in patrons working in the library. The
patron is automatically logged out after a specified period. Search the Polaris online
help for "Set an inactivity timeout for in-house workstations."

“Autocomplete” is the browser feature that automatically supplies information on forms,
based on past entries. You should disable the Autocomplete feature in public
workstation browsers. In Internet Explorer, for example, select Tools, Internet Options.
On the Content tabbed page, select AutoComplete. Clear Usernames and passwords on
forms. This prevents previous usernames and passwords from being exposed when the
next patron logs in to use a feature.

Polaris PowerPAC and JavaScript™

Polaris PowerPAC uses JavaScript, and displays a warning message at the top of the
page when JavaScript is disabled in the user’s browser.

The default message is
JavaScript has been disabled in your browser. Please enable JavaScript to enjoy all
features of this site.

You can customize the message in Polaris Language Editor (WebAdmin). For more
information about editing messages, see Customizing Language Strings.
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Polaris PowerPAC Accessibility

Polaris PowerPAC pages include features to facilitate accessibility in the following
ways:

l ALT tags provide text equivalents for inline images.
l “Skip navigation” links are included at the top of each PowerPAC page.
l Table header <TH> tags distinguish column headers for data tables, such as those

displayed on patron account pages.

Although these features are not generally visible when the pages are displayed, they
improve the experience of patrons who use screen readers.

Note:
If you customize PowerPAC pages, you will likely want to retain these
features. For more information about code-level customization, see the
Polaris Developer Network.

In addition, the footer of the page displays a text-only site index.

The available links depend on the features you have enabled in Polaris Administration.
For example, if you have suppressed Boolean searching from the menu bar, it is also
suppressed from the site index.
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Analyzing Polaris PowerPAC Use

Google Analytics is a free tool from Google that allows website administrators to record
and analyze traffic on their sites. Polaris PowerPAC includes the JavaScript code for
Google Analytics 4 in the page footer. To use this feature, open the Polaris
Administration PowerPAC profile PowerPAC Analytics. The profile is available at the
system, library, and branch levels. On the Google tab, select Enable and supply your
Google Analytics 4 measurement ID. For more information about Google Analytics, and
to obtain a measurement ID, go to:
https://analytics.google.com/analytics/.

Alternatively, you can supply your own JavaScript for site analysis. Open the PowerPAC
Analytics profile. On the Custom tab, select Enable, and type your JavaScript code in the
field provided.

Note:
This profile also applies to Polaris PowerPAC Children’s Edition. A
separate profile applies to Mobile PAC. Search Polaris online help for
"Analyzing Polaris Mobile PAC Use."

Note:
If the PAC browser session is run directly on the PAC server, the following
domain must be open for Google Analytics to work properly:
Port 80/443: google-analytics.com

Set up basic operating features for Polaris PowerPAC

To set basic operating features for Polaris PowerPAC:

1. Set up the Polaris PowerPAC Web server in Polaris Administration. See Setting
Public Access Profiles and Parameters.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PowerPAC tab in the details view.

Note:
Except where noted in this procedure, you can set these profiles at the
system, library, or branch level.

https://analytics.google.com/analytics/
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3. To allow remote connections to Polaris PowerPAC, double-click the PowerPAC pro-
file Remote User PowerPAC: Enable, and select Yes. If you use Polaris PowerPAC
as your PAC interface only in the library, and you do not offer remote PAC access,
set this profile to No.

4. To allow access to the portal page, double-click the PowerPAC profile Navigation:
Portal, and select Yes.

This setting displays the Portal option on the Library Info menu. Set this
profile to Yes if you are using the portal page as the Polaris PowerPAC home
page. For more information, see Customizing Portal Page Features. Set this
profile to No if the home page is a library page from which patrons access
the public catalog. When you turn off the portal button, the default Polaris
PowerPAC home page is the keyword search page.

5. To allow access to the library Web site from the portal page, or to another page
you specify, set these PowerPAC profiles:

l Double-click Navigation: Web Site, and select Yes. This setting displays the
Web site option on the Library Info menu.

l Double-click Navigation: Web Site URL, and type the URL or complete net-
work path to the page you want to display. If you leave this value blank, the
default page website.aspx is displayed.

Note:
Website.aspx is stored on the Web server
(Polaris/PowerPAC/library/website.aspx. You can edit the file to display a
set of appropriate Web links. If you customize this file, back up your
changes to preserve them in case Polaris is reinstalled on the server.

6. To allow patrons to connect to other branches in the system once they have con-
nected to Polaris PowerPAC, double-click the PowerPAC profile Branch Switching:
Enable, and select Yes.

This setting allows patrons to choose branches in the Branch list on the
Polaris PowerPAC banner. The chosen branch’s settings become effective. If
you set this to No, the patron can connect only to the organization
represented by the connection URL.

If you set Branch switching: Enable to Yes, select Profiles, select the PAC
tab, and set the PAC profile Branch list Order to specify the display order of
the branches: select Yes to display the branch names in ascending
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alphabetical order by name, or No to display the branch names in ascending
numerical order by internal organization ID.

With either setting, the system organization is always first. This profile also
controls the display order of branches on the search options page, the self-
registration page, and the donations page. The setting for the current
connection branch is used. The profile also controls the display order of the
list of pick-up libraries for requests, but in this case the setting for the
patron’s registered branch is used.

Note:
Use the system-level PAC profile Suppress branches to suppress a
branch from display in the Switch to another branch list. This profile also
suppresses the selected branches from the branch lists on the Search
Options scoping page, the Advanced Search scoping page, and the
donation page.

7. To log transactions (such as hold requests and renewals) initiated through Polaris
PowerPAC, select System, Profiles and select the PowerPAC tab, select Enable
logging of transactions, and select Yes.

Note:
This setting is available at the system level only.

8. To allow patrons to log on once for the Polaris PowerPAC session, double-click
Single Login: Enable, and select Yes.

When this profile is set to Yes, the My Account menu and page footer display
a Log In option. Once logged in, patrons select a Log Out option or quit
Polaris PowerPAC to log out. For more information, see Controlling Patron
Account Login and Access. Be sure to set the profile to Yes in these cases:

l You offer e-sources that require patron log-in. See Setting Up E-Source
Targets.

l You offer the ability to save searches, and want patrons to be able to
work with a list of their saved searches in the dashboard. See Setting
Up Saved Searches in the PAC.

l Your library uses 3M™ Public Access Management System smart
cards. See step 10.
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9. To display a link to Polaris PowerPAC Children’s Edition on Polaris PowerPAC
pages, double-click Navigation: Children’s PAC, and select Yes.

Note:
Polaris PowerPAC Children’s Edition is available by specific contract.

10. If your library uses 3M™ Public Access Management System smart cards, double-
click 3M PAMS: Enabled, and select Yes.

Patrons use smart cards to log in by placing the card in a reader. The cards
may also provide scheduling and fund transaction capabilities. If you set this
profile to Yes, also set Single logon: Enable to Yes.

Note:
Polaris PowerPAC workstations with readers must be listed in the In-
House IP Addresses table. See Setting Public Access Profiles and
Parameters.

11. Select File > Save.

Related Information

l Page header - You can specify colors and your own logo image and position for
the page header. See Customize the page header.

l Page themes - You can choose the overall appearance of Polaris PowerPAC pages
from several ready-made themes. See Setting Polaris PowerPAC Themes.

l Portal page - See Customizing Portal Page Features.
l Main menu bar features - See Set Polaris PowerPAC features on the menu bar.
l Messages - Certain messages and labels on the portal page are stored in your

database, and you can edit them in Polaris Administration. If you have Polaris
PowerPAC Multilingual Version, you can edit them for each supported language.
See Edit PowerPAC messages and labels.

l Dashboards - See Defining Web Parts for Dashboards.
l Searching options - See Setting Available Search Types.
l Search results display - See Displaying PAC Search Results.
l Patron help - See Polaris PowerPAC Help.
l Patron log-on and access to patron accounts - See Setting Up Patron Account

Access.

l Email from PAC - Set the following PAC profiles for patron email:
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o Double-click Email notification: Email address of sender, and type the
address that should appear on patron email from the library (such as when a
patron sends a title list by email). You can use a real address or a fictitious
account. It must contain the @ symbol.

o Double-click Email notification: Server running SMTP service, and type the
domain name of the email service.

l Editing text on Polaris PowerPAC pages - You can edit most of the text on Polaris
PowerPAC pages, and preserve your changes from being overwritten if the applic-
ation is updated and reinstalled. See Customizing Language Strings.

l PowerPAC profiles - For reference information about each Polaris PowerPAC pro-
file, see Polaris PowerPAC Profiles Reference. For basic information about setting
profiles, see Setting Public Access Profiles and Parameters.

l Server settings - Certain parameters at the server level determine how Polaris
PowerPAC works in the context of the system network. See Setting Public Access
Profiles and Parameters

Customize the page header

You can customize the header for all PowerPAC pages using the PowerPAC profile
Page header options. The profile is available at the system, library, and branch levels;
the system uses the setting for the PowerPAC connection organization. You can specify
your own graphic file for the header logo. This area is also a link to the Polaris
PowerPAC home page (the portal page, if you choose to use it, otherwise the keyword
search page or a destination you specify).

The profile also offers options to set the position of the logo image and branch name for
medium and wide screens. You can also set custom colors for background and text, and
suppress the branch name text if your logo already includes this information.
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To customize the PowerPAC page header:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PowerPAC tab in the details view.

2. Double-click Page header options. The Page Header Options dialog box opens.

3. If you will use your own logo, type the path for your custom graphic file, in the
Alternate logo (URL) box.

If none is specified, the default logo image is used. Any standard graphic file
format, such as .gif or .jpg, is acceptable. The maximum image width is 1500
pixels. The system scales the image for the medium display.

Example:
[PACWebServer]/Polaris/custom

Note:
You can place the graphic file in a different location. In this case, type the
complete URL for that location. Be sure the security settings for the
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directory allow access to the file. The location must have a security (SSL)
certificate.

4. Select Left, Center, or Right to position the logo and branch name in the header.
The default position is center. This setting applies to medium and wide screen dis-
plays only.

5. If your logo image already includes your branch name, check Exclude the branch
name to suppress the branch name text string from the header. Narrow width dis-
play: When this option is checked, the logo is displayed in the narrow width header,
appropriately scaled. If you leave this option unchecked, only the branch name is
displayed in the narrow width header.

Note:
If you suppress the branch name at the system level, and all connection
branches inherit the system setting, users cannot readily determine their
connection branch after switching branches if the branch logo does not
include the branch name. To avoid this problem, you can suppress the
organization name for the system but allow the branch name to be
displayed at the appropriate branches by setting the profile at the branch
level.

6. In the Return link URL for header logo box, type the URL for the page that should
appear when the user clicks the header logo or branch name. If this setting is left
blank, the link destination is the portal page if you choose to use it, or the keyword
search page if you do not use the portal page.

7. Set custom background and/or branch name text colors:

a. Select Customize background color, Customize branch name text color, or both.

Note:
You can suppress the branch name text from the header, which you may
want to do if your logo image includes the organization name. See step 5
above.

b. Select the drop-down arrow for each selected option to access the color picker.
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c. Click a color, or click Other to open the color tool.

l To select a color on the Standard tab of the color tool, click Select and click the
color or gray-scale value.

l Or click the Custom tab to select a color from a palette. Alternatively, you can type
standard RGB values.
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d. Click OK to close the color tool.

Tip:
Reload Polaris PowerPAC to see your changes. See Updating Page
Caches.

8. Click OK to close the Page Header dialog box and save your changes.

Related Information

l Page themes - You can choose the overall appearance of Polaris PowerPAC pages
from several ready-made themes. See Setting Polaris PowerPAC Themes.

l Portal page - See Customizing Portal Page Features.
l Basic setup - See Set up basic operating features for Polaris PowerPAC.
l Advanced customization - See the PAC Customization Guide.

Set Polaris PowerPAC features on the menu bar

All menu features are available regardless of screen size, but certain options shift to
accommodate display on a narrow phone screen. The example below shows main menu
options on a desktop or tablet screen.
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For the narrow screen size (phone), certain options move from the default
desktop/tablet position to a menu.

When the user taps Menu, a "flyout" menu displays the main menu options .

To set Polaris PowerPAC features on the menu bar:
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PowerPAC tab in the details view.

Note:
You can set these profiles at the system, library, or branch level.

2. To allow access to an events page, double-click Navigation: Events, and select
Yes. This setting displays the Events option on the Library Info menu. When the
patron selects Events, the events page on the Web server, Polar-
is/PowerPAC/library/events.aspx, is displayed. For information about editing the
events page, see Add text to the Events page.

3. To allow access to a policies page, double-click Navigation: Policies, and select
Yes. This setting displays the Policies option on the Library Info menu. When the
patron selects Policies, the policy page on the Web server, Polar-
is/PowerPAC/library/policies.aspx, is displayed. For information about editing the
policies page, see Add text to the Policies page.

4. To allow patrons to send an e-mail message to a designated library address,
double-click Navigation: Ask Us, and select Yes. This setting displays the Ask Us
option on the Library Info menu. For information about setting up the Ask Us fea-
ture, see Set up and start Ask Us.

5. To allow access to patron accounts, double-click Navigation: Patron Account, and
select Yes. This setting displays the My Account option on the main menu bar.
See Setting Public Access Profiles and Parameters.

6. To offer access to help topics, double-click Navigation: PAC Help, and select Yes.
This setting controls access to the html help files that Innovative Interfaces
provides with Polaris PowerPAC. See Polaris PowerPAC Help.

7. To allow access to the e-Sources page, double-click Navigation: E-Sources, and
select Yes. This setting displays the E-Sources option on the Search menu. E-
sources are non-Z39.50, proprietary databases that may require authentication for
use. See Setting Public Access Profiles and Parameters. When the patron selects
this option, the e-Sources page is displayed.

8. To allow access to an Hours page, double-click the PowerPAC profile Navigation:
Hours, and select Yes. This setting displays the Hours option on the Library Info
menu. When the patron selects Hours, the hours page on the Web server, Polar-
is/PowerPAC/library/hours.aspx, is displayed. The Hours page includes location
information and optional schedule information for the current connection organ-
ization. The schedule information is drawn from settings in the Patron Services
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parameter Hours of operation for the connection organization. The location
information comes from the organization administration record. For formatting
options, see step 10.

9. Select File, Save.
10. To set the information to display on the Hours page, choose one or both of the fol-

lowing PAC profiles:

Note:
These settings also affect Mobile PAC.

l To display the organization’s hours formatted in a table, set the PAC profile Hours
of operation: Display to Yes.

Important:
The hours listed in the table on the PAC Hours page are controlled by the
settings in the Patron Services parameter Hours of operation. Even if you
do not want to display the table on the PAC Hours page, you must set up
the organization’s schedule in the Patron Services parameter Hours of
operation, because these settings also affect due dates and other
circulation processes.

l To specify a message to display on the Hours page, double-click the PAC profile
Hours of operation message. (This option is useful for organizations with split
hours or other conditions that the Hours of Operation table does not accom-
modate.) The Language Strings dialog box opens.

Choose a language from those licensed for Polaris PowerPAC. Then double-click
the message field in the Display text column and type the message (up to 500
characters). Click OK.
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Notes:
You can insert diacritic characters in your message. Click Diacritics. In the
Character Picker dialog box, select a graphic character set. Then select
the character, and click Insert.

You can also use the PAC profile Multiple language strings to specify the
message. This method may be more convenient if you have multiple
messages to customize. For more information, see Editing Messages and
Labels.

11. Select File, Save.

Related Information

l Search options - See Setting Available Search Types.
l Profile list - See Polaris PowerPAC Profiles Reference.

Add text to the Events page

The Events page is displayed when a patron selects Events on the Library Info submenu
in Polaris PowerPAC. The Events page is located on the Web server, Polaris
[version]/PowerPAC/library/events.aspx. You can place your own text on the page by
editing the file Polaris [version]/PowerPAC/library/userdef/ud_events.ascx. You can
format your text with basic HTML tags.

Note:
Be sure your custom content displays correctly for wide (computer),
medium (tablet), and narrow (phone) screens.

To add events or other text to the events page:

1. On the Web server, open the file Polaris [version]/PowerPAC/library/userdef/ud_
events.ascx in any HTML or text editor. The text of the file is displayed in the
editor.

2. Insert your text between the elements </div> and <!-- End -->. For example:

SessionObject.GetLanguageString("PACML_UD_EVENTS_1118") %></div>

<p> event1 </p>

<p> event2 </p>
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<p> event3 </p>

<!-- End -->

3. Save the file.
4. Back up your edited file to preserve your changes from being overwritten when

Polaris PowerPAC is reinstalled on the server.

Note:
To display the Events option on the Library Info menu, set the PowerPAC
profile Navigation: Events to Yes.

Add text to the Policies page

The Policies page is displayed when a patron selects Policies on the Library Info menu
in Polaris PowerPAC. The Policies page is located on the Web server, Polaris
[version]/PowerPAC/library/policies.aspx. You can place your own text on the page by
editing the user-defined file Polaris [version]/PowerPAC/library/userdef/ud_
policies.ascx. You can format your text with basic HTML tags.

Note:
Be sure your custom content displays correctly for wide (computer),
medium (tablet), and narrow (phone) screens.

To add text to the policies page:

1. On the Web server, open the file Polaris [version]/PowerPAC/library/userdef/ud_
policies.ascx in any HTML or text editor. The text of the file is displayed in the
editor.

2. Insert your text between these elements: SessionObject.GetLanguageString
("PACML_UD_POLICIES_1123") %></asp:panel></p>and <!-- End -->. For example:

SessionObject.GetLanguageString("PACML_UD_POLICIES_1123")
%></asp:panel></p>

<p> policy1 </p>

<!-- End -->
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3. Save the file.
4. Back up your edited file to preserve your changes from being overwritten when

Polaris PowerPAC is reinstalled on the server.

Note:
To display the Policies option on the Library Info menu, set the PowerPAC
profile Navigation: Policies to Yes.

Setting Polaris PowerPAC Themes

You can change the overall appearance of your library’s Polaris PowerPAC, without
complex coding, by choosing a page theme (skin). You can set themes at the system,
library, or branch level. When a patron connects to Polaris PowerPAC, the connection
branch’s theme is displayed. If you allow patrons to switch branches, the theme
changes according to the selected branch’s setting. Five themes are available: Ocean
(the default), Pomegranate, Mint, Black & Gold, and Gray. You can also set the
dashboard position (left or right side of the page) for any theme you select.

To set a Polaris PowerPAC theme and dashboard position:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PowerPAC tab in the details view.

2. Double-click Theme selection, and select a theme from the drop-down list.
3. Double-click Theme dashboard position, and set the position of the dashboard

(Left or Right) for your selected theme.

Note:
This setting does not affect the product page (full display) for an entry in
the user’s search results. The product page dashboard is always on the
right.

4. Select File > Save.
5. Reload PowerPAC pages to see your changes. See Setting Up Polaris PowerPAC -

Overview.

Related Information

l Editing theme fonts and colors - Theme appearance is controlled by a shared style
sheet (.css) file. You can override fonts, colors, and link appearance for a custom
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theme. For more information, see Setting Public Access Profiles and Parameters.
l Editing text on Polaris PowerPAC pages - You can edit most of the text on Polaris

PowerPAC pages no matter what theme is chosen, and preserve your changes
from being overwritten if the application is updated and reinstalled. See Cus-
tomizing Language Strings.

Customizing Portal Page Features

The default Polaris PowerPAC portal page offers a quick search feature; content
carousels or rotating book jackets; optional custom content; and specific dashboard
elements. The illustration shows the Polaris PowerPAC portal page (Ocean theme) with
a content carousel.

Each branch can use the default portal page or a custom portal page, or all
organizations can share a single portal page. You can designate the portal page as the
home page, see Set up Polaris PowerPAC.

You can customize the portal page with the following features:

l Default quick search - The default quick search launches a keyword search in any
field. You can set the search field, the default search filter (Limit by), the database
to search, and the sort order for results in Polaris Administration, although patrons
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cannot specify these options for the quick search other than selecting a search fil-
ter. By selecting an option in the Limit by list, a patron can limit the quick search
by any filter you offer. For information about search filters, see Setting Up Search
Filters (Limit By).

l Quick search with search option buttons - You can provide optional buttons with
the quick search feature, instead of a search filter. The patron types the search
text and selects a button to launch a particular type of search. You can offer Any-
where, Fiction, Nonfiction, My Library, My Library plus Articles, Subject, Title,
Author, and Series buttons. Anywhere, Fiction, and Nonfiction, My Library, or My
Library plus Articles are always keyword searches. For Subject, Title, Author, and
Series, you can specify whether a keyword or browse search should be launched.
See Set up basic operating features for Polaris PowerPAC.

l Rotating book jackets - If you subscribe to enriched data, you can offer rotating
book jacket images on the portal page. Each time the page is loaded, the image
changes to show the book jacket of a title randomly selected from best-seller lists.
When a patron selects the jacket image, a search is launched for the title. If the
title is not found, a form opens where the patron can ask the library to purchase
the title. See Set up basic operating features for Polaris PowerPAC.

l Custom content - You can also place custom content on the portal page. See Set
up custom portal page content.

l Content carousels - A content carousel is a rotating graphical representation of a
list of materials in the local library catalog. The PowerPAC user can click any title
in the carousel to launch a search for the title in the catalog. You can set up con-
tent carousels based on bibliographic record sets, and/or on certain system-
defined and automatic dashboards (Web parts). See Content Carousels on the
PowerPAC Portal Page.
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l Custom dashboard links - Web parts can provide links to pre-defined searches or
Web sites. See Defining Web Parts for Dashboards.

Set Up Quick Search with Search Option Buttons

By default, the Polaris PowerPAC portal page includes a quick search feature that allows
the patron to select a search filter. You can choose instead to supply a quick search
feature with search option buttons.

To set up the quick search feature with search option buttons:

Note:
You can set up the quick search with search option buttons at the system,
library, or branch level. The settings for the organization to which the
patron is connected determine whether this feature is available.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PowerPAC tab in the details view.

2. Double-click Quick search button configuration. The Quick Search Button Con-
figuration dialog box opens.

3. Select Enable quick search buttons. The remaining options become available for
selection.

Note:
If you select Enable quick search buttons but do not select any specific
buttons, Polaris PowerPAC will use the default quick search feature
instead of the quick search with buttons.

4. Select each button option that you want to display for quick search.
5. Select the search type (Browse or Keyword) that each selected button should

launch.

Notes:
Anywhere always launches a keyword search for the search text in any
indexed field in the bibliographic records. This type of search is also
launched if a patron presses ENTER without selecting a search option
button.

Fiction and Nonfiction also launch keyword searches in any indexed field,
but filtered by fiction or nonfiction as appropriate. The system determines
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whether a title is fiction or non-fiction by the following bibliographic
record information:

Fiction - 008/33= 1, c, d, f, h, j, p

Nonfiction - 008/33 = 0, e, i, s

Selecting My Library searches only your library's database.

If your library subscribes to EBSCO Discovery Service (EDS) and has
integrated EDS with Polaris PowerPAC, selecting My Library plus Articles
searches your library's database plus articles from EDS.

Keyword search results are presented as a list of titles that match the search
criteria. The results are sorted by relevance. Brief information is presented about
each title, and the patron can select various options to see more information. See
Displaying PAC Search Results.

Browse search results initially present the portion of the index or title listings that
begins with the search text. Patrons can browse through the index or title listings
and select an entry to see the titles associated with the entry.

6. Click OK.

Related Information

Default quick search settings - If you choose to use the default quick search instead of
the quick search with search option buttons, you can set certain values that apply to
every quick search. See Specifying Default Search Settings.

Set up rotating book jackets

If you subscribe to an enriched data service, you can display book jacket images drawn
from the enriched data source, randomly selected from the titles in the best-seller lists
provided for dashboards. See Setting Public Access Profiles and Parameters. A
different image is displayed each time the portal page is accessed or refreshed. When a
patron selects the image, a search is launched in the catalog for the title. If the title is
not found in the catalog, the patron can click an email link to the library to request that
the title be purchased. To set up rotating book jackets (system, library, or branch level):
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1. Set up the subscription to the enriched data service. For more information about
enriched data, see Setting Public Access Profiles and Parameters.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PAC tab in the details view.

3. Double-click Enriched data.
4. Enable cover images from your enriched data provider.
5. In the Administration Explorer tree view, open the Profiles folder for the organ-

ization, and select the PowerPAC tab in the details view.
6. Double-click Rotating best seller jacket on portal page, and select Yes.
7. Select File, Save.

Related Information

l Email server and address for purchase request - When a search on the book jacket
returns no results in the library catalog, the patron can request that the library pur-
chase the title. Any email from PAC, including the purchase request, requires you
to specify the SMTP server in Polaris Administration. Double-click the PAC profile
Email notification: Server running SMTP service, and type the domain name of
the email SMTP server. The purchase request goes to the email address specified
for Ask Us email. See Set up and start Ask Us.

l Rotating book jackets and content carousels - A content carousel is a rotating
graphical representation of a library-specified list of materials in the local library
catalog. The PowerPAC user can click any title in the carousel to launch a search
for the title. While it is possible to enable both rotating book jackets and content
carousels on the portal page, the result will likely confuse the user since the fea-
tures may appear somewhat similar but serve different purposes. Innovative
recommends that you enable one or the other of these features, but not both. If
you do enable both, the content carousel appears below the rotating book jacket
image. See Content Carousels on the PowerPAC Portal Page.

Set up custom portal page content

You can display your own content on the portal page. To specify the link to your content:

Tip:
If you use Polaris Bookstore, you can use the custom content area to
promote the bookstore. For more information about Polaris Bookstore,
see Enabling Online Book Purchases.
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PowerPAC tab in the details view.

2. Double-click Portal custom content (URL).
3. Type the complete URL for your content, beginning with http://.
4. Select File, Save.

Custom Portal Page Content Tips
l The HTML content from the page you specify will be displayed in the custom con-

tent area on the portal page. You can include elements such as links and graphics,
but be sure the source HTML specifies an absolute path for these elements.

l Be sure your custom content displays correctly for wide (computer), medium (tab-
let), and narrow (phone) screens.

l You do not have to reload Polaris PowerPAC to clear the cache whenever you
change your custom content. The HTML is reloaded whenever the portal page is
accessed and the content was cached more than five minutes previously. Also,
you can enable or disable the custom content by setting or clearing the profile
without reloading Polaris PowerPAC.

Content Carousels on the PowerPAC Portal Page

A content carousel is a rotating graphical representation of a list of materials in the local
library catalog, displayed on the PowerPAC portal page. The PowerPAC user can click or
tap any title in the carousel to launch a search for the title in the library catalog.
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Each carousel can consist of a specified bibliographic record set created in the staff
client, or titles from any of the following system-defined and automatic dashboards
(Web parts):

l Most Circulated Titles
l On-Order Items
l New Books
l New Large Print
l New Sound Recordings
l New Videos
l BookSense best-seller lists:

o Children's Fiction Series
o Children’s Illustrated
o Early and Middle Grade Readers
o Hardcover Fiction
o Hardcover Non-Fiction
o Mass Market
o Trade Paperback Fiction
o Trade Paperback Non-Fiction
o Young Adult
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Tip:
The content carousel is not intended to be an alternate display of the
best-seller lists as they appear in the dashboard. Instead, it is an entry
point into the library’s collection because it contains only materials known
to be in the library’s database.

For more information about these system-defined and automatic Web parts, see
Defining Web Parts for Dashboards.

Carousels based on record sets are populated when they are displayed. If a title is
added to or deleted from a record set, the carousel is updated when the page cache is
refreshed (for example, through IIS reset or auto-cycling), rather than every time the
carousel appears. If the record set is deleted, the carousel is not created and does not
appear on the page. Carousels based on automatic and system-defined dashboards are
also refreshed to reflect new content whenever the cache is rebuilt in PowerPAC.

There is no limit to the number of content carousels that can appear on the portal page,
but you may find that displaying too many content carousels will adversely affect
response time.

Tip:
If a bibliographic record on a carousel is deleted or updated to not display
in PAC, it will continue to display on the carousel until the cache is rebuilt.
If the user selects that record before the cache is rebuilt, the search
returns 0 results.

l Carousel title display - Content carousels display only titles for which there is a bib-
liographic record in the local database. The record must be set to display in PAC,
and the record status must be final. For each title, the carousel contains the cover
image if any, and title and author tags and subfields specified in the Primary Dis-
play Title and Primary Display Author database tables. When the PAC connection
is to a branch, carousels based on new titles include only new titles for that
branch. When the PAC connection is to the system, the carousel includes new
titles for the whole system.

l Sort order and entry point - Carousels based on ranked best-seller lists are sorted
in the ranked order provided by the best-seller list supplier. All other carousels are
sorted in title order. The carousel “starts” at a random point in the list every time it
appears, and the display is circular. That is, the user can scroll endlessly through
the carousel. When the carousel reaches the end of the designated sort order
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(when the scrolling forward) or the beginning (when scrolling backward), the carou-
sel continues at the beginning (or end) of the sorted list.

l Maximum entries - Content carousels display a maximum of 50 titles. If the list
that generates the carousel contains more than 50 items, only the first 50 items in
the sorted list appear in the carousel, using the sort order described above.

l Content carousels and rotating book jackets - You can enable a rotating, random
book jacket image on the portal page. The user clicks the book jacket image and if
the title is not in the library catalog, the user can request that the library purchase
it. For details, see Set up rotating book jackets. While it is possible to enable both
rotating book jackets and content carousels on the portal page, the display may
confuse the user since the features may appear somewhat similar but serve dif-
ferent purposes. Polaris recommends that you enable one or the other of these
features, but not both. If you do enable both, the content carousel appears below
the rotating book jacket image.

You can set up content carousels at the system, library, or branch level. The system
uses the settings of the PowerPAC connection organization. To set up content
carousels:

Important:
Content carousels are displayed on the PowerPAC portal page. You must
also enable the portal page. See Set up Polaris PowerPAC.

1. To enable the display of cover images in content carousels, check that enriched
data options for cover images have been set in Polaris Administration. See
Enabling Enriched Data.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PowerPAC tab in the details view.

3. Double-click Portal page content carousels. The Portal Page Content Carousels
dialog box opens.
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4. Select Enable.
5. To add a dashboard carousel, select a dashboard (Web part) from the dashboard

list and click Add New Dashboard Carousel. The selected dashboard appears in
the Carousels list in the upper part of the dialog box. For more information about
these lists, see Defining Web Parts for Dashboards.
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6. To add a record set carousel, follow these steps:

a. Click Find. The Find Tool for bibliographic record sets opens.
b. Search for the record set and select one or more record sets in the results lists.

Tip:
You can search for any bibliographic record set. Existing rules and
permissions are in effect when searching for and selecting record sets.
For example, you cannot find record sets owned by individuals other than
yourself.

The record set or sets you selected are displayed in the record set list.

c. To create the carousel, select the record set in the list and click Add New Record
Set Carousel. The selected record set appears in the Carousels list in the upper
part of the dialog box.
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7. By default, the carousel name is the name of the dashboard or record set. To
assign a different display name for the PAC:

a. Select the carousel in the Carousels list. The name appears in the text box just
below the list.

b. Type the new name and click Rename.

8. To set the display order of multiple carousels, select a carousel and click the up
arrow to move it closer to the top of the list, or click the down arrow to move it
closer to the bottom. The order of the list represents the display order in PAC.

9. Click OK.

Related Information

l Delete a carousel - Select the carousel in the Carousels list and click the Remove

carousel icon .
l Inherit settings from a parent organization - The top of the dialog box indicates the

organization where the current carousel options have been set. To inherit the set-
tings of the parent organization, click the up arrow at the top of the dialog box.

l Content carousels and Community Profiles - For libraries that use Polaris Com-
munity Profiles, organization representatives can display content carousels on the
organization’s page in PAC search results or on the organization’s own web site
through widgets that are created with ContentXChange. These carousels can
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consist of title lists or searches saved in association with the organization rep-
resentative’s patron account. See the Community Profiles Guide.

Defining Web Parts for Dashboards - Overview

Web parts are displayed in the dashboard area on the side of the pages on Polaris
PowerPAC and Polaris PowerPAC Children’s Edition. Web parts can provide links to pre-
defined searches or websites and deliver messages or instructions. Different web parts
can be displayed on different pages. You set up web parts at the system level for use by
any or all branches. Then, each branch can choose which web parts to display on the
dashboard for any particular page.

Note:
Separate Polaris Administration profiles control web parts for Polaris
PowerPAC and Polaris PowerPAC Children’s Edition, but the process for
setting up the web parts is the same for both PACs.

For general information on web parts, see:

l Automatic Web Parts
l Custom Web Parts
l Best-Seller Lists from IndieBound (Book Sense, Inc.)

For information on creating and using web parts, see:

l Create a custom web part
l Assign web parts to public pages
l Limit items in Polaris and third-party lists
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For reference lists of Polaris PowerPAC and Polaris PowerPAC Children's Edition pages,
see:

l Polaris PowerPAC Pages Reference
l Polaris PowerPAC Children's Edition Pages Reference

Automatic Web Parts

Polaris provides several web parts that are automatically updated by background
database processing, using transactions at your library to determine the contents of the
lists:

l Most Circulated - The Most Circulated web part elements are links that launch
searches for popular titles, authors, or subjects in the Polaris database, based on
circulation statistics for the past 31 days. Only items that are marked for display in
PAC are listed. By default, the SQL job Dashboard_MostCirculated updates the list
once a month.

l New Titles - The New Titles web part elements are organized by the broad material
categories Books, Videos, Sound Recordings, and Large Print. When the patron
selects a category, the page displays appropriate links that launch searches for
titles that have recently been added to your catalog. Only items that are marked for
display in PAC are listed, and an item must have been checked in to be eligible for
inclusion. By default, the SQL job Dashboard_NewTitles updates the list nightly
and includes items new in the last 31 days. Although the title search is for bib-
liographic records, if the process finds any bibliographic records that do not have
a First Available date, the process checks their associated items to see if an item
has become available since the last time it was processed. If so, the First Available
date in the bibliographic record is updated with the item’s First Available date. You
can also provide RSS feeds from the New Titles web part. See Setting Up RSS
Feeds.

Note:
When the PAC connection is to a branch, the patron sees only new titles
for that branch. When the PAC connection is to the system, the patron
sees new titles for the whole system.

l On-Order Items  - The On-Order Items web part elements are links that launch
searches for titles in the Polaris database that have linked items with a status of
On Order. By default, 20 titles are listed; the title that has the linked item with the
most recent status change to On Order is listed first. If more than one On-Order
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item is associated with a bibliographic record, the most recent On-Order item is
used to order the list. Only titles that are marked for display in PAC are listed. This
web part is updated as part of the nightly Dashboard_NewTitles job.

Tip:
By default, Narrow and Related web parts are displayed on the search
results page. You can determine whether or not to display these features,
specify the filters and categories they contain, and customize the labels.
See Setting PowerPAC Narrow/Related Search Options. You cannot
specify the number of elements in them or assign them to other pages.

You can set the number of items that are automatically listed in the Most Circulated,
New Titles, and On-Order Items web parts. See Limit items in Polaris and third-party
lists.

Polaris also provides a Make a Donation web part that allows users to make a donation
to the library by credit card. The user does not have to log in to make the donation.

Custom Web Parts

You can create custom web parts tailored to your needs and programs. See Create a
custom web part. Custom web parts can include any combination of the following types
of data elements:

l Title Search - Links that launch searches for specific titles. Title search elements
work well for listing titles for a particular purpose, such as a reading program, sea-
sonal reading, special-interest subjects, or a teacher’s reading list.

l URL - Links to websites or pages. You define the text or image that serves as the
link. The link element can be formatted with basic HTML tags. For example, you
can create a link to a URL that launches a search for the records in a record set cre-
ated in the staff client. See Searching Record Sets (Polaris PowerPAC).

l Free text - Text that is displayed in the web part. You can use free text for
announcements, page instructions, or for introducing other elements in the list.
The text can be formatted using basic HTML tag elements. You can include
images using the <IMG> tag.

Best-Seller Lists from IndieBound (Book Sense, Inc.)

The following web parts are updated automatically with content from IndieBound
(formerly Book Sense, Inc.), based on sales from over 350 independent bookstores in
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the United States: Trade Paperback Fiction, Trade Paperback Nonfiction, Hardcover
Fiction, Hardcover Nonfiction, Mass Market, Early and Middle Grade Readers, Young
Adults, Children's Fiction Series, and Children’s Illustrated. When a patron selects a title
from one of these lists, a search for the title is launched in the Polaris database.

Every week, Innovative Interfaces receives a file of the updated best-seller lists from
IndieBound. During overnight processing at your library, the BookSenseImport Microsoft
SQL Server Agent at Innovative Interfaces updates the best-seller lists at your site.

Polaris Customer Operations helps you set up your Polaris system to support updating
the IndieBound best-seller lists. The server running MS SQL Server must be able to do
FTP downloads, and your webpage caches must be cleared after the download to allow
the updated pages to be displayed (see Updating Page Caches).

You can limit the number of items that are automatically listed, but you cannot change
the contents of the lists. See Limit items in Polaris and third-party lists.

Create a custom web part

To create a custom web part, you define a heading for the web part and add data
elements to the heading. You can add any combination of elements to the heading. (You
create web parts for Polaris PowerPAC Children’s Edition separately from Polaris
PowerPAC, but the method is the same.)

To create a custom web part:

Important:
You can create web parts at the system level only. To actually display the
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created web parts in the PAC, you assign them to specific pages for the
appropriate organization. See Assign web parts to public pages.

1. In the Administration Explorer tree view, open the Profiles folder for the system,
and select the PowerPAC tab in the details view.

Note:
If you are working with web parts for Polaris PowerPAC Children’s
Edition, select the Children’s PAC tab.

2. Double-click Dashboards: Web part construction. The Web Part Editor dialog box
appears.

3. Select the User Defined tab.
4. Select Add by the Web Parts list to specify the heading for the new web part.
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The Add Web Part Title dialog box appears.

5. Type the heading text in the Title box, and select OK. The heading for the new web
part is displayed in the Web Parts list.

6. Select the heading in the Web Parts list to which you want to add elements.
7. Select Add by the Data Elements list.

The Add Data Element: Pick Type dialog box appears.
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8. Select one of the following element types to add to the web part. When you select
an element type, the appropriate Add … Element dialog box for the selected
element type appears:

l Title Search – Puts a title link in the list. When a patron selects the title in the
list, the title information is displayed as search results. Type the
bibliographic control number of the title, or select the title from the Polaris
Find Tool results list (select Find to display the Find Tool).

l URL – Puts a link to a website or page in the list. When a patron selects the
link, the browser displays the destination page. Type the link text in the
Title box, and type the uniform resource locator (address) in the URL box.
See also URL Data Elements and PowerPAC Context After Timeout.

l Free Text – Puts text in the list. Use free text for announcements, page
instructions, or introducing the list. Type the text of the announcement or
message you want to display. You can use basic HTML tags to format the
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text.

9. Select OK on the Add … Element dialog box. The new element is displayed in the
Data Elements list on the Web Part Editor dialog box.

10. Repeat steps 8 and 9 to add additional elements to the selected Web Part (head-
ing). You can add any combination of element types to a single heading.

11. When you are finished working with the library-defined web parts, select OK.
12. Select File > Save.

URL Data Elements and PowerPAC Context After Timeout

To protect patron privacy, Polaris PowerPAC is designed to return to the system
organization context after a timeout period even if the last connection had been to a
specific branch organization. For example:

l The user connects to Polaris PowerPAC at the system level.
l The user then clicks a link to an external page with a specific organizational con-

text (for example, a branch's hours page).
l The user has no activity and leaves the browser open for 20 minutes. PowerPAC

times out.
l The user then clicks a link to a page with a specific organizational context, but

Polaris PowerPAC returns to the system organization context.

If you want the URL on the external page to bring the user to the specific organization
context in the above circumstances instead of reverting to the system context , place
only the organization ID in the ctx portion of the URL data element. For example, use
ctx=30 instead of ctx=30.1033.0.1.
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Related Information

l Edit the title of a web part - Select the heading in the Web Parts list, and select Edit
by the Web Parts list.

l Delete a web part - Select the heading in the Web Parts list, and select Delete by
the Web Parts list.

l Edit an element in a web part - Select the heading in the Web Parts list, and select
the element in the Data Elements list. Select Edit by the Data Elements list.

l Delete an element from a web part - Select the heading in the Web Parts list, and
select the element in the Data Elements list. Select Delete by the Data Elements
list.

l Reorder the elements in a web part - Select the heading in the Web Parts list, and
select the element in the Data Elements list. Select Up or Down by the Data Ele-
ments list. The order in the Data Elements list determines the display order in the
dashboard.

l Add a web part to a page - See Assign web parts to public pages.

Assign web parts to public pages

Each organization specifies which web parts are displayed on the dashboard for
specific pages. You can add and remove web parts from individual pages without
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affecting other pages, and change the order in which web parts appear on any specific
page.

Note:
Custom web parts must be defined at the system level before they can be
assigned to public pages at the branch level. See Create a custom web
part. Web parts set up for Polaris PowerPAC are available to be assigned
to Children’s PAC pages, and web parts set up for the Children’s PAC are
available to be assigned to Polaris PowerPAC pages.

To specify which web parts are available on specific public pages for an organization:

Important:
Web parts are inherited from the system level unless you make any
change at the branch level. Then none are inherited for that branch and
you must make the appropriate assignments at the branch level.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PowerPAC tab (or Children’s PAC tab) in the details view.

Note:
You assign web parts to Polaris PowerPAC Children’s Edition separately
from Polaris PowerPAC, but the procedure is the same.

2. Double-click Dashboards: Web Page/Web Part Assignment. The Web Page - Web
Part Assignment dialog box opens.
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3. In the Web Pages list, select the public page to which you want to assign web
parts:

l If you are assigning web parts to Polaris PowerPAC pages, see Setting
Public Access Profiles and Parameters for information about each page.

l If you are assigning web parts to Polaris PowerPAC Children’s Edition pages,
see Setting Public Access Profiles and Parameters for information about
each page.

Tip:
To set a page to use the same web parts specified for the
page in a parent organization, select the page, and select
 Revert.

The web parts currently assigned to the page are shown in the Assigned Web
Parts list.
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4. To assign a web part to the selected page, do the following:

a. Select Add. The Web Page - Add Web Parts dialog box appears.

b. Select the web parts you want to assign to the webpage.

c. Select OK.

The selected web parts are displayed in the Assigned Web Parts list on the
Web Page - Web Part Assignment dialog box. The order of the list
determines the display order in the dashboard for the selected page. To
change the position of a web part in the dashboard, select the web part in the
Assigned Web Parts list, and select Up or Down.

5. Repeat steps 3 and 4 for each page to which you want to assign web parts for this
organization.

6. Select OK on the Web Page - Web Part Assignment dialog box.
7. Select File > Save.

Related Information

l Delete a web part from a page - On the Web Page - Web Part Assignment dialog
box, select the web part in the Assigned Web Parts list, and select Delete.

l Revert to system-level settings - On the Web Page - Web Part Assignment dialog
box, select Revert.
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l Set the default display of web parts - You can determine whether web parts are
expanded or closed by default when a page opens. (Patrons can always select a
control in the header to expand or close a web part.) To set the default display to
expanded web parts, set the PowerPAC profile Dashboards: Expanded to Yes. To
set the default display to closed web parts, set the profile to No.

Limit items in Polaris and third-party lists

To specify the maximum number of items to display in the Polaris and third-party web
parts that are updated automatically, such as “Most Circulated.”

Note:
You must set the limit at the system level. You set the limits for Polaris
PowerPAC Children’s Edition separately from Polaris PowerPAC, but the
procedure is the same.

1. In the Administration Explorer tree view, open the Profiles folder for the system,
and select the PowerPAC tab (or Children’s PAC tab) in the details view.

2. Double-click Dashboards: Web part construction. The Web Part Editor dialog box
appears.

3. On the Polaris and 3rd Party tabbed page, select the heading in the Web Parts list
for the web part you want to limit.

4. Type the number of items (elements) in the Total Listing Rows box to display for
the selected list, and select Save.

Tip:
The maximum number is 100 for Polaris and 3rd Party web parts, except
the New Titles web part. The maximum for this web part is 9,999.
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Type 0, indicating no limit, in the Total Listing Rows box to display all items
available for the automated list. For the web part New Titles, a setting of 0 in the
Total Listing Rows box will display all titles added to the catalog in the past 31
days in each New Title category. Any other setting limits the number of new titles
in each category to that number. The zero setting has the same effect on the On-
Order Items web part. For more information about these web parts, see Automatic
Web Parts.

5. Repeat steps 3 and 4 for each Polaris and third-party web part you are using.
6. Select OK. The Web Part Editor dialog box closes.
7. Select File > Save. Your new settings are effective when the automatic lists are

updated.

Setting Up RSS Feeds

Real Simple Syndication (RSS) is a method of publishing links to content on your Web
site. You can allow patrons to set up RSS feeds for new titles from Polaris PowerPAC
directly to a Web site such as My Yahoo!. When the feed is received, the patron can click
the link on the Web site to see a list of new titles in your library catalog and launch a
catalog search for a specific title. Polaris PowerPAC is RSS 2.0 compliant.

Processing for the RSS feed is related to Polaris PowerPAC’s New Titles dashboard
feature (see Automatic Web Parts). Automatic processing for the New Titles Web part
occurs nightly via the SQL job Dashboard_NewTitles, and the dashboard links contain
new titles for the past 31 days. For the RSS feed, background processing updates the
current New Titles list hourly via the SQL job RSS_PopulateNewTitles. If you want to test
RSS feeds after setup, you can run this job manually.

Set these PowerPAC profiles to control RSS feeds:

l RSS Feeds: Enable - Allows RSS feeds from Polaris PowerPAC. This profile is avail-
able at the system, library, and branch levels.

l RSS Feeds: Maximum new releases - Specifies how many titles should be listed in
the RSS feed that the patron receives. This profile is available at the system level
only; that is, it controls the number for every branch that enables RSS feeds.

When RSS is enabled, an orange RSS icon appears in the New Titles dashboard.
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Patrons can click the icon to set up feeds, or click What’s RSS? for more information
about how to set up RSS feeds and where to find readers. When you click the RSS icon,
the RSS feeds are listed in the center area of the page. If you have a Windows-based
reader such as SharpReader, you can drag each feed’s orange XML icon to the reader. If
you have a Web-based RSS news reader such as My Yahoo!, you copy the URL for the
feed and paste it into the appropriate field on the news reader’s RSS set-up page. If the
patron subscribes to the RSS feed while connected to the system organization, the feed
supplies all new titles in the system. If the patron subscribes to the feed while
connected to a branch organization, the feed supplies all new titles for the branch.

When RSS is enabled, the header of the Polaris PowerPAC default.aspx page includes
link tags that contain the RSS URLs. This allows RSS-aware browsers such as Firefox®
to recognize the RSS feeds automatically when the user navigates to the portal page.
Also, certain RSS programs such as SharpReader allow the user to enter the main URL
of the Web site. For these programs, the patron can enter the main Polaris PowerPAC
URL. The RSS program recognizes the links in the page header and subscribes to the
feeds automatically.

Setting Up Live Virtual Reference Services

If your library contracts for services with a virtual reference service provider, you can
offer online reference services in live chat format through Polaris PowerPAC. Polaris
currently supports virtual reference services from Tutor.com (Virtual Reference
Toolkit™) and QuestionPointSM from OCLC Online Computer Library Center, Inc. The
provider can be set at the branch level, and different organizations in the system can
use different providers. However, a branch can offer only one provider at a time.
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Tutor.com services require a patron logon to use live virtual reference. If you use
QuestionPoint services, you can require a patron logon or allow users to access virtual
reference services as “guests” without logging on.

When the virtual reference service is enabled, a link at the bottom of most PowerPAC
pages leads to the reference service. If a search is unsuccessful, Polaris PowerPAC also
displays a prompt to use the service. A patron selects the link, logs on, and types a
question. The question, along with patron identification information, is sent to the
provider’s URL. If you do not require users to log on for QuestionPoint, the Guest link on
the log-on page goes directly to the QuestionPoint site, and users submit their questions
at the site. Polaris records a transaction for every virtual reference session.

In addition, patrons can access their patron accounts to see a list of their virtual
reference sessions. Only logged-on sessions are listed. The session list includes the
date and time the session was ended and the original question. From the list, the patron
may be able to view a detailed transcript of the session. The branch where the patron is
logged on (not necessarily the patron’s registered branch) must be set up for the
specific provider in order to display that provider’s transcripts in the patron account. The
information available in a transcript varies by virtual reference provider, and some virtual
reference providers may not support stored transcripts. Currently, both Tutor.com and
QuestionPoint support transcripts viewable from the PAC.

To make a virtual reference service available:

1. Establish an agreement with a virtual reference service.

Note:
Obtain the settings you need for this procedure from the virtual reference
provider. See later steps in this procedure for the appropriate list of
settings. Be sure the provider is aware of which Polaris PowerPAC page
patrons should return to when they exit from the provider’s site.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

3. Double-click Virtual reference: Enable, and select Yes. This setting displays the vir-
tual reference link on Polaris PowerPAC pages, and allows access to the virtual ref-
erence session history from the patron account.

4. Double-click Virtual reference: Supplier, and select your virtual reference provider
from the list.
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5. Double-click Virtual reference: Configure. The Virtual Reference Configure dialog
box opens with the Tutor.com tabbed page displayed.

Note:
You need specific information from the provider to do the next steps.

6. If your provider is Tutor.com, set the following connection profiles on the Tutor.-
com tabbed page:

l Category, DB Name, DB Login, DB Password, Interact Server, Live Server - Obtain
these site-specific values from Tutor.com.

l Main URL - URL that connects to the Tutor.com virtual reference librarian
l Partition - Obtain this site-specific value from Tutor.com.
l Transcript URL - URL that retrieves virtual reference history for a patron
l View Port - Your Polaris PowerPAC home page URL

7. If your provider is QuestionPoint, set the following profiles on the QuestionPoint
tabbed page:
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l Library ID, Category - Obtain these site-specific values from OCLC.
l Partner ID - Not needed
l Main URL - URL that connects to the QuestionPoint virtual reference librarian
l Transcript URL - Not needed
l View Port - Your Polaris PowerPAC home page URL
l Log in required - If you want to restrict access to registered patrons, select this

option. If this option is not checked, a Guest button is displayed on the virtual ref-
erence log-in page. The user can click Guest to go straight to the QuestionPoint
Web site and submit a question.

l No Login URL - If you do not require log-in, type the QuestionPoint URL to which
the Guest link should connect.

For more information about setting up QuestionPoint virtual reference, go to

http://questionpoint.org/support

8. Click OK to save your settings for the currently selected provider and close the dia-
log box.

Note:
Click X in the upper right corner of the dialog box to cancel your changes
for the currently selected provider and close the dialog box.

9. Restart the Internet Information Server (IIS). Polaris Hosted customers should con-
tact Polaris Customer Support to perform an IIS reset.

Related Information

Email reference service - You can allow patrons to send reference questions to your
library via email. See Set up and start Ask Us.

Polaris PowerPAC Help

Polaris PowerPAC is installed with a default set of help topic html files. When the user
clicks the Help option on the menu bar, a scrollable set of help topic links is displayed.
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When the user clicks a topic link, the appropriate topic is displayed in a lightbox, without
losing the current page context.
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When the user clicks All topics at the bottom of the Help menu list, a page with the
complete set of links is displayed. This page is also available by clicking the Help link in
the site index list at the bottom of the page.

Certain links are always displayed because they are applicable to PowerPAC in general.
Availability is an example of this type of topic link. Others are displayed only when the
connection organization has enabled the corresponding feature in Polaris
Administration. For example, if the organization has not enabled Google Maps, the topic
link Locate Items with Map It is automatically suppressed. The table shows the
PowerPAC feature settings in Polaris Administration that control whether a help topic is
displayed. You can customize the link labels in Polaris WebAdmin (Language Editor);
see Customizing Language Strings. The table lists the Language Editor string IDs.

HELP TOPIC FILENAME TOPIC LINK
LABEL

LANGUAGE EDITOR
STRING ID

POLARIS
ADMINISTRATION
FEATURE SETTING

Overview.htm Getting PACML_HELP_INTRO [Always displayed]
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HELP TOPIC FILENAME TOPIC LINK
LABEL

LANGUAGE EDITOR
STRING ID

POLARIS
ADMINISTRATION
FEATURE SETTING

Started

QuickSearch.htm Quick Search PACML_HELP_
SEARCHQUICK

PowerPAC profile

Navigation: Portal

Keyword.htm Keyword
Searches

PACML_HELP_
SEARCHKEYWORD

PowerPAC profile

Navigation:
Keyword

Phrase.htm Phrase
Searches

PACML_HELP_
SEARCHPHRASE

PowerPAC profile

Navigation: Phrase

Exact.htm Exact
Searches

PACML_HELP_
SEARCHEXACT

PowerPAC profile

Navigation: Phrase

Advanced.htm Advanced
Searches

PACML_HELP_
SEARCHADVANCED

PowerPAC profile

Navigation:
Advanced

Boolean.htm Boolean
Searches

PACML_HELP_
SEARCHBOOLEAN

PowerPAC profile

Navigation:
Boolean

Browse.htm Browse the
Catalog

PACML_HELP_
SEARCHBROWSE

PowerPAC profile

Navigation: Browse

CommInfo.htm
Community
Information
Searches

PACML_HELP_
SEARCHCOMMUNITY

Community profile

Navigation
(PowerPAC):
Community -
Keyword Search

CourseReserve.htm
Course
Reserve

PACML_HELP_
SEARCHCOURSE

PowerPAC profile

Navigation: Course
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HELP TOPIC FILENAME TOPIC LINK
LABEL

LANGUAGE EDITOR
STRING ID

POLARIS
ADMINISTRATION
FEATURE SETTING

Searches Reserves

Filters.htm

Narrowing
Results and
Related
Searches

PACML_HELP_
SEARCHNARROW [Always displayed]

SavingSearches.htm Saving
Searches

PACML_HELP_
SAVESEARCH

PAC profile

Search agent:
Enabled

TitleInfo.htm Viewing Title
Information

PACML_HELP_
TITLEINFO [Always displayed]

Availability.htm Availability PACML_HELP_
AVAILABILITY [Always displayed]

MapIt.htm
Locating
Items with
Map It

PACML_HELP_MAPIT
PowerPAC profile

Google Maps

Fusion.htm

Access
Digital
Collection
Materials

PACML_HELP_
FUSION

[Polaris Fusion is
enabled]

TitleLists.htm
Save Results
with Title
Lists

PACML_HELP_
TITLELISTS

PowerPAC profile

Title List: Enable

Share.htm Share Search
Results PACML_HELP_SHARE

PowerPAC profile

Bookmarking &
Sharing: Enable

ESources.htm
Search
Subscription
Databases

PACML_HELP_
ESOURCES

PowerPAC profile

Navigation: E-
Sources
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HELP TOPIC FILENAME TOPIC LINK
LABEL

LANGUAGE EDITOR
STRING ID

POLARIS
ADMINISTRATION
FEATURE SETTING

(E-Sources)

Request.htm Request
Materials

PACML_HELP_
REQUEST

Request parameter

Holds options

Purchase.htm Buy Materials PACML_HELP_
PURCHASE

PAC profile

Purchase options

NewAccount.htm Set Up a New
Account

PACML_HELP_
NEWACCOUNT

PAC profile

Patron access
options (self-
registration
enabled)

Username.htm Create a User
Name

PACML_HELP_
USERNAME

PAC profile

Patron access
options (patron
user name
enabled)

AcctUpdates.htm

Account
Updates,
Preferences,
Messages

PACML_HELP_
UPDATEACCOUNT [Always displayed]

AcctRequests.htm Manage Your
Requests

PACML_HELP_
ACCTREQUESTS

PowerPAC profile

Navigation:
Requests

AcctItemsOut.htm
View and
Renew Items
Out

PACML_HELP_
ACCTITEMSOUT

PowerPAC profile

Navigation: Items
out

AcctReadingHistory.htm Your Reading
History

PACML_HELP_
ACCTHISTORY

[Reading history is
enabled for patron]
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HELP TOPIC FILENAME TOPIC LINK
LABEL

LANGUAGE EDITOR
STRING ID

POLARIS
ADMINISTRATION
FEATURE SETTING

AcctFines.htm Fines and
Fees

PACML_HELP_
ACCTFINESFEES

PowerPAC profile

Navigation: Fines
and fees

AcctCourseStats.htm
Course
Reserve
Statistics

PACML_HELP_
ACCTCOURSE

[Course reserves
enabled, patron is
instructor]

Donations.htm Make a
Donation

PACML_HELP_
DONATE

Credit Card
Payment
parameter

Online payments:
Configure (Allow
donations from
PowerPAC)

The PowerPAC profile Navigation: PAC help controls whether the Help option appears
on the menu bar. If you choose to offer your own help materials from the dashboard, set
this profile to No to suppress the Help option from the menu bar.

You can also display the Help option on the menu bar but edit the default .html files,
retaining the same filenames. The files, with the .css style sheet and appropriate
graphic files, are located at {PowerPAC Root}/help/content.

Important:
If you edit the .html help files, be sure to back up your customized files in
a location where they will not be overwritten if Polaris is re-installed.

If you have some programming knowledge, you can add your own links to the Help
page. For more information, see the Polaris Developer Network.

Help with Searching

On each search page except Advanced, the user can click a link to display the
appropriate help information.
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Creating Custom Help on the Dashboard

To provide custom help from the dashboard in Polaris PowerPAC:

Tip:
Your instruction pages can be any file format that the workstation can
display. If patrons use Polaris PowerPAC from remote locations, choose a
format that is accessible to most workstations and browsers, such as
.html.

1. Create and save the instruction pages you want to be accessible from the dash-
board.

2. In the Administration Explorer tree view, open the Profiles folder for the system,
and select the PowerPAC tab in the details view.

3. Double-click Dashboards: Web part construction. The Web Part Editor dialog box
appears.

4. Click the User Defined tab.
5. Click Add by the Web Parts list to specify the heading for the instruction Web part.

The Add Web Part Title dialog box appears.
6. Type the heading text in the Title box, and click OK. The heading for the new Web

part is displayed in the Web Parts list.
7. Select the new heading in the Web Parts list.
8. Click Add by the Data Elements list. The Add Data Element: Pick Type dialog box

appears.
9. Select URL. The Add … Element dialog box for the URL element type appears.

10. Type the link text in the Title box, and type the complete path and filename or URL
in the URL box.
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11. Click OK on the Add … Element dialog box. The new element is displayed in the
Data Elements list on the Web Part Editor dialog box.

12. Repeat steps 8-11 to add additional elements to the selected Web Part (heading),
and click OK. The Web Part Editor dialog box closes.

13. Select File > Save.
14. To assign the instruction Web part to the appropriate pages, do these steps:

a. In the Administration Explorer tree view, open the Profiles folder for the
organization, and select the PowerPAC tab in the details view.

b. Double-click Dashboards: Web Page / Web Part Assignment. The Web Page
- Web Part Configuration dialog box appears.

c. In the Web Pages list, select the page to which you want to assign the instruc-
tion Web part. See Polaris PowerPAC Pages Reference. The Web parts cur-
rently assigned to the page are shown in the Assigned Web Parts list.

d. Click Add. The Web Page -Add Web Parts dialog box appears. It lists all the
Web parts not currently assigned to the selected page.

e. Select your instruction Web part.
f. Click OK on the Web Pages - Add Web Parts dialog box. The selected Web

parts are displayed in the Assigned Web Parts list.
g. Click OK on the Web Page - Web Part Configuration dialog box.

15. Select File > Save.

Related Information

More about dashboards - See Defining Web Parts for Dashboards.

Prompting PowerPAC Users to Accept Cookies

You can configure PowerPAC to display a message that informs patrons that the site
uses cookies and prompts them to agree to the use of cookies.

When you enable this feature, the following message appears at the bottom of each
PowerPAC screen. The message formatting matches your PowerPAC theme.
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When a patron clicks Accept, the message disappears.

By default, the cookie policy message is not enabled.

To enable and manage the cookie policy message

l Enabling the Cookie Policy Message
l Customizing the Cookie Policy Message Text
l Configuring How Frequently the Cookie Policy Message Appears

Enabling the Cookie Policy Message

You can enable or disable the appearance of the cookie policy message at the system
level.

To enable the cookie policy message

1. In the Administration Explorer, select System > Profiles > PowerPAC.

2. On the PowerPAC tab, set the Cookie acceptance: Enable profile to Yes.
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Customizing the Cookie Policy Message Text

Two strings in the Polaris Web Admin Tool allow you to customize the cookie policy
message:

l PACML_PRIVACY_POLICY - Cookie policy message text
l PACPROF_COOKIE_ACCEPT_BUTTON - Accept button label

By default, the cookie policy message includes links to Innovative's privacy policy and
services privacy policy. You can edit the message to include links to your library's
policies.

Configuring How Frequently the Cookie Policy Message Appears

When a patron clicks Accept, the cookie policy message disappears and does not
reappear for a configurable period of time. You can configure different "cookie



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 63

acceptance" periods for different types of users:

l In-house patrons (patrons accessing PowerPAC at public workstations in the lib-
rary)

l External patrons (patrons accessing PowerPAC from home)

For In-house Patrons
For in-house patrons, PowerPAC uses the PowerPAC: Patron inactivity timeout profile
setting to determine when to display the cookie policy message.

When an in-house patron clicks Accept, the cookie policy message disappears and does
not reappear until one of the following conditions causes it to reappear:

If the patron is And The following occurs

Signed in Signs out of
PowerPAC The cookie policy message appears.

Signed in
Leaves the
workstation without
signing out

The cookie policy message appears
when the Patron inactivity timeout
period elapses.

If this profile is not enabled in Polaris
Administration, the cookie policy
message appears when the session
timeout period elapses.

Not signed in Leaves the
workstation

The cookie policy message appears
when the session timeout period
elapses.

Notes:

l For more information about the Patron inactivity timeout profile
setting, see Set inactivity timeout for in-house workstations.

l PowerPAC's default session timeout period is 20 minutes. Contact
Innovative Support to change the timeout period.

For External Patrons
For external patrons, PowerPAC uses the system-level PowerPAC: Cookie acceptance:
External workstation retention period profile setting to determine when to display the
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cookie policy message.

To configure how frequently the cookie policy message appears for external patrons

1. In the Administration Explorer, select System > Profiles > PowerPAC.

2. On the PowerPAC tab, double-click the value beside the Cookie
acceptance: External workstation retention period profile.

3. Enter a value in days.

When an external patron accepts the cookie policy, the message disappears and
does not reappear until the specified External workstation retention period
elapses. By default, this profile is set to 365 days.

Note:
The cookie policy message reappears before the External
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workstation retention period elapses if the patron clears their
browser cache and cookies.
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Setting Search Options for Polaris PowerPAC

Polaris PowerPAC search features can be tailored to your library catalog and your
patrons’ needs. (Certain settings described here also affect Polaris Mobile PAC. For
details, see Mobile PAC Search Settings.)

See also:

l Specifying Default Search Settings
l Setting Up Search Filters (Limit By)
l Setting Available Search Types
l Related Words in PowerPAC Searches
l Setting Up Saved Searches in the PAC
l Setting Up Did You Mean Term Checking
l Auto-Search Suggestions - PowerPAC
l Searching Record Sets (Polaris PowerPAC)
l Deep Links to Polaris PowerPAC and Mobile PAC
l PAC CQL Commands and Access Points
l Customizing Search by Labels

Specifying Default Search Settings

Patrons can set various options for each type of search in Polaris PowerPAC. For
example, for keyword searches, patrons can set a search field (Search by) and search
filter (Limit by) for the search, and then sort the returned results by any of several
options.
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You use the PAC profile Search settings defaults to specify the default settings for
search field, search filter, and sort order.

See also:

l Set PAC search setting defaults
l Specify level of relevance applied to popularity sort
l Customizing Search by Labels

Set PAC search settings defaults

To set the library’s defaults for PAC searches:

Note:
Certain search settings affect both Polaris PowerPAC and Polaris Mobile
PAC. These are noted in the following procedure.

1. In the Administration Explorer tree view, open the Profiles folder for the
organization, and click the PAC tab in the details view.

2. Double-click Search settings defaults. The Search Settings Defaults dialog box
opens. Settings on each tabbed page control the defaults for that search type.

3. Click the Quick tab and set the quick search defaults:

Note:
Quick search settings also apply to Mobile PAC.

a. Select the library default search field in the Search by list.
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The Polaris default selection is Any Field. Patrons cannot select a search field
for quick searches, so your setting applies to every quick search.

Note:
You can customize the labels displayed in Polaris PowerPAC for Search
by options. See Customizing Search by labels. However, the Search
Setting defaults dialog box always displays the default labels.

b. Select the library default search filter in the Limit by list.

The available selections depend on the library’s settings in the PAC Limit By
Display policy table. You can change the label of existing filters and set up
custom filters. See Setting Up Search Filters (Limit By). The default selection is
All formats (that is, no filter).

c. Select the library’s default sort order for search results in the Sort by list. The
Polaris default selection is Relevance. This selection sorts results based on
weighted keyword frequency and proximity, so that those most likely to meet the
user’s needs appear first in the list.

If you select Most Popular, the sort is affected by the settings in the Most
popular sort settings system level PAC profile, which is set to a Polaris default
of 50% relevance and 50% popularity. You can adjust this setting to factor
relevance either more or less than 50% when results are sorted by popularity.
For example, if you want the sort to be based only on popularity (the titles most
frequently checked out or requested over the past 120 days first in the list) you
can adjust the Most popular sort settings to 100% popularity. See Specify level
of relevance applied to popularity sort.

Note:
Quick searches are available for the library catalog only, not remote
databases.

Options that include two categories sort results by the first category, then by
the second category. For example, with Author, then Title, the titles are sorted
alphabetically by author then within each author’s works, alphabetically by title.

Note (Polaris PowerPAC):
These settings apply only to the default quick search. If you choose to
offer a quick search feature with search option buttons, these settings are



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 69

not used. For more information about the two types of quick searches,
see Customizing Portal Page Features.

4. Click the Keyword, Phrase, or Exact tab to set search defaults:

Note:
The same settings are available for keyword, phrase, and exact searches.
Click the appropriate tab to make the settings

a. Select the library default search field in the Search by list.The Polaris default
selection is Any Field.

Note:
You can customize the labels displayed in Polaris PowerPAC for Search
by options. However, the Search Setting defaults dialog box always
displays the default labels. See Customizing Search by Labels.

Tip:
You can set an automatic subsort by title for many types of searches. See
“Related Information” at the end of this procedure.

b. Select the library default search filter in the Limit by list. The available selections
depend on the organization’s settings in the PAC Limit By Display policy table. See
Setting Up Search Filters (Limit By).

c. Select the library default sort order for local catalog search results in the When
searching local database only list.
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d. Select the library default sort order for search results in the When at least 1
remote database is selected list.

e. Most Popular and call number sorting options are not available for searches that
include at least one remote database.

5. Click the Advanced tab and set the advanced search defaults:

a. Select the default search field in the Search by list. This setting also applies to
Mobile PAC. The default selection is Any Field.

Note:
You can customize the labels displayed in Polaris PowerPAC for Search
by options. See Customizing Search by Labels. However, the Search
Setting defaults dialog box always displays the default labels.

b. Select the default search filter in the Limit by list.This setting also applies to
Mobile PAC. The available selections depend on the organization’s settings in the
PAC Limit By Display policy table. See Setting Up Search Filters (Limit By).

c. Select the sorting default for results from local databases in the When searching
local database only. This setting also applies to Mobile PAC.

d. Select the default sort order for results where a remote database is selected in the
When at least 1 remote database is selected list.

Note:
Most Popular and call number sorting options are not available for
searches that include at least one remote database.
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e. To offer patrons choices regarding how multiple words in a text entry box should
be handled, select Show relational operators dropdowns.

When this option is checked, a drop-down list of options next to each text box is
displayed. The table shows the applicable access points for each option, and
the effect on search results:

RELATIONAL OPERATOR
OPTION ACCESS POINTS SEARCH EFFECT

Keyword (ALL) AU, GENRE, KW (Any Field),
NOTE, PUB, SE, SU, TI

All of the keywords in the
search term must exist.

Keyword (ANY) AU, GENRE, KW (Any Field),
NOTE, PUB, SE, SU, TI

Any one of the keywords in
the search term must exist.

Phrase (ADJ) AU, GENRE, KW (Any Field),
NOTE, PUB, SE, SU, TI

All of the keywords in the
search term must exist,
and must be adjacent to
each other in the order
specified in the search
term.

Exact (==)
AU, CODEN, ISBN, ISSN,
LCCN, PN, SE, STRN, SU,
SUDOC, TI

The search term must be
an exact match.

If you think these choices would be confusing to patrons, leave the Show
relational operators dropdowns option unchecked (the default setting). In this
case, the list of options is suppressed and the search looks for all the words
entered in a text box (Keyword ALL search).

Note:
You must display the relational operators to make phrase searching
available in Advanced searches. The Advanced Keyword All search does
not support quotation marks to indicate a search phrase.

6. Click the Boolean tab and set the Boolean search defaults.
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a. Select the default sort order for local catalog search results in the When searching
local database only list.

b. Select the default order for search results from remote databases in the When at
least 1 remote database is selected list.

Note:
Most Popular and call number sorting options are not available for
searches that include at least one remote database.

7.  Click the Browse tab and set the browse search default:

a. Select the default search index in the Search by list. The default selection is Title.

If you are setting this profile at the system level, the Call Number choice is
unavailable as a default, since it browses a local (item-level) call number index.
See also Related Information, at the end of this procedure.
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Note:
You can customize the labels displayed in Polaris PowerPAC for Search
by options. See Customizing Search by Labels. However, the Search
Setting defaults dialog box always displays the default labels.

b. In the Sort by list, select the default sort order for the list of titles associated with a
heading.

Note:
Browse searches are available for the library catalog only, not remote
databases.

8. Click the Course Reserves tab and set the course reserve search default in the
Search by list. The default selection is Course Name.

9. Click Save.

Related Information

l Customizing labels for search options - You can customize the labels displayed in
Polaris PowerPAC for Search by options. See Customizing Search by labels.
However, the Search Setting defaults dialog box always displays the default labels.

l Making search types available in Polaris PowerPAC - See Setting Polaris
PowerPAC search types.

l Limit call number browse searching to the local item-level call number index -
Open PowerPAC profiles, double-click Local Call Number Indexed Field: Limit
Choice, and select Yes. If the profile is set to Yes at the system level, and a Polaris
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PowerPAC user is connected to the system organization, all call number options
for browse searching are suppressed. If the profile is set to No at the system level,
and a Polaris PowerPAC user is connected to the system organization, the user
can choose to browse the Dewey or LC bibliographic-level call number indexes.
(The item-level call number index is not available for the system organization.) If
the profile is set to Yes at the branch level, and a Polaris PowerPAC user is
connected to the that branch, the user can browse the local item-level call number
index only. If the profile is set to No at the branch level, and a Polaris PowerPAC
user is connected to that branch, the user can choose to browse the Dewey or LC
bibliographic-level call number indexes as well as the local item-level index.

l Automatic subsorting by title (PowerPAC and Mobile PAC) - Set the PAC profile
Search: Sub-sort-by-title to Yes to have PowerPAC and Mobile PAC search
results for most types of searches secondarily sorted by title. This allows patrons
to quickly find a known title in a large results set. The profile is available on the
system, library, and branch levels. It is set to No by default; you may want to leave
this setting to preserve former behavior for patrons or if you find the automatic
subsort impacts performance. When the profile is set to Yes, the records are first
sorted by the selected sort option and then sorted alphabetically by title, ignoring
nonfiling characters (respecting the value of the 245 second indicator). However,
the setting does not cover the following search and sort types:

o Any browse search
o Any multi-database search
o The following sort types: relevance, most popular, title, author then title, title

then author, title then publication date, title then format, publication date
then title, call number then title

l Search performance - You may experience decreased performance for searches
with large results sets if your server capacity is limited. To improve performance,
you can adjust the maximum number of records to return. The PowerPAC profile
Result set: Maximum number of records to return, available at the system, library,
and branch levels, controls this limit for Polaris PowerPAC.

Notes:
If you lower the maximum number of records to return, relevancy ranking
may be less effective.
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For browse search results, the maximum number of headings that a user
can browse through is 1,000.

l Did You Mean search suggestions - See Setting Up Did You Mean Term Checking.
l Related words in search results - When this feature is enabled, PowerPAC users

can choose to add records containing related words as well as the literal typed
search term to keyword and phrase search results. See Related Words in
PowerPAC Searches.

Specify level of relevance applied to popularity sort

The system-level PAC profile, Most popular sort settings, automatically incorporates
relevance into the Most popular sort option if this sort is selected for search results in
the PowerPAC or Mobile PAC. The Polaris default setting provides a 50/50 balance
between popularity and relevancy when the Most popular sort option is selected. If you
want the sort to consider only the popularity of the titles, adjust the setting in the Most
Popular Sort Settings dialog box to 100% popularity. If you adjust the sort settings and
do not like the results, click Revert to return to the default setting of 50% popularity and
50% relevance.

To adjust the relevancy factor applied to most popular sorting of search results in the
PowerPAC or Mobile PAC:

1. In the Administration Explorer tree view, open the Profiles folder at the System
level, and click the PAC tab in the details view.

2. Double-click Most popular sort settings.

3. To adjust the Polaris default sort settings of 50/50, either click on an up or down
arrow or move the slider. The % Relevance number increases as you move the
slider right, and the % Popularity number increases as you move the slider left.

If you find that this adjustment is not what you expected, click Revert to restore
the 50/50 default.
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Any changes made to this dialog box are reflected immediately in PAC search
results.

Setting Up Search Filters (Limit By)

You can set up search filters that PAC users can select to limit search results.
PowerPAC users can select a filter before launching a quick, keyword, phrase, exact, or
advanced search. For example, a patron can filter a keyword search to return only DVDs.
The filters are also available to Mobile PAC users who use the Mobile PAC Advanced
search.

Use the PAC Limit by Display policy table to specify the search filters available to PAC
users in the Limit by drop-down list, and the order in which the filters are listed. The PAC
Limit by Display policy table is available at the system, library, or branch level. The
organization level at which the table is opened determines the entries you see in the list,
and you can view and change entries for the selected organization only. This table can
be displayed with the Administration Explorer.

Note:
These System Administration permissions are required to modify this
table: Access administration: Allow; Access tables: Allow; Modify PAC
limit by display table: Allow
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You can include the following types of filters in the Limit by list:

Note:
If a PAC user enters a search term, selects the local database and one or
more remote databases, and selects a Limit by option, the Limit by filters
will be applied to the remote databases that can support that filter. If the
remote database is unable to use the filter, it will be applied only to the
local results. Results may be returned from the remote databases using
the search string without the filter. If an unsupported filter was removed
from a search of a remote database, a message appears in the Search
Status box.

l Type of material (TOM) filters - Polaris PowerPAC offers a set of standard format-
s/types of material and custom search filters in the Limit by list. In the PAC Limit
by Display policy table, you can modify the description and the Enabled setting for
standard formats/types of materials, but you cannot edit the CQL command for
these standard filters. The TOM Limit by filters are used in Z39.50 searches of
remote databases, but not in MuseGlobal databases. For MuseGlobal databases,
the TOM limiter is discarded because MuseGlobal databases cannot interpret this
limiter and would return zero results if this limiter were included in the search.

l Custom filters - Use CQL commands to set up custom filters for the Limit by list.
You can combine standard type of material codes with other CQL commands to
create custom search filters. See PAC CQL Commands & Access Points.

l Availability filters - You can also use the PAC Limit by Display policy table to set up
search filters that limit search results to titles with at least one available linked
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item. The patron selects the filter in the Limit by list before launching the search. If
a PowerPAC or Mobile PAC connection is at the system level, the search results
include all titles with at least one available item. If the connection is at the branch
level, the results include all titles that have at least one linked available item
assigned to that branch or the other branches defined as Local in the branch’s
Item Availability Display Order table. (At either level, items with a suppressed cir-
culation status are not included, and items where Display in PAC is not checked in
the linked bibliographic record are not included.)

See also:

l Set up type of material/custom search filters for PAC
l Set up availability search filters for PAC

Set up type of material/custom search filters for PAC

To specify what format/types of material are listed in the Limit by list as search filters in
Polaris PowerPAC and Mobile PAC, set up your own filters, and specify the default (top)
filter for the Limit by list:

Note:
For a list of the Type of Material codes, see Type of Material Filters. For a
list of CQL codes that you can use to create custom filters, see Setting
PowerPAC Narrow/Related Search Options.

1. In the Administration Explorer tree view, open the Policy Tables folder for the
organization, and select PAC Limit By Display. The PAC Limit by Display table
appears in the details view.
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2. To work with a standard format/type of material, follow these steps:

a. Select the format and click . The Modify PAC Limit by Display dialog box
appears.

b. To change the name of the format/type of material, type the new name in the
Description box.

Note:
This setting affects only the names as listed in the PAC Limit by list. The
tooltip associated with each format icon in PAC search results always
displays the default name of the format, as does the detailed information
for a title.

c. To display or suppress the format/type of material in the PAC Limit by list, select
Yes (display) or No (suppress) in the Enabled box.

Set all the table entries to No to suppress the Limit by list from display.

Note:
The Digital Collection format/type of material identifies materials such as
images, sound files, video clips, and text files. It is intended for use with
Polaris Fusion™, a separately licensed feature. Contact the Polaris
Customer Sales Department for more information about Polaris Fusion.

d. Click OK. The Modify PAC Limit by Display dialog box closes, and the table dis-
plays your changes.

3. To set up a custom filter, follow these steps:

a. Click in the PAC Limit By Display table. The Insert PAC Limit By Display dialog
box appears.
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b. Type the filter name in the Description box. This name appears in the Limit by list
in PAC.

c. Type the CQL search command for the filter in the CCL Filter box.

Tip:
You can construct a filter that limits search results to titles with at least
one linked item that is available. See Set up availability search filters for
PAC.

You can type any valid CQL command. Refer to PAC CQL Commands &
Access Points. (If the command is not valid, the PAC search will return no
results.) If the patron leaves the search term blank, the search finds all the
titles that satisfy the CQL command.

Examples:
A filter that allows patrons to search quickly for mysteries on DVD:
Description: DVD Mysteries
CQL Filter: TOM=DVD and GENRE=mystery

d. Click OK. The Insert PAC Limit by Display dialog box closes, and the table displays
your changes.

Tip:
When Polaris ILS is installed, the default selection is All formats, which
specifies no filter on the search. You may want to change the description
of this selection—to No limits, for example—if your list includes custom
filters.

4. To set the order of options in the Limit by list, select a filter in the table and click

 or . Repeat this step until the list is ordered the way you want it.
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The higher an enabled item is positioned in the table (the lower the Display
Order number), the closer to the top the item appears in the Limit by list. The first
enabled item in the table is the top item in the Limit by list.

5. Select File > Save.

Related Information

l Setting a default search filter by search type - You can specify a Limit by default
setting for each search type that includes this feature. See Specifying Default
Search Settings.

l Deleting a search filter - Select a custom filter in the PAC Limit by Display policy

table, and click . You cannot delete standard formats/types of materials. The
Protected column indicates whether a filter can be deleted. If the value is Yes, you
cannot delete the filter.

l Modifying a search filter - Select the filter in the PAC Limit by Display policy table,

and click . You can modify the description, CQL command, and the
Enabled setting for a custom filter. You can modify only the description and the
Enabled setting for standard formats/types of materials. The Protected column
indicates whether the CQL command can be edited for a filter. If the value is Yes,
you cannot edit it.

l EContent - The definition of electronic resources includes any ebooks that contain
07/00=c (see the Cataloging Guide). If you want ebooks to be excluded from
searches for electronic resources, change the Enabled setting for the standard
electronic resource (TOM=elr) to No. Then create a custom Limit by filter for elec-
tronic resources that excludes ebooks: TOM=elr not TOM=ebk and enable your
custom filter for display.

l Narrowing search results - The Narrow Web part is displayed in the dashboard by
default with the patron’s search results. When the patron selects a filter with this
feature, the filter is applied to the current results set. See Setting PowerPAC Nar-
row/Related Search Options.

l Scoping searches by collection - To offer an option to scope searches by col-
lection, set the PowerPAC profile Search options: Limit by collection enabled to
Yes. This setting places the Collections option on the More Search Options light
box in Polaris PowerPAC.
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l Scoping searches by language - To allow search scoping by the languages spe-
cified in the MARC Language Scoping Display table, set the PowerPAC profile
Scoping: Use MARC language scoping display table to Yes. For more information
about this table, see the Administration Guide. If you select No, all languages
defined by the MARC 21 format are displayed for search scoping on the Search
Options page of Polaris PowerPAC.

Type of Material Filters
The standard formats/material types are derived from the bibliographic records. The
Polaris database includes a Type of Material search access point, which finds the
formats and types of materials defined in the Z39.89 standard for MARC bibliographic
records, as well as several Polaris-specific types. Formats are identified in the LDR/06,
LDR/07, 006/00 or 007/00 fields of the MARC record. Types of material are identified in
the LDR/06, LDR/07, 006/00, 007/00, 008/21, 008/23, or 008/29 fields. For details, see
the Cataloging Guide. You can offer any, all, or none of these as options in the Limit by
list. In addition to selecting a format/material type filter from the Limit by list, patrons
can do a Boolean (CQL) search for any format/type of material using the access point
TOM =. For more information about CQL, see Setting Public Access Profiles and
Parameters.

In PAC search results, an icon indicates the format/type for a title. A tooltip identifies
the icon. If several formats/types are associated with a title, a programmed order of
precedence determines which icon is displayed. Users can see all the formats/types in
the record in the detailed information view of the title.

You can also use CQL commands to set up custom filters for the Limit by list. You can
offer only standard formats/types of material, only your custom filters, or any
combination of the two.
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Note:
Search filters do not apply to title searches launched from the dashboard.

The table lists the standard types of material (TOM) by name and code, the TOM’s
corresponding icon, and the icon filename. These are the default TOM filters available
for the Limit by list.

Note:
By default, the TOM icon files are located at C:\Program Files\Polaris\
{version}\PowerPAC\themes\shared\formats on your PowerPAC server.
See the table below for icon filenames. If you edit an icon file, be sure to
back up your changes so you can replicate them after an upgrade.

Format/Type of
Material Code Icon Icon Filename Enabled by

Default

Abstract abs formatid39.gif Y

Archival/mixed
materials

mix formatid07.gif N

Atlas atl formatid47.gif Y

Audio books abk formatid37.gif Y

Audio book on
cassette

abt formatid53.gif Y

Audio book on
CD

abc formatid52.gif Y

Blu-Ray Disc brd formatid40.gif Y
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Format/Type of
Material Code Icon Icon Filename Enabled by

Default

Blu-Ray + DVD bdv formatid45.gif Y

Book bks formatid01.gif Y

Book + Cassette bcs formatid43.gif Y

Book + CD bcd formatid42.gif Y

Book + DVD bkv formatid46.gif Y

Braille brl formatid28.gif N

Cartographic
material

cmt formatid03.gif N

Digital collection dmc formatid38.gif Y

DVD dvd formatid33.gif Y

EAudioBook aeb formatid41.gif Y

Ebooks ebk formatid36.gif Y
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Format/Type of
Material Code Icon Icon Filename Enabled by

Default

Electronic
resources

elr formatid06.gif Y

Emagazine emg formatid50.gif Y

Globe glb formatid14.gif Y

Kit kit formatid23.gif N

Large print lpt formatid27.gif Y

Manuscript
cartographic
material

mcm formatid12.gif N

Manuscript
material

mss formatid15.gif N

Manuscript
music

mmu formatid10.gif N

Map map formatid13.gif Y

Microform mic formatid26.gif N

Motion picture mot formatid17.gif Y
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Format/Type of
Material Code Icon Icon Filename Enabled by

Default

Music CD mcd formatid35.gif Y

Musical sound
recording

msr formatid21.gif Y

Newspaper new formatid25.gif Y

Nonmusical
sound recording

nsr formatid22.gif Y

Periodical per formatid24.gif Y

Printed
cartographic
material

pcm formatid11.gif N

Printed music pmu formatid09.gif N

Printed or
manuscript
music

mus formatid02.gif N

Projected
medium

pgr formatid16.gif Y

Serial ser formatid08.gif Y

Sound recording rec formatid05.gif Y
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Format/Type of
Material Code Icon Icon Filename Enabled by

Default

Streaming music stm formatid48.gif Y

Streaming video stv formatid49.gif Y

Three-
dimensional
object (artifact)

art formatid20.gif Y

Two-dimensional
nonprojected
graphic

ngr formatid19.gif Y

Video game vgm formatid44.gif
Y

Videorecording vid formatid18.gif
Y

Videotape vcr formatid34.gif
Y

Vinyl vyl formatid51.gif
Y

Visual materials vis formatid04.gif
N

Set up availability search filters for PAC

Note:
When a patron selects remote databases to search along with the local
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Polaris database, and an availability search filter is selected, the
availability search filter is applied to the Polaris database but not to the
selected remote databases.

To place an availability search filter in the Polaris PAC Limit by list:

1. In the Administration Explorer tree view, open the Policy Tables folder for the
organization, and select PAC Limit By Display. The PAC Limit By Display table
appears in the details view.

2. Click in the PAC Limit By Display table. The Insert PAC Limit By Display dia-
log box appears.

3. Type a name for your availability filter in the Description box. This name appears
in the Limit by list in PAC.

4. In the CCL Filter box, type the following command:

AVAILABILITY > 0

Note:
The AVAILABILITY access point works only for values greater than 0.
(AVAILABILITY = 0 is not valid.)

5. Click OK. The Insert PAC Limit by Display dialog box closes, and the table dis-
plays your changes.

Tip:
When Polaris ILS is installed, the default selection is All formats, which
specifies no filter on the search. You may want to change the description
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of this selection—to No limits, for example—if your list includes custom
filters.

6. To set the order of options in the Limit by list, select a filter in the table and click

 or . Repeat this step until the list is ordered the way you want it. The
higher an enabled item is positioned in the table (the lower the Display
Order number), the closer to the top the item appears in the Limit by list. The first
enabled item in the table is always the top item in the Limit by list.

7. Select File > Save.

Related Information

l More about search filters - See Setting Up Search Filters (Limit By).
l Defining local branches for availability - See Set up the local/system item avail-

ability display.
l Suppressing items by circulation status - See Suppress items by circulation status.
l Availability facet for filtering search results - See Setting PowerPAC Nar-

row/Related Search Options

Setting Available Search Types

You can make the following kinds of searches available in Polaris PowerPAC, in addition
to the Quick Search feature:

l Keyword - Search for a word or multiple words (in any order) in bibliographic
record fields.

l Browse - Browse the title, author, subject, series, and call number indexes in the lib-
rary catalog database.

l Phrase - Search for multiple words (in order) in bibliographic record fields.
l Exact - Search for multiple words (in order) in bibliographic record fields, including

stop words.
l Advanced - Do a complex keyword search by typing keywords and selecting And,

Or, and Not operators.
l Boolean - Search by typing a CQL (Common Query Language) command.
l Course reserves - Search for course records and associated reserved items (avail-

able only if your Polaris contract includes course reserves)
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Note:
Options for community information keyword and browse searches are
also available if your Polaris installation includes Polaris Community
Profiles, a separately licensed feature. For more information, see the
Community Profiles Guide.

You control what searches are available with settings that display or suppress options
on the Search menu.

To set the search types available in Polaris PowerPAC:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Set the following profiles to display or suppress the appropriate search types; by
default, all are set to Yes (available):

l Navigation: Advanced
l Navigation: Boolean
l Navigation: Browse
l Navigation: Course reserves (available by contract)
l Navigation: Exact
l Navigation: Keyword
l Navigation: Phrase

3. Select File, Save.

Related Information

l Quick search setup (Polaris PowerPAC) - You can offer a quick search feature on
the portal page that includes search option buttons. See Customizing Portal Page
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Features.
l Search filters (Limit by) - PAC offers a set of standard formats/types of material

and custom search filters in the Limit by list. Users can select a filter before
launching a quick, keyword, phrase, exact, or advanced search. See Setting Up
Search Filters (Limit By).

l Default search settings - Users can select various settings for each type of search.
For example, for keyword searches, patrons can set a search field, search filter,
search database, and sort order for the results. You can set the default selections
for these options. See Specifying Default Search Settings.

l Remote databases (Z39.50 search targets) for PAC searches - See Managing
Federated Search Targets .

l Subscription databases for PAC searches - See Managing E-Sources.
l Course reserve functions - See Setting Up Course Reserves. 
l Search results display - You can determine what data to display in PAC search res-

ults. See Configuring the PowerPAC Title Display.
l Search Agent - Using the search agent, patrons can save searches and have them

run automatically. The PAC parameter Search Agent Parameters controls search
agent functions for both Polaris PowerPAC and Mobile PAC. When the search
agent is enabled, the Save Search link is available in the Polaris PowerPAC and
Mobile PAC. See Setting Up Saved Searches in the PAC.

Related Words in PowerPAC Searches

When you enable the Related Words feature, PowerPAC users can choose to add
records containing related words as well as the literal typed search term to keyword and
phrase search results. "Related words" include words formed from stemming (for
example, regular plurals and verb endings such as walk, walks, walker, walked, walking,
but not irregular forms such as mouse/mice or run/ran) and synonyms. Synonyms
include common nicknames, proper name variations, and spelling variations. The
Include related words link is enabled by default; the connection library's setting
determines whether to display the option (see Enabling Related Words).

The Include related words link is available for keyword and phrase search results when:

l The user enters search terms for a keyword or phrase search and clicks or taps

the search icon .
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l The user does a keyword or phrase search from the Advanced Search screen.
l The user selects an Other Searches entry in the Related Searches dashboard.

The link appears only if additional records are found when the stemming and synonyms
rules are applied.

If the user clicks the link, additional records are retrieved. The search results list is then
refreshed, and the Include related words link disappears until the user does a new
search. Any facets that had been selected become unselected for the new search
results, and a Related Words facet, if enabled, is added to the top of the Narrow your
search dashboard element. See Related Words Facet.

The link becomes available again when a search is relaunched; for example:

l The user changes the search terms, the Search by selection, or the Limit by selec-
tion, and clicks or taps the search icon.

l The user updates a selection in More Search Options.
l The user updates a selection in Select Databases.

The default Include related words strings are Include related words (nnn more titles)
(plural) or Include related words ({0} more title) (singular). You can change the string in
Polaris WebAdmin (Language Editor). The PowerPAC string ID for the plural statement
is PACML_INCLUDE_RELATED_WORDS_LINK_TEXT. The PowerPAC string ID for the
singular statement is PACML_INCLUDE_RELATED_WORDS_SINGUAL.

See also:

l Search Results Including Related Words
l Related Words Facet
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l Overnight Processing for Related Words
l Enabling Related Words

Search Results Including Related Words

The search results with related words depend on the user's Search By selection and
return only records containing the related word in the same field ( Any Field, Title,
Author, Subject, General notes, Publisher, Genre, and Series). The related words option
does not apply to number searches (ISBN, ISSN, LCCN, Publisher no., SuDoc, CODEN,
STRN).

For phrase search results that include related words:

l Individual words in the phrase are processed for related words separately. For
example, a phrase search for "fate and fury" retrieves titles with phrases such as
"fate and furies," "fates and furies," and "fates and fury."

l The system checks the synonyms table for individual words in the phrase. For
example, a phrase search for "colour purple" retrieves titles with "color purple."

l The phrase as a whole is NOT checked for synonyms. For example, a phrase
search for "united kingdom" does NOT retrieve titles with "uk." Stemming and syn-
onym pair matching is limited to individual keywords. That is, related terms map a
keyword to another keyword. Mapping a single keyword to multiple keywords or
multiple keywords to a single keyword is not supported.

Like the user's literal search term, related words appear in italics in the search results on
the brief, summary and full displays in PowerPAC. Relevancy ranking also applies to
search results that include related words. A match on the exact form of the word carries
more weight than a match on other forms.

Related Words Facet

A Related Words facet is available as the first filter on the Narrow Your Search
dashboard when the user has selected Include related words for search results. The
filter consists of two checkbox options: See what was added (nnn titles), and See
original results (nnn titles).
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l To see only the related words records, select only See what was added.
l To see only the original search results without the related words records, select

only See original results.
l To see the original search results PLUS the related words records, check or

uncheck both checkboxes.

You can control the display of the Related Words facet in system administration with the
PowerPAC profile Dashboards: Narrow your search & related searches. The facet is set
to display by default. For more information about this profile, see Setting PowerPAC
Narrow/Related Search Options.

Overnight Processing for Related Words

A step in the nightly CJ K Keyword Processing job applies processing rules and a
Synonyms table to keywords in the BibliographicKeywords table. The job output goes to
the BibliographicKeywordRelations table, which the search engine uses to find records
containing words that are related to the user's search terms.

Enabling Related Words

To enable related words in Polaris PowerPAC search results:

1. In the Administration Explorer tree view, open the Profiles folder for the PowerPAC
connection organization, and click the PowerPAC tab in the details view.

2. Select the PowerPAC profile Related words options.
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3. To enable the feature if it is not enabled, select Enable 'Include related words' link
on keyword and phrase search results.

When this option is checked, overnight processing occurs (see Overnight Pro-
cessing for Related Words) and the Include related words option appears on the
search results screen. If the feature is not enabled, overnight processing occurs,
but the Include related words option does not appear on the search results
screen.

4. (Optional) Specify a maximum number of titles for the search results; if the max-
imum is exceeded, the Include related words option is not displayed. The default
value is 1000 results. Note that including related words increases the number of
titles in the search results list.

Note:
Be sure the value specified here does not exceed the number specified in
the PowerPAC profile Result set: Maximum number of records to return
for the same organization. If it does exceed Result set maximum, the link
will never be suppressed.

5. Click OK.

Setting Up Saved Searches in the PAC

Using the search agent, registered patrons can save any search except browse
searches, and have the saved searches run automatically either weekly or monthly.
(Patrons can also run a saved search manually, at any time.) Saved search criteria have
full Unicode support; that is, saved searches can contain non-ASCII characters. Each
search run looks for results in the local database that are new since the last run. The
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results are automatically sent to an email address the patron specifies. By accessing
their patron accounts, patrons can view, edit, and delete saved searches. The result
count displayed in the PAC patron account shows the total number of new records
found in all weekly and/or monthly runs (excluding the initial run).

Note:
Saved searches return results from the local database only, even if the
original search included remote databases.

You specify a maximum number of titles to return in the email message. If the
maximum is exceeded, the email message includes a link that allows the patron to
retrieve the entire set of new titles. Resource groups are honored in saved searches, and
a logon link is displayed for eContent in the search results email message. If the
patron’s registered branch is a member of a resource group for the econtent, the patron
can access the eContent.

The system also stores a “DaysToBacktrack” value, set to 180 days. This allows records
that did not match the search criteria in a previous run, but that match now (for example,
because a record’s Display in PAC setting has been changed) to be reported once they
become available.

The search agent is available in Polaris PowerPAC and Mobile PAC. The example shows
the Save Search option in the PowerPAC dashboard.

For each organization that makes the search agent available, you can specify how many
searches a patron can have currently saved, the maximum total number of new titles
that can be returned when a search is run, and the number of times a search can be run.
You specify whether to offer weekly search runs, monthly search runs, or both, and
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designate a “from” address to appear in the email message that delivers the search
results to the patron.

The SQL job SDIDaily runs nightly to process the appropriate saved searches. That is, on
any given night, both the weekly and monthly searches scheduled to run on that date are
processed. Any errors in the job are reported in an error log, which is placed by default in
C:\ProgramData\Polaris\[version]\Logs\SDIAgent (server installation). If there is a
datalink (instance), the default location is C:\ProgramData\Polaris\[version]\
[DataLinkName]\Logs\SDIAgent.

To set up and enable the search agent:

1. In the Administration Explorer tree view, open the Parameters folder for the organ-
ization, and click the PAC tab in the details view.

2. Double-click Search agent parameters. The Search Agent Parameters dialog box
opens.

3. In the Number of Saved Searches box, type the maximum number of searches a
patron can have saved at a time.

4. In the Maximum Number of Search Results Returned box, type the maximum num-
ber of titles that any run of a saved search can return after filtering for newness.

The default value is 500. Since 500 is a potentially large number to include in an e-
mail message, you may want to set this to a lower number. (The minimum value is
1, and the maximum value is 1000.)

5. In the Number of Times to Run a Saved Search box, type the maximum number of
times a saved search can be run.

Note:
Patrons can set the number of times to run a saved search, up to the
maximum you specify with this setting.
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6. Specify what search frequencies to offer to patrons by selecting either or both of
the following options:

l Select the Allow Weekly Searches checkbox to offer patrons the option of running
a saved search weekly.

l Select the Allow Monthly Searches checkbox to offer patrons the option of run-
ning a saved search monthly.

The frequency options you specify are displayed in the form that patrons complete
when they save searches. The form always offers the additional option Suspend,
which the patron might use to stop the search for a period of time.

7. To set up a “from” address for the notification e-mail, type the address in the Noti-
fication “from” Address box. The address can be a real address or a fictitious
account. The address must contain the @ symbol; for example, your-
search@yourlibrary.org

8. Click OK on the dialog box.
9.  In the Administration Explorer, open the Profiles folder for the organization, and

click the PAC tab in the details view.
10. Double-click Search Agent: Enable, and select Yes.

Note:
To allow logged-in patrons to view a list of their saved searches in the
dashboard area of the Polaris PowerPAC window, set the PowerPAC
profile Single Login: Enable to Yes.

11. Select File > Save.

Related Information

l Book jacket images in search agent results - When a saved search is run, book
jackets are displayed in the results based on the Enriched Data setting for the pat-
ron’s registered branch. See Setting PowerPAC Narrow/Related Search Options.

l Patron email format - All saved searches sent to the same patron email address
must be in the same email format. If the patron specifies a format different from
existing saved searches when saving a new search, a message provides the
options to specify a different format for the new search or to change all the others.

l Mobile PAC interface - See Saved Searches (Search Agent) in Mobile PAC.
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Setting Up Did You Mean Term Checking

When Did You Mean is enabled, suggestions are displayed on the search results page if
there would be results in the Polaris database when the user clicks or taps a suggestion.
Potential results in the Polaris database take into account any Search by, Limit by, and
More Search Options selections, as well as resource groups, that were in effect when
the search was launched. However, if the user changes a selection in the Limit By
dropdown list or a selection in More Search Options and then clicks or taps the Did You
Mean suggestion without launching the search again, the new selections are ignored.

Note:
If the user is also searching a remote database, Did You Mean
suggestions may display even if there will be no results in the Polaris
database, in case the remote database will return results. No attempt is
made to determine if there will be hits in the remote database due to
concerns about processing time.

If enabled, the Did You Mean function applies to quick, keyword, phrase, and exact
phrase searches in Polaris PowerPAC, and to searches typed in the Look for bar in
Polaris PowerPAC Children’s Edition. Additional suggestions, if any, are displayed in line
when the user clicks or taps More. The illustration is an example from Polaris
PowerPAC.
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The user can click or tap Less to collapse the list of suggestions and display only the
first suggestion.

The Did You Mean process identifies a possible search suggestion or suggestions in a
Did You Mean Overrides table match, a sound value (metaphone) match in the
underlying SearchSuggestions table, or one or more matches in the spell check
dictionary.

At least one bibliographic record will be retrieved if the user follows the suggestion. If
the process returns multiple suggestions, each suggestion is checked individually and is
not displayed in the suggestion list if it produces zero hits. Any returned records must
have Display in PAC checked. When multiple suggestions are returned, the first
suggestion is displayed with a "more" link, which opens a small pop-up window that
shows the other suggestions. Multiple matching suggestions show all the suggestions
that will return at least one record.

When the user clicks or taps a Did You Mean suggestion, there may be a pause while the
search is conducted; the pause is most noticeable when CQL filters from the Limit by
list were applied to the search. Processing is limited to 10 seconds. The user is not
prevented from doing other actions during processing time, but if another action is
taken, the Did You Mean results are not returned. No additional search transaction is
logged when the user clicks a Did You Mean suggestion.

You can set whether Did You Mean suggestions are displayed at all, for PowerPAC only,
whether they are displayed when there are search results or only when there are none. In
addition, in the Did You Mean Overrides database table, you can specify your own Did
You Mean suggestions for specific search terms to be displayed instead of the
program’s suggestions.

To set up Did You Mean search suggestions and optionally specify override
suggestions:
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

2. Double-click the profile Did You Mean: Enabled, and set the profile to Yes. This set-
ting displays Did You Mean search suggestions in Polaris PowerPAC and Polaris
PowerPAC Children’s Edition.

3. (PowerPAC only) On the PowerPAC profile tab, double-click the profile Did You
Mean: Suggestions are to display even when hits are returned, and set the profile
to Yes to display Did You Mean search suggestions when a search returns hits.

When this profile is set to No (the default), Did You Mean search suggestions are
displayed only when a search returns no hits at all. If you think patrons will find the
search suggestions confusing when they already have satisfactory results, set the
profile to No.

Note:
This profile does not apply to Polaris PowerPAC Children’s Edition. In the
Children’s Edition, when Did You Mean is enabled, suggestions are
displayed only when a search produces no hits.

4. Select File > Save.
5. To set override suggestions, follow these steps:

Note:
You may want to wait to set overrides until you have an idea of the
common mistakes your patrons may make.

a. In the Administration Explorer tree view, open the Database Tables folder for the
organization, and select Did You Mean Overrides. The Did You Mean Overrides
table appears in the details view.

Important:
You can modify this table at the system, library, or branch level, but your
changes affect all organizations in the system.
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b. Click to display the Insert: Did You Mean Overrides dialog box.

c. In the Phrase box, type the search term as your patrons may enter it.
d. In the Override Phrase box, type the Did You Mean suggestion that you want to be

displayed instead of any system-generated suggestion.

These fields are not case-sensitive.

Example:
A unique local place name is commonly misspelled. You can enter the
common misspelling in the Phrase box, and the correct spelling in the
Override Phrase box. Your override phrase will always be suggested for
the misspelled term.

Note:
You may find that the system suggests inappropriate terms for terms that
the patron intended. For example, the patron types amelia bedelia
(correct), but the system suggests Amalia Delia.You can enter a correctly
spelled term in the Phrase box and the identical term in the Override
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Phrase box. In this case, when the patron enters the term correctly, no Did
You Mean suggestion will be displayed.

e. Click OK.
f. The new entry is displayed in the Did You Mean Overrides database table for the

organization. Modification pending appears in the status bar.
g. Repeat steps a-f until you have listed all the overrides for the organization.

6. Select File > Save.

Related Information

l

Modify a table entry - Select the entry and click .

l

Delete an entry - Select the entry and click .

Auto-Suggest in PowerPAC

The system-level Cataloging parameter Auto-suggest feature enabled controls whether
the auto-suggest feature is available in both Polaris PowerPAC and the staff client Find
Tool. (For details on the applicable Find Tool searches, see the Polaris Basics Guide.) If
you set this parameter to No, automatic search suggestions are suppressed in both PAC
and the Find Tool.

By default, quick, keyword, and phrase searches in Polaris PowerPAC offer suggested
search terms as you type. A user can ignore the suggestions and continue to type the
search term, or click a suggestion to launch the search for the suggested term.

Note:
The auto-suggest feature is not available for numeric search access
points, such as ISBN and ISSN, in keyword searches.

To hide suggestions for the PAC session, the PowerPAC user can click Hide
Suggestions at the bottom of the suggestion list.
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To show the suggestions after hiding them, the user clicks the arrow in the search text
box.

Secure Socket Layer (SSL) and Auto-Suggest

The ERMS Daemon is a service that provides storage, processing, and access to
electronic resources. When ERMS Server is selected during Polaris server software
installation, an ERMS Port Configuration dialog box appears. Use this dialog box to
change the default listening ports if necessary. The HTTPS Port option is disabled by
default. If you will use HTTPS (Secure Socket Layer) for the entire Polaris PowerPAC
site, select the HTTPS Port checkbox and enter the HTTPS port (normally 443). This
allows auto-suggest features to function properly when site-wide Secure Socket Layer is
in use.

Note:
If you will use Secure Socket Layer to protect patron account information
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only (not site-wide HTTPS), do not check the HTTPS Port option. For
more information about Secure Socket Layer, see the Polaris Basics
Guide.

Searching Record Sets (Polaris PowerPAC)

You can create a bibliographic record set in the Polaris staff client and publish the URL
to the record set on your Polaris PowerPAC portal page, to a page dashboard, or to your
website pages. One or multiple record sets can be referenced by a single URL, and you
can specify a sort order for the results. For information on creating record sets, see the
Cataloging Guide. For information about making record sets available in PowerPAC, see
Defining Web Parts for Dashboards.

When the patron clicks the URL link, a catalog search is launched for the titles in the
record set. The Polaris PowerPAC results set consists of the titles in the record set,
formatted according to your organization’s settings for PowerPAC search results and
including all the title information that your PAC normally displays. You can use this
feature to integrate bibliographies such as summer reading lists with your catalog and
make them readily accessible to your patrons.

This feature uses two search access points that are also available for Boolean searches
in Polaris PowerPAC: brs - Record set control number; brsn - Record set name

See also:

l Record Set Control Number Searches
l Record Set Name Searches
l Sort Order
l Record Set Results

Record Set Control Number Searches

To set up a record set link with the record set control number, structure the URL like this:

http://{PowerPACURL}/polaris/view.aspx?brs=bibrecordsetid

Where bibrecordsetid is the Polaris control number for the bibliographic record set.

Example (single record set by number)
http://mylibrary.org/polaris/view.aspx?brs=1234
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Separate multiple record set control numbers with commas.

Example (multiple record sets by number):
http://mylibrary.org/polaris/view.aspx?brs=1234,12345,123456

Record Set Name Searches

To set up a record set link with the record set name, structure the URL like this:

http://{PowerPACURL}/polaris/view.aspx?brsn='bibrecordsetname'

Where bibrecordsetname is the name of the record set. Enclose the name in single
quotation marks.

Example (single record set by name):
http://mylibrary.org/polaris/view.aspx?brsn='MyRecordSet'

This format also works with a record set name that contains spaces.

Example (record set name with spaces):
http://mylibrary.org/polaris/view.aspx?brsn='Science Fiction Book Club'

Separate multiple record set names with commas, enclosing each name in single
quotation marks.

Example (multiple record sets by name):
http://mylibrary.org/polaris/view.aspx?brs='TotSummer','TeenSummer','
AdultSummer'

Sort Order

By default, the PAC search results (the titles in the record set) are sorted by author, then
title. You can specify a different sort option using this format:

http://{PowerPACURL}/view.aspx?brs={bibrecordsetid}&sort={sortoption}

Example (results sorted by call number):
http://mylibrary.org/polaris/view.aspx?brs=1234&sort=CALL

The following table lists the mnemonics for the valid sort options:
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Sort Order Mnemonic Sort Order Mnemonic

Relevance &sort=RELEVANCE Title, then Author &sort=TI_AU

Most Popular &sort=MP Title, then
Publication Date

&sort=TI_PD

Author &sort=AU Title, then Format &sort=TI_TOM

Title &sort=TI Publication Date,
then Author

&sort=PD_AU

Call Number &sort=CALL Publication Date,
then Title

&sort=PD_TI

Publication Date &sort=PD Call Number, then
Author

&sort=CALL_AU

Author, then Title
(default)

&sort=AU_TI Call Number, then
Title

&sort=CALL_TI

Author, then
Publication Date

&sort=AU_PD Call Number, then
Publication Date

&sort=CALL_PD

Record Set Results

Record sets may contain any number of records, but the number of records displayed in
the PAC is limited by the setting in Polaris Administration for the PowerPAC profile
Result set: Maximum number of records to return. Searches for multiple record sets
return results in one results list.

Note:
Bibliographic records that are suppressed from display in PAC are not
included in the results set.

If records are added, edited, or removed from the record set, the changes are reflected
in the result set. If you have enabled the Search Agent for Polaris PowerPAC, patrons
can save the search, have it run automatically, and receive notification of any changes.

If the record set itself is deleted, and you do not remove the URL from the Web page or
dashboard, the standard Web error message for “page not found” is displayed when a
patron clicks the URL.
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Deep Links to Polaris PowerPAC and Mobile PAC

Deep links allow searches for specific bibliographic records in your PAC from external
sites. Such searches are launched, for example, when you use the PAC look-up feature
on the sites of book and material vendors. This section lists the PowerPAC and Mobile
PAC URLs for setting up links to specific bibliographic records in your PAC from an
external site.

PowerPAC

All URLs should be prefixed with your site-specific base URL (example:
mylibrary.com/polaris/). The URL is necessary for each link parameter.

ISBN
view.aspx?isbn={isbn},{isbn}, …

Examples - Single and multiple ISBNs, any branch:

http://mylibrary.com/polaris/view.aspx?isbn=1234567890

http://mylibrary.com/polaris/view.aspx?isbn=1234567890,2222333344,987698765X

Important: To limit by branch, you must use searchresults.aspx instead of view.aspx.
Be aware of the following points:

l Searchresults.aspx is subject to change as Polaris PowerPAC changes. You may
need to change your link format accordingly. (View.aspx is stable from release to
release.)

l You must have already set up a custom “limit by” for assigned branch in Polaris
Administration. For instructions, see Setting Up Search Filters (Limit By).

Example - Branch-specific and limited to titles with linked items at that branch

http://mylibrary.com/polaris/search/searchresults.aspx?ctx=17.1033.0.0.1&type=key
word&by=ISBN&term=0375750126&limit=AB=17&page=0

Where 17 is the branch’s organization ID in Polaris. You can use the same format with
other link parameters.

LCCN
view.aspx?lccn={lccn},{lccn}, …

Examples:
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http://mylibrary.com/polaris/view.aspx?lccn=2001627090

http://mylibrary.com/polaris/view.aspx?lccn=2001627090,2001336783,85153773

Control Number
view.aspx?cn={control_number},{control_number}, …

Examples:

http://mylibrary.com/polaris/view.aspx?cn=13243

http://mylibrary.com/polaris/view.aspx?cn=13243,9999,24354,348

See also Limited Control Number.

Keyword
view.aspx?keyword={url_encoded_keywords}

Examples:

http://mylibrary.com/polaris/view.aspx?keyword=cars

http://mylibrary.com/polaris/view.aspx?keyword=science+fiction+robots

Title
view.aspx?title={url_encoded_title}

Examples:

http://mylibrary.com/polaris/view.aspx?title=Misery

http://mylibrary.com/polaris/view.aspx?title=Punishment+Crime

Title searches are keyword searches, and hits are returned regardless of the word order
in the tag. If you want the title search to return only hits that match the order in the tag,
you can have your vendor add a type=phrase query string parameter to the vendor’s
template.

Example (type=phrase):

http://mylibrary.com/polaris/view.aspx?title=Crime+and+Punishment&type=phrase

Author
view.aspx?author={url_encoded_author}

Examples:
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http://mylibrary.com/polaris/view.aspx?author=Shakespeare

http://mylibrary.com/polaris/view.aspx?author=John+Grisham

Author searches are keyword searches to ensure that hits are returned whether the
name order is first, last or last, first. If you want the author search to return only hits that
match the order in the tag, you can have your vendor add a type=phrase query string
parameter to the vendor’s template.

Example (type=phrase):

http://mylibrary.com/polaris/view.aspx?author=Grisham+John&type=phrase

Subject
view.aspx?subject={url_encoded_subject}

Examples:

http://mylibrary.com/polaris/view.aspx?subject=dogs

http://mylibrary.com/polaris/view.aspx?subject=History+Civil+War

Subject searches are keyword searches, and hits are returned regardless of the word
order in the tag. If you want the subject search to return only hits that match the order in
the tag, you can have your vendor add a type=phrase query string parameter to the
vendor’s template.

Example (type=phrase):

http://mylibrary.com/polaris/view.aspx?subject=Civil+War+History&type=phrase

Series
Example:

http://mylibrary.com/polaris/view.aspx?series=lonely+planet

Combination: Author, Title, Subject
You can combine Author, Title, and/or Subject parameters in the same query.

Examples:

http://mylibrary.com/polaris/view.aspx?author=King&title=Misery

http://mylibrary.com/polaris/view.aspx?title=Harry+Potter&subject=wizard+schools

http://mylibrary.com/polaris/view.aspx?subject=cabin+building&author=Thoreau
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UPC
view.aspx?upc={upc_code},{upc_code}, …

Examples:

http://mylibrary.com/polaris/view.aspx?upc=287986736748

http://mylibrary.com/polaris/view.aspx?upc=289839472834,771826736475,1129897
83678

OCLC
view.aspx?oclc={oclc_number},{oclc_number}, …

Examples:

http://mylibrary.com/polaris/view.aspx?oclc=ocm12384675

http://mylibrary.com/polaris/view.aspx?oclc=ocm768375267,ocm38916725,ocm1128
6756

Record Sets (Bibliographic)
See Create a URL Link to a Record Set in the PAC.

E-Source Targets
See Provide links to e-sources on external sites.

Limited Control Number
Polaris PowerPAC’s full bibliographic product page (title.aspx) also supports a deep link
by control number for local titles. This limited-function deep link was added to improve
link sharing on social web sites that the PowerPAC deep link format for view.aspx (see
Control Number) did not support as well. The deep link for title.aspx supports a control
number parameter (cn={control-number}) which, if present, searches for and goes
directly to the PAC product page for the single, local bibliographic title with that control
number.

{pac-root-url}/search/title.aspx?&ctx={ctx-value}&pos=1&cn={control-number}

Examples:

l Any branch or language (no ctx parameter):

http://mylibrary.com/polaris/search/title.aspx?&pos=1&cn=12345

Create_a_URL_link_to_a_record_set_in_the_PAC.htm
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l Branch organization ID is 83 (ctx=83):

http://mylibrary.com/polaris/search/title.aspx?ctx=83&pos=1&cn=12345

l Branch organization ID is 83, language is English (ctx=83.1033):

http://mylibrary.com/polaris/search/title.aspx?ctx=83.1033&pos=1&cn=12345

Mobile PAC

All URLs should be prefixed with your site-specific mobile base URL (example:
mylibrary.com/mobile/). The URL is necessary for each link parameter:
{Base Mobile PAC URL}/view.aspx?{TYPE}={TERM}

Because Mobile PAC does not currently support Boolean searching, only single terms
are allowed. The following access points {TYPE} are available:

l ISBN
l LCCN
l CN - Control number
l ISSN
l Title
l Author
l Subject
l Series
l Keyword
l brs - Record set ID
l brsn - Record set name

In general, if a mobile device goes to a PowerPAC deep link and Mobile PAC supports
the search criteria specified in the URL, the mobile device user is automatically directed
to the Mobile PAC search results page. If Mobile PAC does not support the search
criteria, the mobile device user is directed to the PowerPAC search results page.

However, if type=phrase is part of the PowerPAC deep link, the user is directed to the
Mobile PAC search results page. Also, the user is directed to the Mobile PAC search
results page when there are multiple terms for author, title, or subject in the PowerPAC
deep link.

Examples:

http://mylibrary.com/polaris/view.aspx?title=time+to+kill&type=phrase
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http://mylibrary.com/polaris/view.aspx?title=time+to+kill&author=grisham+john

Note:
Although the user is directed to the Mobile PAC search results page in
these cases, if the user then clicks the Search bread crumb in the Mobile
PAC page header, the search form does not support the deep link search
terms due to their complexity.

PAC CQL Commands and Access Points

This section lists the CQL (Common Query Language) commands and access points
you can use to construct custom search filters for Polaris PowerPAC. For more
information about this procedure, see Setting Up Search Filters (Limit By). You can also
use CQL commands to construct ready-made searches for search categories in Polaris
PowerPAC Children’s Edition. For more information about this procedure, see the
Community Profiles Guide.

The CQL search command can include the following parts:

l The text for which you are searching
l The access points (fields) you want to search; for example, author or title (see the

Community Profiles Guide). Operators (connectors) that link one part of the search
with another

Example:
To find the works of author Asimov published in or after 1970, you type
the following command:
AU=asimov AND PD >= 1970
AU specifies the access point Author. The search text for this access
point is asimov. AND is the Boolean operator connecting the two
conditions of this search (the author and the date). PD specifies the
access point Publication Date. The search text for this access point is
1970. The symbol >= stands for the relative operator greater than or equal
to.

Fields that can be searched with CQL search commands fall into one of three
categories:
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l Keyword-indexed fields (for example, author, title, subject, notes) - A record must
contain all the keywords entered in the field selected for search, in any order. Other
words may be present, or the words may be present in different fields of the same
type.

To retrieve only records that contain the search words in a specific order with no
words in between (that is, to do a phrase search), enter the words in double quo-
tation marks. For example, a search for TI=french cooking finds the title French
Provincial Cooking while TI=“french cooking” does not.

l Fields that are searched with string searches - A record must contain an exact
match on the search characters (for example, a call number or publisher number
search). If the field typically includes spacing or punctuation, and you want to find
an exact match on the entire string, enter the text within double quotation marks.
For example, when searching for a call number: CALL="641.5944 Dia"

l Fields that require library-specific or Polaris-specific codes (for example, language,
target audience, type of material).

Note:
To see whether fields use keywords or codes, refer to the Community
Profiles Guide.

Boolean Operators

The Boolean operators And, Or, and Not combine search terms:

l And - A record must match both the term before and the term after the operator to
be included in the search results.

Example:
AU=“isaac asimov” AND TI=planets
Finds only the items written by Isaac Asimov that have the word planets in
the title.

l Or - A record can match either the term before or the term after the operator, or
both, to be included in the search results.

Example:
AU=“isaac asimov” OR TI=planets
Finds all items written by Isaac Asimov and all items with the word
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planets in the title by any author, including Asimov.
If you have a number of terms to combine with OR, type the command this
way:
AU={list}asimov, dick, ballard, lem, capek{/list}
You can insert as many terms as you need between {list} and {/list}

l Not - A record must match the term before the operator, but not the term after the
operator, to be included in the search results.

Example:
AU=“isaac asimov” NOT TI=planets
Finds only those items written by Isaac Asimov that do not have the word
planets in the title.

If you use multiple operators in the same search command, use parentheses to group
the operations to be performed.

Search Text That Includes Operators or Special Characters

To search for text that includes an operator or special characters as part of the search
text, put the text in double quotation marks.

For example, to find the title Bud, Not Buddy, type this command:
TI = “bud not buddy”
Put this text in quotation marks because not is ordinarily a Boolean operator.

As another example, to find the title Tim O'Toole and the Wee Folk, type this command:
TI= “tim o’toole”
Put this text in quotation marks because the apostrophe in the word o’toole is a special
character.

Relative Operators

Relative operators are symbols that compare search terms:

Symbol Relative Operation

= Equal to search term

<>
Not equal to a single search
term:
PD <> 1970
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Symbol Relative Operation

For a range of dates, use NOT:
NOT PD = 1970-1980.

>= Greater than or equal to search
term

> Greater than search term

<= Less than or equal to search
term

< Less than search term

Example:
PD >= 1987
This example finds items published in or after 1987. PD specifies the
publication date access point. See the Community Profiles Guide for
access point codes.

Example:
KW=solar system AND PD < 1932
This example finds items published before 1932 that have the words
“solar system” in any record field. KW specifies the keyword access point.
See the Community Profiles Guide for access point codes.

Proximity-Distance Operator

With proximity searching, you specify the allowable distance between two terms, which
can be keywords or phrases. The proximity-distance operator is PROX/distance. The
proximity-distance is the difference between the positions of the left and right terms.
The distance is never negative, and adjacent terms have a proximity-distance equal to 1.
You can use the operator with the relative operators < (less than), <= (less than or equal
to), = (equals), >= (greater than or equal to), > (greater than), or <> (not equal to).

You can use the following modifiers:

/ordered - The order of the two terms in the search results must be the same as the
order of the terms in the query.

/unordered - The order of the two terms does not matter in the search results.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 117

You can use keyword or phrase search access points (such as KW, AU, TI) but the
access point must be the same for both terms. See the Community Profiles Guide.

Example:
KW=“cat” PROX/distance<=5 KW=“the hat”
Find the keyword cat where it appears less than or equal to 5 words
before or after the phrase the hat. That is, between 0 and 4 words exist
between the keyword cat and the phrase the hat.

Example:
KW=“Harry Potter” PROX/distance<10/ordered KW=“J. K. Rowling”
Find the phrase Harry Potter where it appears less than 10 words before
the phrase J. K. Rowling. That is, between 0 and 8 words must exist
between the phrase Harry Potter and the phrase J. K. Rowling, counting
from the first word in each phrase.

Example:
KW=“United States” PROX/distance=2 KW=“Union”
Find the phrase United States where it appears exactly 2 words before or
after the keyword Union. That is, exactly 1 word must exist between the
phrase United States and the keyword Union.

Restrictions
l The proximity operator does not support nested Boolean expressions in either the

left or right terms. For example,
((KW=Dog OR Cat) PROX/distance=5 KW=Food) PROX/distance=6 KW=Kennel is
not supported.

l The maximum proximity-distance is 1024. If the proximity-distance in the query is
greater than 1024, the search process changes it to 1024.

l The total maximum number of keywords in a proximity expression is 16. That is,
the number of keywords on the left side of the proximity operator plus the number
of keywords on the right side of the proximity operator is limited to 16. If a prox-
imity expression contains more than 16 words, then the proximity operator will be
ignored but up to the first 16 words on the left and the right will be checked for
adjacency.

l The keyword or phrase access point (such as KW, AU, TI) used in the left and right
terms must be the same. For example, the query
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SU="HARRY" PROX/distance<=5 AU="POTTER" is not supported and will produce
an Unsupported search error.

l The left and right terms for each proximity operator must be a keyword or phrase
and not a Boolean expression, but there is no limit to the number of proximity oper-
ators in a query. For example, this query is valid:
(AU=“J. K.” PROX/distance<10 AU=“Rowling”)
AND (TI=“Conversations With” PROX/distance<10 TI=“Rowling”)
AND MAT=BKS

Search Access Point (Field) Codes

Access Point Description

AB Assigned branch (requires library-specific codes)

AU Author (keyword)

AVAILABILITY

Filters search results to titles that have at least one available item.
Type AVAILABILITY > 0. Example: To find Harry Potter titles with
at least one available item, type TI = Harry Potter AND
AVAILABILITY > 0.The AVAILABILITY access point works only for
values greater than 0. (AVAILABILITY = 0 is not valid.)

BRS Polaris bibliographic record set - control number

BRSN Polaris bibliographic record set - record set name

CALL Call number

CN Polaris bibliographic record - control number

CODEN Identifier for scientific and technical periodicals

COL Collection (requires library-specific codes)

DD Dewey classification

GENRE Genre (keyword)

GOV Superintendent of Documents classification number for
government documents

ISBN International Standard Book Number
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Access Point Description

ISSN International Standard Serial Number

KW Keyword (any field)

LA Language (see LA (Language) Codes)

LC Library of Congress classification

LCCN Library of Congress Control Number

MAT Material type of physical items (requires library-specific codes)

NAL National Agricultural Library classification

NLC National Library of Canada classification

NLM National Library of Medicine classification

NOTE General notes (keyword)

OCLC Online Computer Library Center (OCLC) control number

OCN Other system control number (requires library-specific codes)

OWN Record owner (requires library-specific codes)

PD Publication date

PN Publisher’s number

PUB Publisher (keyword)

SE Series (keyword)

STATB Record status (requires library-specific codes)

STRN Standard Technical Report Number

SU Subject (keyword)

TA Target audience (see TA (Target Audience) Codes)

TI Title (keyword)

TOM Format/Type of Material (see TOM (Format/Type of Material)
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Access Point Description

Codes)

UDC Universal Decimal classification

UPC Universal Price Code number

LA (Language) Codes

These are some common codes to use with the language access point (LA) in a
Boolean (CQL) search. Use the code, not the language name. For example, to specify
English, type LA=ENG.

Note:
You can see a complete list of language codes at the Library of Congress
Web site:
www.loc.gov/marc/languages

Language Code

Arabic ARA

Bosnian BOS

Chinese CHI

Czech CZE

Danish DAN

Dutch DUT

English ENG

French FRE

German GER

Modern Greek GRE

Hebrew HEB

Hindi HIN
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Language Code

Italian ITA

Japanese JPN

Korean KOR

Latin LAT

Multiple Languages MUL

Polish POL

Portuguese POR

Romanian RUM

Russian RUS

Serbian SCC

Sign SGN

Spanish SPA

Ukrainian UKR

Vietnamese VIE

Yiddish YID

TA (Target Audience) Codes

Use these codes with the target audience (TA) access point in a Boolean (CQL) search.
Use the code, not the target audience name. For example, to specify a preschool
audience, type TA=a.

Note:
Not all bibliographic records include target audience information.

Target Audience Code

Preschool a
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Target Audience Code

Primary school b

Elementary and junior high
school c

Secondary (senior high)
school d

Adult e

Specialized f

General g

Juvenile j

TOM (Format/Type of Material) Codes

Use these codes with the Type of Material access point (TOM) in a Boolean (CQL)
search. Use the format/type of material code, not the name. For example, to specify
DVDs, type TOM=DVD.

Format/Type of Material Code

Abstract abs

Atlas atl

Audio book abk

Audio book on cassette abt

Audio book on CD abc

Blu-Ray Disc brd

Blu-Ray + DVD bdv

Book bks

Book + Cassette bcs

Book + CD bcd
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Format/Type of Material Code

Book + DVD bkv

Braille brl

Cartographic material cmt

Digital media collection dmc

DVD dvd

EAudiobook aeb

Ebooks ebk

Electronic resources elr

Emagazine emg

Globe glb

Kit kit

Large print lpt

Manuscript cartographic
material mcm

Manuscript material mss

Manuscript music mmu

Map map

Microform mic

Mixed materials mix

Motion picture mot

Music CD mcd

Musical sound recording msr

Newspaper new
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Format/Type of Material Code

Nonmusical sound
recording nsr

Periodical per

Printed cartographic
material pcm

Printed music pmu

Printed or manuscript
music mus

Projected medium pgr

Serial ser

Sound recording rec

Streaming music stm

Streaming video stv

Three-dimensional object art

Two-dimensional
nonprojected graphic ngr

Video game vgm

Videorecording vid

Videotape vcr

Vinyl vyl

Visual materials vis

Customizing Search by Labels

You can edit the search field (Search by) labels in Polaris WebAdmin (Language Editor).
Your custom labels are displayed in Polaris PowerPAC but the default system labels are
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used in the Polaris Administration profile for search setting defaults. See Set PAC
search setting defaults. The table shows the default labels and the corresponding
language string in Polaris WebAdmin. For more information about using Polaris
WebAdmin, see WebAdmin online help.

Search By Option
Default Label Code Language String ID

Any Field KW PACML_SEARCHBARS_XSL_
1607

Title TI PACML_SEARCHBARS_XSL_
1608

Author AU PACML_SEARCHBARS_XSL_
1609

Subject SU PACML_SEARCHBARS_XSL_
1610

General notes NOTE PACML_SEARCHBARS_XSL_
1611

Publisher PUB PACML_SEARCHBARS_XSL_
1612

Genre GENRE PACML_SEARCHBARS_XSL_
1613

Series SE PACML_SEARCHBARS_XSL_
1614

ISBN
[International Standard Book
Number]

ISBN PACML_SEARCHBARS_XSL_
1615

ISSN
[International Standard
serial Number]

ISSN PACML_SEARCHBARS_XSL_
1616

LCCN
[Library of Congress Control
Number]

LCCN PACML_SEARCHBARS_XSL_
1617
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Search By Option
Default Label Code Language String ID

Publisher No.
[Publisher’s number] PN PACML_SEARCHBARS_XSL_

1618

LC
[Library of Congress call
number option for browse
searches]

LC PACML_SEARCHBARS_XSL_
1642

Dewey
[Dewey call number option
for browse searches]

DD PACML_SEARCHBARS_XSL_
1643

Call Number
[Local call number option
for browse searches]

LOCAL PACML_SEARCHBARS_XSL_
1624

SuDoc
[Superintendent of
Documents classification
number (identifier)]

SUDOC PACML_SEARCHBARS_XSL_
1639

CODEN
[Identifier for scientific and
technical periodical titles]

CODEN PACML_SEARCHBARS_XSL_
1640

STRN
[Standard technical report
number (identifier)]

STRN PACML_SEARCHBARS_XSL_
1641

Control Number
[Not exposed in default user
interface, but available as a
search access point by
editing the configuration file
SearchByOptions.xml.]

CN PACML_SEARCHBARS_
CNUMBER

Item Barcode
[Not exposed in default user BC PACML_SEARCHBARS_

BARCODE
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Search By Option
Default Label Code Language String ID

interface, but available as a
search access point by
editing the configuration file
SearchByOptions.xml.]

Course Name CRSNA PACML_SEARCHBARS_XSL_
1647

Course Number/Section CRSNO PACML_SEARCHBARS_XSL_
1648

Course Abbreviation CRSABBR PACML_SEARCHBARS_XSL_
1649

School/Division Name CRSSCHL PACML_SEARCHBARS_XSL_
1650

Department Name CRSDPT PACML_SEARCHBARS_XSL_
1651

Instructor Name CRSINST PACML_SEARCHBARS_XSL_
1652
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Displaying PAC Search Results

You can control the information displayed in PAC search results for both bibliographic
records and specific items (holdings).

Note:
Certain settings described in this unit also affect Mobile PAC. For detailed
information about Mobile PAC search results, see Mobile PAC Results
Settings. Separate settings control the display of community information
search results. See the Community Profiles Guide.

See also:

l Configuring the PowerPAC Title Display
l Configuring the PowerPAC Product Page
l Setting Up Recently Viewed Titles
l Managing Feature It Promotions
l Setting PowerPAC Narrow/Related Search Options
l Suppressing Request and Availability Options
l Cross-Reference Display in Browse Search Results
l Setting Up Local and System Availability
l Sending Call Numbers by Text Message
l Suppressing Items from Search Results
l Naming Shelf Locations
l Highlighting Titles with Local Items (PowerPAC)
l Map It (Google Maps) in PAC
l Google Preview for PowerPAC Search Results
l Enabling PAC Title Lists
l Bulk Hold Requests from Polaris PowerPAC Title Lists
l Social Bookmarking for Search Results (AddThis™)

Configuring the PowerPAC Title Display

Polaris provides complete flexibility in selecting, editing, and displaying information in
PAC search results. Using the PowerPAC profile Title Display: Configure, you can do the
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following:

l Select which bibliographic data elements appear in the initial search results list, on
the summary view for a title, and in the full display. The brief display is the inform-
ation shown in initial search results. The summary information is displayed when
the user hovers the cursor over a cover image (desktop or tablet) or taps the
image (phone). The full display appears on the product page, when the user
selects Full Display or the title itself.
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l Show multiple instances of a single tag in the brief display: for example, multiple
856$u fields.

l Specify different elements for monographs and serials.
l Suppress selected elements from display at narrow screen (cell phone) width.
l Edit existing data elements.
l Set the display order of the data elements.
l Specify a custom label for each data element, and create translated versions of

the data labels for languages you have licensed.
l Specify any additional data elements you need (custom entities), selecting the

tags, indicator values, and subfields to include in each custom entity.
l Display a "requested" indicator for titles on which the patron has an active,

pending, held, shipped, or located hold request. The indicator is a message: You
requested this on [date]; the system supplies the date. The indicator can be dis-
played to logged-in patrons on the search results page, the title screen, the work-
ing title list, and saved title lists. The Brief and Full configuration view settings in
the profile apply to both search results screens and title lists; that is, when you set
the Requested date indicator to display in search results, it will also display in
working and saved title lists.
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Note:
When enabled, the indicator is displayed only for requests that have
been placed in Polaris. The requested indicator does not apply to
integrated eContent titles.

l Copy all these settings from any organization to any other organization.

You can also use the PowerPAC profile Title Display: Number of characters in the
Summary (Short) to specify the maximum number of characters of the Summary
(Short) field that are displayed in the brief and full search results views for a title in the
Polaris PowerPAC. By default, this profile is set to "0", and the number of characters
displayed is not limited. When Summary field text exceeds the specified limit, Polaris
PowerPAC displays truncated summary text followed by a More link. Users can click
More to expand the display to show the entire summary, and click Less to collapse the
display again.

The Mobile PAC profile Title Display: Configure provides similar flexibility for the Mobile
PAC bibliographic results display, and you follow the same procedures to set up the
display. Search the Polaris online help for "Configuring the Mobile PAC Title Display."
For libraries that use Polaris Community Profiles, separate profiles control the
PowerPAC and Mobile PAC displays of community information results, and a separate
set of data elements is available for your community information displays. See the
Community Profiles Guide.

See also:

l Select bibliographic entities for display and edit labels
l Suppress bibliographic entities from small screen display
l Select bound-with host and constituent links for display in PAC
l Edit bibliographic information display order
l Edit a bibliographic entity definition
l Define custom entities
l Share a bibliographic information display configuration
l Default Title Display Configuration for PowerPAC - Reference

Set up the PowerPAC Product Page

To set the default state of categories (expanded or collapsed) on the Polaris PowerPAC
product page and determine their display order.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 132

Note:
You need the permission Modify product page categories: Allow to do
this procedure.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Product page categories: Configure.
a. The Product Page Categories: Configure dialog box opens. The top portion

lists the categories (features) that have been enabled for the organization.

b. To set a category to be expanded in the initial product page display, check
the category.

c. To change the display order, select the category and click the appropriate
arrow at the side of the dialog box to move the category up or down in the
display order.

d. Click OK to save the changes and close the dialog box.

Related Information

l Editing category labels - The Product Page Categories: Configure dialog box lists
the language string ID for each category for use in Polaris Language Editor
(WebAdmin), where you can search for and edit the drawer labels. For more inform-
ation, see the Polaris Language Editor (WebAdmin) Guide or Language Editor
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online Help.
l Enabling categories - The bottom portion of the Product Page Categories: Con-

figure dialog box lists the features that are possible to display on the product
page, but have not been enabled for the organization.

l Map It - Map It (Google Maps) in PAC
l Librarian’s View - Set the PowerPAC profile Librarian’s (MARC) View: Enable to
Yes.

l Mobile PAC product page - You can use a separate profile to configure the product
page for Mobile PAC. See Set up the Mobile PAC title (product) page.

Select bibliographic entities for display and edit labels

To select entities for display and edit their labels for PowerPAC bibliographic search
results:

Note:
You need the permission Modify bibliographic record title displays: Allow
to do this procedure.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view. To see the PowerPAC pro-
files, select the appropriate level - System, Library, Branch.

2. Double-click Title Display: Configure. The Title Display: Configure dialog box
opens.
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3. Select the view you want to configure from the Configuration view menu.

Note that you can configure separate displays for monographs and serials. The
system uses your serials configurations for bibliographic records where LDR/07 =
b or i or s.

The Available entities list on the left side of the dialog box displays the entities
that can be added to a view.

Note:
The Available entities list may include both system-supplied and custom
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entities. Custom entities are defined at the system level only. See Define
custom entities. You can also edit many existing entities. See Edit a
bibliographic entity definition.

The Display these entities list on the right side of the dialog box lists those entities
that are currently selected for the configuration view.
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“Short” entities are not repeatable for a single view. “Long” entities are repeatable
within a single view. You can double-click the edge of a column header to expand
the column and display the full text if necessary.

4. To see what tags, indicators and subfields are included in an entity, hover the
cursor over the entity for a quick view, or right-click and select Properties from the
context menu. The Entity Properties dialog box opens.

5. To add an entity to the view, click the entity in the Available entities list and then
click Add.The entity is added to the Display these entities list.

6. To remove an entity from the view, click the entity in the Display these entities list
and then click Remove.

7. If the Available Entities or Display these entities list does not include the data ele-
ment you want to display, follow these steps:

a. Click the Browse icon  at the top of the Available entities list. The Browse
Entities dialog box opens.
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b. In the Browse Entities dialog box, select the entity you want to add to the Available
entities list. You can hover the cursor over an entity to see its properties.

c. Click Reveal. The entity now appears in the Available entities list and can be selec-
ted for display.

Note:
You can shorten the Available entries list to reduce scrolling. Select the
entity that you want to remove, right-click and select Suppress from the

context menu, or click the Suppress icon  at the top of the Available
entities list. To add an entry back to the list, repeat steps a-c.

8. To edit the default English label for an entity, and to enter or change the labels for
other languages, follow these steps:

a. Right-click the entity in the Available entities or the Display these entities list, and
select Labels from the context menu, select Edit Labels from the Entity Properties

dialog box, or click the Change Labels icon  at the top of the Available
entities or Display these entities list. The Change Labels dialog opens for the
entity you selected.
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Tip:
You can also edit the labels using Polaris Language Editor (WebAdmin).
The Mnemonic field at the top of the Change Labels dialog box displays
the language string ID for the entity’s label. In Polaris Language Editor,
select the ERMSPortal “product” to edit entity labels. For more
information about using Polaris Language Editor, see online Help for
Polaris Language Editor.

b. On the Change Labels dialog box, click the language you want to edit.
c.  To customize the label, click the Customize option and then enter your text.

Note:
To enter diacritics or non-Latin characters, press and hold ALT while
typing the code on the numeric keypad.

l To permanently save your changes and keep the dialog box open, click Apply.
l To permanently save your changes and close the dialog box, click OK.
l To remove any changes that have not been applied and close the dialog box, click
Cancel.

9. Save or cancel your work in the Title Display Configure dialog box:
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l To remove any changes that have not been applied and close the Title Display Con-
figure dialog box, click Cancel.

l To remove any changes that have not been applied and keep the Title Display Con-
figure dialog box open, click Reset.

l To permanently save changes and keep the Title Display Configure dialog box
open, click Apply.

Important:
After saving your changes, use Polaris Language Editor (WebAdmin)
to reload PowerPAC. PowerPAC users may also need to clear their
browser caches.

l To permanently save changes and close the Title Display Configure dialog box,
click OK.

Important:
When you click Revert, all branch-level configuration settings are
lost. The action cannot be undone.

After making changes to the Title Display Configure dialog box at the branch or library
level, you can revert to the parent-level settings. Click Revert on the Title Display
Configure dialog box. Only the currently-selected configuration view is inherited from
the parent organization. If you make changes after clicking Revert, then inheritance is
broken and you will no longer inherit settings from the higher organization.

Related Information

l Suppress bibliographic entities from small screen display
l Edit bibliographic information display order
l Share a bibliographic information display configuration
l Edit a bibliographic entity definition (system level only)
l Define custom entities (system level only)
l Share a bibliographic information display configuration.

Suppress bibliographic entities from small screen display

All title entities that are set to display for a given configuration view will display at
mobile width by default. You can suppress bibliographic entities from the PowerPAC
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results display at mobile (650 px or narrower) width. This saves user data use and
excessive scrolling through title information.

To suppress a bibliographic entity from the mobile display:

1. Using the PowerPAC profile Title Display: Configure, set up bibliographic entities
for display. See Select bibliographic entities for display and edit labels.

2. Select the configuration view that you want to modify; for example, Full (mono-
graph).

3. Select the entity to suppress in the Display the entities list and click the phone
icon at the top of the list.

4. Click Apply.

When you have selected an entity to suppress from the mobile display, a phone
icon by the entity in the Display these entities list indicates that it will be
suppressed.
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Selecting Bound-With Host and Constituent Links for Display in PAC

Bound-with groups display in the PAC according to the settings in the PowerPAC and
Mobile PAC Title Display Configuration profiles in Polaris Administration. The display
entities, Constituent link and Host link, are system-generated and display as single
strings that wrap, if necessary. The display entities are system-generated and cannot be
edited, but the labels can be edited.
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Libraries using bound-with features should be sure to add the display entities to the PAC
views (especially brief and full) so PAC users will be able to see why individual titles
were retrieved. In addition, they should add both host and constituent links to each view
in which they want the linking entries to appear. Only one type of link will appear in any
given record, depending on whether it is a host or constituent.

The constituent links display as active or “hot” links in on all displays (PowerPAC brief,
summary, and full; and Mobile PAC details). The text of the hot links is equal to the value
in the $t, $a, and $d equivalent fields (not the $w).

See the Cataloging Guide.

Host Title Displays Constituent Links in the PAC
When the host title is displayed in the PAC, the titles bound within the volume display as
active links next to the Constituent Part heading.

In the Librarian’s View, the constituent titles are displayed in 774 tags, subfield t.
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Constituent Title Displays the Host Link in the PAC
When a user searches for a title that is a constituent in a bound-with group, the
constituent title displays at the top level with the host title on the following line next to
In.

In the Librarian’s View, the host title is displayed in the 773 tag, subfield t.
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Item Display for Bound-With Group in the PAC
In the Availability display, the call number for a constituent title in a bound-with group is
taken from the constituent call number tag, unless none has been defined. If a
constituent does not have a call number, the host item’s call number is displayed.

Hold Requests Placed in the PAC
Hold requests are placed on the host volume that contains the constituent titles of the
bound-with group.
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Edit bibliographic information display order

To insert a zone separator or set the entity display order:

1. Open the Title Display Configure dialog box if it not already open, and select the
view you want to arrange. See Select bibliographic entities for display and edit
labels.

2. To insert a zone separator:

a. In the Display these entities list, select the entity that should appear just below the
new zone separator.

b. Right-click and select Create Zone from the context menu, or click the Create Zone

icon  at the top of the Display these entities list.

3. To remove an existing zone separator, select it, right-click and select Drop Zone, or

click the Drop Zone icon .
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4. To change the order in which the entities and zone separators are displayed, select
the entity or zone separator and click the up or down arrow buttons at the top of
the Display these entities list.

5. To suppress the field label (but not the entity itself) from the PAC display, select
the data element in the Display these entities list, right-click, and select
Show/Hide Label from the context menu.

Tip:

In the Display these entities list, the label icon  indicates that the label
is currently set to be shown.

6. Save or cancel your work in the Title Display Configure dialog box:

l To remove any changes that have not been applied and close the dialog box, click
Cancel.

l To remove any changes that have not been applied and keep the dialog box open,
click Reset.

l To permanently save changes and keep the dialog box open, click Apply.
l To permanently save changes and close the dialog box, click OK.

Important:
After saving your changes, use Polaris Language Editor (WebAdmin) to
reload PowerPAC. See Updating Page Caches.

Edit a bibliographic entity definition

At the system level, you can edit the definitions (tags, indicators, subfields) of many
bibliographic information display entities. However, the following system-defined
entities cannot be edited:

Bibliographic call number Fiction

Primary title Hold Request Count

Primary author Holdings Note

Snippet [the brief text string that
shows the search terms in
context]

Local Availability (Available
Local Item Count and Total
Local Item Count)
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System Availability (Available
System Item Count and Total
System Item Count)

OCLC Control Number

Holdings Statement Publication year

Available Local item Count Retention Statement

Available System Item Count Total Local Item Count

Control Number Total System Item Count

Course Reserve Count Type of Material

Also note that certain fields are ordinarily displayed as hyperlinks leading to a browse
search in PowerPAC (for example, author or subject). However, adding a tag to a
materialization rule for that type of data does not automatically cause the field to be
displayed as a hyperlink (that is, it is not added to the browse index). The hyperlink will
only occur if the tags, indicator values, and subfields selected for inclusion in the display
correspond exactly to the fields that are already included in the browse index.

To edit existing entities for display in PAC search results:

Note:
You need the permission Modify and create display entities: Allow to do
this procedure.

1. In the Administration Explorer tree view, open the Profiles folder for the system,
and click the PowerPAC tab in the details view.

2. Double-click Title Display: Configure. The Title Display: Configure dialog box
opens.

3. Right-click the entity in the Available entities list and select Properties from the
context menu.

Note:
To display an entity for selection, you may need to click the Browse icon

at the top of the Available entities list. Select the entity in the Browse
Entities dialog box and click Reveal to add the entity to the Available
entities list.
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4. On the Entity Properties dialog box, click Define Entity. The Entity Definition dialog
box opens.

5. To add a new tag to the entity, click the ellipsis button in the Tags column.

The Tag Picker dialog box opens.

6. Select a tag or multiple tags:
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l To select one tag, click it in the grid, and then click Enable.
l To select a contiguous range of tags, enter the beginning and ending tags in the
Select range box, and click the + button to highlight the tags in the grid. Then click
Enable.

l To select a non-contiguous set of tags, press CTRL+click to select the tags in the
grid, and then click Enable.

l To save your changes and close the dialog box, click OK. The Entity Definition dia-
log box is displayed.

7. To select indicator values, click the ellipsis button in the Ind1 or Ind2 column.

The Code Picker dialog box opens.

8. Select an indicator value or multiple indicator values:

l To select an indicator value, click it in the grid, and then click Enable.

Note:
The dot character in the upper left corner of the Code Picker grid indicates
a space.

l To select a contiguous range of indicator values, enter the beginning and ending
values in the Select range box, and click the + button to highlight the values in the
grid. Then click Enable.
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l To select a non-contiguous set of values, press CTRL+click to select the values in
the grid, and then click Enable.

l To save your changes and close the Code Picker dialog box, click OK. The Entity
Definition dialog box is displayed.

9. To select subfields, click the ellipsis button in the Subfields column to display the
Code Picker dialog box, and follow the same steps you used to select the indicator
values. See step 8.

10. When all the tags, indicators and subfields are defined for the entity, click Apply to
permanently save your work and keep the Entity Definition dialog open, or click
OK to permanently save your work and close the dialog box.

Use the Change Labels dialog box to edit labels. See Select bibliographic entities for
display and edit labels.

Define Custom Entities

Custom entities can be defined at the system level only. To define new entities for
display in PAC bibliographic search results:

Note:
The maximum number of custom entities that can be defined at one time
is 16,383. Internally, custom entities are assigned identifiers in the range
of 16,384 and 32,767. The identifier number is displayed in the Entity
Properties dialog box, Advanced tabbed page (Entity path).

Note:
You need the permission Modify and create display entities: Allow to do
this procedure.

1. Select System, PowerPAC profiles, Title Display: Configure to open the Title Dis-
play: Configure dialog box at the system level.

2. Click the new entity icon at the top of the Available Entities list. The New Cus-
tom Entity dialog box opens.

3. Type a description for the entity. The description identifies the entity in the system,
but does not display in PAC. Your description must contain at least one character
and no more than 255 characters, and it must be unique within the set of bib-
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liographic entities.
4. Type an initial label for the entity.

The label will be displayed in PAC if this entity and its label are both set to display.
Labels associated with custom entities do not have default values. The initial label
that you specify is created for each language at the system level. You can later
edit the label for specific languages; see Select bibliographic entities for display
and edit labels.

5. If this entity is repeatable, select Repeatable.
6. Click OK to save the new entity and close the New Custom Entity dialog box. The

Entity Properties dialog box appears.
7. Define the tags, indicators, and subfields for the new entity:

a. On the Entity Properties dialog box, click Define Entity.
b. See Edit a bibliographic entity definition for editing instructions.

Related Information

Deleting a custom entity - You cannot delete a custom entity if it is currently used in any
display configuration. Select the entity in the Available Entities list and click the delete

icon  above the list. If the entity is currently in use, a message lists the
configurations where it is used.

Share a bibliographic information display configuration

To copy your bibliographic display configurations to other organizations:

1. Open the Title Display Configure dialog box if it not already open, and select the
view you want to copy. See Select bibliographic entities for display and edit labels.
If the dialog box is already open and you have been making changes, click Apply to
save your changes.

2. Click Copy. The Copy dialog box opens.
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3. Select the configuration views you want to copy.
4. Select the organizations that should receive your settings.
5. (Optional) To overwrite the destination organization’s labels with the source organ-

ization’s labels, select Overwrite labels.
6. Click Copy.

Important:
The copy action takes place immediately. The action cannot be undone.

Default Title Display Configuration for PowerPAC - Reference

The tables show the default title display configuration for PowerPAC bibliographic
search results.

PowerPAC Brief Display - Monograph PowerPAC Brief Display - Serial

Entity Display
Order Label Entity Display

Order Label

Primary Title 1 Title: Primary Title 1 Title:

Primary Author 2 Author: Primary Author 2 Author:

Snippet 3 Snippet: Snippet 3 Snippet:

Publisher 4 Publisher, Publisher 4 Publisher,
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(Short) Date: (Short) Date:

Web Link
(Short) 5 Web Site: Web Link

(Short) 5 Web Site:

Description
(Short) 6 Description: Description

(Short) 6 Description:

Series (Short) 7 Series: Series (Short) 7 Series:

Target
Audience Note
(Short)

8
Target
Audience
Note:

Target
Audience Note
(Short)

8
Target
Audience
Note:

Former Title
(Short) 9 Former Title: Former Title

(Short) 9 Former Title:

Later Title
(Short) 10 Later Title: Later Title

(Short) 10 Later Title:

System
Availability 11 System

Availability:
System
Availability 11 System

Availability:

Available
System Item
Count

12 # System
items in:

Available
System Item
Count

12 # System
items in:

Total System
Item Count 13 System

Availability:
Total System
Item Count 13 System

Availability:

Call Number
(Short) 14 Call Number: Call Number

(Short) 14 Call Number:

Holdings
Statement 15 Holdings

Statement:
Holdings
Statement 15 Holdings

Statement:

PowerPAC Summary Display -
Monograph PowerPAC Summary Display - Serial

Entity Display
Order Label Entity Display

Order Label

Primary Title 1 Title: Primary Title 1 Title:
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Primary Author 2 Author: Primary Author 2 Author:

Snippet 3 Snippet: Snippet 3 Snippet:

Publisher
(Short) 4 Publisher,

Date:
Publisher
(Short) 4 Publisher,

Date:

Web Link
(Short) 5 Web Site: Web Link

(Short) 5 Web Site:

Description
(Short) 6 Description: Description

(Short) 6 Description:

Series (Short) 7 Series: Series (Short) 7 Series:

Target
Audience Note
(Short)

8
Target
Audience
Note:

Target
Audience Note
(Short)

8
Target
Audience
Note:

Former Title
(Short) 9 Former Title: Former Title

(Short) 9 Former Title:

Later Title
(Short) 10 Later Title: Later Title

(Short) 10 Later Title:

System
Availability 11

System
Availability: System

Availability 11
System
Availability:

Available
System Item
Count

12 # System
items in:

Available
System Item
Count

12 # System
items in:

Total System
Item Count 13 System

Availability:
Total System
Item Count 13 System

Availability:

Call Number
(Short) 14 Call Number: Call Number

(Short) 14 Call Number:

Holdings
Statement 15 Holdings

Statement:
Holdings
Statement 15 Holdings

Statement:

PowerPAC Full Display - Monograph PowerPAC Full Display - Serial
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Entity Display
Order Label Entity Display

Order Label

Type of
Material 1 Format: Type of

Material 1 Format:

Uniform Title
(Long) 2 Uniform Title: Uniform Title

(Long) 2 Uniform Title:

Author (Long) 3 Author: Author (Long) 3 Author:

Title (Long) 4 Title: Title (Long) 4 Title:

Edition (Long) 5 Edition: Edition (Long) 5 Edition:

Publisher
(Long) 6 Publisher,

Date:
Publisher
(Long) 6 Publisher,

Date:

Description
(Long) 7 Description: Description

(Long) 7 Description:

Summary
(Long) 8 Summary: Summary

(Long) 8 Summary:

Target
Audience Note
(Long)

9
Target
Audience
Note:

Target
Audience Note
(Long)

9
Target
Audience
Note:

Series (Long) 10 Series: Series (Long) 10 Series:

Volume (Long) 11 Volume: Volume (Long) 11 Volume:

Frequency
(Long) 12 Frequency: Frequency

(Long) 12 Frequency:

Subjects 13 Subjects: Subjects 13 Subjects:

Other Author
(Long) 14 Other Author: Other Author

(Long) 14 Other Author:

Other Title
(Long) 15 Other Title: Other Title

(Long) 15 Other Title:

Former Title 16 Former Title: Former Title 16 Former Title:
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(Long) (Long)

Later Title
(Long) 17 Later Title: Later Title

(Long) 17 Later Title:

Web Link
(Long) 18 Web Site: Web Link

(Long) 18 Web Site:

LCCN (Long) 19 LCCN: LCCN (Long) 19 LCCN:

ISBN (Long) 20 ISBN: ISBN (Long) 20 ISBN:

ISSN (Long) 21 ISSN: ISSN (Long) 21 ISSN:

OCLC Control
Number 22 Other

Number:
OCLC Control
Number 22 Other

Number:

STRN (Long) 23 STRN: STRN (Long) 23 STRN:

GPO (Long) 24 GPO Item
No.: GPO (Long) 24 GPO Item

No.:

CODEN (Long) 25 Label:
CODEN: CODEN (Long) 25 Label:

CODEN:

Total System
Item Count 26 System

Availability:
Total System
Item Count 26 System

Availability:

Hold Request
Count 27 Current

Holds:
Hold Request
Count 27 Current

Holds:

Control
Number 28

Control
Number: Control

Number 28
Control
Number:

Bibliographic
Call Number 29 Call Number: Bibliographic

Call Number 29 Call Number:

Course
Reserve Count 30 Course

Reserves:
Course
Reserve Count 30 Course

Reserves:

Medium (Long) 31 Medium: Medium (Long) 31 Medium:
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System-Defined Entities for Title Display Configuration
This table lists the available system-defined entities for configuring the Brief and Full
Title Display for PowerPAC.

Available System-Defined Entities for Configuring Brief or Full Title Display

Data Element Description

Keywords in Context
string

Like many popular web search engines, this element shows an
excerpt from the record that contains the search term in quick,
keyword, phrase, exact, advanced, and Boolean brief search
results. Helps patrons determine if a title is relevant by
showing context, but some may find the additional information
confusing.

Publisher, date (260
$b, $c) Taken from the MARC record fields indicated.

Edition (250 all
subfields) Taken from the MARC record fields indicated.

856 (URL link)

Taken from the MARC record field indicated. The following
program logic determines the link text:

•856 $y - Link Text - If the bibliographic record has an 856 $y,
the text in the first occurrence of this tag is used for the web
link display instead of the URL in the 856 $u.

•856 $3 - Material Specified - If the bibliographic record does
not have an 856 $y, but it does have an 856 $3, the text in the
first occurrence of this tag is used for the web link display
instead of the URL in the 856 $u.

•856 $u - URL - If the bibliographic record does not have an
856 $y or an 856 $3, the web link text that you specify in the
Label field. The default text is Web Site.

Note: If there is text in the 856 $z, it displays as a note but not
part of the web link.

When the link is selected, the related web site opens.

Description (300 all Taken from the MARC record fields indicated.
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subfields)

Series

A single series field is selected for brief display. The following
program logic determines which series field is used:

1. Use the first 4xx in the record that is not a 490.

2. If the only 4xx in the record is a 490, do not use it; instead,
use the first 8xx in the record.

3. If the only 4xx in the record is a 490 and there is no 8xx, use
the 490.

Clicking the series entry launches a browse search on the
series.

Target Audience
(521 $a)

Taken from the MARC record field indicated. This field
displays the Motion Picture Association of America (MPAA)
rating for movies.

Former Title (780
selected subfields)

Taken from the MARC record fields indicated. Note:

Subfields o, r, u, w, x, y, z, 4, 6, 7, and 8 are suppressed from the
brief title display

Later Title (785
selected subfields)

Taken from the MARC record fields indicated. Note:

Subfields o, r, u, w, x, y, z, 4, 6, 7, and 8 are suppressed from the
brief title display.

Local Availability
Summary

Set this in conjunction with # Local items in and # of Local
items (see below). This setting displays the specified label;
the other two provide the appropriate numbers. If the local
count is 0 and the user is connected to the system, the display
is suppressed. Example with default label: Local Availability: 3
(of 4)

System Availability
Summary

Set this in conjunction with # System items in and # of
System items (see below). This setting displays the specified
label; the other two provide the appropriate numbers. Example
with default label: System Availability: 3 (of 4)

Call Number
If the user is connected to a branch, the item call number from
the first item with a status of In at that location is displayed; if
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none are in, the call number of the last item that was In is
displayed. If there are no local items, no call number is
displayed. If the user is connected to the system and this data
element is set to display, the bibliographic call number is used.

Edition (250 all
subfields) Taken from the MARC record fields indicated.

ISBN (020 $a) Taken from the MARC record field indicated.

# System items

Total items in the system attached to this bibliographic record.
Works with the # System items in data element (see below) to
construct an availability count - for example, 3 of 4. The data
element System Availability Summary (see above) specifies
the label for the count. To be included in item counts, Display
in PAC must be checked in the item record, and the item
record status must not be provisional or deleted. Serials: An
item is considered a serial if there is an issue record (with or
without linked item records), the copy order type is
subscription, and issues are retained. These serials are
included in the counts if Display in PAC is checked in the
serial holdings record.

# Hold requests Number of current hold requests for the title.

Summary (520 $a) Taken from the MARC record field indicated.

# Local items

Total number of local items attached to this bibliographic
record. A local item is one whose assigned branch is listed as
local to the connection organization in the Item Availability
Display Order policy table for the organization. Works with the
# Local items in data element (see below) to construct an
availability count - for example, 3 of 4. The data element Local
Availability Summary (see above) specifies the label for the
count. If the local count is 0 and the user is connected to the
system, the display is suppressed.

Control number
(001)

The Polaris control number of bibliographic record, taken from
the MARC record field indicated.

# Course reserves Number of courses for which items linked to this bibliographic
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record are reserved.

# Local items in
Works with the # Local Items data element (see above) to
construct an availability count. If the local count is 0 and the
user is connected to the system, the display is suppressed.

# System items in Works with the # System Items data element (see above) to
construct an availability count.

Holdings Statement
For serials. Displays the retention period from the first to the
last retained for all branches. Gaps are not included, certain
issues may not be actually available locally.

Medium (245 $h) Taken from the MARC record field indicated.

Format Polaris Type of Material entries, taken from multiple MARC
record fields.

UPC (024 $a) Taken from the MARC record field indicated when IND1 = 1.

Gov Doc Number
(086 $a) Taken from the MARC record field indicated.

Bibliography Note
(504 $a) Taken from the MARC record field indicated.

Restrictions on
Access Note (506 $a
- $f, $u)

Taken from the MARC record field indicated.

Credits Note (508
$a) Taken from the MARC record field indicated.

Participants and
Performers Note
(511 $a)

Taken from the MARC record field indicated.

Summary Note (520
$a - $c, $u)

Taken from the MARC record field indicated when IND1 =
blank or 8.

Subject Note (520 $a
- $c, $u) Taken from the MARC record field indicated when IND1 = 0.

Review Note (520 $a Taken from the MARC record field indicated when IND1 = 1.
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- $c, $u)

Scope and Content
Note (520 $a - $c,
$u)

Taken from the MARC record field indicated when IND1 = 2.

Abstract Note (520
$a - $c, $u) Taken from the MARC record field indicated when IND1 = 3.

Content Advice Note
(520 $a - $c, $u) Taken from the MARC record field indicated when IND1 = 4.

Audience Note (521
$a - $b)

Taken from the MARC record field indicated when IND1 =
blank or 8.

Reading Grade Level
Note (521 $a - $b) Taken from the MARC record field indicated when IND1 = 0.

Interest Age Level
Note (521 $a - $b) Taken from the MARC record field indicated when IND1 = 1.

Interest Grade Level
Note (521 $a - $b) Taken from the MARC record field indicated when IND1 = 2.

Special Audience
Characteristics (521
$a - $b)

Taken from the MARC record field indicated when IND1 = 3.

Motivation/Interest
Level (521 $a - $b) Taken from the MARC record field indicated when IND1 = 4.

Reading Program
Note (526 $a -$d, $i,
$z)

Taken from the MARC record field indicated.

System Details Note
(538 $a, $i, $u) Taken from the MARC record field indicated.

Terms Governing
Use and
Reproduction Note
(540 $a - $d, $u)

Taken from the MARC record field indicated.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 162

Language Note (546
$a - $b) Taken from the MARC record field indicated.

Awards Note (586
$a) Taken from the MARC record field indicated.

# Hold requests Number of current hold requests for the title.

Summary (520 $a) Taken from the MARC record field indicated.

# Local items

Total number of local items attached to this bibliographic
record. A local item is one whose assigned branch is listed as
local to the connection organization in the Item Availability
Display Order policy table for the organization. See “Set up the
local/system item availability display” on page 158. Works
with the # Local items in data element (see below) to
construct an availability count - for example, 3 of 4. The data
element Local Availability Summary (see above) specifies the
label for the count. If the local count is 0 and the user is
connected to the system, the display is suppressed.

Control number
(001)

The Polaris control number of bibliographic record, taken from
the MARC record field indicated.

# Course reserves Number of courses for which items linked to this bibliographic
record are reserved.

# Local items in
Works with the # Local Items data element (see above) to
construct an availability count. If the local count is 0 and the
user is connected to the system, the display is suppressed.

# System items in Works with the # System Items data element (see above) to
construct an availability count.

Holdings Statement
For serials. Displays the retention period from the first to the
last retained for all branches. Gaps are not included, certain
issues may not be actually available locally.

Medium (245 $h) Taken from the MARC record field indicated.

Format Polaris Type of Material entries, taken from multiple MARC
record fields.
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UPC (024 $a) Taken from the MARC record field indicated when IND1 = 1.

Gov Doc Number
(086 $a) Taken from the MARC record field indicated.

This table lists the available system-defined entities for configuring the Full Title Display
for PowerPAC.

Available System-Defined Entities for Configuring the Full Title Display

Data
Element Description

Format Polaris Type of Material entries, taken from multiple MARC record
fields.

Uniform Title
(130 all
subfields)

Taken from the MARC record fields indicated. If a record in the search
results does not have a Title Statement (245 tag), the system uses the
Uniform title as the primary title. If you select this element for display,
and the record has entries in both the 245 and 130 tags, both will
display.

Author (1xx
all subfields)

Taken from the MARC record fields indicated. Clicking an author entry
launches a browse search on the author.

Title (245 all
subfields) Taken from the MARC record fields indicated.

Edition (250
all subfields) Taken from the MARC record fields indicated.

Publisher,
date (260 $b,
$c)

Taken from the MARC record fields indicated.

Description
(300 all
subfields)

Taken from the MARC record fields indicated.

Summary
(520 $a) Taken from the MARC record field indicated.

Target Taken from the MARC record fields indicated.
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Audience
(521 $a - $z)

Series (400,
410, 411,
440, 490,
800, 810,
811, 830 all
subfields)

Taken from the MARC record fields indicated. Clicking a series entry
launches a browse search on the series.

Volume (362
$a) Taken from the MARC record fields indicated.

Frequency
(310 $a) Taken from the MARC record fields indicated.

Subject (6xx
- except 655 -
alphabetic
subfields)

Taken from the MARC record fields indicated. Clicking a subject entry
launches a browse search on the subject.

Genre (655
all subfields) Taken from the MARC record fields indicated.

Added
Author (700,
710, or 711
all subfields)

Taken from the MARC record fields indicated.

Added Title
(222, 240,
242, 243,
246, 247,
730, or 740
all subfields)

Taken from the MARC record fields indicated.

Former Title
(780 all non-
numeric
subfields)

Taken from the MARC record fields indicated. Note:

Subfields o, r, u, w, x, y, and z are retained in the full title display.
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Later Title
(785 all non-
numeric
subfields)

Taken from the MARC record fields indicated. Note:

Subfields o, r, u, w, x, y, and z are retained in the full title display.

Notes (5xx
all subfields,
except 505,
520, and
521)

Taken from the MARC record fields indicated.

Contents
(505 all
subfields)

Taken from the MARC record fields indicated.

856 (URL
link)

Taken from the MARC record field indicated. The following program
logic determines the link text:

•856 $y - Link Text - If the bibliographic record has an 856 $y, the text
in the first occurrence of this tag is used for the web link display
instead of the URL in the 856 $u.

•856 $3 - Material Specified - If the bibliographic record does not have
an 856 $y, but it does have an 856 $3, the text in the first occurrence
of this tag is used for the web link display instead of the URL in the
856 $u.

•856 $u - URL - If the bibliographic record does not have an 856 $y or
an 856 $3, the web link text that displays is the URL in the 856 $u.

Note: If there is text in the 856 $z, it displays as a note but not part of
the web link.

When the link is selected, the related web site opens.

LCCN (010
$a) Taken from the MARC record field indicated.

ISBN (020
$a) Taken from the MARC record field indicated.

ISSN (022
$a) Taken from the MARC record field indicated.
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Publisher
Number (028
$a)

Taken from the MARC record field indicated.

Other
Number (035
$a)

Taken from the MARC record field indicated.

STRN (027
$a) Taken from the MARC record field indicated.

GPO Item
No. (074 $a) Taken from the MARC record field indicated.

CODEN (030
$a) Taken from the MARC record field indicated.

# System
items

Total items in the system attached to this bibliographic record. Works
with the # System items in data element (see below) to construct an
availability count - for example, 3 of 4. To be included in item counts,
Display in PAC must be checked in the item record, and the item
record status must not be provisional or deleted. Serials: An item is
considered a serial if there is an issue record (with or without linked
item records), the copy order type is subscription, and issues are
retained. These serials are included in the counts if Display in PAC is
checked in the serial holdings record.

# Hold
requests Number of current hold requests for the title.

# Local
items

Total number of local items attached to this bibliographic record. A
local item is one whose assigned branch is listed as local to the
connection organization in the Item Availability Display Order policy
table for the organization. Works with the # Local items in data
element (see below) to construct an availability count - for example, 3
of 4.

Control
number
(001)

The Polaris control number of the bibliographic record, taken from the
MARC record field indicated.
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Configuring the PowerPAC Product Page

The PowerPAC product page is displayed when a user clicks or taps a title, cover image,
or Full Display for a title in the search results list. This page includes the bibliographic
information set for the full display in the PAC profile Title display: Configure (see
Configuring the PowerPAC Title Display). Since this information may be extensive, this
section of the page can be scrolled. Below the bibliographic information is a series of
expandable category “drawers” for availability information, enriched content, and other
features. External links to other resources are indicated by an icon . (These links

open in a new browser window.) The user can click Expand All or Collapse All to control
the display of the drawer contents, or expand and collapse individual drawers. In Polaris
Administration, you can set which drawers are expanded by default when the page is
opened, and specify the display order of the drawers on the page. The illustration shows
an example with drawers collapsed (not all drawers are shown).

To configure the Polaris PowerPAC product page:

Note:
You need the permission Modify product page categories: Allow to do
this procedure.
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Product page categories: Configure. The Product Page Categories:
Configure dialog box opens. The top portion lists the categories (features) that
have been enabled for the organization.

3. To set a category to be expanded in the initial product page display, check the cat-
egory.

4. To change the display order, select the category and click the appropriate arrow at
the side of the dialog box to move the category up or down in the display order.

5. Click OK.

Related Information

l Editing category labels - The Product Page Categories: Configure dialog box lists
the language string ID for each category for use in Polaris Language Editor
(WebAdmin), where you can search for and edit the drawer labels. For more inform-
ation, see the Language Editor online Help.

l Enabling categories - The bottom portion of the Product Page Categories: Con-
figure dialog box lists the features that are possible to display on the product
page, but have not been enabled for the organization. For information about set-
ting up the features that can be displayed on the product page, see also:

l Enriched content from third parties - Enabling Enriched Data
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Note:
NoveList Select content drawers are not displayed for digital content
(Polaris Fusion) bibliographic records.

l Map It - Map It (Google Maps) in PAC

l Librarian’s View - Set the PowerPAC profile Librarian’s (MARC) View: Enable to
Yes.

l Mobile PAC product page - You can use a separate profile to configure the product
page for Mobile PAC. See Set up the Mobile PAC title (product) page.

Set up the local/system item availability display

To specify how an organization’s holdings are displayed in the PAC:

Note:
These settings control how information about specific items is displayed
in Polaris PowerPAC, and Mobile PAC where noted. Use the PowerPAC
profile Title display configure to specify the information that should be
included in brief and expanded title information, which bibliographic-level
title information should be displayed, and the labels for the information.
See Configuring the PowerPAC Title Display.

In the Administration Explorer tree view, open the Profiles folder for the organization,
and click the PowerPAC tab in the details view.

Double-click the profile Item Availability: Display local and system levels, and select
one of the following options:

l Yes - In Polaris PowerPAC, when a patron is connected to a branch, items for the
branches defined as local for that branch are displayed and the patron can click a
link to see those of other branches. When the patron is connected to the system
organization, all branches’ items are displayed in one list.

l No - Shows all holdings, both local and system, in one view.

Set the following additional PowerPAC profiles for the PowerPAC display:

l Item Availability: Display last circ date - Set to Yes to display the last circulation
date of the item.
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l Item Availability: Display notes - Set to Text to display any item or issue public
notes as text, set to Icon to display an icon that the user hovers over to see the
notes, or set to Do not display to suppress item or issue public notes from display.

Note:
For a serials public note to display in PAC, at least one issue or issue with
a linked item must be added to a serials holdings record. If no issues
exist, you can generate a “dummy” issue so the note will display. See the
Serials Guide.

l Item Availability: Display textual holdings notes - Set to Text to display serials
textual holdings notes as text, set to Icon to display an icon that the user hovers
over to see the notes, or set to Do not display to suppress textual holdings notes
from display.

Set the following PAC profiles to Yes or No to specify what information about each item
should be displayed. These settings also affect Mobile PAC:

l Item Availability: Display detailed item status - Set to Yes to display the specific
item circulation status of unavailable items, such as Lost or Bindery. Set to No to
display No items available or your own text for items that are unavailable for
circulation for any reason. (You must also set Item Availability: Display status to
Yes.) This setting also affects Mobile PAC.

Note:
If you set this profile to No, you can customize the text that is displayed to
indicate that an item is unavailable. See Editing Messages and Labels.

l Item Availability: Display due date in detailed item status - If you set Item
Availability: Display detailed item status to Yes, you can set this parameter to
display or suppress the item’s due date. (If you set Item Availability: Display
detailed item status to No, you cannot display the due date.) This setting also
affects Mobile PAC.

l Item Availability: Display shelf location - Set to Yes to display an item’s shelf
location. For more information, see Naming Shelf Locations. This setting also
affects Mobile PAC.

l Item Availability: Display status - Set to Yes to display an item’s availability status.
If you set this to Yes, also review the setting for Item Availability: Display detailed
item status. This setting also affects Mobile PAC.
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l Item Availability: Display type - Set to Yes to display the item’s material type. This
setting also affects Mobile PAC.

In the Administration Explorer tree view, open the Policy Tables folder for the
organization, and select Item Availability Display Order.

Note:
These System Administration permissions are required to modify this
table: Access administration: Allow, Access tables: Allow, Modify item
availability display order table: Allow. The organization level at which the
table is opened determines the entries you see in the list.

The Item Availability Display Order table appears in the details view.

Click  to display the Insert Item Availability Display Order dialog box.

In the Organization box, select the organization for which the item availability entry is
being set up. The new entry will affect the PAC item availability display for this
organization.
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Note:
If the Item Availability Display Order table is opened at the branch level,
only the branch name is displayed in the Organization list.

In the Branch Location box, select the organization whose holdings you want to display
in the PAC for the Organization branch.

Tip:
If you want a branch to display in both the Local and System Availability
views, add it to the table twice, designating it as Local for one entry and
System for the other.

Specify whether the item holdings for the organization named in the Branch
Location box are displayed in the Local or System Availability view of the PAC for the
Organization branch:

l To display the Branch Location item holdings as local holdings, select Local in the
Level box.

l To display the Branch Location item holdings as system holdings, select System in
the Level box.

Note:
If you set the PAC profile Item Availability: Display local and system
levels to Yes, entries designated as Local are displayed in the Local
Availability view, and entries designated as System are displayed when
the user clicks the link to see all items. If you set the profile to No, only the
entries designated as System are displayed.

Click OK on the dialog box.

The Item Availability Display Order dialog box closes. The new item availability
display entry is displayed at the end of the policy table.

Position the item holdings in the availability display for the organization by following
these steps:

a) Select (highlight) the branch location entry for which you want to change the
displayed order.

b) To move the branch entry’s holdings higher on the list, click .
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c) To move the branch entry’s holdings lower on the list, click .

The Sorting Order value changes for the entry as you position the entry.

Select File > Save.

Related Information

l Modify an entry in the Item Availability Display Order policy table - Select the entry

and click .You can change only the Highlight setting for an existing entry. If you
need to change the entry in another way, delete the incorrect entry and create a
new entry.

l Delete an entry in the Item Availability Display Order policy table - Select the entry

and click . If you delete an entry in the middle of the sort order, the remaining
entries are automatically reordered.

l Item availability display in Polaris PowerPAC - You can set the default item
availability display for a branch or collection to expanded or closed, and make
separate settings for non-serial and serial holdings. (Patrons can always select
branch and collection controls to expand or close the list of items under each
branch and collection.) To set the default display to expanded branch and
collection lists for non-serial holdings, set the PowerPAC profile Item Availability:
Expand non-serial titles to Yes. To set the default display to closed branch and
collection lists, set the profile to No. To set the default display to expanded lists
for serial holdings (those with a holdings statement for that particular branch), set
the PowerPAC profile Item Availability: Expand serial titles to Yes. To set the
default display to closed branch and collection lists, set the profile to No. (If you
have extensive serial holdings, consider setting this profile to No to reduce
scrolling in the PAC. Patrons can expand the lists they want to see at any time.)

l Item Availability display in Mobile PAC - See Title Link: Find It.

l Text-message call numbers from item availability display - See Sending Call
Numbers by Text Message.

l Item availability summary in Polaris PowerPAC - You can display a summary count
of available items associated with a title, and the current number of holds on the
title, on the initial search results pages. See Configuring the PowerPAC Title
Display.
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l Item display and circulation status - You can specify item circulation statuses that
should prevent an item from being displayed in PAC search results. See Suppress
items by circulation status.

l Suppressing availability for specific types of material - You can suppress
availability information for designated types of material from the PowerPAC and
Mobile PAC search results displays. See Suppressing Request and Availability
Options.

l Serials display in PAC availability views - Settings in the serial holdings record
control the location-specific compressed holdings statement and the issues that
are displayed.

Suppress items by circulation status

To suppress items with specific circulation statuses from appearing in Polaris
PowerPAC and Mobile PAC search results:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

Tip:
For any particular item, the system uses the setting for the item’s
assigned branch to determine whether the item should be included in the
search results display.

2. Double-click Suppress item display.

The Suppress Item Display dialog box opens.

3. Select the circulation statuses that should prevent an item from being displayed in
PAC search results.

The OK button becomes available.

4. Click OK.

Your changes will not be evident in the PAC until the SQL job PAC
Availability adjusts the counts. This job ordinarily runs automatically during
overnight processing.
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Setting Up Recently Viewed Titles

The Recently View Titles list is available when the user has viewed at least one product
page for a title in the current session. It is displayed in the PowerPAC dashboard on the
product page for a title, and on any bibliographic record search and results page. The
list displays the titles already viewed, including the cover image, title, author, format
icon, and publication date. The user can click or tap a title in the list to launch a search
for the title.

The list is available as long as the current session is active, and is cleared when the
browser is closed or the session times out. It is available regardless of whether the user
has logged in. The user can disable the feature for the session by clicking or tapping
Turn off recently viewed titles. This action clears the list; the user can start it again by
clicking or tapping Turn on recently viewed titles.

You can enable the feature for in-house workstations, remote workstations, or both. Use
the PowerPAC profile Recently viewed titles, available at the system, library, or branch
level, to set up the Recently Viewed Titles web part.

To set up the Recently Viewed Titles feature in Polaris PowerPAC:
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Recently viewed titles. The Recently Viewed Titles dialog box opens.
3. Set either or both location options:

l Check Enable for in-house workstations to make this feature available at work-
stations in the library. In-house workstations are those defined by the settings in
the organization’s PowerPAC profile In-house access definitions. If you have pri-
vacy concerns regarding in-house PAC workstations, leave this option unchecked.

l Check Enable for remote access to make this feature available to users outside
the library.

4. Set the maximum number of titles that should appear in the list. The maximum is
99; the default value is 5.

5. Click OK.

Managing Feature It Promotions

Libraries can use Feature It to generate awareness of relevant resources that might
otherwise go undiscovered in the public access catalog or in the community. With
Feature It, you can promote library materials, web resources, and/or community
organizations and events in the context of specific search results, similar to “You might
also like” features on many popular web sites.

Note:
Feature It and Community Profiles are available by separate licenses.

Use the Cataloging Promotions function in the staff client to select resources to feature,
and to specify the conditions under which they will be featured. See the Cataloging
Guide.

Once promotions are set up, when one or more of the PowerPAC user’s search terms
(16 words maximum) match the triggers and filters associated with one or more
promotion records, promotion links are displayed in a position you specify on the
PowerPAC search results screen. A maximum of 8 promotion links can be displayed. If
more than 8 promotion links match the user’s search terms, a relevancy ranking formula
is applied to select those most relevant to the user’s search terms. (Relevancy is based
on the words entered as triggers in the promotion record, not on the metadata in the
featured resource records.)
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The example shows promotion links for community resources on the dashboard, and
library material promotion links at the top of the search results list.

For bibliographic searches, promotions may be displayed for keyword, phrase, exact,
advanced, and Boolean searches by one of the following access points (Search by): Any
field, Author, General notes, Publisher, Series, Subject, Title. Promotions are not
available for course reserve searches or browse searches. However, when the user
selects a heading in a browse search headings list, promotions are displayed along with
the titles associated with the heading. The selected heading is considered to be the
user’s search term when determining which promotions to display.

Promotions are also available for community keyword searches by one of the following
access points: Any Field, Organization Name, Event Name, Services available, Subject,
Notes. Promotions are not available for community browse searches, but when the user
selects a heading in community browse results, promotions are displayed along with the
records associated with the heading. As with bibliographic browse results, the selected
heading is considered to be the user’s search term when determining which promotions
to display.

When the user clicks a promotion for a bibliographic record, a deep link to the catalog,
or a community/event record, a search is launched for the appropriate bibliographic or
community/event record, and the record is displayed in the PowerPAC results list.
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When the user clicks a promotion link that is a URL for an external resource, a new
browser window opens.

You can enable Feature It for library materials and web resources, community profile
and event information (if licensed), or both, setting a separate display placement for
each or presenting all promotions in one merged list. In the PAC display, the library icon

 indicates bibliographic materials. The briefcase icon  indicates community
information.

For library (bibliographic) material, the list header is You might also like these library
materials and web pages. For community information, the list header is You might also
like these community resources. For a merged list, the header is You might also like.
You can edit the headers in Polaris Language Editor (WebAdmin). The language string
IDs are:

l Bibliographic materials - PACML_PACFEATURE_DASHHEAD
l Community information - PACML_CIPACFEATURE_DASHHEAD
l Merged list - PACML_FEATURE_DASHHEAD

In the staff client, use the Cataloging Promotions workform to set up promotions for
specific resources (see the Cataloging Guide). To specify how the promotions are
displayed in Polaris PowerPAC:

Note:
You can set Feature It display options at the system, library, or branch
level. The system uses the settings for the PowerPAC connection
organization.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 179

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Feature It: Screen display options. The Feature It: Screen display
options dialog box opens.

3. To set up Feature It for library materials and web resources:

a. Select Enable Feature It for library materials and web pages.This setting enables
promotion links for library materials and featured URLs when the user searches for
either bibliographic records or community information.

b. Select the promotion placement on the search results screen. You can select Dash-
board area, Beginning of search results, or End of search results.

4. To set up Feature It for community information:

a. Select Enable Feature It for community profiles. This setting enables promotion
links for community information when the user searches for either bibliographic
records or community information.

b. Select the promotion placement on the search results screen. You can select Dash-
board area, Beginning of search results, or End of search results.

Note:
Community Profiles is a separately licensed feature.

5. To display library materials and community profile information in one list:

a. Enable both options and choose the same display position for both. See steps 3
and 4.

b. Select Display library and community resources in a single merged list.
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6. If you have selected Dashboard area as the placement for an enabled Feature It
option, set the maximum number of promotion links to show in an unexpanded
dashboard list.

The maximum (and default) value is 8 promotion links. Since this list can occupy
considerable dashboard space at the top of the dashboard, forcing the user to
scroll to see search filters and related searches, you might want to set the value to
a lower number. In this case, the dashboard list displays a more link when
appropriate. The user can click more to expand the list (up to 8 links) and less to
collapse it. If you set this value to 0, the list is completely collapsed and the user
must click a plus sign to expand it.

7. Click OK.

Setting PowerPAC Narrow/Related Search Options

When a user’s search results are returned, the Polaris PowerPAC dashboard can display
two web parts related to the results. The Narrow your search web part offers facets to
filter the current search results; the Related searches web part offers links to launch
other, related searches. By default, both web parts and all their available elements are
enabled and set to an expanded initial display.

Using the PowerPAC profile Dashboards: Narrow your search & Related searches, you
can:

l offer the Narrow your search web part, the Related searches web part, or both;
l specify the elements available for each web part and set the display order;
l set the initial display to expanded or collapsed;
l set the minimum and maximum number of links for each element;
l specify your own labels for the web parts and elements and translate the labels.

Note:
This profile does not affect course reserve or community information
search results. A separate profile is available for community information
search results. See the Community Profiles Guide.

See also:

l Narrow Search Web Part
l Availability and Assigned Branch Facets in the Narrow Your Search Web Part
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l Related Searches Web Part
l Set up the Narrow your search Web part
l Set up the Related searches Web part
l Translate labels for Narrow/Related web parts (Polaris PowerPAC)

Narrow Search Web Part

The Narrow your search dashboard offers two types of facets for filtering a set of
search results: checkboxes and bulleted items. When a user selects a facet, it is placed
at the top of the list and the results set is filtered accordingly.

l Checkbox facets represent “or” filters for the results set. If you select another
facet from within the same group, it is also added to the top of the list for that
facet type. The filtered results set grows to include results that match the first
selected facet or the second selected facet. When you select facets from different
checkbox groups, the filtered results set is restricted to results that match the
selected facet in one group and the selected facet in the other group.

Note:
Checkbox facets are not necessarily mutually exclusive. For Type of
Material, each title is included in the count for all facets that apply to it.
For example, a large print book appears in the counts for both the
Book and Large Print facets. As another example, Musical sound
recording is a subset of Sound recording. If you select the Musical sound
recording facet, the count for Sound recording may go down.
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l Bulleted facets represent “and” filters for the results set. When you select a bullet
facet, it is also placed at the top of its list. The filtered results set is now restricted
to results that match any already selected facet and the selected bullet facet.
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The following elements are available for narrowing search results:

l Related words - See Setting PowerPAC Narrow/Related Search Options for inform-
ation about this element.

l Availability - See Availability and Assigned Branch Facets in the Narrow Your
Search Web Part for information about this element.

l Database - See Develop the remote targets display for PAC for information about
setting up remote databases for searching.

l Type of Material - See Setting Up Search Filters (Limit By) for detailed information
about this filter.

l Target Audience
l Publication Date
l Subjects
l Authors
l Series
l Popularity - Divides the results set into three roughly equal-sized groups. Records

with the highest popularity index are placed in the high group, those with the low-
est popularity index are placed in the Low group, and the others are placed in the
Medium group. The popularity index rank associated with each bibliographic
record is based on sorting all the bibliographic records in the database by the
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following characteristics, listed in descending order of significance: (1) number of
hold requests plus the number of check-outs in the last 120 days; (2) number of
check-outs in the last 120 days; (3) lifetime circulation count; (4) in-house use
count; (5) record creation date.

l Language
l Assigned Branch
l Record Owner
l Literary Form
l Reading Level - The Reading Level facet allows filtering based on reading level

ranges from the MARC bibliographic record 521 tag. The reading level for a title is
derived from the 521 $a. The first indicator must be 8. The second indicator is
undefined (#). The 521 $b should indicate the reading level type. When multiple
521 tags exist in the bibliographic record, all tags that meet these criteria are con-
sidered. The system normalizes the data from the 521 tag and displays facets for
reading level ranges. For example, a 521 $a value of "1150" is included in the
"1100-1195" range facet.

Record counts are included for each filter offered on the Narrow your search dashboard
element. The counts are recomputed by the Keyword Processing SQL job, which runs
nightly by default.

Availability and Assigned Branch Facets in the Narrow Your Search Web Part

You can display an Availability facet under the Narrow Your Search dashboard. Used in
conjunction with the Assigned Branch facet, your patrons can filter their search results
to identify items that are available anywhere or at specific branches. Item availability for
most titles is updated in real time. The Assigned Branch facet consults the system
administration Item Availability Display Order policy table for the connection branch to
show local libraries first in the list of assigned branches, making it simple for patrons to
find available titles that are nearby.

Libraries that have "availability" or "assigned branch" limits configured for the Limit By
search drop-down list, see Setting PowerPAC Narrow/Related Search Options, might
want to consider using the Availability and Assigned Branch facets instead. The
Availability facet works much like the “availability” Limit By feature, but PowerPAC users
can combine the facet with multiple assigned branches to retrieve a narrow or wide
range of available titles from their search results.
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Libraries whose branches all connect at the system level can take advantage of the new
Availability facet since both local and system organizations (as defined in the Item
Availability Display Order table) are included in the Availability facet results. For more
information about the Item Availability Display Order table, see Setting Up Local and
System Availability.

When you enable the facet, an Available now checkbox is displayed in the Narrow Your
Search dashboard for search results. The Available now line also displays the number
of titles that will be in the search results list if Available now is selected.

Libraries listed under the Assigned Branch facet are divided into two categories: Local
and Other. Local lists those branches defined as local in the Item Availability Display
Order policy table for the connection branch. Other lists those branches defined as
system in the Item Availability Display Order policy table. You can edit the Local and
Other labels in Polaris WebAdmin; the string mnemonics are PACML_DASHBOARD_
LOCAL and PACML_DASHBOARD_OTHER.

A branch appears in the Assigned Branch list only if it has at least one item on at least
one title in the search results. Within each category, organizations are listed in
descending order by the number of titles that will be retrieved if the facet is selected.
The connection branch appears at the top of the local list. An icon indicates the
connection branch. See the example below.
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If the assigned branch in an item record is changed, the change is reflected in the
results the next time a search is done.

The Assigned Branch facet uses the Minimum to Show and Maximum to Show settings
in the PowerPAC profile Dashboards: Narrow your search & Related searches. The
settings are applied to the list as a whole, regardless of where the local/other cut-off
point may occur for any given set of search results. The system limit on the number of
entries for the web part is 99.

A title is available for a connection branch when these conditions are met:

l Display in PAC is selected in the bib record, and either:
o There is at least one linked item record where the item record status is Final,

and
o The item circulation status is In, and
o The assigned branch is in the Item Availability Display Order policy table for

the connection branch, and
o Display in PAC is selected in the item record, and
o The item's circulation status is not selected in the PAC profile Suppress Item

Display for the connection branch (for example, shelving or non-circulating).
l Or Display in PAC is selected in the bib record, there is an issue record, the issue is

not linked to an item, and the issue is linked to a subscription Serial Holdings
record and is retained.

Note:
Bib records that do not typically have linked item records (for example,
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titles from remote databases, non-integrated eContent titles, digital
collections, and cataloged web sites) have an availability count of 0, and
are not included in the filtered search results list when Available Now is
selected.

Note:
For integrated eContent, the availability results reflect the status of the
Polaris eContent item records and are accurate unless a checkout or
checkin has taken place in the last few minutes.

When the patron selects Available now, but does not select an Assigned Branch facet,
the search results list is filtered to display the titles that meet the requirements for
displaying in PAC and have at least one item record that is “available” at a branch listed
in the organization’s Item Availability Display Order table. Bib records that do not meet
those requirements are no longer in the search results list. The Assigned Branch facet
lists only organizations that have at least one item record that is available at a branch
listed in the organization's Item Availability Display Order table. The assigned branch
facet count for an organization is the number of titles that will be in the search results
list if that assigned branch facet is selected.

If the patron selects both Available Now and an Assigned Branch facet, the search
results list is filtered to display only the titles that meet all current requirements for
displaying in PAC and have at least one item record that is available at the selected
assigned branch. The Assigned Branch facet count on the remaining assigned branch
facets includes a plus sign and the number of records that will be added to the search
results list if the patron selects the branch facet.

When the Availability facet is combined with another dashboard facet, each title in the
results list matches both facet selections. When the Availability facet is combined with
a CQL filter from the Limit By drop-down list, each title in the results list matches both
the CQL filter and the availability facet. When the availability facet is combined with title-
level More Search Options (Publication Dates, Target Audiences, Languages), each title
in the results list matches both the selected options and the availability facet. When the
availability facet is combined with item-level More Search Options (Libraries, Detailed
Material Types, Collections), each title in the results list matches the selected item-level
search options and the selected facets, but the selected options and facets are not
necessarily on the same item record.

Once Available now is selected, it remains selected if the user navigates to the full
display for a title or logs in to place a request, then returns to the search results. The
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facet checkbox is cleared when a new search is launched, the PAC times out, the user
clicks Reset after setting More Search Options, or the user logs in from the My Account
menu.

Related Searches Web Part

The Related searches web part is displayed below the Narrow your search web part in
the dashboard. When the user selects an element in this web part, a new search for the
same search text is launched. Depending on the element, the new search may be a
browse search for a heading in a specified index (Subject, Author, or Series), a keyword
search in a specified field (Other searches), or a keyword search in a different (Z39.50)
database (Other databases). The Other databases element lists the databases you
specified for the Using box in the top area of the search page (see Develop the remote
targets display for PAC).

Note:
The Related browse search options (Subject, Author, or Series) are not
displayed when remote databases have been selected.
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Set up the Narrow your search web part

To set up the Narrow your search web part, which provides elements to filter a PAC
search results set:

Note:
You save your settings separately for the Narrow your search and
Related web parts, and they are inherited separately. For example, your
branch may set its own elements for the Narrow part, but inherit the
system settings for the Related Web part. Once you change the settings at
the branch level, the branch no longer inherits the system settings.
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Dashboards: Narrow your search & related searches. The dialog box
opens to the Narrow Your Search tabbed page.

Settings on this tabbed page control whether the Narrow your search web
part is displayed, and what elements will be available for filtering search
results. If at least one element is set to display (set to Yes), the Narrow your
search web part label can be displayed in the dashboard.

3. To modify the display of a Narrow element, select the element and click Modify
Dashboard Element. The Modify Search Dashboard Element (Narrow) dialog box
appears.

4. To display the element in the Narrow your search web part, select Display the ele-
ment.
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5. To display the element’s links when the search results page appears, select Show
initially expanded. By default, all elements are set to display as initially expanded.

Note:
To minimize the need to scroll the PAC search results page, you
may want to consider displaying some or all elements as initially
unexpanded. The patron can choose to expand any element that is
unexpanded.

6. To change the minimum and maximum number of links that can be displayed for
the element, select or type the numbers in the Minimum to show and Maximum to
show boxes. The default values are 5 minimum, 25 maximum.

Important:
The maximum number of links that can be displayed for one
element is 99. However, higher numbers of links can slow
processing time and may not be particularly useful to patrons, since
the list of links for an element may be quite long for certain
searches.

Note:
Reading Level: There are 15 possible reading levels. Typically you
would leave the Minimum to Display setting at 15 to display all
possible ranges if they exist in the search results, and leave the
Maximum to Display setting at 25.

7. If you want to change the default English label for the element, type the text in the
Label box. The maximum number of characters is 50.

8. Click OK. The Modify Search Dashboard Element (Narrow) dialog box closes.
9. To change the order in which elements are displayed, select each element and

click the up or down arrow until these elements are listed in the order you want
them.

Note:
Elements toward the top of the list are displayed before elements
lower in the list. The web part label is always displayed at the top of
the list, before the individual elements.
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Tip:
If you have enabled the Availability facet, consider positioning the
Assigned Branch facet immediately under the Availability facet. See
Availability and Assigned Branch Facets in the Narrow Your Search
Web Part.

10. Select Save to save your settings on the Narrow Your Search tabbed page.

Note:
A message alerts you if you have set DASHBOARD to be displayed
without setting elements to be displayed. At least one element
within the web part must be set for display in order to display the
web part itself.

Your changes are immediately applied to the Polaris database, but you need
to clear the page cache. See Updating Page Caches.

Note:
Because the Narrow your search Web part may be quite long, the
Related Web part may not be visible in the interface without
scrolling. If you want to be sure that patrons see the Related Web
part without scrolling, you will need to limit the elements you enable
for the Narrow your search Web part, or set at least some of the
elements to be displayed as initially unexpanded.

Related Information

l Set up the Related searches Web part
l Translate labels for Narrow/Related Web parts (Polaris PowerPAC)
l Setting up other dashboard features - See Defining Web Parts for Dashboards.

Set up the Related searches web part

To set up the Related searches web part, which provides elements to launch new
searches related to a PowerPAC search results set:

Note:
You save your settings separately for the Narrow your search and Related
searches web parts, and they are inherited separately. For example, your
branch may set its own elements for the Narrow your search web part,
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but inherit the system settings for the Related searches web part. Like
other Polaris Administration settings, once you change the settings at the
branch level, the branch no longer inherits the system settings.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Dashboards: Narrow your search & Related searches. The dialog box
opens to the Narrow Your Search tabbed page.

3. Click the Related Searches tab.

Settings on this tabbed page control whether the Related searches Web part is
displayed, and what elements will be available for filtering search results.

4. To modify the display of a Related element, select the element and click Modify
Dashboard Element. The Modify Search Dashboard Element (Related) dialog box
appears.

5. To display the element in the Related searches Web part, select Display the ele-
ment.

Tip:
To minimize the need to scroll the PAC search results page, you may want
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to consider displaying some or all elements as initially unexpanded. The
patron can choose to expand any element that is unexpanded.

6. To display the element’s links when the search results page appears, select Show
initially expanded. By default, all elements are set to display as initially expanded.

7. To change the minimum and maximum number of links that can be displayed for
the element, select or type the numbers in the Minimum to show and Maximum to
show boxes. The default values are 5 minimum, 25 maximum.

Important:
The maximum number of links that can be displayed for one element is
99. However, higher numbers of links can slow processing time and may
not be particularly useful to patrons, since the list of links for an element
may be quite long for certain searches.

8. If you want to change the default English label for the element, type the text in the
Label box. The maximum number of characters is 50.

9. Click OK. The Modify Search Dashboard Element (Related) dialog box closes.
10. To change the order in which elements are displayed, select each element and

click the up or down arrow until these elements are listed in the order you want
them.

Note:
Elements toward the top of the list are displayed before elements lower in
the list. The web part label is always displayed at the top of the list, before
the individual elements.

11. Click the Save icon to save your settings on the Related Searches tabbed page.

Note:
A message alerts you if you have set DASHBOARD to be displayed but
have not set any elements to be displayed. At least one element within the
web part must be set for display in order to display the web part itself.

Your changes are immediately applied to the Polaris database, but you need to clear the
page cache. See Updating Page Caches.

Note:
Because the Narrow your search Web part may be quite long, the Related
searches web part may not be visible in the interface without scrolling. If
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you want to be sure that patrons see the Related searches web part
without scrolling, you will need to limit the elements you enable for the
Narrow your search web part, or set some or all of the elements to be
displayed as initially unexpanded.

Related Information

l Set up the Narrow your search Web part
l Translate labels for Narrow/Related Web parts (Polaris PowerPAC)
l Setting up other dashboard features - See Defining Web Parts for Dashboards.

Translate labels for Narrow/Related web parts (Polaris PowerPAC)

If your library system has purchased other language versions of Polaris PowerPAC, you
can translate the labels for the Narrow your search and Related searches web parts and
the labels for the elements displayed under them. To translate the labels:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Dashboards: Narrow your search & Related searches. The dialog box
opens to the Narrow Your Search tabbed page.

3. Click the appropriate tab (Narrow Your Search or Related Searches) for the labels
you want to translate. See Set up the Narrow your search web part or Set up the
Related searches web part.

4. Select the appropriate data element, and click Translate Label. The Language
Strings dialog box opens.

5. Select a language from the Choose Language list. The options are determined by
the language versions of Polaris PowerPAC purchased by your library system.
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6. Double-click the box in the Display Text column next to the label name you want to
translate, and type the translated text in the box. The maximum number of char-
acters is 50.

7. To insert a diacritic character, follow these steps:

a. Click Diacritics. The Character Picker dialog box opens.

b. Select a graphic character set.
c. Select the character, and click Insert. The Character Picker dialog box closes.

8. Click OK on the Language Strings dialog box.
9. Click the Save icon on the Dashboards: Narrow your search & Related searches

dialog box to save your settings on the current tabbed page.

Your changes are immediately applied to the Polaris database, but you need to clear the
page cache. See Updating Page Caches.

Suppressing Request and Availability Options

Typical Polaris PowerPAC and Mobile PAC search results include title-level options for
placing requests and viewing availability information. However, you may want to
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suppress the ability to place requests and view availability for titles that do not have
linked items in the Polaris database and have a specific primary system-defined type of
material.

For both PowerPAC and Mobile PAC, you can suppress the ability to place requests and
view availability information for bibliographic records with the primary system-defined
types of material (TOMs) that you specify. For example, you can suppress these
features for materials where the item is not physically in the library, either because it is
eContent that is available only in downloadable form from another site, or because it is
in an external storage device from companies such as Libramation’s MediaBank or
redbox®.

This PAC profile does not apply to EContent that is integrated with Polaris because in
this case, item records are attached to the bibliographic record and the availability
information is updated by the vendor. You can opt to suppress the display of integrated
eContent titles using the PAC profile, Item availability: Suppress for integrated
econtent titles.

The ability to place requests and view availability information in PAC is suppressed
under these conditions:

l The title’s primary TOM is checked in the PAC profile Suppress Availability and
Requests

l At least one 856$u or resource entity is present in the bib record (if you have selec-
ted Records with an 856 for that TOM)

l The system availability count = 0, which means that there are no linked item
records, the linked item records all have Display in PAC set to No, or the linked
item records all have circulation statuses that are set for suppression from the dis-
play in the PAC profile Suppress item display.

Tip:
If a bibliographic record has linked issue records (via the serial holdings
record) but no linked item records, the issue records are factored into the
availability count, so availability information is not suppressed in this
case.

l The title is for integrated eContent and the PAC profile Item availability: Suppress
for integrated econtent titles is set to Yes. See Suppress EContent availability dis-
play in PAC.
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If these conditions are met, the following elements are suppressed from the results
displays in PowerPAC (local and remote databases) and Mobile PAC:

l Item availability fields in the brief and full title displays
l Local Availability Summary
l System Availability Summary
l # Local items
l # System items
l # Local items in
l # System items in
l PowerPAC Availability button at the title level
l Mobile PAC Find It button at the title level
l PowerPAC Place Request button and Mobile PAC Request It button at the title

level

To suppress request and availability options for designated types of material from the
PowerPAC and Mobile PAC search results display:

Note:
You can make these settings at the system, library, or branch level. The
setting of the PAC connection organization determines the effect on
Polaris PowerPAC and Mobile PAC. These settings do not affect the staff
client. They can lessen patrons’ confusion about how to access and
obtain certain material types, but they do not prevent a staff client user
from placing a hold on one of the suppressed types of material.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PAC tab in the details view.

2. Double-click Suppress availability and requests. The Suppress Availability and
Requests dialog box opens.
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Note:
The list is ordered by the three-character alphabetic code that represents
the TOM (Type of Material). The descriptions are the Polaris default
descriptions, not the custom display descriptions you may have defined in
the PAC Limit by Display policy table.

3. Select the TOM code and choose one of the following options:

l Records with an 856 - Suppress request and availability options for records with
this TOM if there is an 856$u tag or resource entity. Note that this setting affects
only records with an 856$u tag.

l All records - Suppress request and availability options for all records with this
TOM.

Important:
If All records is selected for any given type of material, records of that
type that do not have 856$u tags will appear in the catalog but there will
be no way for the user to request the resource or view availability. This is
likely acceptable for Polaris Fusion resources (TOM=dmc), which typically
do not have 856$u tags and are accessed by clicking a thumbnail image,
but may be a problem for other types of material. The All records setting
should be used with caution.
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l Do not suppress - Request and availability options are displayed in search results
for this type of material.

4. Repeat step 3 for each TOM for which you want to change the display setting.
5. Click OK.

Cross-Reference Display in Browse Search Results

You specify the labels that identify cross-references in Polaris PowerPAC browse search
results. Typical cross-reference labels are See and See Also. However, you can specify
any text for cross-reference labels.

You edit cross-reference labels in the Cross Reference Display Constants policy table, at
the system, library, or branch level. Settings from the parent organization are used for
the libraries or branches unless you change them at the lower level. The organization
level at which the Cross Reference Display Constants table is opened determines the
entries you see in the list, and you can view and change entries for the selected
organization only. This table can be displayed on an organization workform or with the
Administration Explorer.

Note:
These System Administration permissions are required to modify this
table: Access administration: Allow, Access tables: Allow, Modify cross
reference display constants table: Allow.
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To edit the labels that identify cross-references:

Note:
The cross-reference structure is set up when Polaris is implemented. You
cannot add entries to this table or delete entries from it, only modify the
text for the cross-reference labels.

1. In the Administration Explorer tree view, open the Policy Tables folder for the
organization, and select Cross Reference Display Constants. The Cross-reference
Display Constants table is displayed in the details view.

Note:

The table may be blank at the library or branch level. Click  to copy the
entries from a higher level into the table for editing.

2. To modify an entry, select the entry and click . The Modify Cross Reference
Display Constants dialog box appears. You can change only the Description text
for an existing entry. You cannot delete an entry.

3. Click OK on the dialog box.
4. Select File > Save to save any changes.

Related Information

l Action when a cross-reference is selected - The PowerPAC profile Perform a new
search if a cross-reference is selected controls what happens when a cross-ref-
erence is selected. When this profile is set to Yes and a cross-reference is selec-
ted in the PAC browse headings index, the display is reset to the new location in
the browse headings index. When this profile is set to No and a cross-reference is
selected, the browse headings index remains at the same location, but the titles
associated with the cross-reference are displayed.

l Text in Titles column for “See” references - The PowerPAC profile Text: Headings
count column for “See From” headings sets the characters that are displayed
instead of a title count for a “See” cross-reference entry when no titles are asso-
ciated with a heading. The default characters are hyphens --, but you can specify
any characters.
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Setting Up Local and System Availability

When a user searches for and selects a title in the PAC, he or she can see detailed
holdings information about the items associated with the title. Polaris Administration
settings control the availability display in the PAC: whether all the system holdings are
displayed in one list, or separated into local and system views; which branches are
defined as “local,” the order of branch holdings; and the specific information that is
displayed about each item.

Entries in the Item Availability Display Order policy table, combined with the Display
local and system levels PowerPAC profile, create the following availability displays in
Polaris PowerPAC:

l Item Availability: Display local and system levels profile set to No - Only the
entries designated as System are displayed. Put the same list of libraries under
both Local and System in the Item Availability Display Order policy table to gen-
erate local availability counts and facets.

l Item Availability: Display local and system levels profile set to Yes - The Local
Availability view initially displays items for the branches designated as Local in the
Item Availability Display Order policy table. The user clicks or taps a link to see
branches designated as System in the table.

Note:
The Assigned Branch box in the item record determines the branch for
which an item is displayed in the Availability view. If the item is not
assigned to a branch, the item is not listed in any PAC availability display.
Also, if the Display in PAC box is not checked in the item record, or the
item has a circulation status that is suppressed from display, the item is
not listed in any PAC availability display.

To set up the item availability display in the PAC:

Note:
These settings control how information about specific items is displayed
in Polaris PowerPAC, and Mobile PAC where noted. Use the PowerPAC
profile Title display configure to specify the information that should be
included in brief and expanded title information, which bibliographic-level
title information should be displayed, and the labels for the information.
See Configuring the PowerPAC Title Display.
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click the profile Item Availability: Display local and system levels, and
select one of the following options:

l Yes - In Polaris PowerPAC, when a patron is connected to a branch, items for the
branches defined as local for that branch are displayed and the patron can click or
tap a link to see branches defined as system. When the patron is connected to the
system organization, all branches’ items are displayed in one list.

l No - Shows only entries designated as system. In this case, put the same list of lib-
raries under both Local and System in the Item Availability Display Order policy
table to generate local availability counts and facets.

3. Set the following additional PowerPAC profiles for the PowerPAC display:

l Item Availability: Display last circ date - Set to Yes to display the last circulation
date of the item.

l Item Availability: Display notes - Set to Text to display any item or issue public
notes as text, set to Icon to display an icon that the user clicks or taps to see the
notes, or set to Do not display to suppress item or issue public notes from display.

Note:
For a serials public note to display in PAC, at least one issue or issue with
a linked item must be added to a serials holdings record. If no issues
exist, you can generate a “dummy” issue so the note will display. See the
Serials Guide.

l Item Availability: Display textual holdings notes - Set to Text to display serials tex-
tual holdings notes as text, set to Icon to display an icon that the user clicks or
taps to see the notes, or set to Do not display to suppress textual holdings notes
from display.

4. Set the following PAC profiles to Yes or No to specify what information about each
item should be displayed. These settings also affect Mobile PAC:

l Item Availability: Display detailed item status - Set to Yes to display the specific
item circulation status of unavailable items, such as Lost or Bindery. Set to No to
display No items available or your own text for items that are unavailable for cir-
culation for any reason. (You must also set Item Availability: Display status to
Yes.) This setting also affects Mobile PAC.
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Note:
If you set this profile to No, you can customize the text that is displayed to
indicate that an item is unavailable. See Editing Messages and Labels.

l Item Availability: Display due date in detailed item status - If you set Item Avail-
ability: Display detailed item status to Yes , you can set this parameter to display
or suppress the item’s due date. (If you set Item Availability: Display detailed item
status to No, you cannot display the due date.) This setting also affects Mobile
PAC.

l Item Availability: Display shelf location - Set to Yes to display an item’s shelf loc-
ation. For more information, see Naming Shelf Locations. This setting also affects
Mobile PAC.

l Item Availability: Display status - Set to Yes to display an item’s availability status.
If you set this to Yes, also review the setting for Item Availability: Display detailed
item status. This setting also affects Mobile PAC.

l Item Availability: Display type - Set to Yes to display the item’s material type. This
setting also affects Mobile PAC.

5. In the Administration Explorer tree view, open the Policy Tables folder for the
organization, and select Item Availability Display Order.

Note:
These System Administration permissions are required to modify this
table: Access administration: Allow, Access tables: Allow, Modify item
availability display order table: Allow. The organization level at which the
table is opened determines the entries you see in the list.

The Item Availability Display Order table appears in the details view.
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6. Click  to display the Insert Item Availability Display Order dialog box.

7. In the Organization box, select the organization for which the item availability entry
is being set up. The new entry will affect the PAC item availability display for this
organization.

Note:
If the Item Availability Display Order table is opened at the branch level,
only the branch name is displayed in the Organization list.

8. In the Branch Location box, select the organization whose holdings you want to
display in the PAC for the Organization branch.

Tip:
If you want a branch to display in both the Local and System Availability
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views, add it to the table twice, designating it as Local for one entry and
System for the other.

9. Specify whether the item holdings for the organization named in the Branch Loca-
tion box are displayed in the Local or System Availability view of the PAC for the
Organization branch:

l To display the Branch Location item holdings as local holdings, select Local in the
Level box.

l To display the Branch Location item holdings as system holdings, select System in
the Level box.

Note:
If you set the PAC profile Item Availability: Display local and system
levels to Yes, entries designated as Local are displayed in the Local
Availability view, and entries designated as System are displayed when
the user clicks the link to see all items. If you set the profile to No, only the
entries designated as System are displayed; in this case, put the same list
of libraries under both Local and System in the Item Availability Display
Order table to generate local availability counts and facets.

10. Click OK on the dialog box. The Item Availability Display Order dialog box closes.
The new item availability display entry is displayed at the end of the policy table.

11. Position the item holdings in the availability display for the organization by fol-
lowing these steps:

a. Select (highlight) the branch location entry for which you want to change the dis-
played order.

b. To move the branch entry’s holdings higher on the list, click .

c. To move the branch entry’s holdings lower on the list, click .

The Sorting Order value changes for the entry as you position the entry.

12. Select File > Save.

Related Information

l Modify an entry in the Item Availability Display Order policy table - Select the entry

and click .You can change only the Highlight setting for an existing entry. If you
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need to change the entry in another way, delete the incorrect entry and create a
new entry.

l Delete an entry in the Item Availability Display Order policy table - Select the entry

and click . If you delete an entry in the middle of the sort order, the remaining
entries are automatically reordered.

l Item availability display in Polaris PowerPAC - You can set the default item avail-
ability display for a branch or collection to expanded or closed, and make separate
settings for non-serial and serial holdings. (Patrons can always select branch and
collection controls to expand or close the list of items under each branch and col-
lection.) To set the default display to expanded branch and collection lists for non-
serial holdings, set the PowerPAC profile Item Availability: Expand non-serial
titles to Yes. To set the default display to closed branch and collection lists, set
the profile to No. To set the default display to expanded lists for serial holdings
(those with a holdings statement for that particular branch), set the PowerPAC pro-
file Item Availability: Expand serial titles to Yes. To set the default display to
closed branch and collection lists, set the profile to No. (If you have extensive
serial holdings, consider setting this profile to No to reduce scrolling in the PAC.
Patrons can expand the lists they want to see at any time.)

l Item Availability display in Mobile PAC - See Title Link: Find It.
l Text-message call numbers from item availability display - See Sending Call Num-

bers by Text Message.
l Item availability summary in Polaris PowerPAC - You can display a summary count

of available items associated with a title, and the current number of holds on the
title, on the initial search results pages. See Configuring the PowerPAC Title Dis-
play.

l Item display and circulation status - You can specify item circulation statuses that
should prevent an item from being displayed in PAC search results. See Suppress
items by circulation status.

l Suppressing availability for specific types of material - You can suppress avail-
ability information for designated types of material from the PowerPAC and
Mobile PAC search results displays. See Suppressing Request and Availability
Options.

l Serials display in PAC availability views - Settings in the serial holdings record con-
trol the location-specific compressed holdings statement and the issues that are
displayed. See the Serials Guide.
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Sending Call Numbers by Text Message

From the Polaris PowerPAC or Mobile PAC item availability display, a user can send an
email text message containing the item call number to his or her mobile phone via the
mobile phone carrier’s SMTP email service. If you enable this feature, a Text It icon

 appears next to each item in the Availability display for a title.

The illustration shows the Text It icon in the Availability view in Polaris PowerPAC brief
search results.

In Polaris PowerPAC, the icon is displayed in the Availability view when the view is
accessed from the brief search results and from the title product page. When the user
clicks the Text It icon, a window opens. (For details about the Mobile PAC interface, see
Text It in Mobile PAC.)
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If the user is logged in and the patron record includes a phone number designated for
TXT notification, the Mobile phone number and Carrier fields are already filled in. If the
user is not logged in, or is logged in but does not have a phone number designated for
TXT notification in the patron record, the user enters the mobile phone number and
selects a carrier from the list. (The carrier options are set in the system-level database
table Mobile Phone Carriers.) When the patron clicks Send, the text message is sent to
the patron’s mobile phone.

To display the Text It icon in Polaris PowerPAC and Mobile PAC, set the PowerPAC
profile Item availability: “Text it” feature enabled to Yes (the default setting). The
profile is available at the system, library, and branch levels.

In addition, the current connection organization must have specified the email server in
the PAC profile Email notification: Server running SMTP service. The “from” field of the
message is taken from the PAC profile Email notification: email address of sender for
the current connection organization. If no address has been specified in that profile, the
“from” field is taken from the system-level parameter setting for the return email
address in Notification options. (If no address is available from these settings, the Text
It icon is not displayed.) The subject of the message is the first 30 characters of the
title. The body of the message includes the branch display name and the call number
and designation (if present).
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Due to common carrier limitations, the entire message must not exceed 160 characters.
If the message is longer, certain fields are automatically eliminated in the following
order:

l Branch display name
l Designation
l If the branch display name and designation have been eliminated and the total still

exceeds 160 characters, characters are removed from the end of the call number
field until a total of 156 characters is reached. Then the system adds a space and
an ellipsis to the end of the call number.

The patron does not receive notification if the delivery fails, and Polaris does not record
the failure.

Text It Report

A report, PAC Text It Use, is available in Polaris SimplyReports on the Patron tab, Patron
Statistical Reports sub-tab. The report includes an activity summary, the number of in-
house transactions, and the number of outside transactions. In-house transactions are
those from workstations that are identified as in-house for the selected transacting
organizations in the In-House IP Addresses database table. Standard SimplyReports
parameters, filters, and formats for patron statistical reports are available for the report.
For more information, see online Help in SimplyReports.

Suppressing Items from Search Results

To be included in item counts and displayed in search results, Display in PAC must be
checked in the item record, and the item record status must not be provisional or
deleted. Serial issues are included in the counts if Display in PAC is checked in the
linked serial holdings record and the issues are retained (see the Serials Guide). In
addition, you can use the PAC profile Suppress item display to specify item circulation
statuses that should prevent an item from being displayed in both Polaris PowerPAC
and Mobile PAC search results. When a circulation status is selected, items with this
status are not displayed in PAC even when Display in PAC is checked in the item record.
You can set this profile at the system, library, or branch level.

To suppress items with specific circulation statuses from appearing in Polaris
PowerPAC and Mobile PAC search results:
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

Tip:
For any particular item, the system uses the setting for the item’s
assigned branch to determine whether the item should be included in the
search results display.

2. Double-click Suppress item display. The Suppress Item Display dialog box opens.
3. Select the circulation statuses that should prevent an item from being displayed in

PAC search results.
4. Click OK.

Your changes will not be evident in the PAC until the SQL job PAC
Availability adjusts the counts. This job ordinarily runs automatically during
overnight processing.

Naming Shelf Locations

If the PAC profile Item Availability: Display shelf location is set to Yes, the Availability
view in the PAC displays the shelf location of an item, as specified by the setting in the
Shelf Location box on the Item Record workform. Each branch can have its own shelf
location descriptions. Typically, shelf locations are names of the various areas where
items are currently shelved, such as the New Books Shelf, the Display Case, or the Atlas
Stand.

Note:
You can also define collections in Polaris. For example, a branch may
have collections named Genealogy, Non-Fiction, Children, and Reference.
Any collection you define can be shown, along with call number and shelf
location, in the Availability view in the PAC. Shelf locations are not related
to collections, and you do not need to define collections to use shelf
locations.

Entries in the Shelf Locations database table determine the branch’s shelf location
options in an item record. You can open the table from the system, library, and branch
levels, but entries are branch-specific. Shelf locations are not inherited or shared from
the parent organizations. If you open the table at the system level, you can view, add,
and change shelf locations for any branch. If the table is opened at the library level, you
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can view, add, or change shelf locations for the branches in the selected library. If the
table is opened at the branch level, you can view, add, or change entries for the specific
branch.

Note:
These System Administration permissions are required to modify this
table: Access administration: Allow, Access tables: Allow, Modify shelf
locations table: Allow.

To define shelf location options for an organization’s item records:

1. In the Administration Explorer tree view, open the Database Tables folder for the
organization, and select Shelf Locations. The Shelf Locations table appears in the
details view.

Note:
To better manage memory, a program-defined row limit determines
whether this table can be opened at a specific organizational level. For
example, if the table is opened at the system level and would require more
than the limit (comprising entries from all branches) to be loaded, you will
see a message advising you to open the table at a lower organizational
level.

2. Click to display the Shelf Locations dialog box.
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3. Select the branch that needs the shelf location in the Organization list.

Note:
If the Shelf Locations policy table is opened at the branch level, only that
branch name is displayed in the Organization list.

4. Type the shelf location in the Description box, and click OK. The new entry is dis-
played in the Shelf Locations database table for the selected branch. Modification
pending appears in the status bar.

5. Repeat steps 2-4 until you have listed all shelf locations for the branch.
6. Select File > Save.

Related Information

l

Modify a table entry - Select the entry and click . You can change only the
description for an existing shelf location entry. Your changes should be limited to
correcting spelling unless the location name has changed; for example, the Chil-
dren’s Reading Room officially becomes the Young Readers’ Center.

Important:
Changes to a shelf location description are applied to all item records that
used the original description of the entry.

l

Delete an entry - Select the entry and click .

Important:
You cannot delete a shelf location description if it is used by any item
record in Polaris. Use the Bulk Change tool on the Record Set workform to
change the shelf location on item records that use the entry, so you can
delete the entry.
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Highlighting Titles with Local Items (PowerPAC)

In Polaris PowerPAC search results, you can choose to highlight titles that have at least
one local item. The items considered to be local are based on the connection
organization’s settings in the Item Availability Display Order policy table (see Set up the
local/system item availability display). This setting can help patrons quickly see the
titles with locally owned items.

Note:
If the connection organization is the system, or if only one local library or
branch is defined as a connection organization, no titles are highlighted

Use the PowerPAC profile Highlight local items in matching title view to control
whether these titles are highlighted. The profile is available at the system, library, and
branch levels. To highlight local items, set the profile to Yes. The default setting is No
(do not highlight).
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Map It (Google Maps) in PAC

Using the JavaScript interface provided by Google Maps™, Polaris PowerPAC and
Mobile PAC offer a Map It feature that provides a visual guide to the location of items
linked to titles in the patron’s search results list. The Map It feature offers all the zoom,
pan, satellite and map imagery available on Google’s hosted mapping site.

Note:
If the PAC browser session is run directly on the PAC server, the following
domain must be open for Google Maps to work properly:
Port 80: maps.google.com

When the patron clicks or taps Map It in the title product page (full display), a map
displays bubble markers for branch locations that have linked items.

Note:
For a description of the Map It display in Mobile PAC, see Title Link: Map
It.
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On a desktop computer, the patron can place the cursor over a marker bubble to see the
branch name.

Click or tap the branch marker to see the branch’s address and hours.

When you click or tap Get Directions in the hours window, you can get directions to the
branch from any address. You enter the address and click or tap Go!. (If the patron is
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logged in, the primary address from the patron record is already filled in for
convenience, but it can be changed.)

Note:
No separate fees are required to enable Map It in Polaris PowerPAC,
either by Google or Innovative Interfaces. However, to comply with
Google’s terms of free use, the mapping feature must be accessible on
the public Internet to any user; no private Intranet use is allowed without
paying Google for the service. Also, public users of the service must not
be charged any fee to use it. For details, see
http://code.google.com/apis/maps/terms.html

For general information about Map It, see:

l PowerPAC Map It Option Display
l Marker Display
l Hours Display

For instructions on setting up Map It, see:

l Set up Map It for PowerPAC and/or Mobile PAC

PowerPAC Map It Option Display

The Map It drawer is displayed for any title in a results set whose # system items count
in the PAC brief display is greater than 0. For more information about # system items,
see Configuring the PowerPAC Title Display. The Map It button does not appear for any
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title whose # system items is 0, even when Google Maps is enabled for the connection
organization.

The PAC profile Suppress availability and requests also controls whether the Map It
drawer appears. If the bibliographic record meets the criteria for suppression as
specified in this profile, the Map It option does not appear. For more information about
these settings, see Suppressing Request and Availability Options.

Marker Display

The map displays markers for every branch that has at least one item for that title (that
is, # local items is greater than 0). Default markers for branches that have items that are
currently in are orange and display the number of copies in, while blue markers indicate
branches that have no copies currently in. “In” is defined using the same rules that
govern the # local items in count in the PAC brief display (see Configuring the
PowerPAC Title Display). Non-circulating items are included in the availability counts, so
an orange marker does not necessarily mean that an item can circulate outside the
library. A text key explains the meaning of the markers.

You can edit the explanatory text and the label on the Map It “drawer” itself with Polaris
Language Editor (WebAdmin). Polaris provides a set of stock marker images in
/Themes/Shared/Map/Pins/, so you can specify different marker shapes and colors.

Hours Display

When the patron clicks a map marker, details about the availability counts at that branch
as well as address, phone, and hours open that day are listed. The details window uses
the settings for the Polaris PowerPAC Hours page. For details, see Set Polaris
PowerPAC features on the menu bar.

Set up Map It for PowerPAC and/or Mobile PAC

Map It is a feature that uses Google Maps provides a visual guide to the location of
items linked to titles in the patron’s search results list. To set up Map It for Polaris
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PowerPAC and/or Mobile PAC:

1. Find and copy or record the geographic coordinates for each branch that should
appear on the map.

2. Enter the geographic coordinates in Polaris Administration by following these
steps:

a. In the Administration Explorer, select the system-level database table Geographic
Coordinates. The table is displayed in the details view of the Explorer.

Note:
You need the System Administration permission Modify geographic
coordinates table: Allow to edit this table.

b. To add an organization to the table, click . The Insert dialog box opens.

c. Select the organization from the Organization list, which displays all the system
organizations that have not yet been added to the table.
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d. Enter or copy the organization’s latitude and longitude (obtained in step 1) in the
appropriate text boxes. You can enter up to 20 characters in each box. Valid char-
acters include one minus sign (to indicate a negative number, must be the first
character), one period (to indicate a decimal point) and numerals 0-9. The allowed
range is -90 to 90 latitude, and -180 to 180 longitude.

e. Click OK.

3. Set up Google Maps for an organization by following these steps:

a. Double-click the PAC profile Google Maps for the organization. The profile is avail-
able at the system, library, and branch level. The Google Maps dialog box opens.

b. Select Enable in PowerPAC to display the Map It button in Polaris PowerPAC when
this organization is the connection organization.

c. Select Enable in Mobile PAC to display the Map It link in Mobile PAC when this
organization is the connection organization.

d. If you are implementing Map It for the first time after June 2016, enter your Google
Maps API key in the box. For more information about obtaining the API key, go to
https://developers.google.com/maps/faq#keysystem. If you implemented Map It
before June 2016 and are simply changing your settings, the API key is not neces-
sary.
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e. For Geographic center of map position, enter the latitude and longitude that
should be used to position the initial display of the map. For valid format, see step
2. If you have entered geographic coordinates for the system organization (see
step 2), these are already entered as the default values. If no system coordinates
have been entered, the default coordinates are those of the current organization. If
these have not been entered in the Geographic Coordinates table, the Latitude and
Longitude fields are blank.

Note:
Users can shift the map away from the initial center as they navigate it.

Tip:
Change the zoom level on the Polaris Latitude and Longitude tool to
determine the zoom level you want for the initial map display. See step 1.

f. Set a value for Zoom level of initial display. This setting determines the zoom
level of the initial map display. The default level is 10; valid values are 1-21. Higher
numbers produce a view that is zoomed in closer.

Note:
Users can change the initial zoom level as they navigate the map.

g. Click OK.

Google Preview for PowerPAC Search Results

Google Preview is a book viewer for every book that has a preview in Google Book
Search. You can offer Google Preview for titles in the brief search results list, on the
product page (full display) for a title, or in both locations. The Google Preview button is
displayed only for titles with an ISBN match that have Google previews.

Note:
On rare occasions, a match is found but Google Preview fails to load
when the user clicks the Google Preview button. Polaris PowerPAC
displays the following message in this situation: Google Preview is not
available for this title at this time.

The illustration shows the Google Preview button on the title product page.
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When you click the Google Preview button, the preview is displayed in a lightbox window
(desktop computer or tablet) or full screen on a new browser tab (phone). The Preview
controls are available to page through the preview.
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Use the PowerPAC profiles Google Preview: Enable on search results pages and
Google Preview: Enable on full display to enable this feature in the brief search results
and the product page for a title respectively. The profiles are available on the system,
library, or branch level and are set to Yes by default.

Important:
You do not need any kind of Google account ID to enable this feature, but
Google’s terms of service document states that you cannot alter the
Google Preview button image. For details, go to
https://developers.google.com/books/branding

Note:
If the PAC browser session is run directly on the PAC server, the following
domain must be open for Google Preview to work properly:
Port 80: www.google.com

Setting Up PAC Title Lists

PAC users can place titles selected from their search results in a formatted title list that
can be printed, saved, or sent by email. List formats include Brief Bibliographic, Full
Bibliographic, Chicago Manual of Style, and APA.

As the user selects titles from search results, they are placed in a working list that is
displayed in the dashboard.
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In Polaris PowerPAC, the working list remains in the dashboard for the duration of the
session. (For details about title list features in Mobile PAC, see Title Lists in Mobile
PAC). Working title lists are limited to 100 titles. When the user tries to add more, the
system displays a message advising the user to save the list. The example shows a
portion of a working list when the user has clicked or tapped Show list details.

Registered library patrons can create and save multiple title lists in association with
their patron accounts. Whenever patrons log in, they can see and work with their saved
lists. The example shows a portion of the dashboard for a logged-in patron with saved
title lists.
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For more information:

l Selecting Multiple Titles in a List
l Paging Title Lists
l Sorting Title Lists
l Printing and Emailing Title Lists
l Availability Information in Title Lists
l Setting Up Title List Functions

Selecting Multiple Titles in a List

In working and saved lists, the user can check multiple titles and move or copy them
from a working list to a saved list or among saved lists, and print, email, or save to disk
any list pages, as well as email the entire list. The user can also check single or multiple
titles to place hold requests on the selected title or titles. if you choose to enable this
feature (see Bulk Hold Requests from Polaris PowerPAC Title Lists).

A Select Page checkbox is available at the top and bottom of the title list page in Polaris
PowerPAC. When you select this checkbox, all titles on the current page are checked. A
Remove from list button is also available for individual titles on working and saved title
lists when displayed in Brief Bibliographic or Full Bibliographic format. You can click or
tap Remove from list to remove a single title without first selecting the checkbox.
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The user clicks or taps the appropriate button at the bottom of the page to take action
on the selected titles.
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Paging Title Lists

PowerPAC title lists offer paging. The user can choose to display 10 (the default), 20, 30,
50, or 100 titles per page from a drop-down control at the top or bottom of the list.

Paging controls are available at the bottom of multi-page lists.

Sorting Title Lists

The user can sort the brief and full views of working and saved title lists by date added
to list (the default), author, publication date, or title. When you select a new sort order,
the entire list is sorted even if it extends to multiple pages; the page refreshes and you
return to the first page of the list. The selected sort order is retained in the output file
when you select print, email list, or save to disk. When a logged-in patron selects a sort
order in a saved title list, the sort order is retained the next time the patron logs in, and
any titles added to the saved list are correctly sorted for that list.
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Note:
If you select the Chicago Manual of Style or APA format, the list is sorted
according to the rules of those style guides, and that order is retained in
the output file for print, email, or save to disk. If you switch back to the
brief or full view, the sorting order is the one most recently selected for
those views.

Printing and Emailing Title Lists

When you click or tap Printer Friendly or Email List on a working or saved title list, titles
from the current list page are displayed in the printer-friendly view. You can click or tap
Print Page, Save Page to Disk, or Email Page to to take action on the current page, or
select Email all to, which emails the entire list to the designated address. Very long
emails may exceed system or email service limits that prevent successful delivery. In
this case, the system displays an alert message. The user can click or tap OK to close
the alert and send the email, or Cancel to return to the title list. The user can then select
a different display format, or select fewer titles.

Availability Information in Title Lists

Availability counts and availability details on working and saved title lists are
automatically updated to reflect real-time data whenever the user displays the list.

Note:
As in previous versions of Polaris, availability details are available only on
the working list.
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When availability counts on the brief and full displays for the connected branch are set
to display (PowerPAC profile - Title Display: Configure), the counts on working and
saved title lists reflect real-time data when the patron displays the title list page. The
counts are refreshed when the patron takes any action that refreshes the page; for
example, leaving the page and returning; paging through a multi-page list; changing the
sort order; changing the list format.

When availability details on the brief and full displays for the connected branch are set
to display (PowerPAC profile - Title Display: Configure), the working list displays the
details when the patron selects Local Availability or System Availability from the
Include Availability drop-down list. Availability details are also updated in real time
when the patron takes any action that refreshes the page.
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Setting Up Title List Functions

To set up title list functions in Polaris PowerPAC and Mobile PAC:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Title List: Enable, and select Yes.
3. To allow patrons to send title lists by email, double-click Title List: Email, and

select Yes.
4. To allow patrons to print title lists, double-click Title List: Print, and select Yes.

Note:
This setting does not apply to Mobile PAC. See Title Lists in Mobile
PAC for details about Mobile PAC title list features.

5. To allow patrons to save title lists to a computer drive or disk, double-click Title
List: Save, and select Yes.
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Note:
This setting does not apply to Mobile PAC. See Title Lists in Mobile
PAC for details about Mobile PAC title list features.

6. Select File > Save.

Related Information

l Bulk holds - You can allow patrons to place hold requests on one or more titles dir-
ectly from a working or saved title list in PowerPAC. See Bulk Hold Requests from
Polaris PowerPAC Title Lists.

l Requested indicator - You can display a "requested" indicator in Polaris PowerPAC
and Mobile PAC title lists for titles on which the patron has an active, pending,
held, shipped, or located hold request. The indicator is a message: You requested
this on [date]; the system supplies the date. See Configuring the PowerPAC Title
Display and Configuring the Mobile PAC Title Display.

Bulk Hold Requests from Polaris PowerPAC Title Lists

When you enable the bulk holds feature, patrons can select multiple titles from their
working or saved title lists in Polaris PowerPAC and place hold requests on all the
selected titles at once.

Note:
For more information about PAC title lists, see Setting Up PAC Title Lists.
A Requested date indicator is also available to let patrons know which
titles they have already requested in a title list or set of search results. See
Configuring the PowerPAC Title Display.

The bulk holds feature is not available in these cases:

l Titles from remote databases listed in the title list cannot be requested through
bulk holds.

l Integrated eContent titles cannot be cannot be requested through bulk holds.
l The bulk hold feature does not apply to Borrow by Mail requests.
l The bulk hold feature is not available in Mobile PAC.

For details, see:
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l Placing Bulk Hold Requests in PowerPAC
l Bulk Holds Processing
l Enabling Bulk Holds

Placing Bulk Hold Requests in PowerPAC

In Polaris PowerPAC, the logged-in patron checks at least one title in a working or saved
title list and clicks or taps Place Request.

l The Place Request button is disabled if the patron has not selected at least one
title in the list. The button is also disabled for secured patrons. (The button is not
displayed at all if PAC title-level holds and bulk holds have not been enabled in
Polaris administration. See Enabling Bulk Holds.)

l You can edit the Place Request button label in Polaris WebAdmin. The string mne-
monic is PACML_REQUESTS_1380. See Polaris WebAdmin online help.

l If the patron has selected more titles than allowed by the PowerPAC profile Title
list: maximum number of titles to request in bulk, the system displays a mes-
sage: "You can only place [n] holds at once. Uncheck one or more titles and try
again." You can edit the message in Polaris WebAdmin; the string mnemonic is
PACML_REQUESTS_MAXREQ

Place Requests Page

When the patron's selections meet the bulk hold limit and the patron clicks or taps Place
Requests, the Place Requests page is displayed. The patron can set an activation date;
the patron can also select a pickup library and enter a note if these features are enabled
for patron-initiated requests. See the Patron Services Administration Guide for more
information about these settings. This page also displays a policy statement link if the
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PAC profile Patron access: Policy statement hypertext link permitted is set to Yes for
the connection branch.

Note:
The activation date must be entered in the format displayed on the Place
Requests page. It cannot be in the past, and cannot be more than two
years from the current date. If there is a problem with the date entry, the
system displays a message. The patron clicks or taps OK and re-enters
the date.

You can edit the Place requests: title on this page in Polaris WebAdmin. The string
mnemonic is PACML_REQUESTS_1380.

The Place Requests page displays a warning message if the system-level Request
parameter Holds Options (Charges tab) is set to charge for holds. See the Patron
Services Administration Guide. The patron can click or tap OK to proceed or Cancel to
exit. If your library system has set this option, you can edit the message in the Request
parameter Holds Options, Charges tab.

The patron can click or tap Cancel on the Place Requests page to return to the title list,
where any titles previously checked remain checked, or (if not blocked) the patron can
select Continue to proceed with the bulk hold requests. A progress indicator and the
message "Checking status and limits..." are displayed. The WebAdmin string mnemonic
for the message is PACML_REQUESTS_1395.

If placing the hold requests would meet or exceed the maximum total number allowed
for the patron as set in the Patron/Material Type policy table, and If the patron is
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blocked: Block in PAC is checked in the Holds Options parameter (Staff client & PAC
tab), the system displays a page with a message: "Your requests cannot be placed
because you have reached your limit of [n] requests. You may want to cancel some
requests from your patron account, then try again." The WebAdmin string mnemonic for
the message is ILL_BULK_BLOCKEDMAXNUMREQS. The patron can click or tap Back to
return to the title list.

Confirm Bulk Requests Page

When the patron clicks or taps Continue on the Place Requests page, the Confirm Bulk
Requests page appears.

The list displays the selected titles, and for each title, the material types of the items
that can potentially satisfy the request. If the PAC profile Patron access: Display hold
queue information is set to Yes for the patron's registered branch, the list includes an
Active Requests column that displays how many other requests exist for the title. (This
profile also affects the PAC patron account Requests page. See Controlling Patron
Account Login and Access.) Titles with checkboxes can be unchecked if the patron
does not want them.

Titles without checkboxes in the display cannot be requested at all, either because they
are from remote databases, they are duplicates, they represent integrated eContent, the
bibliographic record has been deleted but not yet removed by overnight processing, or
due to item-related or patron-related conditions. A message specific to the error
displays under the title of each request.

The Confirm Bulk Requests page displays appropriate messages if a request on a
selected title or titles cannot be placed due to the following item-related conditions:
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Note:
When no items can fill a request on a title and the checkbox is
suppressed, the material type and active request information is also
suppressed.

l The title has no linked items and If no items are attached: Block in PAC checked
in the Holds Options parameter (Staff client & PAC tab). The system displays this
message under the title: "No items are available to fill your request. Contact the lib-
rary for assistance." The WebAdmin string mnemonic for this message is ILL_
TEXT_NOITEMSAVAILABLE.

l The title is linked to at least one item that is IN and Prevent on status: In is
checked in the Holds Options parameter (Requests tab). The system displays this
message under the title: "The request cannot be placed because a copy of this title
is currently available at the library. You can obtain the item at the library." The
WebAdmin string mnemonic for this message is ILL_TEXT_ERR_
COPYAVAILABLE.

l All items associated with the title are restricted from being held. The system dis-
plays this message under the title: "Requests are not permitted for this title.
Contact the library for assistance." The WebAdmin string mnemonic for this mes-
sage is ILL_TEXT_REQNOTPERMITTED.

l There are no item records linked to the title, or all the linked item records fit one or
more of these conditions:

o Display in PAC is set to No (not checked) in the item record, or
o The item circulation status is set to be suppressed from the PAC display in

the PAC profile Suppress item display for the connection branch, or
o The connection organization is the System, and the linked item is assigned

to a branch that is set for suppression from PAC in the system-level PAC
profile Suppress branches,

AND
o Suppress All records is selected for the Type of Material (TOM) in the PAC

profile Suppress availability and requests for the connection branch, or
o Suppress Records with an 856 is selected for the Type of Material (TOM) in

the PAC profile Suppress availability and requests for the connection
branch. Note that this selection applies only to records with the 856$u tag.
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The system displays this message under the title: "Requests are not
permitted for this title. Contact the library for assistance." The WebAdmin
string mnemonic for this message is ILL_TEXT_REQNOTPERMITTED.

l All items associated with the title have an excluded status. The system displays
this message under the title: "This item is not available to fill your request. Contact
the library for assistance." The WebAdmin string mnemonic for this message is
ILL_TEXT_ITEMNOTAVAILABLE.

l The title is from a remote database, or the bibliographic record has been deleted
but the cached copy has not yet removed by overnight processing. The system dis-
plays this message under the title: "The library does not own this title. You cannot
request this title from your title list. You can search for the title in a remote data-
base and request it individually, or contact the library for assistance." The WebAd-
min string mnemonic for this message is PACML_REQUESTS_REMOTEDB.

l All items linked to the title are restricted, and at least one item's eContent check-
box is checked. The system displays this message under the title: "You cannot
request this eContent title through bulk requests. Please contact your library for
more information." The WebAdmin string mnemonic for this message is ILL_
BULK_NO_ECONTENT.

l The title is a journal and Allow requests on serials in PAC and Staff client is set in
the Holds options parameter, Requests tab (Manage item requests). The system
displays this message under the title: "Serial issues must be searched for and
requested individually." The WebAdmin string mnemonic for this message is ILL_
BULK_SERIALSNOREQ.

l The title is a multi-part set and Allow requests on multi-part sets is set in PAC
and Staff client is set in the Holds options parameter, Requests tab (Manage item
requests).The system displays this message under the title: "Multi-volume sets
must be searched for and requested individually." The WebAdmin string mne-
monic for this message is ILL_BULK_MULTIPARTNOREQ.

l The title appears in the list more than once, so the system does not allow the
duplicate request. The system displays this message under the title: "This title is a
duplicate of another title in this list." The WebAdmin string mnemonic for this mes-
sage is PACML_REQUESTS_1396.

The Confirm Bulk Requests page also displays appropriate messages if a request on a
selected title or titles cannot be placed due to patron-related conditions as specified in
Polaris Administration. the Patron Services Administration Guide for more information
about these settings. The following situations are examples:
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l Placing a hold request on a title would result in a duplicate request. The system
displays this message: "The request cannot be placed because a duplicate request
has been found. Please check your account." The WebAdmin string mnemonic for
the message is ILL_TEXT_DUPLICATEREQ.

l If placing these hold requests would exceed the maximum total number allowed
for the patron as set in the Patron/Material Type policy table, and If the patron is
blocked: Block in PAC is checked in the Holds Options parameter (Staff client &
PAC tab) for the pickup branch, the system displays a message: "You currently
have [n] total requests. You are allowed a maximum of [n]. Uncheck [n] and click
Update." The WebAdmin string mnemonic for the message is ILL_BULK_ILL_
BULK_EXCEEDMAXREQUESTS.

l Placing the hold requests would exceed the maximum number of holds for a par-
ticular material type for the patron as set in the Patron/Material Type policy table
and If the patron is blocked: Block in PAC is checked in the Holds Options para-
meter (Staff client & PAC tab). The system displays this message: "You will exceed
the maximum number of requests allowed for one or more material types:". The
WebAdmin string mnemonic for the message is ILL_BULK_
EXCEEDMATERIALLIMITS. Separate messages then detail the material types
affected; for example:

o "Book: maximum = 20; uncheck 4 of this type" (ILL_BULK_
EXCEEDMATERIALLIMITS_UNCHECK)

o "Audiobook: maximum = 5; limit reached, uncheck all of this type" (ILL_
BULK_EXCEEDMATERIALLIMITS_UNCHECKALL)

Note:
For both maximum holds and maximum holds for material type, if the
system-level Patron Services parameter Consortium circulation - Patron
blocks is set to Transacting branch, the pickup branch's setting for Block
in PAC determines whether the patron can place the hold requests. If
Consortium circulation - Patron blocks is set to Patron branch, the
patron's registration branch setting for Block in PAC determines whether
the patron can place the hold requests.

The Confirm Bulk Requests page may also display warning messages for certain titles
with checkboxes:

l An item attached to a selected title might fill the request, and the Patron Services
parameter Check-out: Charge options for the item's assigned branch is checked
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for the logged-in patron's code. The default message text is "If your request is
filled you may be charged to Borrow this item according to the policy of the own-
ing library." You can edit the message in WebAdmin. The string mnemonic is ILL_
BULK_CHARGECKOREQ.

l The title has no linked items, but If no items are attached: Block in PAC is not
checked in the Holds Options parameter (Staff client & PAC tab). The default mes-
sage text is "This title has no items. Your request may not be filled." You can edit
the message in WebAdmin. The string mnemonic is ILL_TEXT_
NOITEMSAVAILABLE_BULK .

The patron can uncheck selected titles if necessary, and click or tap Update. If no titles
are selected and the patron clicks or taps Update, a message is displayed: "You must
select one or more titles, or click Cancel to return to your title list" (WebAdmin string
mnemonic PACML_REQUESTS_1394). When the list is satisfactory, and after the patron
has clicked ortapped Update to save any changes, the patron clicks or taps Confirm. If
the patron clicks or taps Cancel, the display returns to the page of the title list that was
displayed when the patron navigated away from the page; any titles previously checked
remain checked.

You can edit the text of page elements on the Confirm Bulk Requests page in Polaris
WebAdmin. The string mnemonics are as follows:

LABEL MNEMONIC

Confirm bulk requests PACML_REQUESTS_1381

Click Update to make changes. Click Confirm to submit
your hold requests. PACML_REQUESTS_1382

Type PACML_REQUESTS_1383

Active Requests PACML_REQUESTS_1384

Title PACML_REQUESTS_1385

Update PACML_REQUESTS_1386

Confirm PACML_REQUESTS_1387

Cancel PACML_REQUEST_XSL_
1652
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Bulk Requests Results Page

When the patron clicks or taps Confirm, a "processing" spinner icon is briefly displayed
with the message Creating requests . . .. You can edit the message in Polaris
WebAdmin (string mnemonic PACML_REQUESTS_1393). When processing is complete,
the system displays the Bulk Requests Results page with the message: Your requests
were successfully placed!

The patron can select Return to your Title List, Go to your list of hold requests, or Log
Out. The labels can be edited in Polaris WebAdmin. The string mnemonics for the page
are as follows:

LABEL MNEMONIC

Bulk requests results: [page title] PACML_REQUESTS_1389

Return to your Title List PACML_REQUESTS_1392

Go to your list of hold requests PACML_REQUEST_GOTO_
ACCOUNT

Log Out PACML_BASICINFO_1195

Bulk Holds Processing

Bulk Holds processing uses two database tables: BulkHolds and BulkHoldsBibs. These
tables are populated with data that is needed during bulk holds processing but are not
required once the bulk holds process has completed. The Hold Request Cleanup Nightly
SQL job includes a Bulk Holds Cleanup step. This step deletes all entries in the
BulkHolds and BulkHoldsBibs tables that are over 120 minutes old. See the Polaris
Administration Guide.

Enabling Bulk Holds

To enable bulk hold requests:
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1. Confirm that the setting Enable title-level hold requests from PowerPAC and
Mobile PAC is checked for the connection branch (Request parameter Holds
options, Requests tab). See the Patron Services Administration Guide.

2. Set the PowerPAC profile Title list: Enable bulk holds to Yes.

The profile is available at the system, library, and branch levels; the system
uses the PAC connection branch setting. When this profile is set to Yes and
title-level hold requests from PAC are enabled, the Place Request button is
displayed in working and saved title lists.

3. (Optional) Set the number of titles that can be processed in one bulk hold request.

The default number is 10. Change the setting with the PowerPAC profile Title
list: maximum number of titles to request in bulk. The range is 1-100. The
profile is available at the system, library, and branch levels; the system uses
the PAC connection branch setting.

Social Bookmarking for Search Results (AddThis™)

Social bookmarking is a method for Internet users to share, organize, search, and
manage bookmarks of web resources. Polaris PowerPAC users can share bookmarks to
titles in their search results on over 200 sites that support social bookmarking, such as
Facebook™, Twitter™, and Digg™. Polaris uses AddThis™ to provide this feature, a widely
available no-fee service that maintains the social bookmarking URLs and provides
usage analytical statistics to libraries that register for an AddThis account.

If you enable bookmark sharing, icons representing popular bookmarking sites are
displayed on the summary view when the user hovers the cursor over or taps a book
jacket image in brief Polaris PowerPAC search results, and on the product page for a
title.
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The initial icons represent the most popular bookmarking and sharing sites according to
AddThis. The user can select an icon, or click or tap Share to open a dialog box with a
list of additional sites and a search feature that covers more than 200 social
bookmarking providers.

Tip:
Users can “pin” PowerPAC search results pages in Pinterest only with the
Pin It icon. The Pin It browser bookmark offered by Pinterest currently
supports only static URLs and does not accommodate the dynamic URLs
generated through a PowerPAC search.
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The user selects a site link to open a new window for the selected site, log on to the site
account, and add a bookmark for the selected title. When someone selects the link on
the social network site, a search for the title is launched in the library catalog.

To set up bookmarking and sharing for PowerPAC search results:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Bookmarking & Sharing: Enable, and select Yes. This setting displays
the Share link for titles in Polaris PowerPAC search results.

3. If you want usage statistics from AddThis, follow these steps:

a. Set up an AddThis account at the AddThis Web site: go to http://www.ad-
dthis.com/ and click the Join Now link at the top of the page.

b. Create a user name and password for the AddThis account, and supply an appro-
priate e-mail address.

Note:
The AddThis terms of service and privacy policies are available on the
AddThis Web site.

c. In Polaris Administration, type your AddThis profile ID in the PowerPAC profile
Bookmarking & Sharing: Profile ID for AddThis analytics.

Note:
The current implementation of Pinterest by AddThis does not function
properly across all web sites. The Pinterest feature is therefore a custom
integration in PowerPAC and is not included in AddThis analytics.

Select File > Save.

Related Information

Polaris Social, in partnership with ChiliFresh Connections, offers integrated social
features in Polaris PowerPAC. See Polaris Social with ChiliFresh Connections.
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Managing Integrated EContent in the PAC

EContent titles provided by integrated vendors can be displayed in the Polaris
PowerPAC, Mobile PAC, and PowerPAC Children’s Edition. Patrons can search for and
view eContent title information using the same features and functions that are available
for searching for physical material titles. For information on setting up integrated
eContent in Polaris, see the Integrated EContent Administration Guide.

Note:
RBdigital titles display in the patron's account in Polaris Mobile PAC, but
patrons cannot take action on RBdigital titles from Mobile PAC.

Many Polaris Administration settings are used for both physical and eContent titles.
These include settings for search types, access points, limit by options, facets, and title
display configuration. Advanced search options are supported to the extent that the
data is present in the eContent item and bibliographic records.

Note:
If your library offers a Limit By filter for currently available items, the
system uses the information currently in the Polaris database. Selecting
this filter does not trigger real-time synchronization with the integrated
eContent vendor.

Other Polaris Administration settings apply only to eContent in the PAC. These settings
are used to: limit title display and access based on the resource group that shares the
vendor account; manage eContent availability and hold counts; and track eContent
circulations separately from physical items. The library can also customize the text for
the Check Out and Place Hold buttons in WebAdmin.

Important:
Be sure to reload both PowerPAC and Mobile PAC (if your library uses
Mobile PAC) each time you: add or change a resource group; add or
change a vendor account; or change the Resource Groups: Search results
settings profile in Polaris Administration. See the Public Access
Administration Guide, "Updating Page Caches.".



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 244

EContent in PAC Search Results

When patrons search for titles in the PAC, the integrated eContent titles display along
with titles for physical material. For example, if a patron searches for a specific title, the
results may include a physical DVD and a downloadable ebook or audio ebook from one
or more integrated eContent vendors, such as OverDrive and cloudLibrary (formerly 3M
Cloud Library).

The Availability display depends on how your eContent vendor accounts are set up and
whether these accounts are shared by the entire library system, shared by specific
organizations, or limited to a single branch. You may also suppress detailed item
availability display for integrated eContent. See EContent Availability and Holds Counts.

EContent Availability and Holds Counts in PAC

The availability and holds counts for integrated eContent titles are populated in real time
on the PAC search results lists. These counts are not affected by settings in the Title
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Display: Configure profile.

Your library may opt to suppress detailed item availability display for integrated
eContent titles in PowerPAC and Mobile PAC by setting the PAC profile Suppress
availability display for integrated econtent titles to Yes. When the PAC connection
branch has set this profile to Yes, the Availability button and drawer do not display in
PowerPAC, and the Find It link does not display in Mobile PAC. The availability counts
still display. See Suppress eContent Availability Display in PAC.

For OverDrive Advantage accounts, Advantage copies for the branch display when a
patron is connected to the PAC at that branch, regardless of whether the patron is
logged in or not. The library uses an option in the Vendor Record to specify whether
patrons see Advantage titles when connected to the PAC at the system level. See
"Create an Overdrive integrated vendor account" in the Integrated EContent
Administration Guide.

The patron may see a Please log in for availability message that indicates Polaris
cannot determine the library organization. This might happen if the patron has not yet
logged in and is connected to the PAC at an organization that does not honor resource
groups. If the patron does not have access to the eContent title, a Restricted button is
displayed with the hover text Sorry this title is currently not available at your registered
branch. You can modify this text string in WebAdmin using the mnemonic: PACML_
EBRESTRICTED_TIP. See "Manage patron access to eContent using resource groups" in
the Integrated EContent Administration Guide.

Suppress eContent Availability Display in PAC

Your library can prevent detailed availability information from displaying for integrated
eContent titles in PAC (PowerPAC and Mobile PAC). When the PAC profile Item
availability: Suppress for integrated econtent titles is set to Yes for the branch the
patron is connected to, eContent titles display as follows:

l PowerPAC - Neither the Availability button nor the Availability drawer are dis-
played for integrated eContent. The availability counts are not affected by this set-
ting and will continue to display.

l Mobile PAC - The Find It links do not display for integrated eContent.

Note:
The Suppress availability and requests profile applies to bibliographic
records without any linked items, and generally does not apply to
integrated eContent titles, which have linked items. The Item availability:
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Suppress for integrated econtent titles option suppresses availability
display for integrated eContent titles that have eContent items.

To suppress the availability display for integrated eContent titles:

1. Select Administration > Explorer, and select the organization (System, Library, or
Branch).

2. Select Profiles, and select the PAC tab.
3. Double-click Item availability: Suppress for integrated econtent titles, and select

Yes.

4. Select File > Save to save your changes.

For examples of integrated eContent title display when availability is suppressed
for the selected branch connection in the PAC, see:

l EContent Availability Suppressed in PowerPAC
l EContent Availability Suppressed in Mobile PAC

EContent Availability Suppressed in PowerPAC
When the PAC profile, Item availability: Suppress for integrated econtent titles, is set to
Yes for the branch the patron is connected to, the results list does not display the
Availability button, and the full display for a title does not include the Availability drawer
for integrated eContent titles in PowerPAC. The availability counts display regardless of
the profile setting.
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EContent Availability Suppressed in Mobile PAC
When the PAC profile Item availability: Suppress for integrated econtent titles is set to
Yes for the branch the patron is connected to, the Find It link does not display on the
Mobile PAC Title view.

EContent Product Page Display in the PAC

The product page (full display) for eContent is similar to the full display for other
bibliographic materials.
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The bibliographic information display for eContent is configured with the PowerPAC and
Mobile PAC Title Display Configure profiles. See Configuring the PowerPAC Title
Display.

The Purchase button and the Map It feature are suppressed for eContent. If your library
does not want to display detailed availability information for integrated eContent titles,
you can set the PAC profile Item availability: Suppress for integrated econtent titles to
Yes. See Suppress eContent Availability Display in PAC.

See also:

l Configure the Enriched Content Drawers for PowerPAC
l Enable enriched content for Axis 360 or OverDrive

Configure the Enriched Content Drawers for PowerPAC

To configure the enriched content display for the eContent vendor in Polaris PowerPAC:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Product page categories: Configure to open the dialog box.
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3. Select the checkboxes next to the categories you want to be expanded upon initial
display of the product page in PowerPAC.

4. Click OK.

Enable enriched content for Axis 360 or OverDrive

You can enable enriched content provided by Baker & Taylor for Axis 360, or for
OverDrive. When your library has implemented the eContent vendor, and enabled the
enriched content, patrons will see a “drawer” in the PAC, labeled Descriptions and more,
from [vendor name].

To enable enriched content for an eContent vendor:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

2. Double-click Enriched data.
3. Select Baker & Taylor and select the Content Cafe subtab for Axis 360, or select

the OverDrive tab, and select the Enable checkbox. This selection enables the
enriched content.
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Patron-Initiated EContent Circulation from PAC

In Polaris, the loaning branch for circulation transactions is typically the patron’s
registered branch. However, your library may want to set the loaning branch as the
eContent item’s assigned branch for patron-initiated circulations, where the patron
places holds or checks out eContent from the PAC. This option can be set at the System
level only.

EContent titles in PAC search results display the Check Out button if the item is
available to the patron or a Place Request button if no local item is available. (If the
vendor account is not active, a Temporarily Unavailable button is displayed.)

If the patron does not have access to the eContent title, a Restricted button is displayed
with the hover text Sorry this title is currently not available at your registered branch.
You can modify this text string in WebAdmin using the mnemonic: PACML_
EBRESTRICTED_TIP. Patrons can also be blocked from checking out eContent based on
settings in the Patron Services Administration profile Patron initiated circulation:
Blocking conditions See the Patron Services Administration Guide.

Note:
Your library can change the labels on the Place Hold and Check
Out buttons by modifying vendor-specific strings in WebAdmin.

See also:

l Set the Loaning Branch for eContent Circulations
l Require Format for Integrated eContent Check Outs in PAC
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l Prevent or allow downloads of OverDrive eContent on in-house workstations
l EContent in the PAC Patron Account

For information regarding patron access to a specific vendor's integrated eContent, see
the Integrated EContent Administration Guide.

Set the Loaning Branch for eContent Circulations

In Polaris, the loaning branch for circulation transactions is the patron’s registered
branch. However, your library might want to set the loaning branch as the item’s
assigned branch for patron-initiated circulations, where the patron places holds or
checks out eContent from the PAC. This profile can be set at the System level only.

To set the loaning branch for eContent circulation:

1. In the Administration Explorer tree view, open the Profiles folder at the System
level, and select the Patron Services tab in the details view.

2. Double-click Patron initiated circulation: Transaction branch to open the drop-
down list.

3. Select Patron’s branch or Item’s branch. This setting applies to eContent cir-
culations from the PAC only; the loaning branch for physical items is still the pat-
ron’s registered branch.
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Require Format for Integrated eContent Check Outs in PAC

Your library can require patrons to select a format when they check out integrated
eContent titles from the PowerPAC or Mobile PAC. When the Patron Services parameter
Check out: Require format selection when checking out integrated econtent is set to
Yes for the library organization the patron is connected to, the format list defaults to
Please select, and the patron must select a format from the list to check out the
eContent.

To require patrons to select a format when checking out integrated eContent titles in
PAC:

1. Select Administration > Explorer and select the organization (system, library, or
branch).

2. Select Parameters under the organization, and select the Patron Services tab.
3. Double-click Check out: Require format selection when checking out integrated

econtent and select Yes.
4. Select File > Save.

Prevent or allow downloads of OverDrive eContent on in-house workstations

Your library can prevent patrons from downloading OverDrive eContent titles to library
workstations or opening checked-out eContent in the browser on a library workstation. If
the OverDrive download: Enable on in-house workstations profile is set to No (the
default), patrons will not be able to download or open checked-out OverDrive eContent
on workstations specified as In-house for the PAC connection library (see the Polaris
Administration Guide).

To allow or prevent patrons from accessing and downloading OverDrive integrated
eContent on in-house library workstations:

1. Select Administration > Explorer and select the organization (system, library, or
branch).

2. Select Profiles under the organization, and select the PowerPAC tab.
3. Select the OverDrive download: Enable on in-house workstations profile and set it

to Yes to allow patrons to download or open checked-out OverDrive eContent on
library workstations, or set it to No (the default) to prevent patrons from down-
loading or opening checked-out OverDrive eContent on workstations specified as
In-house (using the In-House Access Definitions table for the PAC connection lib-
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rary).
4. Select File > Save.

EContent in the PAC Patron Account

After eContent titles are checked out, they are listed on the Items Out page of the patron
account. The list reflects the eContent currently checked out, regardless of whether the
patron has actually downloaded content.

Note:
EContent titles cannot be renewed from PAC, the staff client, or Polaris
Phone Attendant. Check-in from the staff client is not supported. For more
information, see the Integrated EContent Administration Guide.

EContent items automatically expire when the item’s expiration date and time are
reached. When the expiration date of the item is reached, the item becomes available to
someone else. Polaris automatically checks in the item and removes it from the patron
account. Patrons can also check in cloudLibrary eContent and some OverDrive eContent
formats before they expire. Check in does not apply to Axis 360 eContent.

A logged-in patron can view the status of requests for eContent on the Requests page of
the patron account. Items available for checkout and download are also included in the
count of items ready for pickup in the patron account summary dashboard. (This count
may change if the user takes action after accessing the account.)

Requests for eContent titles cannot be suspended or reactivated, but requests with a
status of Active can be canceled. The patron can click Refresh eContent on the patron
account Requests page to see the changes in PAC. All actions taken on the PAC patron
account Requests page result in a real-time update to the vendor account and to the
information on the Requests page.

See the following topics in the Integrated EContent Administration Guide:

l "Patron Access to Axis 360 EContent"
l "Patron Access to OverDrive EContent"
l "Patron Access to cloudLibrary EContent"
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Managing Federated Search Targets

Polaris PowerPAC features integrated federated searching, which enables users to
simultaneously search local and remote databases, and retrieve merged search results.
Libraries can offer federated searching of Z39.50 databases only, a feature included in
Polaris at no additional cost. These search targets are remote databases or Web search
engines that can be searched simultaneously with the Polaris database using the
Z39.50 search protocol. If your library allows patrons to place interlibrary loan requests
from PAC, you will likely provide Z39.50 search targets that patrons can choose using
the Select Databases feature in Polaris PowerPAC. You can filter Z39.50 search target
results to show only those materials that patrons can actually request. See "Filter
Remote Z39.50 Target Search Results in PowerPAC" in the Polaris Administration Guide.

Note:
Vital is Innovative's digital asset management solution for describing,
indexing, and making available electronic content, such as photographs,
slides, digital video, sound clips, and electronic documents. Polaris
PowerPAC users can search for Vital digital resources along with other
types of material in the library catalog. You set up Vital for searching as
you would other remote databases. See Searching Vital Digital Resources
in PowerPAC - Overview.

Tip:
Your library can also offer remote databases that are searched separately
in PowerPAC. See Configure remote database usage settings.

In addition, Polaris offers separately-activated federated searching in partnership with
MuseGlobal, a leading supplier of content integration, aggregation and transformation
solutions. This partnership extends federated search capabilities to other protocols in
addition to Z39.50, such as: HTTP sources; free text databases; SQL or ODBC
databases; and proprietary protocol sources. MuseGlobal offers over 6,500 potential
targets and provides search access, connectors, and appropriate URLs for the target
resources covered by your subscription. For more information about MuseGlobal, see
http://www.museglobal.com

Note:
For specific information about setting up federated searching with
MuseGlobal, see the Polaris Administration Guide.

http://www.museglobal.com/
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To set up remote resources as federated search targets, you set up server records for
the remote resources in Polaris Administration. See the Polaris Administration Guide for
more information. Then, using the procedures outlined here, you organize them in the
way that is most convenient for your patrons, using the PowerPAC profile Remote
databases: Categorization of target databases. You can set usage conditions on
individual databases, and set a limit on the number of targets that can be searched at
one time.

See also:

l Merged Results in Polaris PowerPAC
l Organizing Target Databases for PowerPAC Display
l Maximum Number of Databases Searchable at One Time
l Remote Database Usage Settings for PowerPAC

Merged Results in Polaris PowerPAC

When users search both remote databases and the local catalog, the results are
displayed in a merged list. To select the remote databases for searching, the user clicks
or taps the Select Databases link to open the list of available databases, and selects the
checkbox next to the databases.
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Note:
You can specify a remote database or databases to be included by default
in PowerPAC search results. When you have set this option, patrons do
not have to deliberately select the databases for searching using the
Select Databases feature. See Remote Database Usage Settings for
PowerPAC.

The user then clicks or taps Set Databases, enters the search term, and clicks or taps
the search icon. The search results list first displays results from the local catalog, if
selected, and the user can select Add Pending Results to add more results to the list.
The number displayed at the top of the list changes as the results are added.

As results are being added from the selected databases, the user can click or tap
Search Status to see the progress. A status window displays the total results for each
database, the database status, the results pending, and the results retrieved.
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When all the pending records have been retrieved, the search bar indicates that all
retrieved results have been added.

Users can filter the search results list by database. The Narrow your search dashboard
displays the Database facets. For more information about setting up facets, see Setting
PowerPAC Narrow/Related Search Options.
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In the merged result set, the brief information for the title displays a database icon
 and the source database for titles found in remote databases.

Organizing Target Databases for PowerPAC Display

By default, all remote search targets available for the connection organization’s
PowerPAC searches are displayed as a single list, which may be very long. Using the
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PowerPAC profile Remote databases: Categorization of target databases, you can
organize the list into categories, add search targets, and specify which targets should be
listed under each category heading. A specific search target can be represented in
multiple categories. In the PowerPAC Select Databases lightbox, the user can select a
category to search all the targets in the category, or select single targets to search. For
example, you might set up categories for different types of targets, such as university
libraries and local history archives, or for topics such as Genealogy, Health, and
Employment. Categories are initially displayed as expanded, but the user can collapse
them as desired. You can have an unlimited number of categories that you can set up at
the system, library, or branch level. If categories are not set up for an organization, the
organization scheme from the parent level is used.

See also:

l Select Databases Lightbox in PowerPAC
l Develop the remote targets display for PAC

Select Databases Lightbox in PowerPAC

Your settings in the PowerPAC profile Remote databases: Categorization of target
databases determine the Select Databases lightbox display in Polaris PowerPAC.
However, any access restrictions you have set may suppress specific targets from the
display (see Remote Database Usage Settings for PowerPAC).

An explanatory message is displayed at the top of the Select Databases lightbox. If the
patron is not logged in, the default text is:

Some databases are not available to all catalog users in all locations.
Please log in to see which databases are available to you. You may
continue without logging in, but some databases may not be searched.

You can edit the message in Polaris WebAdmin (Language Editor). Choose the
PowerPAC product; the language string IDs for this message are PACML_SELECTDB_
NOTE_LOGIN and PACML_SELECTDB_NOTE_LOGIN2. See WebAdmin online help for
detailed instructions.
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In addition, the Select Databases lightbox displays a Why these databases? link. When
the user clicks or taps the link, an explanatory message is displayed:
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You can edit the label and message in Polaris Language Editor (WebAdmin). Choose the
PowerPAC product; the language string IDs for the label and message are PACML_
SELECTDB_WHYDB and PACML_SELECTDB_NOTE_CONNECT.

At the bottom of the lightbox, the user clicks or taps Set Databases to save the
database selections. This action typically launches the search in the selected databases
using the search term from the user’s immediately preceding search. However, no
search is launched in these cases:

l The immediately preceding search was a keyword control number search
(launched when the user selected a dashboard or content carousel link).

l There was no immediately preceding search in the current session.

Note:
If the user types a new search term but does not click the search icon, and
then opens the Select Databases lightbox and clicks or taps Set
Databases, the new search term is ignored and the search is launched
using the immediately preceding search for which the application actually
constructed a search string.

Selecting Clear deselects (unchecks) all databases except the local database, and
selects the local database.

The Close option is displayed when no changes have been made, and simply closes the
lightbox, retaining the current selections. A new search is not launched. If changes have
been made, a Cancel option is displayed instead of Close; this option cancels any
changes and closes the lightbox, retaining the selections in place before the lightbox
was opened. A new search is not launched. The X button in the upper right corner of the
lightbox functions like Close if no changes have been made, or like Cancel if changes
have been made.

Users can also reset the database selections from the search form. When remote
databases have been selected, a Clear option appears next to the Select Databases
option; both are highlighted.

Develop the remote targets display for PAC

To make remote search targets available for searching in Polaris PowerPAC, and
organize them into categories:

Note:
You establish connections to remote resources through Polaris
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Administration server records. See the Polaris Administration Guide. In
Polaris PowerPAC, if no remote search targets have been set up, the
Select Databases link and the Using label and drop-down list are not
displayed.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click the PowerPAC profile Remote databases: Categorization of target
databases.

The Remote databases: Categorization of target databases dialog box displays a
list of remote database targets and any defined categories. Book icons represent
individual targets. Folder icons represent categories.

3. Select Root to add a new category at the top level, or select an existing category
folder to add a subcategory, and click Add Category. A new category folder icon
appears in the tree view, with the cursor positioned to name the folder.

Note:
Root is the default category, represented by a tree icon. It cannot be
copied, deleted, or renamed.

4. Type a category heading, and press ENTER.
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5. To make an individual search target available, select the category, and click Add
Target. (To add a target directly to the Root level, select Root.)

Note:
New search server targets are not automatically added to the Root level
category folder for the system. You must explicitly add them to make
them available for search selection. Also, if an organization no longer
inherits system-level settings, the organization will need to manually add
the new target at the organization level.

The Add Target dialog box appears with a list of databases available to the
organization, based on its membership in the resource groups with access to the
databases. See the Polaris Administration Guide.

6. Select the target database to add to the category.
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Note:
You can specify a PAC display name for the target. See Remote Database
Usage Settings for PowerPAC.

Note:
If a single category contains more than the maximum number of
databases to search (see Maximum Number of Databases Searchable at
One Time), a warning message advises you to put fewer databases in the
category.

7. Click OK. The target database is added to the category.
8. Continue adding categories and targets as needed for the organization.

Related Information

l Copy a target - Select the target in the Remote databases: Categorization of target
databases dialog box, and click Copy. Then select the category where you want to
place the copy of the target, and click Paste. You can use the Copy/Paste function
to add a target to multiple categories. However, a single target cannot appear
more than once at the same category level, unless the different instances of the
target are in different subcategories.

l Copy a category - Select the category in the Remote databases: Categorization of
target databases dialog box, and click Copy. Then select the category where you
want to place the copy, and click Paste. This procedure creates categories that are
linked. When you copy categories, all subcategories and targets are copied, and all
the copied subcategories and targets also become linked. Any change to one cat-
egory is applied to all the linked categories. A linked category is indicated by a
hand on the folder icon. To remove the link between categories, select the cat-
egory you want to make independent, and click Unlink.

Note:
You cannot paste a copied category at the same level as the original
category.

l Delete a target - Select the target in the Remote databases: Categorization of tar-
get databases dialog box and click Delete. (Deleting a target from a particular cat-
egory, including Root, does not delete it from other categories.) The local Polaris
database cannot be completely removed from the categorization dialog box. If
you select the last instance of the local database and click Delete, a message
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informs you that the local database must appear at least once, either at the root
level or within one category. When you click OK, the message box closes and the
local database remains selected. It is not deleted.

Important:
When the last instance of a target is removed from the categorization
dialog for an organization, the Enable for follow-on searching and Include
in quick-select drop down options are automatically disabled for that
database in that organization context. For more information about these
options, see Remote Database Usage Settings for PowerPAC. If you add
the database back to the categorization dialog, the Enable for follow-on
searching and Include in quick-select drop down options must be
manually set again; they are not automatically restored.

l PAC display - See Select Databases Lightbox in PowerPAC.
l Enable ILL requests from PAC - See the Patron Services Administration Guide.

Maximum Number of Databases Searchable at One Time

If system performance is a concern, you can restrict the number of databases that can
be searched at one time. Use the PowerPAC profile Remote databases: Maximum
number that can be searched at once. Valid values are 1-25; the default setting is 10.
The profile is available at the system, library, and branch levels. The PAC connection
organization’s setting is used.

Note:
You cannot set a maximum number of databases searchable at one time
that is fewer than the number of databases you have selected for follow-
on searches. See Remote Database Usage Settings for PowerPAC.
Conversely, you cannot select more follow-on databases than your setting
for the maximum number searchable at one time.

Remote Database Usage Settings for PowerPAC

You can set usage conditions for individual remote databases, including use in the
PowerPAC quick-select drop-down, limits on records returned and search time, use as
follow-on databases, access restrictions, and search access points.
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See also:

l Follow-On Search Display in PowerPAC
l Default Remote Databases for PowerPAC Searches
l Configure remote database usage settings

Follow-On Search Display in PowerPAC

You can enable a prompt to the PowerPAC user for a follow-on search of databases pre-
selected by the library, when a search of the local database returns no hits. This feature
is most effective when you specify follow-on target databases that all your patrons can
access, regardless of branch, location, or logon status; for example, a state union
database.

If you have enabled follow-on searching and designated follow-on databases (see
Configure remote database usage settings), a message and link are displayed when the
PowerPAC user searches the local database only and no hits are found. If you have not
enabled the Show total hits in follow-on search databases option (see Configure
remote database usage settings), the user must click or tap the link to determine if there
are results in the follow-on databases.

If the Show total hits in follow-on search databases option is enabled and no results
are found, no message is displayed. If there are results in the follow-on databases, the
message displays the search link and the total number of hits found in the follow-on
databases.

Note:
If Show total hits is enabled, the search is performed in the background
regardless of whether the user links to the results. The remote database
will likely count the search for statistical purposes. If Show total hits is
not enabled, no searches are done unless the user clicks or taps the link
to see the results.

When follow-on searching is enabled, the user does not have to retype the search term
when the follow-on search is launched. However, if any of the follow-on databases
require logon, and the user has not logged on, the database requiring logon is not
searched. Only those follow-on databases that do not require logon are searched, and
an error message is displayed in the search status window for the databases that could
not be searched. Similarly, if the library has selected databases that are not accessible
to the current user (perhaps because of the user’s registered branch, location, or patron



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 267

code), those databases are not searched and an error message is displayed in the
search status window for the databases that could not be searched.

The follow-on databases (and the local database) are also automatically selected on the
Select Databases light box (see Select Databases Lightbox in PowerPAC). All
subsequent searches use the selected databases, until the user resets the search
databases or ends the session. The Reset Databases option is also displayed next to
the Select Databases option on the search form.

Default Remote Databases for PowerPAC Searches

You can specify a remote database or databases to be included by default in PowerPAC
search results. When you have set this option, patrons do not have to deliberately select
the databases for searching using the Select Databases feature, but they can deselect
them to omit the database results from a search if they choose.

Be sure the database servers are registered in Polaris, and that resource groups have
been specified if necessary. See the Polaris Administration Guide.

Note:
The PowerPAC profile Remote databases: Maximum number that can be
searched at once sets the maximum number of databases that can be
searched at one time. The system honors this limit when including remote
databases to be searched by default. For example, if you set the
maximum number that can be searched at once to 10, but select 12 to be
searched by default, only the first 10 will be selected in PowerPAC.

See Configure remote database usage settings for set-up instructions.

Configure remote database usage settings

Usage settings for remote databases can be defined at the system, library, or branch
level. To configure usage for each remote database:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click the Remote databases: Usage settings profile. The Remote Data-
bases: Usage Settings dialog box opens.
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The database list is filtered based on the organization’s resource group
membership. The number of entries is displayed at the top of the list. The Follow
On column indicates whether the database has been configured to be a follow-on
search database for the organization (see step 6).

Note:
Each database can inherit configuration settings independently of the
other databases. The icon to the left of the database name indicates the
level at which the database was configured.

3. To enable any remote databases to be suggested automatically if a search of the
local database yields no results, select the Enable follow-on search after zero hits
in local database search checkbox. To also show the total number of hits in the
follow-on search databases, select the Show total hits in follow-on search data-
bases checkbox.

Once follow-on searching is enabled, you can set specific databases for the
follow-on search. See step 6.

4. Select the database you want to configure, and click Configure Database. The Con-
figure <Database Name> dialog box opens to the Parameters tabbed page.
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Note:
The Revert button returns all settings in this dialog box to those of the
parent organization (System, Library, or System defaults).

5. (Optional) Specify a PowerPAC display name for this database, if you want a name
other than that shown.

6. To designate this database for follow-on searching, select Enable for follow-on
searching.

Note:
This option is available only if follow-on searching has been enabled for
remote databases on the Remote Databases Usage Settings dialog box
(see step 3). The database must also be added as a search target for this
organization’s PAC. See Organizing Target Databases for PowerPAC
Display.

Consider selecting databases that are universally available to all patrons,
regardless of location (all branches, both in-house and remote locations) or patron
code, and that do not require logon. If you select a database that requires logging
on, the patron will be required to be logged on before the follow-on search occurs.
If you select a database that is not available to all patrons, then that database will
not be searched during the follow-on search. See Follow-On Search Display in
PowerPAC.
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Note:
You cannot select more follow-on databases than the limit set with the
PowerPAC profile Remote databases: Maximum number that can be
searched at once. See Maximum Number of Databases Searchable at
One Time. Conversely, you cannot set a maximum number that is fewer
than the number of follow-on databases you have selected.

7. To enable interlibrary loan (ILL) requests from the PowerPAC for this remote data-
base, select Enable ILLs in PAC. This checkbox is checked by default. If you do
not want to enable ILL requests for this database, clear the Enable ILLs in PAC
checkbox.

Important:
To allow ILL requests to be sent to remote databases from the PAC, the
Enable checkbox must be selected in the ILL options dialog box available
from the Parameters Request tab (Parameters, Request, ILL options).

8. To include this database in PowerPAC searches by default, select Include by
default. For more information about this feature, see Default Remote Databases in
PowerPAC Searches.

Note:
The PowerPAC profile Remote databases: Maximum number that can be
searched at once sets the maximum number of databases that can be
searched at one time. The system honors this limit when including remote
databases to be searched by default. For example, if you set the
maximum number that can be searched at once to 10, but select 12 to be
searched by default, only the first 10 will be selected in PowerPAC.

9. To include the database in the Using drop-down list box in the PowerPAC, select
the Include in quick-select drop down checkbox.

The illustration shows an example from PowerPAC.
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The PowerPAC Using field always includes the local database. When at least one
remote database is specified for the Using quick-select drop down, the drop-down
list includes the local database and any remote databases specified for inclusion.
However, the drop-down list suppresses a database from display according to
access restrictions (see steps 13-16), even if it is selected for inclusion.

Note:
A database must be selected to appear in at least one place in the
Remote Databases: Categorization of Target Databases dialog box for
the organization. See Organizing Target Databases for PowerPAC Display.
If the database is not currently categorized and you select Include in
quick-select drop down, a warning message appears and the selection is
stopped.

10. Specify the retrieved records limit by selecting a number in the Maximum number
of records to return box.

11. Specify the search time limit in seconds by selecting a number in the Maximum
search time (seconds) box.

12. Click Save.
13. Click the Authentication tab to set the authentication methods. The Authentication

tab page has three subtabs: Restrictions, Patron Codes, and IP Addresses. The
Restrictions subtab is displayed first.
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14. On the Restrictions subtab, specify whether and how patrons access the database
from in-house computers within the library and from remote computers:

a. Select one of the following options under In-house access:

l Disabled - Prevents patrons from accessing the database from a library computer.

l Login required - Requires patrons to log on with their library account credentials to
access the database from a library computer.

l No login required - Patrons can access the database from a library computer
without logging on.

Note:
For information about setting the criteria that determine whether a
workstation is in-house or remote, see the Polaris Administration Guide.

b. Select one of the following options under Remote access:

l Disabled - Prevents patrons from accessing the database from a computer out-
side of the library.

l Login required - Requires patrons to log in with their library account credentials to
access the database from a computer outside of the library.

l No login required - Patrons can access the database from a computer outside of
the library without logging in.

15. To control access to the database by patron code, select the Patron Codes subtab,
and select the patron codes to restrict. Patrons whose records have the selected
patron code will be prevented from accessing the database.
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Important:
If you choose to restrict access by patron code, you must also require the
patron to log in (see Step 13). If you do not require log-in, your settings for
restricted patron codes are ignored.

16. To allow access to the remote database by the IP address of the PAC search com-
puter, select the IP Addresses subtab, and do the following:

l Type the IP address in the top boxes and click Add.
l To include an IP address range, select Enter IP range, type the beginning IP

address in the top boxes and the last two digits of the ending IP address in the bot-
tom boxes.

The IP addresses allowed access are listed in the Allowed IP Addresses box.

l To remove an IP address, select it and click the Remove button.
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17. Select the UI Options tab to define the search access points that are available for
the selected database and search type as follows:

Note:
The default access points for all search types are: Author, Subject, and
Title.

l Keyword - Select the access points available for a keyword search with this data-
base selected. ISBN and Any field are additional default access point for keyword
searches.

l Advanced - Select the access points available for an advanced search with this
database selected. ISBN and Any field are additional default access point for
advanced searches.

l Phrase - Select the access points available for a phrase search with this database
selected. Any field is an additional default access point for phrase searches.

l Exact - Select the access points available for an exact search with this database is
selected.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 275

Your settings also control the types of searches available in the PowerPAC Other
Searches dashboard that is displayed with results when this database is searched.

18. Click Save to save the settings.

Related Information

Filtering PAC remote database search results - You can set up a Contextual Query
Language (CQL) filter for a particular Z39.50 connection that filters the results to show
only those materials that patrons can actually request. See the Polaris Administration
Guide.
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Managing E-Sources

E-sources are subscription databases presented as search links on an e-sources page in
Polaris PowerPAC. The library may limit access to specific e-sources, often to comply
with the terms of the database subscription.

Unlike federated databases, which can be searched simultaneously along with the local
catalog, e-source databases are searched separately. When the patron selects an e-
source target, the patron uses the provider’s interface for searching (not the PowerPAC
interface). When the e-source session is finished, the Polaris PowerPAC session is
resumed.

Tip:
You can also offer remote databases that can be searched
simultaneously in PowerPAC. See Managing Federated Search Targets.

To set up e-source targets, you need to get the appropriate connection information from
the e-source provider and enter it in the PowerPAC profile, Categorization of e-source
targets.

See also:

l Setting Up E-Source Targets
l Organizing E-Source Targets
l "E-Source Reports" in the Polaris Basics Guide

Setting Up E-Source Targets

To set up an e-source target for Polaris PowerPAC, you specify how the connection to
the database is made, and set any authentication criteria and access restrictions. The
terms of your library’s contract with the e-source provider may require authentication
from your system when a patron attempts to connect to the e-source. Authentication
identifies your library as a subscriber to the e-source provider. When a patron selects an
e-source, and the access criteria are met, authentication data for the library is
automatically passed to the e-source target for validation, bypassing the provider’s
logon page. You can allow access from in-house workstations, remote workstations, or
both, and set separate logon requirements for each location. You can further define
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access by preventing patrons with certain patron codes from accessing an e-source
target, and by setting specific IP addresses for access.

See also:

l Set up an e-source target
l Example - E-Source Target Post Transfer Type
l Example - E-Source Target Get Transfer Type
l Provide links to e-sources on external sites
l Organizing E-Source Targets

Set up an e-source target

To set up access restrictions and authentication data elements for an e-source target:

1. Obtain the following information from the e-source target provider:

l URL for the target’s login page - The complete URL for the target’s login page (not
the site’s home page, or account setup page). Polaris automatically passes your
library’s authentication information to this URL.

l Connection data parameters  - Connection data parameters are set up in sets con-
sisting of Name and Value. Name is the descriptive field name that the database
provider uses to prompt for input. Value is the actual text string that the database
provider assigns to your library when the subscription is established.

Example:
A vendor requires a user ID and a password to access a database, so you
define two parameters (two sets of Name and Value data elements). For
the first set, Name is UserID. Value is WESTSIDELIBRARY. For the second
set, Name is Password and Value is read.

l Transfer type (Get or Post) - The protocol for passing authentication data from
your library to the e-source target. Get displays authentication information in the
URL string, unless Secure Socket Layer (SSL) is enabled at the server level.
Post does not display the authentication information. Most vendors can use the
post method. To determine this information yourself, see Example - E-Source Tar-
get Post Transfer Type and Example - E-Source Target Get Transfer Type.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.
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3. Double-click Categorization of ESource targets. The ESource Categorization dia-
log box appears.

Tip:
Click Revert to restore system-level settings.

4. Select a category for the new target (optional), and click Add Target. The Add
ESource Target dialog box appears.

Note:
Root is the default category, represented by a tree icon. Other categories
are represented by folder icons. See Organizing E-Source Targets.

5. Set up general information for the target as follows:
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l Type a name for the target in the Name box. This name is displayed on the PAC E-
Sources page.

l Type a brief (890-character maximum) description in the Description box, if you
want to display a description on the PAC E-Sources page.

Tip:
The message can inform patrons of any use restrictions for the target, or
to highlight a new offering.

l Type a brief message in the Message box, if you want to display a message to pat-
rons regarding the target.

l Input the complete URL for the target’s log-in page in the URL box.
l Select Get or Post in the Transfer Type box (see step 1). If you are unsure of the

transfer type, see Example - E-Source Target Post Transfer Type and Example - E-
Source Target Get Transfer Type.

6. To set in-library access to the target, select an option under Inhouse access (Gen-
eral Restrictions tabbed page):

l To make the e-source unavailable to in-house users, select Disabled.

Note:
If you disable access for both in-house and remote users (see step 7), the
e-source will be displayed on the PowerPAC page as unlinked text.

l To make the e-source available from in-house workstations only to registered pat-
rons, select Login required. If you select this option, you can further restrict
access by blocking selected patron codes. See step 8.

l To make the e-source available from in-house workstations to anyone, select No
login required.

By default, if a workstation is registered in Polaris Administration, it is
automatically considered “in-house.” If the workstation is not registered in Polaris
Administration, but the IP address is listed in the system-level In-House IP
Addresses database table, it is considered to be in-house. If you use Polaris
PowerPAC on workstations within the library, you may want to list them in the In-
House IP Addresses database table. If neither the workstation nor the IP address
is found in the system, the user is considered remote.

Note:
By default, the system checks both the In-House IP Addresses table and
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registered workstations to determine if a computer is in-house. However,
if you experience performance issues related to e-source restrictions, you
can set the system to check only the In-House IP Addresses table.

7. To set remote access to the target, select an option under Remote access (Gen-
eral Restrictions tabbed page):

l To make the e-source unavailable to remote users, select Disabled.

Note:
If you disable access for both remote and in-house users (see step 6), the
e-source will be displayed on the PowerPAC page as unlinked text.

l To make the e-source available from remote workstations only to registered pat-
rons, select Login required. If you select this option, you can further restrict
access by blocking selected patron codes. See step 8.

l To make the e-source available from remote workstations to anyone, select No
login required.

8. If you have required login for in-house or remote access, and you want to prevent
patrons with certain patron codes from accessing the target, follow these steps:

a. Click the Patron Codes tab on the Add E-Source Target dialog box.
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b. Select the codes you want to prevent from accessing the target. Patrons who are
assigned these codes cannot access the e-source target.

Important:
Your patron code settings are used only if you have required log-in for in-
house or remote access.

9. If you want to allow access only from certain IP addresses, follow these steps:

Important:
Set this restriction if you want to allow access only from the specific IP
addresses listed here. If at least one address is listed, the system blocks
access from any workstations or IP addresses that are not listed here,
regardless of any other access restrictions you may have set. You might
use this setting to limit access to a very specialized (and costly) research
site.

a. Click the IP Addresses tab on the Add ESource Target dialog box.

b. Define IP addresses using one of the following methods:

l To define IP addresses one at a time, type each IP address in the boxes and click
Add. The addresses are displayed in the Allowed IP Addresses list.
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l To define a range of IP addresses, select the Enter IP Range checkbox. Then enter
the first address of the range in the IP address boxes, and enter the last address of
the range in the End of IP Range boxes. Click the radio button below the appro-
priate End of IP Range box to specify if the last number in the range is in that
address segment. Click Add to add the range to the Allowed IP Addresses list.

Note:
To remove IP addresses from the Allowed IP Addresses list, select the
address and click Remove. Use CTRL+select or SHIFT+select to select
multiple entries.

10. Set connection parameters for the target by following these steps:

a. Click the Connection Data tab on the Add ESource Target dialog box.

b. Type a name in the Name box, type a value in the Value box for the first parameter,
and click Add.

Note:
The Name requirement is specific to the vendor, and the Value
requirement is set up in your organization’s account with the vendor. See
step 1.
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c. Repeat step b to add as many parameters as the e-source provider requires for
connection authentication.

11. Click OK on the Add ESource Target dialog box. The new target is represented by
a book icon in the ESource Categorization dialog box.

12. Click OK on the ESource Categorization dialog box.

Related Information

l Connection setup examples - Example - E-Source Target Post Transfer Type and
Example - E-Source Target Get Transfer Type

l Modify an e-source target - Select the target in the ESource Categorization dialog
box, and click Modify. The Modify ESource Target dialog box offers the same func-
tions as the Add ESource Target dialog box.

l E-Source reports - You can print a report of the e-source targets you have set up,
including any access restrictions and connection requirements. You can also
choose to log e-source transactions for custom reports. See E-Source Reports.

Example - E-Source Target Post Transfer Type

This procedure lists how to enter a URL and view source code to set up connection
authentication to EBSCOhost as an example of post transfer type. See Set up an e-
source target for a detailed procedure on setting up e-sources.

1. On the PowerPAC profiles tab for the organization, double-click Categorization of
ESource targets.

2. Click Add Target on the ESource Categorization dialog box to display the Add
ESource Target dialog box.

Tip:
If the library has an existing subscription with the supplier that uses IP
authentication, the logon page is automatically bypassed. You can access
the logon page by working from an IP outside the subscribed range.

3. Open a Web browser, and access the online log-in form for the vendor. The
example shows EBSCO at http://search.ebscohost.com.
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4. Copy the URL in the browser address bar, and paste it into the URL field on the Add
ESource Target dialog box. (Keep the browser window open.)

Note:
As a general rule, if the URL contains a question mark, copy all the text
before the question mark. Do not copy the question mark or any text
following it.

5. Return to the browser menu bar, and select Page, View Source. The HTML source
code for the logon page is displayed in your default text editor.
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6. Determine the transfer method by following these steps:

a. Select Edit, Find (or press CTRL+F) to display a Find dialog box.
b. Search for the text string form or method.

The transfer method in this example is post.

7. On the Add ESource Target dialog box, set the Transfer Type to Post.
8. On the source code window, determine the logon parameters by following these

steps:

a. Select Edit, Find (or press CTRL+F) to display a Find dialog box.
b. Search for the text string input. Ignore input type= “hidden” entries. Look for asso-

ciated name= statements.
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For the purposes of this example, the EBSCOhost logon form requires two
parameters. Each parameter has a name (user and password) that you enter in the
Name box on the Connection Data tabbed page of the Add ESource Target dialog
box (see step 9). Each parameter also requires a value specific to your
organization.

Important:
Vendors with multiple databases usually require a separate set of
parameters for each database. Typically, two parameters in the set are
your library’s user name and password; a third parameter is named db and
the value is the code for the specific database.

9. On the Connection Data tabbed page of the Add ESource Target dialog box, set
the first EBSCOhost parameter by following these steps:

a. Type user in the Name box.
b. Type your organization’s subscriber name (as determined by your organization

and EBSCO) in the Value box.
c. Click Add.

The first parameter is listed in the Parameter box.

10. Set the second EBSCOhost parameter by following these steps:
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a. Type password in the Name box.
b. Type your organization’s password (as determined by your organization and

EBSCO) in the Value box.
c. Click Add.

The second parameter is listed in the Parameter box.

11. Close the logon source code window, and exit from the browser.
12. On the Add ESource Target dialog box, specify a description and a message, if you

wish, and set any access restrictions. See Set up an e-source target.
13. Close the Add ESource Target dialog box, and save your changes. See Set up an e-

source target.

Example - E-Source Target Get Transfer Type

This procedure lists how to enter a URL and view source code to set up connection
authentication to Gale as an example of get transfer type. See Set up an e-source target
for a detailed procedure on setting up e-sources.

Note:
Database suppliers may require different authentication routines for
different databases. Therefore, the authentication setup for one Gale
database may differ from the setup for another Gale database. The
following procedure is an example only. You must contact your vendor to
get your library-specific connection information.
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1. On the PowerPAC profiles tab for the organization, double-click Categorization of
ESource targets.

2. Click Add Target on the ESource Categorization dialog box to display the Add
ESource Target dialog box.

Tip:
If the library has an existing subscription with the supplier that uses IP
authentication, the logon page is automatically bypassed. You can access
the logon page by working from an IP outside the subscribed range.

3. Open a Web browser, and access the online logon form for Gale at http://-
gale.cengage.com.

4. Copy the URL for the logon form that now displays in the browser address bar and
paste it into the URL field on the Add ESource Target dialog box. (Keep the
browser window open.)

Note:
As a general rule, if the URL contains a question mark, copy all the text
before the question mark. Do not copy the question mark or any text
following it.
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5. Return to the browser menu bar, and select Page, View Source. The HTML source
code for the log-in page is displayed in your default text editor.

6. Determine the transfer method by following these steps:

a. Select Edit, Find (or press CTRL+F) to display a Find dialog box.
b. Search for the text string form or method.

The transfer method is get.

7. On the Add E-Source Target dialog box, set the Transfer Type to Get.
8. On the source code window, determine the logon parameters by following these

steps:

a. Select Edit, Find (or press CTRL+F) to display a Find dialog box.
b. Search for the text string input. Ignore input type= “hidden” entries. Look for asso-

ciated name= statements.
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For the purposes of this example, the Gale log-in form requires two parameters.
Each parameter has a name (userName and password) that you enter in the
Name box on the Connection Data tabbed page of the Add ESource Target dialog
box (see step 9). Each parameter also requires a value specific to your
organization.

Important:
Vendors with multiple databases usually require a separate set of
parameters for each database. Typically, two parameters in the set are
your library’s user name and password; a third parameter is named db and
the value is the code for the specific database.

9. On the Connection Data tabbed page of the Add ESource Target dialog box, set
the first Gale parameter by following these steps:

a. Type userName in the Name box.
b. Type your organization’s subscriber name (as determined by your organization

and Gale) in the Value box.
c. Click Add.

The first parameter is listed in the Parameter box.

10. Set the second Gale parameter by following these steps:

a. Type password in the Name box.
b. Type your organization’s password (as determined by your organization and Gale)

in the Value box.
c. Click Add.

The second parameter is listed in the Parameter box.
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11. Close the logon source code window, and exit from the browser.
12. On the Add ESource Target dialog box, specify a description and a message, if you

wish, and set any access restrictions. See Set up an e-source target.
13. Close the Add ESource Target dialog box, and save your changes. See Set up an e-

source target.

Provide links to e-sources on external sites

After you set up e-source targets, you can place links to specific e-source targets in
other Web site locations, outside the catalog. To find and copy the e-source link:

1. Right-click the e-source target on your PowerPAC e-sources page and select Prop-
erties from the context menu. The Properties dialog box displays the URL in the
Address (URL) field.

2. To select the link, position the cursor at the start of the Address (URL) field, hold
down the Shift key, and use the down arrow key to select all of the text.

3. Right-click the selected URL, and select Copy.
4. Paste the URL as a hypertext link. The external link uses the authentication criteria

and access restrictions placed on the target.
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l If the e-source does not require logon, the user will go directly to that e-source.
l If a logon is required, the user will go to the library’s e-sources page where they

can click a link to log on.

Organizing E-Source Targets

By default, all e-source targets are displayed as a single (potentially long) list on the PAC
e-Source page. To make it easier for patrons to find e-source targets, you can organize
the targets list into categories and subcategories. For example, you might organize e-
source targets by subject matter categories, such as Business and Education, and
perhaps define subcategories within these categories. You can set up categories at the
system, library, or branch level. If categories are not set up for an organization, the
organization scheme from the parent level is used.

A specific e-source target can be represented in multiple categories. You can add a
target to a category when you set up the target, or you can copy targets from other
categories. The copied targets are linked, so if you modify a target in one category, the
same change is made to the linked targets in other categories. Categories can be
copied, pasted, renamed, and deleted.

To organize the library’s e-source targets into categories and subcategories:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Categorization of ESource targets. The ESource Target Cat-
egorization dialog box appears.

3. To add a category, do these steps:

a. Select (highlight) the folder to which you want to add a category. Root, the default
category, cannot be copied, deleted, or renamed. If you are adding a new category
to the root level, select Root. If you are adding a subcategory to an existing cat-
egory, select the existing category folder.

b. Click Add Category. A folder icon appears in the Category tree view, with the
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cursor positioned to name the folder.
c. Type a category heading, and press ENTER.

4. Use the following methods to place e-source targets in categories:

l Add individual e-source targets to a category. See Set up an e-source target.
l Copy an existing e-source target (book icon) to another category. Select the target

in the ESource Categorization dialog box, and click Copy. Then select the category
where you want to place the copy of the target, and click Paste. This procedure cre-
ates targets that are linked. Any change to one target is applied to all the linked tar-
gets.

5. To set the display order in the PAC, select a category or target and click Up or
Down. Repeat until the categories or targets are in the display order you want.

Note:
On the PAC e-sources page, targets defined at the Root level are always
displayed below any categories.

6. Click OK.

Related Information

l Delete an e-source target - Select the target in the ESource Target Categorization
dialog box, and click Delete. Deleting a target from a particular category, including
Root, does not delete it from other categories. Deleting a linked target only
removes the target from the current category, unless the target is part of a linked
category; any linked targets remain in the other categories.

l Copy a category - Select the category in the ESource Target Categorization dialog
box, and click Copy. Then select the category where you want to place the copy,
and click Paste. This procedure creates categories that are linked, indicated by a
hand on the folder icon. When you copy categories, all subcategories and targets
are copied, and all the copied subcategories and targets also become linked. Any
change to one category is applied to all the linked categories. To remove a link,
select the category you want to make stand-alone, and click Unlink.

Note:
You cannot paste a category at the same level as the original category.
There cannot be two subcategories with the same name within a
category.
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E-Source Reports

The E-Source report lists the subscription databases you have set up for searching from
the PAC e-sources page, organized by branch. Information about each e-source includes
the name, description, connection URL, message, categories/subcategories, restriction
data, and connection data. You can filter the report by organization. To access this
report, select Utilities, Reports and Notices from the Polaris Shortcut bar, and select
PAC in the Polaris Reports dialog box. For information on generating reports, the Polaris
Basics Guide.

For the purposes of custom reports, you can choose to log the transaction when a
patron accesses an e-source target:

l Transaction - E-Source Access

l Transaction code - 2201

l Transaction subtypes
o 239 - Remote User flag
o 240 - Selected Language ID
o 241 - Name of e-source selected to view
o 7 - Patron Code (if patron logged on)
o 123 - Patron Assigned Branch (if patron logged on)
o 33 - Patron Statistical Code (if patron logged on)

For information about logging transactions, see the Administration Guide.
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Polaris Social with ChiliFresh Connections

With Polaris Social, the library’s catalog becomes a gateway to a worldwide network of
readers, allowing patrons to share the books they read, see what others are reading, and
discover new books based on the social network connected to a title. Polaris Social
offers integrated social functions in Polaris PowerPAC through a collaboration with
ChiliFresh Connections, with interactions embedded in Polaris PowerPAC. Navigation to
and from each ChiliFresh Connections feature is seamless, and users enjoy a single,
unified interface in Polaris PowerPAC. Features include single sign-on through PAC; the
ability to set up a patron profile; create lists of books that other readers can see; follow
what readers with similar tastes are reading; see the network of patrons connected to a
title; add recommendations, reviews and tags to titles, and more. For information about
ChiliFresh Connections, see www.chilifresh.com.

While ChiliFresh provides the library system administration options for controlling
feature display and functionality, Polaris designates the placement of the ChiliFresh
Connections features in Polaris PowerPAC. Accessing ChiliFresh Connections features
from PowerPAC requires no further authentication once patron logon occurs in Polaris
PowerPAC, and the patron has registered for the first time in ChiliFresh Connections.
Patrons can manage Connections user account information as part of My Account in
Polaris PowerPAC. For any catalog items in the ChiliFresh database, patrons can add
tags and view library users.

Note:
The font type and color scheme for ChiliFresh Connections information
displayed in Polaris PowerPAC matches the PowerPAC theme. The
PowerPAC display does not use any font or color customizations created
by patrons in ChiliFresh Connections.

In the Polaris themes/shared folder, ChiliFresh Connections has its own
style sheet (chilifresh.css). Customers who have a custom theme and
wish to override the default chilifresh.css file should copy the file from the
themes/shared folder to the custom theme folder and edit the custom
version accordingly. Unlike the main styles.css page with overrides, the
custom chilifresh.css page must contain all the CSS classes from the
default version.

Polaris Social with ChiliFresh Connections is a separately licensed feature at the branch
level. You can also offer reviews from ChiliFresh under a separate ChiliFresh contract,

http://www.chilifresh.com/
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without offering the full features of ChiliFresh Connections. However, ChiliFresh reviews
without ChiliFresh Connections require separate patron authentication. Search the
Polaris online help for "ChiliFresh Enriched Data."

See also:

l Exporting Records to the ChiliFresh Database
l Patron Log-In and ChiliFresh Connections Registration
l Social Features in the PowerPAC Patron Account
l Social Features in Search Results
l Set Up ChiliFresh Connections in Polaris Administration

Exporting Records to the ChiliFresh Database

To display Chilifresh Connections content in PAC, you must initially export a file
containing all your library’s MARC bibliographic information to ChiliFresh. Use the
Polaris staff client Utilities, Export function to upload the records, using the default
option Extract All Final MARC 21 Records. Instructions are available on the ChiliFresh
Connections Admin page. For subsequent exports of newly acquired titles, define the
appropriate date range for the export using the Extract Only MARC 21 Records
Added/Changed from Date option.

Patron Login and ChiliFresh Connections Registration

Within PowerPAC, a patron can easily link his or her library account to a new or existing
ChiliFresh account. Once the link is established, the patron logs on with library account
credentials to access Connections features within PowerPAC.

A patron who has not logged on can start this process by clicking or tapping any
Connections function that requires logon. For example, the registration process can be
initiated from search results Connections functions in the patron’s search results, or by
clicking or tapping Connections on the menu bar and logging on.
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Once logged on, the patron receives a sign-up message for social features, and can click
or tap a link to connect the library account to a new or existing ChiliFresh account.

For new accounts, the patron clicks or taps the Create a nickname option, supplies a
nickname, and specifies the birth date. The nickname is the public name exposed to
other users of Polaris Social functions. If the library’s setup with ChiliFresh requires a
birth date and the patron is under 13, a message is displayed and the sign-up is
canceled. To link an existing ChiliFresh account, the patron clicks or taps Use an
existing ChiliFresh Connections account and supplies the email address and password
associated with the account.
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A similar process occurs when a patron who has not logged on clicks or taps a
ChiliFresh feature such as Rate or review in search results.

After the library account and the ChiliFresh account are linked, the patron who is logged
into PAC does not have to log on to ChiliFresh Connections to use those Connections
features in PAC that require logon.

Logging off in PowerPAC also logs the patron off the ChiliFresh Connections account.

Note:
Logging on to ChiliFresh Connections from outside PowerPAC does not
log the user on to the PowerPAC (library) account.

When the library account and the ChiliFresh account are linked, deleting an existing
Connections account from the ChiliFresh Connections site removes the shared logon
credential from PAC. The patron can create a new shared logon credential between the
PAC patron account and Connections by re-registering with Connections via PAC, as
described above.

Social Features in the PowerPAC Patron Account

Social features are available to logged on patrons from the PowerPAC patron account.
The patron can click or tap Connections in the dashboard or Connections in the menu
bar to display these features.
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The Connections account page offers links for invitations, comments, messages,
recommendations, and suggested connections. Each of these features opens in a
lightbox. Below, five content “drawers” contain ChiliFresh Connections user account
data. They are initially displayed as collapsed, but the user can choose to expand
individual drawers, expand all, or collapse all.

ChiliFresh Connections notifies patrons by email when they receive a new message,
recommendation, invitation, or comment. The email message contains a logon link to
the email recipient’s PAC branch. ChiliFresh Connections defines this notification
functionality, including text of the email message and which Connections actions will
initiate a notification.

Bookshelves Drawer

Bookshelves may include My library, My current reads, My wishlist, and any custom
bookshelves (lists) the patron has created.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 300

Books can be added to any bookshelf by clicking or tapping the Search for more
bookslink. (Books can also be added to bookshelves from the patron’s search results.
See Social Features in Search Results.) If a bookshelf currently has contents, the list can
be sorted by Latest, Author, Title, Ascending alphabetical, or Descending alphabetical.

Icons next to each title offer options to remove the title from the bookshelf, set the title
as a current read, or move the title to another shelf. The illustration above shows the
interface when the patron chooses to move the title to another shelf.
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Friends and Followers Drawer

This drawer displays five sections:

l My friends - The patron’s ChiliFresh Connections friends. The patron can invite
friends, see all friends, or browse library users to find other Connections users
registered at the library. Each library user’s name is accompanied by an Add Friend

icon .

l Users following me - Users who follow the logged-in patron.

l Following users - Users whom the logged-in patron follows. You can also select
View recent updates to see recent activity.

l Find users - The logged-in patron can search for any ChiliFresh Connections user
by user name or email address. When the patron selects the link for another
ChiliFresh Connections user, that user’s profile page is displayed.

On that page, the logged-in patron can click or tap a title to display the brief title
information in PowerPAC, as in the patron’s own profile. The social drawers are also the
same. The following features are available by clicking the icons:
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l Add to friends - Sends a friend request to the ChiliFresh user; if the user
accepts, he or she is added to the patron’s friends list.

l

Send message - Sends a message to this user.

l

Add comment to corkboard - This option adds a comment to the user’s
Comments list, and sends the user an e-mail alert.

l

Follow/unfollow this user - Adds the patron to the Followers list on the
ChiliFresh user’s profile and adds the ChiliFresh user to the Following list on the
patron’s profile (or reverses the operation).

Reviews Drawer

This drawer displays the reviews the patron has already submitted. The patron can
select a title to display search results for that title in PowerPAC. Reviews can be added
from search results. See Social Features in Search Results.

Edit My Profile Drawer

The patron can edit the Connections profile picture, nickname, “My Interests” (favorite
authors, books, movies), and Facebook, Twitter, or LinkedIn link settings. The ChiliFresh
site provides more information about these link settings.

Link to Connections Drawer

This drawer is a link to the ChiliFresh Connections site, which opens in a lightbox. The
system uses the linked ChiliFresh Connections authentication for the logged on patron
to log on to the ChiliFresh Connections site.
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After the patron makes account changes in the Chilifresh Connections lightbox window,
the PowerPAC patron account drawer content is refreshed when the account page is
refreshed.

Social Features in Search Results

Ratings and Reviews
Logged on users can rate titles, add reviews, and read reviews from other readers. The
user clicks or taps Rate or review (for titles with no previous reviews) or Review (for
titles with previous ratings or reviews) to open this feature in a lightbox. This illustration
shows a title with no previous reviews.
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Add to Shelf
In PowerPAC initial (brief) search results, an option to add the title to a ChiliFresh
Connections bookshelf is displayed under other Chilifresh content, such as the book
jacket image and the ratings/reviews link.
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When the logged-in patron selects Add to Shelf, a list of bookshelves associated with
the patron’s account is displayed (see Bookshelves Drawer).

Note:
If the patron is not logged in, he or she is prompted to do so.
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Note:
If the title has already been added to one of patron’s bookshelves, the
displayed link is Already on Shelf.

When the patron selects a bookshelf, the bookshelf opens in a lightbox, with the newly-
added title at the top. Icons next to each title offer options to remove the title from the
bookshelf, set the title as a current read, recommend the title to a friend, or move to the
title to another shelf. The patron can also click or tap Manage shelves. This option
opens a light box where the patron can set up a new bookshelf, specify a default
bookshelf, delete custom bookshelves, and choose a bookshelf for display in the
lightbox.
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More Options

More options are available from the product page (full display) of a title in PAC. The
product page includes the Add to Shelf/Already on Shelf option. In addition, the patron
can select More Options to display additional ChiliFresh Connections options:

l Related Users - Selecting this link displays a lightbox that lists users who have
taken an action on the item, such as adding it to their shelf or reviewing it.
Selecting a Connections user in the lightbox opens the public profile display of that
user (see Friends and Followers Drawer).

l Related Items - This option displays a lightbox with “you might also like” titles
related to the currently displayed title. ChiliFresh determines what titles are
“related.” Selecting any item from the list of related items launches a search in
PowerPAC and displays the product page for the selected title.
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l Tags - Selecting Tags opens the Connections tags widget in a lightbox. The patron
may add a new tag or select an existing one. Selecting a tag in the lightbox
navigates within the lightbox to the ChiliFresh Connections list of titles associated
with that tag; selecting a title launches a search and displays the brief result for
the title.

l Comment - The patron can select this option to add the title as a favorite or post a
comment. The Playback option shows any existing discussion (comment thread).

l Share - Selecting any of the options in the Share lightbox shares a deep link to the
PowerPAC product page for the title via e-mail or on the appropriate social media
site.

l Recommend - The patron can recommend the title to another Connections user, or
email the recommendation to a friend.

l Go to Connections - This option opens the ChiliFresh Connections site in a
lightbox. See Link to Connections Drawer.
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Set Up ChiliFresh Connections in Polaris Administration

Open the PAC profile Enriched data for the PowerPAC connection organization. On the
ChiliFresh - Other Features tabbed page, select Enable and supply your ChiliFresh
Service URL, account ID, and API key. Search Polaris online help for "Set up enriched
data - ChiliFresh." See Set up enriched data - ChiliFresh.

For information about port 80/443 access requirements, search Polaris online help for
"Enriched Data Domains Requiring Port 80/443 Access."
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Enabling Enriched Data

The term “enriched data” describes a variety of third-party services that enhance a title’s
display in the PAC. Depending on your contract with the vendor, the enriched data can
consist of a simple book jacket image, or contents, excerpts, reviews, ratings, and other
information related to the title. When enabled, enriched data is displayed automatically
in both Polaris PowerPAC and Mobile PAC search results.

In Polaris PowerPAC, when the patron clicks the title or the Full Display button for a title
in the search results list, the additional information is available in a series of content
“drawers” on the title’s product page. You can set the display order of the drawers and
whether each is initially expanded or collapsed. See Configuring the PowerPAC Product
Page. Reader ratings and reviews may also be displayed. When the patron clicks a link,
the selected information is displayed in a lightbox window. For a description of the
enriched content display in Mobile PAC, see Title Links: Enriched Content.

You can also display rotating book jackets on the Polaris PowerPAC home page, based
on the images supplied by your enriched data vendor, that launch a search for the title.
For more information, see Set up rotating book jackets. Book jackets are also featured
in content carousels. See Content Carousels on the PowerPAC Portal Page.

Polaris supports enriched data from Baker & Taylor; EBSCO’s NoveList®; Syndetics
Solutions (Bowker); Syndetics Unbound; ChiliFresh; OverDrive; and LibraryThing. Polaris
Social, a separately licensed product, offers ChiliFresh Connections features integrated
in Polaris PowerPAC. See Polaris Social with ChiliFresh Connections.

Note:
If you use Secure Socket Layer (SSL) to secure the entire PowerPAC site,
and you use content from third-party vendors, be aware that your patrons
may receive messages about allowing unsecured content. If you think the
messages will be a problem, contact your vendors to see if they can use
https. If so, you will need to change their URL settings from http to
https when you follow the procedures in this unit.

Enriched Data Domains Requiring Port 80/443 Access

If you lock down ports 80 and 443 on your PAC server, be aware that the following
domains must be open on the PAC server for these features to work properly on any
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browser client, including remote access clients:

Feature Domain Port More Setup Inform-
ation

Baker & Taylor
Content Cafe contentcafe2.btol.com 80 Baker & Taylor

Enriched Data

ChiliFresh Reviews &
Ratings secure.chilifresh.com 443 ChiliFresh Enriched

Data

Syndetics Reviews &
Ratings www.syndetics.com 80 Syndetics Enriched

Data

ChiliFresh
Connections

chilifresh.com
secure.chilifresh.com

80
443

Polaris Social with
ChiliFresh Connections

If the PAC browser session is run directly on the PAC server, the following domains
must be open for the features to work properly:

Feature Domain Port More Setup Inform-
ation

Baker & Taylor
Cover Images images.bol.com 80 Baker & Taylor

Enriched Data

ChiliFresh Cover
Images content.chilifresh.com 80 ChiliFresh Enriched

Data

LibraryThing
Reviews & Ratings ltfl.librarything.com 80 LibraryThing

Enriched Data

NoveList Select
(Suggestions and
More)

imageserver.ebscohost.com 80 EBSCO’s NoveList
Enriched Data

Syndetics Cover
Images www.syndetics.com 80/443 Syndetics Enriched

Data

Google Preview www.google.com 80
Google Preview for
PowerPAC Search
Results
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Feature Domain Port More Setup Inform-
ation

Google Analytics google-analytics.com 80/443

Set up basic
operating features
for Polaris
PowerPAC

Google Maps maps.google.com 80 Map It (Google
Maps) in PAC

ChiliFresh
Connections

chilifresh.com
secure.chilifresh.com

80
443

Polaris Social with
ChiliFresh
Connections

See also:

l Baker & Taylor Enriched Data
l EBSCO’s NoveList Select Enriched Data
l Syndetics Enriched Data
l ChiliFresh Enriched Data
l LibraryThing Enriched Data
l OverDrive Enriched Data

Baker & Taylor Enriched Data

You can use book jackets (cover images) from Baker & Taylor, and provide a variety of
Content Cafe links on the PowerPAC and Mobile PAC product pages.

Note:
For Baker & Taylor port access requirements, see Enriched Data Domains
Requiring Port 80/443 Access.

Note:
If you allow patrons to save searches to run automatically, cover images
are displayed in the results based on the Enriched Data settings for the
patron’s registered branch. For more information about setting up saved
searches, see Set up basic operating features for Polaris PowerPAC.
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To set up Polaris to use enriched data from Baker & Taylor, including Content Cafe:

Tip:
Cover images can be enabled for only a single vendor. Other enriched
data services may be received from multiple vendors.

1. Contact your vendor’s customer support department for help in obtaining your lib-
rary’s connection and authentication information for this enriched data provider.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

3. Double-click Enriched Data. The Enriched Data dialog box opens.

4. Click the Baker & Taylor tab, if it is not already selected.
5. If you receive cover images (book jackets) from Baker & Taylor, click the Cover

Images tab. Then select Enable.

Note:
If you use Baker & Taylor cover images for rotating book jackets on the
Polaris PowerPAC portal page, you must also supply Content Cafe
settings. See steps 8 through 10. For more information about setting up
rotating book jackets, see Set up rotating book jackets.
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6. In the URL Prefix (before ISBN) box, type the Web address and path to the Baker &
Taylor content domain or server that provides book jacket images.

This prefix is the part of the URL that comes before the title’s ISBN when a search
is launched at the Baker & Taylor site for the book jacket image. The default
setting is
http://images.btol.com/ContentCafe/Jacket.aspx?UserID={site_userid}&
Password={site_password}&Return=1&Value=

Contact your vendor to obtain the site user id and password to use in this setting.

The URL Suffix (after ISBN) setting is always &Type=S.

7. If you receive other content from Baker & Taylor’s Content Cafe, click the Content
Cafe tab.

8. Select Enable.
9. Type your Content Cafe user ID and password in the appropriate boxes. These are

the same settings you use for Baker & Taylor cover images. Contact your vendor
to obtain these settings.

10. Click OK.

Related Information

Polaris Bookstore with Baker & Taylor - See Enabling Online Book Purchases.
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EBSCO’s NoveList Select Enriched Data

If your library has a contract with NoveList Select, patrons see NoveList content in the
Polaris PowerPAC and Mobile PAC product pages. NoveList Select automatically
provides the appropriate connections for your library's NoveList contract. If you have
any questions or concerns about your NoveList subscription, contact EBSCO at
novelistselectsupport@ebsco.com.

Note:
NoveList works with customers to configure NextReads newsletters and
subscription links.

The NoveList content contains no active links except in the NextReads newsletter, which
offers links to related newsletters (NoveList-generated content) and a link to a
subscription page (also NoveList-generated content). These links open separate
browser windows. The Link to NoveList option opens the NoveList site in a separate
browser window due to frameset security issues.

Note:
For NoveList Select port access requirements, see Enriched Data
Domains Requiring Port 80/443 Access.

Updating the Library’s Holdings for NoveList Select

The accuracy of NoveList Select features such as Similar Titles depends on NoveList
Select having up-to-date information about the titles in your library catalog. NoveList
Select requires a CSV file consisting of one ISBN per line to collect this information.
Polaris provides a SQL job, ISBN List, which is disabled by default. To generate the CSV
file, enable the job, which is scheduled to run weekly (Monday at 1:10 am) by default.
You can change the schedule if necessary. The job places the ISBNList.csv file in
{Server - Active Node}/ProgramData/Polaris/[version]/Logs/SQLJobs. The file includes
the ISBNs for bibliographic records where the ISBN is valid, the record status is final,
and the record is set to display in PAC. For instructions about uploading the CSV file to
NoveList, contact your NoveList support representative or go to:
http://support.ebsco.com/help/index.php?lang=en&amp;int=novselect

You will need to upload the file regularly (typically once a month) to reflect changes in
your catalog.

mailto:novelistselectsupport@ebsco.com
http://support.ebsco.com/help/index.php?lang=en&amp;int=novselect
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Set up Enriched Data - EBSCO’s NoveList

To set up Polaris to use enriched data from EBSCO’s NoveList:

Note:
You can enable and receive enriched data from more than one vendor,
except cover images. These must be enabled for one vendor only.

1. Contact your vendor’s customer support department for help in obtaining your lib-
rary’s connection and authentication information for this enriched data provider.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

3. Double-click Enriched data. The Enriched Data dialog box opens.
4. Click the NoveList tab.

The NoveList Select subtab appears.

5. Select Enable.

6. Type your Profile ID, password, and service URL in the appropriate boxes. Contact
your vendor to obtain the unique first part of the Profile ID and your password.

Important:
The Service URL is the same for all Polaris customers. You do not need to
change it unless the NoveList Select Service URL changes. However, if
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you run Mobile PAC in SSL mode, the Service URL must begin with
https://

7. Click the Other Features tab.

8. Click the checkboxes for the other features you want to enable.

If you enable similar titles, Goodread ratings, or Lexile number, the features appear
on the search results and full display. If you enable separate content drawers, the
selected features appear in separate content drawers on the full display. You can
use the PowerPAC profile Product Page Categories: Configure to specify the
order in which the NoveList content drawers appear and whether they are
expanded by default. See "Configure the Enriched Content Drawers for PowerPAC"
in the Patron Services Administration Guide.

Syndetics Enriched Data

If your library has access to enriched content from Bowker’s Syndetic Solutions or
Syndetics Unbound, you can use the Enriched data PAC profile to enable the display of
the following content in the PAC:
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l Cover images (book jackets) - Polaris automatically sends the ISBN, UPC, and
OCLC number from the title’s MARC record to Syndetics. Be sure to include the
UPC in the MARC records for these types of material to ensure that the
appropriate cover images are displayed. Syndetics cover images may fail to
display in search results for certain types of material, such as music CDs or DVDs,
when there is no ISBN in the MARC record.

Note:
If you allow patrons to save searches to run automatically, book jackets
are displayed in the results based on the Enriched Data settings for the
patron’s registered branch. For more information about setting up saved
searches, see Set up basic operating features for Polaris PowerPAC.

l Other Features - When Other Features are enabled, your library can display content
such as video/music profiles and video game profiles in PowerPAC product page
drawers and Mobile PAC product page links. If available, the enriched content
displays in the PAC for video, music, and video game titles based on real-time
matching on the product’s UPC, OCLC number, and ISBN. The Syndetics
formatting is retained where possible. Once the content has been enabled for your
organization, use the following Administration profiles to specify how the content
displays: Mobile PAC profile, Product page categories: Configure and PowerPAC
profile, Product page categories: Configure.

Syndetics Unbound Service - When the Syndetics Unbound service is enabled,
your library can display enriched content including: cover images, annotations,
author biographies, "look inside book" feature, awards, recommendations, reader
and professional reviews, other formats, tag clouds, and other content.

Syndetics also offers a Find Similar Titles link on the Polaris PowerPAC product page.
The Find similar titles link opens a Web site in a secondary browser window where the
patron can specify the characteristics of a title and get a list of similar titles available at
the library.

Note:
For Syndetics port access requirements, see Enriched Data Domains
Requiring Port 80/443 Access.

To set up Polaris to use enriched data from Bowker’s Syndetic Solutions:
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Note:
You can enable and receive enriched data from more than one vendor,
except cover images. These must be enabled for one vendor only.

1. Contact your vendor’s customer support department for help in obtaining your lib-
rary’s connection and authentication information for this enriched data provider.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

3. Double-click Enriched data. The Enriched Data dialog box opens.
4. Click the Syndetics tab.
5. If you receive cover images (book jackets) from Syndetics, click the Cover Images

tab, and do the following:
l Select Enable.

Note:
If you use Syndetics cover images for rotating book jackets on
the portal page, you must also supply Other Features settings.
See Set up rotating book jackets.

l In the URL prefix box, type the Web address and path to the Syndetics
content server or domain used for your account. The address must
begin with http://www.syndetics.com/

Note:
PAC title lists and request pages use https, which is not
supported by this prefix. If you want book jackets to be
displayed on these pages, use the prefix
https://secure.syndetics.com/

Note:
If possible, use the Fully Qualified Domain Name instead of the
IP address. If your infrastructure does not allow this, your
Polaris Site Manager can help you work with Bowker Technical
Support to resolve connectivity issues.

l In the URL suffix box, type your client code after &client=.The suffix
defines your specific account access information. Contact your vendor
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to obtain this setting.

6. If you receive other Syndetics enriched data, such as video/music content and
game profiles, click the Other Features tab, and do the following:

a. Select Enable.
b. In the URL prefix box, type the Web address and path to the Syndetics con-

tent server or domain used for your account. The address must begin with
http://www.syndetics.com/. Contact your vendor to obtain the account-spe-
cific portion of this setting.

c. In the URL suffix box, type your client code after &client=. Contact your
vendor to obtain this setting.

d. Click OK.
7. If you use the Syndetics Unbound service, click the Unbound tab and do the fol-

lowing:
a. In the Service URL box, type the URL for the Syndetics Unbound JavaScript

library.
b. In the Account ID box, type your library's account ID for Syndetics Unbound.
c. Click OK.

Once the enriched content is enabled, configure the display of this content using the
Product page categories: Configure profiles for PowerPAC and Mobile PAC. See Set up
the PowerPAC product page and Set up the Mobile PAC title (product) page.

ChiliFresh Enriched Data

ChiliFresh.com provides patron reviews and ratings in Polaris PowerPAC and Mobile
PAC. You can choose to display reviews written only by your own patrons, by patrons in
a specific region, or by patrons at multiple locations. You can also choose to screen
reviews before they are made available for viewing. The patron logs in with a user name
(e-mail address) and password to write a review. The ChiliFresh Review Engine consists
of a database of reviews that reside on a ChiliFresh remote server, so your servers are
not burdened with storing and processing the reviews. The illustration is an example of
ChiliFresh reviews in Polaris PowerPAC.
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ChiliFresh.com also offers cover images. If you subscribe to ChiliFresh Connections, a
readers’ social networking tool available in Polaris PowerPAC and Mobile PAC, you can
receive ChiliFresh cover images at no cost. These images are displayed in the PAC and
work with the ChiliFresh drag-and-drop feature to add covers to reader
recommendations and virtual Connections bookshelves.

Tip:
The PAC product page for a title displays a “drawer” for a large cover
image when the large image is available from ChiliFresh. If the large
image is not available, the drawer is not displayed.

Notes:
For ChiliFresh port access requirements, see Enriched Data Domains
Requiring Port 80/443 Access.
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Polaris Social, a separately licensed product, offers ChiliFresh
Connections features integrated in Polaris PowerPAC. See Polaris Social
with ChiliFresh Connections.

For more information about ChiliFresh.com products, go to www.chilifresh.com.

To set up Polaris PowerPAC to use patron ratings and reviews from ChiliFresh.com:

Note:
You can enable and receive enriched data from more than one vendor,
except cover images. These must be enabled for one vendor only.

1. Contact your vendor’s customer support department for help in obtaining your lib-
rary’s connection and authentication information for this enriched data provider.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

3. Double-click Enriched Data. The Enriched Data dialog box opens.
4. Click the ChiliFresh tab.
5. To set up patron reviews and ratings, follow these steps:

a. Click the Other Features sub-tab.
b. Select Enable.
c. In the Service URL box, type your ChiliFresh service URL as in the following

example:
http://chilifresh.com/on-site/js/polaris4.1-R2a.js

Obtain your specific URL from ChiliFresh.

Note:
ChiliFresh supports SSL (Secure Socket Layer). If you use SSL to secure
the entire PowerPAC site, change the beginning of the ChiliFresh URL
setting from http://chilifresh.com to https://secure.chilifresh.com.

d. In the Account ID box, type your account identification code. Obtain your specific
account code from ChiliFresh.

e. In the API Key box, type your API key. Obtain your specific API key from ChiliFresh.
The key is unique for your account ID.

6. To set up cover images, follow these steps:
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a. Click the Cover Images sub-tab.
b. Select Enable.
c. Type the URL prefix and suffix for your ChiliFresh cover images account in the

appropriate fields.

Note:
Mobile PAC also uses ChiliFresh cover images when these are enabled.

7. Click OK.

Related Information

ChiliFresh Connections integration - Polaris Social, a separately licensed product, offers
ChiliFresh Connections features integrated in Polaris PowerPAC. See Polaris Social with
ChiliFresh Connections.

LibraryThing Enriched Data

LibraryThing for Libraries offers tag “clouds” and similar tagged titles to patrons,
available from the product page for a title in PowerPAC search results. Patrons can
browse for titles by clicking tags and links to other editions. Tags are based on
LibraryThing’s database. Tag features appear in a lightbox (an inline frame dialog box).
The illustration shows an example of tag cloud links and the Tag Browser lightbox that
appears when the patron clicks or taps a link.
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You can also offer reader reviews from the LibraryThing database. When this feature is
enabled, a link to reviews appears under the book jacket image for the title in PowerPAC
brief search results and in the full display for a title.
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You can determine the text of this link when you specify your configuration on the
LibraryThing Web site. You can configure your LibraryThing settings to display reviews
from all participating libraries, from specific selected libraries, or from your library only.

Notes
For LibraryThing port access requirements, see Enriched Data Domains
Requiring Port 80/443 Access.

You can export your catalog data to LibraryThing in MARC21 format using
Polaris Export Express, a separately licensed feature of Polaris
SimplyReports. Using SimplyReports scheduling features, you can run
exports periodically to update LibraryThing content for your new titles.
See your SimplyReports documentation for more information.

To set up Polaris PowerPAC to use tags, other edition, and similar title links from
LibraryThing:



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 326

Note:
You can enable and receive enriched data from more than one vendor,
except cover images. These must be enabled for one vendor only.

1. Contact your vendor’s customer support department for help in obtaining your lib-
rary’s connection and authentication information for this enriched data provider.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

3. Double-click Enriched Data. The Enriched Data dialog box opens.
4. Click the LibraryThing tab.
5. Select Enable tags and related titles to display tags and related title links in PAC

search results.
6. Select Enable user reviews to display reader ratings and the link to reader reviews.

You can select either or both of these features.
7. Be sure the Service URL setting is

http://ltfl.librarything.com/connector/connector.php?systype=polaris&id=
8. Type your account number in the Account ID box. Obtain your specific site setting

from LibraryThing.
9. Click OK.

OverDrive Enriched Data

OverDrive supplies enriched data including: reviews, cover images, summaries, star
ratings, samples, and other content. The enriched data is supplied via the OverDrive
Metadata API. If your library has a license for OverDrive, you can enable the enriched
content and then configure its display in the PAC product page.

To set up Polaris to use enriched data from OverDrive:

Note:
You can enable and receive enriched data from more than one vendor,
except cover images. These must be enabled for one vendor only.

1. Contact OverDrive's customer support department for help in obtaining your lib-
rary’s connection and authentication information for this enriched data provider.
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2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

3. Double-click Enriched data.

The Enriched Data dialog box opens.

4. Click the OverDrive tab.
5. Click Enable.

Once the enriched content is enabled, configure the display of this content using the
Product page categories: Configure profiles for PowerPAC and Mobile PAC. See Set up
the PowerPAC product page and Set up the Mobile PAC title (product) page.
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Enabling Online Book Purchases

You can set up either or both of two features to give patrons the ability to purchase
materials through Polaris PowerPAC and Mobile PAC.

l You can set up Purchase links for titles in PAC search results. When a patron
clicks the link, a search for the title is launched at a specified online bookstore
site.

l You can set up Polaris Bookstore by specific contract, and receive back a portion
of the sales as a donation to the library. The patron can click a Buy It Now link for
titles available at the Bookstore, or browse the Bookstore through a Shop Now
link.

If you have a Polaris Bookstore contract and you enable both options, the Buy It
Now link is displayed when the title is available at the Bookstore, and the Purchase link
is displayed when the title is unavailable at the Bookstore and the title has an ISBN.

Setting Up Purchase Links

You can provide Purchase links for titles in Polaris PowerPAC and Mobile PAC search
results. When a patron clicks or taps the link, a search for the title is launched at a
specified online bookstore site, based on the ISBN or ISSN of the title. You can specify a
local book store that offers online purchasing, or one of the larger online merchants
such as Amazon.com®. Any purchase transaction takes place between the patron and
the book vendor; the library does not mediate the transaction in any way. Each branch
may define a different online book store.

In Polaris PowerPAC, when the patron clicks or taps Purchase on the title product page,
the vendor’s site is displayed in a new browser window.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 329

Note:
For information about Purchase links in Mobile PAC, see Title Link:
Purchase or Buy It Now.

To set up Purchase links for titles listed in Polaris PowerPAC and Mobile PAC search
results:

1. Use a Web browser to display the search page for the online book store to which
you want to direct your patrons for their purchases.

2. Do an ISBN search for any title and retrieve the title information, leaving your
browser window open.

3. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

4. Double-click Purchase Options. The Purchase Options dialog box opens. The Gen-
eric Link tabbed page is displayed.
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5. On the Generic Link tabbed page, select Enable. The other data fields become
available.

6. In the Address (or Location) box on your browser, copy everything before the ISBN
of the title you found, and paste it into the URL prefix (before ISBN) box.

Note:
Depending on the vendor’s search methods, you may not be able to
extract the information from the URL at the vendor’s web site. In this case,
check the vendor’s online Help file or contact the vendor for instructions.

7. In the Address (or Location) box on your browser, copy everything after the ISBN,
and paste it into the URL suffix (after ISBN) box.

8. Click OK.

Related Information

Polaris Bookstore - You can set up Polaris Bookstore by specific contract with Baker &
Taylor, and receive back a portion of the sales as a donation to the library. See Setting
Up Polaris Bookstore.

Setting Up Polaris Bookstore

Through Polaris Bookstore and Baker & Taylor Inc., your library can establish an online
bookstore where patrons can purchase materials at a discount comparable to other
major online retailers, and your library receives a portion of the sales as a donation. The
Bookstore is customized for your library, with your own graphics, URL prefix, and
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custom packing slip text. Polaris Bookstore is available to your library by specific
contract with Baker & Taylor.

When a title in a patron’s search results is available in the Bookstore, the patron can
click a Buy It Now link in the title product page to purchase the title. (If the title is not
available at the Bookstore, no link is displayed.)

Note:
For information about Buy It Now links in Mobile PAC, see Title Link:
Purchase or Buy It Now.

You can also place a “shop now” button on your library’s Web site, or promote the
bookstore with a link in the custom content area of the portal page. Patrons can search
or browse the store and order any available title, placing their purchases in an online
shopping cart and paying by credit card.

Baker & Taylor maintains the bookstore site and handles any returns. You receive your
portion of the proceeds at regular intervals as determined by your Polaris Bookstore
contract. You work with your Polaris Site Manager to set up your bookstore profile.
When the bookstore is implemented, ongoing support is provided by Innovative
Interfaces®.

Polaris Bookstore works well for library consortia, because each organization that wants
to participate can have its own bookstore. The proceeds are distributed to the
appropriate organizations. (If the consortium office itself set up a bookstore for the
whole consortium, the consortium office is responsible for dividing the proceeds
appropriately.)

You can set up Polaris Bookstore at the system, library, or branch level. To make Polaris
Bookstore available from Polaris PowerPAC and Mobile PAC:

Important:
This procedure is included for your information only. Your Polaris Site
Manager enters the appropriate Polaris Bookstore settings for your site.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

2. Double-click Purchase Options. The Purchase Options dialog box opens.
3. Click the Polaris Bookstore tab.
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4. Select Enable. The other data fields become available.
5. In the Home Page URL box, type the value specified by Baker & Taylor. This profile

is the Bookstore home page link, typically displayed when the patron clicks Shop
Now. The patron can browse the Bookstore from this page.

6. In the URL prefix (before ISBN) box, type the value specified by Baker & Taylor.
The prefix and suffix settings control the Bookstore search result page that
appears when the patron clicks Buy It Now.

7. In the URL suffix (after ISBN) box, type the value specified by Baker & Taylor.
8. Type your site’s user name in the Username box.
9. Type your site’s password in the Password box.

10. Click OK.

Related Information

l Shop Now dashboard link - You can place a link to the library’s Polaris Bookstore
site on the Polaris PowerPAC dashboard. See Defining Web Parts for Dashboards.

l Polaris Bookstore on the portal page - You can promote the Polaris Bookstore on
your Polaris PowerPAC portal page using custom content. See Set up custom
portal page content.

l Vendor purchase links - You can offer a Purchase link to another vendor’s site. See
Setting Up Purchase Links.
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Setting Up Patron Account Access and Options

If you permit access to patron accounts from the PAC, patrons can log on to view and
cancel requests, view and renew items out, estimate fines on currently overdue items,
and view fines and fees. Depending on the features you offer, they can also manage
messages, view their reading histories, pay fines or make donations by credit card, work
with saved search agent searches, or view transcripts of sessions with a virtual
reference service.

Additional Administration settings allow users to set up a new patron account from the
PAC, create and change user names and passwords, and request address changes. You
can also offer email communication with the library (Ask Us) to registered patrons and
guests. In addition to the patron account options, you can set holds options that enable
patrons to change the hold pickup branch. See the Patron Services Administration Guide.

Notes:

l Important: Certain patron account settings apply to both Polaris
PowerPAC and Mobile PAC. You may need to clear the page cache
to see the results of some changes in either PAC. See Updating
Page Caches. Patrons cannot access their accounts from the
PowerPAC Children's Edition.

l For Patron Access Options, PowerPAC and Mobile PAC honor
system administration settings as follows:

o If the patron is signed in, the system uses the setting for the
patron's registered branch.

o If the patron is not signed in, the system uses the setting for
the connection branch.

See also:

l Controlling Patron Account Login and Access
l Setting Patron Account Options
l Displaying Claimed and Lost Items in Patron Accounts in PAC
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Controlling Patron Account Login and Access

Use the following Polaris Administration settings to control PAC login and access to
patron account information:

Single Login: Enable (PowerPAC profile) - If this profile is set to Yes, a Log
In/Register option is displayed in the My Account menu and in the page footer. A Log In
link is also displayed at the top of the page. This allows a patron to log in once for a
session, instead of each time a function requires identification. When patrons provide
log-in information for the first time (for example, in requesting a hold), they remain
logged in until they select a log-out option, or until the Polaris PowerPAC session times
out.

Important:
If you change this profile, you must clear the page cache. See Updating
Page Caches. If you do not, you may see unexpected results, and it may
be possible for a patron to see another patron’s account information at a
library workstation.

When the patron has logged in, the PowerPAC page displays the patron’s name and the
Log Out option in the dashboard and at the top of the the page. The patron can click or
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tap the Welcome link to display the Items Out page for the patron's account. When a
patron logs in from the My Account menu, the Items Out page is automatically displayed

The logged-in patron can select an option in the My Account menu or on the dashboard
to see their record, the items they have checked out, hold requests, fines and fees, and
saved searches.

Note:
The Single Login profile also allows Polaris to cache patron log-in
information for e-sources authentication. See Setting Up E-Source
Targets.

Polaris Mobile PAC allows a single log-in until the patron deliberately logs out,
disconnects from the Mobile PAC site, or is inactive for 20 minutes. See Patron Log-In
Settings for Mobile PAC.

Patron Access: policy statement hyper text link permitted and Patron Access: policy
statement hyper text link (PAC profile) - Enable the hyperlink text and define the text.
See Set up a privacy statement link (Polaris PowerPAC).

Login retries (PAC profile) - Limits the number of times a patron can attempt to log into
the PAC without success. See Limit log-in attempts.
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Patron inactivity timeout (PowerPAC profile) - Specifies the period of inactivity after
which a logged-in patron at a library (in-house) workstation is automatically logged out.
See Set an inactivity timeout for in-house workstations.

Active directory logon (PAC profile) - Allows a PAC log-on using Active Directory
credentials instead of the Polaris patron barcode or username and password. This
feature is particularly suitable in academic settings, enabling students to authenticate
into Polaris PowerPAC and Mobile PAC using their campus network credentials
established in Active Directory. The user must have a Polaris patron record, but the
authentication uses the user’s network ID, contained in a Polaris patron record User
Defined Field (UDF), rather than the patron record barcode and password. Although a
patron record barcode is required by Polaris, it will not be used for any PAC
authentication. When the user attempts to log in from Polaris PowerPAC or Mobile PAC,
the log-in page prompts for the network credentials instead of the usual Polaris
barcode/username and password. For set-up instructions, see Set Up PAC Active
Directory Log On.

Navigation: Patron account (PowerPAC and Mobile PAC profiles) - When this profile is
set to Yes, the My Account option is displayed on the Polaris PowerPAC menu bar.

Navigation: Fines & fees (PowerPAC and Mobile PAC profiles) - When this profile is set
to Yes, the Fines & Fees option is displayed on the My Account menu.

Navigation: Items Out (PowerPAC and Mobile PAC profiles) - When this profile is set to
Yes, the Items Out option is displayed on the My Account menu and summary
information is displayed in the patron account page dashboard.

Navigation: My Record - When the profile is set to Yes, the My Record option is
displayed on the My Account menu.

Navigation: Requests (PowerPAC and Mobile PAC profiles) - When this profile is set to
Yes, the Requests option is displayed on the My Account menu, summary information is
displayed in the patron account page dashboard, and a link to the list of requests is
displayed when a request is placed.

Navigation: Claimed and Lost (PowerPAC and Mobile PAC profiles) - When this profile
is set to Yes, the Claimed and Lost view is displayed in the patron account.

Patron access: Display hold queue information (PAC profile) - When this profile is set to
Yes, the position of a patron’s request in the holds queue is displayed on the Requests
page of the patron account.
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Patron Access: Renewal (PAC profile) - When the Renewal permitted option is checked,
patrons can renew all or selected items from the Items Out page in the patron account.
If the Allow renewal if patron registration will expire option is selected, the patron sees
the expiration message in PAC but the renewal is allowed. The system uses the setting
of the governing library for patron blocks.

Patron access options (PAC profile) - Use the options available in this profile to set up
self-registration; specify defaults; set password options; specify the reminder notices
that patrons can opt out of receiving; specify the contact information the patron can
change; specify the associated patron information that is displayed for patrons who
have associations; specify which custom fields display and whether they are required;
specify whether patrons can send "Ask us" emails. See Setting Patron Account Options.

Setting Patron Access Options - Overview

You can use the Patron access options PAC profile in Polaris Administration to specify
the options that are available to patrons for registering or updating their account
information from the PowerPAC or Mobile PAC.

Note:

For Patron Access Options, PowerPAC and Mobile PAC honor system
administration settings as follows:

l If the patron is signed in, the system uses the setting for the patron's
registered branch.

l If the patron is not signed in, the system uses the setting for the
connection branch.

The Patron Access Options dialog box has separate tabs to specify the following types
of patron account settings:

Note:
In addition to the patron account options, you can set holds options that
enable patrons to change the hold pickup branch. See the Patron Services
Administration Guide.

l Self-registration - Enable self-registration and set up the fields for the form. This
tab includes two subtabs for UDF and Custom Field Display.
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l Defaults - Set defaults for patron code, language, expiration term, address check
date, and UDFs/Custom Fields.

l Log in - Enable patrons to change their passwords, set up user names, create pass-
words, receive e-mail messages for forgotten passwords and set other log in
options.

l Contact Info - Enable patrons to submit changes to their account contact inform-
ation and opt out of receiving reminder notices.

l Preferences - Select options for displaying settings for associated patrons; define
the UDF and Custom Field display and which fields are required.

l Ask Us - Enable patrons to send a reference question to a designated library email
address. You set up a receiving email address on the branch level, then enable the
feature in PowerPAC, Mobile PAC, or both. You can require a patron logon, or
bypass the logon and allow anyone to send a question via Ask Us.The Sent From
email address on the message to the library is the email address the user has spe-
cified in the Ask Us form, if any. If no address is specified, the user has logged in
as a patron, and the patron account includes an email address, that address is
used. If no email address is specified in the Ask Us form or the patron account, or
the patron has cleared the address from the form, the Sent From address is that
specified in the PAC profile Email notification: Email address of sender.

Note:
Any email from PAC, including Ask Us messages, requires you to specify
the SMTP server in Polaris Administration. Double-click the PAC profile
Email notification: Server running SMTP service, and type the domain
name of the email SMTP server.

See also:

l Set up online patron self-registration
l Set patron password and username options
l Set up online patron account updates
l Set patron associations display in PAC
l Display and require UDFs in patron update pages in PAC
l Display and require PCDFs in patron update pages in PAC
l Set up and start Ask Us
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Set up online patron self-registration

Polaris creates a a patron record when a patron registers for a new library account
online from Polaris PowerPAC or Mobile PAC. Polaris uses your self-registration format,
if you have one defined. By default, Polaris issues the patron a temporary barcode
beginning with PACREG. The temporary barcode allows the patron to do certain
operations online, such as request a hold, but blocks the patron from checking out
materials until the new record is verified by staff.

You can also set Polaris to send an automatic notification email to a library staff
account. When the notification arrives, staff members can review the registration
information and create the library card.

To allow patrons to register for either type of barcode online

Important:
Do this procedure for each branch that allows patron self-registration.

1. In the Administration Explorer tree view, open the Profiles folder for the branch,
and click the PAC tab in the details view.
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2. Double-click Patron access options. The Patron Access Options dialog opens.

3. On the Self-registration tabbed page, select the Patron can self-register checkbox
to make online registration available. When this option is selected, patrons see a
register now link on PAC logon pages such as the Patron Account logon page and
the Ask Us logon page. Clearing the checkbox removes the link, and self-regis-
tration is not available.

4. To specify a staff address for automatic notification email, do the following:
a. Click Add. The Polaris Find Tool appears.
b. Search for the staff member or members who should receive the registration

notification messages, and select their names in the results list.
c. Right-click the highlighted names, and choose Select from the context menu.

The Patron Access Options dialog appears, and the selected names appear
in the E-mail to list.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 341

5. To enable a message regarding self-registration, select the Self-registration warn-
ing message enabled checkbox. This message allows the library to comply with
the Children’s Online Privacy Act. For information about editing the text of this
message, see Editing Messages and Labels.

6. To display user-defined fields in the patron self-registration pages in the PAC, and
to specify that certain user-defined fields are required, do the following:

a. Select the UDF Display tab to display the available user-defined fields
(UDFs).

b. Under User defined fields to display, select the UDFs you want to display.
c. To indicate that a selected UDF is a required field, select the

Required checkbox.

See the Patron Services Administration Guide.

7. To display patron custom data fields (PCDFs) in the patron self-registration pages
in the PAC, and to specify that certain PCDFs are required, do the following:

a. Select the Custom Field Display tab to display the available PCDFs.
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b. To display a PCDF in the patron self-registration page in the PAC, select a
checkbox under Label.

c. To indicate that a PCDF is a required field, select the PCDF, and click Change
Required Status. The status changes from No (the default) to Yes.

See the Patron Services Administration Guide.

8. To continue setting self-registration display preferences, do the following:
a. To require a birth date for self-registration, select Birth date required.

Notes:

l When it is included in PAC self-registration, the system
uses the birth date to check for duplicate patron records
in addition to the first name and last name. If no birth
date is supplied, duplicate checking uses only the first
and last names.

l Innovative recommends requiring the Birth date field if
your library wants to restrict checkouts and holds based
on the patron's age. See "Using Age-Related Loan
Policies" in the Leap documentation for more
information.

b. To allow patrons to proceed through the self-registration without selecting a
gender, select Suppress gender selection.
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c. To include a verification block on all patrons who self-register in the PAC,
Mobile PAC, or Polaris API, select Patron self-registration block.

d. To require a duplicate detection check on a patron's information during self-
registration, select Perform Duplicate Detection. To disable duplicate detec-
tion on patron information entered in PowerPAC, MobilePAC, or Polaris API,
clear Perform Duplicate Detection.

Note:

To completely disable duplicate detection on patron
information entered in PowerPAC, MobilePAC, or Polaris API,
ensure the following option is also cleared:

i. Open the Polaris Administration Explorer, and select
Parameters > Patron Services > Duplicate Detection
Options.

ii. Ensure the Name on Identification (First and Last) >
PAC option is cleared.

9. Click the Defaults tab, and specify the default values for patron records created
through self-registration:
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Notes:
Library staff members can change the default values when they
review the online registration.

The default notification method is set by the Patron Services
parameter Express patron registration options. See the Patron
Services Administration Guide.

l Patron code - Select the patron code to assign to all self-registered patrons.
You might want all self-registered patrons to have the same code assigned
to the majority of your patrons, or you might have a patron code specifically
identifying self-registered patrons.

l Language - Select the default language for self-registered patrons.
l Statistical Class - Select the default statistical classification for self-

registered patrons.
l Expiration term - Set the default period of time before the library card

expires. To set a date according to the current date (such as two years from
today), select months or years in the second Expiration term box, and enter
a number in the first box. To set a precise date, select exact date in the
second Expiration term box; then click the calendar icon and choose a date
from the calendar in the first box (or enter the date in the format shown in
the Expiration term box).

l Address check term - Set the default period of time when the registration
address should be verified. To set a date according to the current date (such
as two years from today), selectmonths or years in the second Address
check term box, and enter a number in the first box. To set a precise date,
select exact date in the second Address check term box; then click the cal-
endar icon and choose a date from the calendar in the first box (or enter the
date in the format shown in the Address check term box).

10. To specify default values for user-defined fields (UDFs) in PAC self-registration
pages, do the following:

a. On the Defaults tabbed page, select the UDFs subtab to display the UDFs for
your organization.
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b. To specify a default value for a text field, enter the text.
c. To specify a default value for a dropdown list, select an option in the list.

Note:
For the best usability, specify a default option if you require a drop-
menu UDF. If you don't, the field is blank in a new record. The user
must select an option, but it might not be obvious they need to do
so.

d. Click Apply to apply your settings.
11. To specify default values for patron custom data fields (PCDFs) in PAC self-regis-

tration pages, do the following:
a. On the Defaults tabbed page, select the Custom Fields subtab to display the

PCDFs that are available for your organization.

b. Select the data field, and do the following:

Note:
A Date field type cannot have a default value.
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l String custom field - When you select a string field type, you can enter a
default value of up to 255 characters.

l Boolean custom field - When you select a Boolean field type, you can
select a default value of Yes or No. Boolean fields appear as check-
boxes in the patron registration forms. If the default is set to Yes, the
checkbox is selected. If the default is No, the checkbox is cleared.

l Integer custom field - When you select an Integer field type, you can
enter a default value of up to 255 numbers in the box.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 347

c. After defining the default value for a field, click Set Default.
12. When you are finished making changes, click Apply.
13. Click  Save, and close the dialog box.

Related Information

l Remove block on self-registered patron record - See the Patron Services Guide.
l Notification preference - The default notification preference for self-registered pat-

rons is the notification setting for the Patron Services parameter Express patron
registration options (General defaults tab). The patron can choose another
method from the dropdown list during self-registration, and staff can change the
notification preference when they verify the registration. You can filter the meth-
ods available for selection; see the Patron Services Administration Guide. If the pat-
ron chooses Phone, the patron must indicate the phone number to use for
notification. If the patron chooses TXT Messaging, the patron must indicate the
phone number to be used for TXT messages, and select a carrier for that number.

l EReceipts - If the patron’s registered branch has enabled eReceipts (see the Patron
Services Administration Guide), that organization can also offer the option to
receive e-mail receipts, TXT receipts, or both for renewals from PAC. The option is
available from both patron self-registration and account updates from PAC. To
enable eReceipt preference options in PAC, use the PAC profile Patron eReceipts,
available at the system, library, or branch level.

l Registered branch - The patron chooses a registered branch from a list during self-
registration. The order of branches in the list is controlled by the PAC profile
Branch list order. The setting for the current connection branch is used. When the
profile is set to Yes, the branch names appear in ascending alphabetical order by
name. When the profile is set to No, the branch names appear in ascending numer-
ical order by internal organization ID. With either setting, the system organization
is always first.

Set patron password and username options

To set the password and username options offered to patrons using Polaris PowerPAC
or Mobile PAC:

Important:
Complete this procedure for each branch that allows patron self-
registration.
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1. In the Administration Explorer tree view, select Profiles > PAC.
2. Double-click Patron access options.

The Patron Access Options dialog appears.

3. Select the Log In tab.

4. To allow patrons to change their passwords online, select the Patron can change
password checkbox.

5. To specify an override password for staff, perform these steps:

Note:
A staff member can use the staff override password to help a patron
access the account in case the password has been forgotten. Once
in the account, if the Patron can change password box is selected,
the patron can specify a new password by selecting a link on the
PAC patron account page.
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a. Select the Enable staff override checkbox.
b. Type a password in the PAC override password box. The password can be 4

to 16 characters (letters and numbers), but cannot include spaces.
6. (System level only) To allow patrons to set up and change usernames, select

Enable patron username.

A patron can enter their username instead of a barcode when signing in to use
PAC functions such as viewing their account or placing a hold request. The
username is displayed in the patron account in PAC, and the patron barcode is
masked to display only the last four digits. The username is also accepted for
signing in to third-party self-service devices (devices that rely on SIP or SIP2) and
in Polaris ExpressCheck.

The username must be a minimum of 4 and a maximum of 50 alphanumeric
characters, and cannot contain spaces. It must begin with a letter. The following
special characters are also allowed: - (dash), _ (underscore), . (period), and @ (at).
The username must not contain two special characters next to each other, and
cannot match an existing patron barcode.

Note:
Patron usernames are not available to staff. Staff cannot assign
them during patron registration, they are not searchable or available
for reports, and they are not displayed in the patron record. Only
patrons can create or change usernames.

7. (System level only) To allow patrons to receive an email message containing a
time-sensitive link to reset their password, select E-mail reset password link.

When this option is set, the PAC, MobilePAC, or Polaris ExpressCheck sign in
pages include a Forgot password? link. When the patron selects the link, an email
message containing a time-sensitive link to reset their password is sent to both
the primary and alternate email addresses in the patron record. If no email
address is present in the patron record, the system displays an error message.

Note:
If the patron has forgotten both their username and their password,
they must contact the library. Staff can assign a new password.
Using this and the barcode, the patron can set up a new username.
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8. To restrict passwords to numeric characters (PINs), select Passwords must be
numeric only.

This option is useful if you use Polaris Phone Attendant and allow patrons to sign
in by telephone to hear information about their accounts. (Alternatively, you can
allow alphanumeric passwords from the Phone Attendant. See the Telephony
Administration Guide). If you choose to enable this option, existing alphanumeric
passwords will continue to work but only numeric passwords are accepted when a
new account is created or when a patron password is changed from the staff
client or from PAC.

9. Select Apply to apply your settings and continue working with Patron Access
options, or select Save to save your settings and close the Patron Access options
dialog.

10. Select File > Save.

Set up online patron account updates

You can allow patrons to request updates to their patron account information in Polaris
PowerPAC or Mobile PAC and opt out of receiving certain email reminder notices.

Notes:

l When patrons request certain updates to their account information
online, Polaris blocks the patron from checking out materials until
staff verify the update. See the Patron Services Guide.

l For Patron Access Options, PowerPAC and Mobile PAC honor
system administration settings as follows:

o If the patron is signed in, the system uses the setting for the
patron's registered branch.

o If the patron is not signed in, the system uses the setting for
the connection branch.

To set up online patron account updates:

1. In the Administration Explorer tree view, open the Profiles folder for the branch,
and click the PAC tab in the details view.

2. Double-click Patron Access options.
The Patron Access Options dialog box appears.
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3. Click the Contact Info tab.

4. Select Patron can change notification method to allow patrons to change their
notification method online. This option does not place a verification block on the
patron account.

5. Select Confirmation e-mail to patron to have the system send an acknow-
ledgment message by email to the patron when he or she submits a request to
change account information.

When you enable this option, a single email message is sent soon after the
patron clicks Submit Change Request. The message is sent to both the
primary and alternate email addresses. If the patron record does not have an
email address, no message is sent.

6. Select Patron address - Change allowed to allow patrons to change their physical
address online, then select one of the following options:
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l Patron can submit change request places a verification block on the patron
account when the patron requests a change, and an email message is sent
to the library staff, so library staff can verify and add the address.

l Patron can change without verification allows a patron to change the
address online without incurring a verification block.

Note: PowerPAC and Mobile PAC perform basic validation against
the postal codes table when updating the patron address,
regardless of which option you select.

7. Select E-mail address - Change allowed to allow patrons to change an email
address online, then select one of the following options:

l Patron can submit change request places a verification block on the patron
account when the patron requests a change, and an email message is sent
to the address specified on this tabbed page.

l Patron can change without verification allows a patron to change the email
address online without incurring a verification block.

8. Select Phone number - Change allowed to allow patrons to change a contact tele-
phone number online, then select one of the following options:

l Patron can submit change request places a verification block on the patron
account when the patron requests a change, and an email message is sent
to the address specified on this tabbed page.

l Patron can change without verification allows a patron to change the phone
number online without incurring a verification block.

l Enable phone validation (system level only) specifies whether Polaris val-
idates phone numbers when they are entered in the Update Preferences
page in Polaris PowerPAC or Mobile PAC. Libraries that require their patrons
to enter an initial 1 with the phone number should leave this option cleared.

Note:
In Mobile PAC, when validation is not enabled, each phone
number option is one entry field, similar to Polaris PowerPAC.
When validation is enabled, each phone number option has
three entry fields (area code/prefix/four-digit number).
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9. Select the patron codes that can request account updates online. (Clear the appro-
priate patron code checkboxes to prevent these patrons from requesting account
updates online.)

10. (Optional) You can click Add to add patron codes or Delete to delete them.
11. To allow patrons to opt out of receiving certain reminder notices, select from the

following options:
l Almost overdue/Auto-renew
l Patron record expiration
l Inactive patron

12. Select Save or Apply.
13. Select File > Save.

Related Information

l Verify borrower blocks - Patrons who have requested the specified account
updates online are automatically blocked from check-out and renewal at the staff
circulation desk until a library staff member has reviewed the change. (The block
is not applied if you have chosen to allow the change without verification.) In addi-
tion, you can set Polaris to block renewals online or by telephone.

l EReceipts - If the patron’s registered branch has enabled eReceipts, that organ-
ization can also offer the option to receive email receipts, TXT receipts, or both for
renewals from PAC. The option is available from both patron self-registration and
account updates from PAC. To enable eReceipt preference options in PAC, use the
PAC profile Patron eReceipts, available at the system, library, or branch level.

See the Patron Services Administration Guide.

Set patron associations display in PAC

If your library uses associated patrons functionality to link patron accounts together,
you can specify whether to display the "block me" and/or "allow me" settings for
associated patrons in the PAC.

To specify the settings that patrons can see about their associated patrons in the
PowerPAC and Mobile PAC:

1. In the Administration Explorer tree view, open the Profiles folder for the branch,
and click the PAC tab in the details view.
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2. Double-click Patron access options. The Patron Access Options dialog box
opens.

3. Select the Preferences tab.

4. Select the Associated Patrons checkbox, and select one or both of these check-
boxes:

l Show 'Block me' setting - When this checkbox is selected for a branch, pat-
rons registered at this branch can see whether they are blocked when their
associated patrons are blocked.

l Show 'Allow me' setting - When this checkbox is selected for a branch, pat-
rons registered at this branch can see whether they are permitted to pick up
and check out held items for their associated patrons.

5. Click Save.

Associated Patron Display in PowerPAC
If both the Associated Patrons options (Show 'Block me' setting and Show 'Allow me'
setting) are selected in the Patron Access Options profile for the branch, patrons
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registered at that branch who have associations can access their account in PowerPAC,
expand the Associated Patrons area, and see the block and allow settings for each of
their associated patrons.

Associated Patron Display in Mobile PAC
If both the Associated Patrons options (Show 'Block me' setting and Show 'Allow me'
setting) are selected in the Patron Access Options profile for the branch, patrons
registered at that branch who have associations can access their account in Mobile
PAC, expand the Associated Patrons area by selecting the right arrow, and see the block
and allow settings for each associated patron.
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Patron account in Mobile PAC

Block and Allow settings for associated patrons in Mobile PAC
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Display and require UDFs in patron update pages in PAC

To display user-defined fields (UDFs) in the patron update pages in the PAC, and to
specify that certain user-defined fields are required:

1. In the Administration Explorer tree view, open the Profiles folder for the branch,
and click the PAC tab in the details view.

2. Double-click Patron Access options.The Patron Access Options dialog box
appears.

a. Select the Preferences tab. The available UDFs are listed on the UDF Display
subtab.

b. To display UDFs in the patron account update pages in the PAC, select the left
checkbox under User defined fields to display.

c. To indicate that a displayed UDF is a required field, select the Required checkbox.

See "Setting Up User-Defined Fields" in the Patron Services Administration Guide.

3. Click Apply when you are finished setting up the UDFs.
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Display and require PCDFs in patron update pages in PAC

To display patron custom data fields (PCDFs) in the patron update pages in the PAC,
and to specify that certain patron custom data fields are required:

1. In the Administration Explorer tree view, open the Profiles folder for the branch,
and click the PAC tab in the details view.

2. Double-click Patron Access options. The Patron Access Options dialog box
appears.

3. Select the Preferences tab.

a. Select the Custom Field Display tab to display the available PCDFs.

b. To display a PCDF in the patron account update page in the PAC, select the left
checkbox under Label.

c. To indicate that a displayed PCDF is a required field, select the PCDF and click
Change Required Status. The Required setting changes from No (the default) to
Yes.

See the Patron Services Administration Guide.

4. Click Apply when you are finished setting up the PCDFs.

Set up and start Ask Us

With the Ask Us feature, patrons can use Polaris PowerPAC or Mobile PAC to send a
reference question to a designated library email address. You set up a receiving email
address on the branch level, then enable the feature in PowerPAC, Mobile PAC, or both.
You can require a patron logon, or bypass the logon and allow anyone to send a
question via Ask Us.

The Sent From email address on the message to the library is the email address the
user has specified in the Ask Us form, if any. If no address is specified, the user has
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logged in as a patron, and the patron account includes an email address, that address is
used. If no email address is specified in the Ask Us form or the patron account, or the
patron has cleared the address from the form, the Sent From address is that specified in
the PAC profile Email notification: Email address of sender.

Note:
Any email message from PAC, including Ask Us messages, requires you
to specify the SMTP server in Polaris Administration. Double-click the
PAC profile Email notification: Server running SMTP service, and type the
domain name of the email SMTP server.

To set up the email addresses to receive questions sent from the PAC, and to start the
Ask Us function:

1. In the Administration Explorer tree view, open the Profiles folder for the branch,
and click the PAC tab in the details view.

2. Double-click Patron Access options. The Patron Access Options dialog box
appears.

3. Click the Ask Us tab.
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4. To specify the receiving address for Ask Us email messages, do these steps:

a. Click Add, and use the Find Tool to search for the staff member or members who
should receive the Ask Us messages.

b. Select the names in the results list, right-click the highlighted names, and choose
Select from the context menu.

The Patron Access Options dialog box appears, and the selected names are
displayed in the E-mail to list.

5. Click Apply to apply your settings and continue working with patron access
options, or click Save to save your settings and close the Patron Access Options
dialog box.

6. To make the Ask Us feature available in Polaris PowerPAC, do these steps:

a. Click the PowerPAC tab in the details view of the Explorer.
b. Double-click Navigation: Ask us, and select Yes.
c. To require a patron login for Ask Us, double-click Ask Us: Require Login, and set

the value to Yes.

If this value is set to No, a Guest button is displayed on the Ask Us logon page in
Polaris PowerPAC. The user can click Guest to send a question without logging
on.

7. To make the Ask Us feature available in Mobile PAC, do these steps:

a. Click the MobilePAC tab in the details view of the Explorer.
b. Double-click Navigation: Ask us, and select Yes.
c. To require a patron login for Ask Us, double-click Ask Us: Require Login, and set

the value to Yes.

If this value is set to No, a Guest button is displayed on the Ask Us logon page in
Mobile PAC. The user can click Guest to send a question without logging on.

Note:
Libraries that use Polaris Community Profiles and ContentXChange
should set this option to No so that logon is not required. Organizations
can place the Ask Us feature on their own Web sites, where any visitor to
the site can send a question to the library. For more information, see the
Polaris Administration Guide.

8. Select File > Save.
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Related Information

The ContentXChange Ask Us widget uses the Ask Us settings for the organization
specified in the ContentXChange widgets link to: box on the Community Record
workform. See the Community Profiles Guide.

Enable patron account access - PowerPAC

To allow patrons to view their accounts from Polaris PowerPAC, and to specify the
available account features:

Note:
Separate Mobile PAC profiles control patron account access, navigation,
and features in Mobile PAC. See Patron Account (My Account) in Mobile
PAC.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Navigation: Patron Account, and set the value to Yes. When this pro-
file is set to Yes, the My Account option is displayed on the Polaris PowerPAC
menu bar.

3. Set the following PowerPAC profiles to control what features you offer when pat-
rons access their accounts:

l Navigation: Fines & Fees - Specifies whether patrons can view the fines and fees
associated with their library accounts. When the profile is set to Yes, the Fines &
Fees option is displayed on the My Account menu. The system uses the setting for
the patron’s registered branch.

Note:

Patrons can select an information icon  to see detailed information
about an individual fine or fee. The history section on the details page
includes the date, type, amount, payment, and staff name associated with
the fine or fee. If you prefer to suppress the history section, set the PAC
profile Fines & Fees: Show history in detailed view to No.
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Note:
If you plan to accept online credit card payments, set Navigation: Fines &
Fees to Yes. See the Patron Services Administration Guide.

l Navigation: Items Out - Specifies whether patrons can view a list of the items
checked out to their account. When the profile is set to Yes, the Items Out option
is displayed on the My Account menu and summary information is displayed in the
patron account page dashboard. The system uses the setting for the patron’s
registered branch.

Note:
If you want to allow patrons to renew items from the Items Out page, set
this option using the PAC profile Patron Access: Renewal Permitted. See
step 4.

l Navigation: My Record - Specifies whether patrons can view their library
registration information. When the profile is set to Yes, the My Record option is
displayed on the My Account menu.

l Navigation: Requests - Specifies whether patrons can view a list of the titles they
have requested. When the profile is set to Yes, the Requests option is displayed on
the My Account menu, summary information is displayed in the patron account
page dashboard, and a link to the list of requests is displayed when a request is
placed. The system uses the setting for the patron’s registered branch. The page
shows the status of each request, and allows the patron to cancel, suspend and
reactivate requests. From the Requests page, the patron can also see detailed
information about each request.

l Patron access: Display hold queue information - Specifies whether the position of
a patron’s request in the holds queue is displayed on the Requests page of the
patron account, and whether the patron receives a message about the current
number of active requests for the material when she places a hold. The profile
setting for the patron’s registered branch controls whether the holds queue
information is displayed.

Note:
You may want to suppress the holds queue information because it can be
confusing in certain circumstances. For example, a request may be first in
the queue, but if it is overridden for some reason, it may not be filled first.
Also, if a branch uses primary and secondary routing groups, the queue
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position of a request may change if the request is sent to the secondary
routing group. For more information about holds processing, see the
Patron Services Administration Guide.

4. To allow patrons to renew items from Polaris PowerPAC and Mobile PAC, do
these steps:

a. Click the PAC tab in the details view of the Administration Explorer.
b. Double-click Patron Access: Renewal, and select Renewal permitted.

When this option is checked, patrons can renew all or selected items from the
Items Out page in the patron account. (When the profile is set to No, the renewal
links are not displayed on the Items Out page.)

Note:
Even when you permit renewals, renewal options are not displayed for
items that cannot be renewed.

c. To allow renewals where the patron registration will expire before the renewal due
date, select Allow renewal if patron registration will expire.

If this option is selected, the patron sees the expiration message in PAC but the
renewal is allowed. The system uses the setting of the governing library for patron
blocks.

5. Select File > Save.

Related Information

l Patron messages - You can allow staff to post library-defined or free-text mes-
sages to patron accounts. Patrons can then read and delete the messages from
the PowerPAC or Mobile PAC patron account. For more information about setting
up patron messages, see the Patron Services Administration Guide. For more
information about posting patron messages in the staff client, see the Patron Ser-
vices Guide.

l Blocks on renewals and ebook circulation - You can set blocking conditions that
apply to renewals and ebook circulation from the PAC or renewals by telephone.
See the Patron Services Administration Guide. You can also block renewal from
PAC if an associated patron has exceeded the 2nd level fine amount as determ-
ined by the governing library for patron blocks, or if the associated patron has
exceeded the maximum overdue limit as determined by the governing library for
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patron blocks. For more information about setting up blocking relationships, see
the Patron Services Guide.

l Hold/ILL requests - You set conditions for requests from PAC with Requests para-
meters. See the Patron Services Administration Guide.

l Online registration, password changes, and account updates - See Setting Patron
Account Options.

l Setting a staff override password - See Set patron password and user name
options.

l Allowing credit card payments - See the Patron Services Administration Guide.
l Search agent (saved searches) - If you offer search agent functionality, patrons

can view and work with their saved searches from the patron account pages. See
Setting Public Access Profiles and Parameters.

l Ask Us - Using Ask Us, registered patrons can log in and send an email message
to designated library staff members. See Set up and start Ask Us. You can option-
ally offer this feature to guest users (no logon required).

l 3M PAMS - 3M™ Public Access Management System “smart cards” allow patrons
to log in by placing a smart card in a reader. See Set up Polaris PowerPAC.

l Polaris® ExpressCheck™ - Use the SelfCheck Unit parameter Polaris
ExpressCheck: Options to control access to the patron account from
ExpressCheck.

Limit log-in attempts

You can limit the number of times a patron can attempt to log in before being forced to
wait 5 minutes. To limit the number of times a patron can attempt to log in before the
waiting period is enforced:

Note:
These settings apply to the following PAC applications:
Polaris PowerPAC - Main log-in page, hold request page
Polaris PowerPAC Children’s Edition - Hold request page
Mobile PAC - Main log-in page

1. In the Administration Explorer tree view, open the Profiles folder at the system
level, and click the PAC tab in the details view.

2. Double-click Login retries. The PAC Login Retries dialog box appears.
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3. Select Enable limit on login retries.
4. Set the number of attempts (5-99) allowed before the patron must wait 5 minutes.
5. Click OK.

Set an inactivity timeout for in-house workstations

To automatically log out patrons from in-house workstations after a specified period of
inactivity:

Note:
These settings do not apply to patrons who are not logged in or those
working outside the library.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PowerPAC tab in the details view.

2. Double-click Patron inactivity timeout. The Patron Inactivity Timeout dialog box
appears.

3. Select Enable patron inactivity timeout for in-house workstations to enable the
inactivity timeout.

4. Set the time after which the patron is logged out and the specified page (see step
5) is displayed. You can specify a time from 1 to 20 minutes.

5. Specify the page to display after the inactivity period and automatic logout:
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l Select Default PowerPAC home page to return to the page you have specified as
the PowerPAC home page. See Set up Polaris PowerPAC.

l Select URL and type the complete URL of the page that should be displayed (255
characters maximum).

6. Click OK to save your settings.

Patron Inactivity Timer

The patron inactivity timer starts only when a patron has stopped doing any of the
following actions: clicking Polaris product buttons, links, cover images; clicking in the
PowerPAC portion of the browser window; or entering a credit card payment. When any
of these actions occur, activity is registered and the inactivity timer is restarted. Actions
that are not counted as activity include resizing or moving the browser window;
accessing browser menu options; scrolling; or accessing any third-party resource that
opens in a lightbox, frameset, or new browser window.

When this feature is enabled, the browser status bar displays a count-down timer when
60 seconds are left before automatic logout. In addition, an alert box displays the
following message 30 seconds before the session is due to time out: Your session will
end in 30 seconds.

If the user clicks the Continue session button in the timeout alert box, the session
timeout clock restarts, and the user remains on the current page. If a lightbox was open,
it remains open. If the user does not click the Continue session button, the session
ends, and the page defined in the Patron inactivity timeout profile displays.

Note:
When a credit card payment is submitted, the Patron Inactivity Timeout
value is calculated by adding it to the credit card gateway timeout set in
the Credit Card parameter Online payments: Configure plus 90 seconds.

The count-down timer text can be edited in Polaris Language Editor (string ID PACML_
TIMEOUMSG).

The following language strings can be edited in Polaris Language Editor:

l PACML_TIMEOUTALERT
l PACML_TIMEOUTALERT2
l PACML_CONTINUESESSION
l PACML_TIMWINTITLE
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l PACML_TIMEOUTCLICK
l PACML_TIMEOUTSECONDS

Note:
The number of seconds cannot be modified.

Note - Secure Socket Layer (SSL):
If SSL is enabled for the entire site, the 60-second countdown timer
appears in the status bar only if you add the site to the trusted sites list in
Internet Explorer. For more information about SSL, see the Polaris
Administration Guide.

Note - Firefox browsers:
You may need to clear the browser history to make the timer work
correctly.

To display the count-down timer in the status bar, select Tools, Options, Content tabbed
page, and click Advanced. On the Advanced JavaScript Settings dialog box, select
Change status bar text.

The automatic logoff applies only to in-house workstations. A workstation is typically
considered to be in-house if it is registered in Polaris Administration (staff client
workstations) or if the workstation’s IP address is listed in the In-House IP Addresses
database table. If you use Polaris PowerPAC on workstations within the library and you
are enabling the patron inactivity timeout, be sure to list them in the In-House IP
Addresses database table.

For information about registering client workstations in Polaris Administration, see the
Polaris Administration Guide.

For information about listing PowerPAC workstations in the In-House IP Addresses
database table, see the Polaris Administration Guide.

You can determine whether the system checks both the In-House IP Addresses table
and the registered workstations (the default setting), or only the In-House IP Addresses
table, to determine whether a workstation is in-house. See the Polaris Administration
Guide.
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Set up PAC Active Directory logon

You can allow users to log on to PAC using network credentials (Active Directory logon)
instead of the Polaris patron record barcode/username and password. ActiveDirectory
logon has these requirements and limitations:

l The Polaris production server must be in the same domain as the Active Directory
service.

l The library must designate a user-defined field (UDF) to contain the network ID in
the patron record. Staff can search for patron records by this UDF if trouble-shoot-
ing is necessary. For information about setting up UDFs, see the Patron Services
Administration Guide.

l The Polaris patron record barcode and password will not work to log on to the
patron record in PAC. Because the network ID is the standard for access and the
Polaris patron barcode/password cannot be used to log on, the library must limit
the user’s ability to manage this Polaris patron data by suppressing certain
options from PAC. In Polaris Administration, suppress the following options with
the PAC profile Patron access options (see Setting Patron Account Options):

o Create a username - On the Log In tabbed page (system level only), clear the
Enable patron username checkbox.

o Change passwords - On the Log In tabbed page, clear the Patron can change
password checkbox.

o Manage forgotten passwords - On the Log In tabbed page (system level
only), clear the E-mail forgotten password checkbox.

o Register for a patron account online - On the Self-registration tabbed page,
clear the Patron can self-register checkbox.

l SIP applications, such as third-party self-check, will not work with the Active Dir-
ectory credentials. They require the Polaris patron record barcode and password.

l Offline Polaris will not work with the Active Directory credentials. It requires the
Polaris patron record barcode and password.

See Active Directory Log On in PAC.

To allow users to log on to PAC using network credentials instead of the Polaris patron
record barcode/username and password:

Note:
These settings apply to both Polaris PowerPAC and Mobile PAC.
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1. In the Administration Explorer tree view, open the Profiles folder for the system,
and click the PAC tab in the details view.

2. Double-click Active directory logon. The Active Directory Logon dialog box
appears.

3. Select Enable.
4. Select the UDF (user-defined field) that contains the network ID from the list.
5. The options are the UDFs defined for the system. See the Patron Services Admin-

istration Guide.
6. Enter the network domain name (maximum 25 characters).
7. Click Save.
8. Suppress user name, password, and self-registration options from display in PAC,

using the PAC profile Patron access options. See Enable patron account access -
PowerPAC.

Important:
There are no programmatic relationships between the Active
Directory Logon settings and the Patron access options settings
that control patron usernames, passwords, or self-registration. You
must suppress these options in Polaris Administration as described
here.

9. Using Polaris Language Editor (WebAdmin), reload Polaris PowerPAC and Mobile
PAC.

Active Directory Log On in PAC

When the Active Directory option is enabled, the PAC log-on page displays Username
and Password fields. The user enters the network ID (username) and password. If the
password is correct and the username matches that entered in a single patron record
UDF, the user is logged on. The Username field label can be edited in Polaris Language
Editor (WebAdmin).

Authentication fails in the following situations:

l The credentials cannot be validated according to network validation rules (for
example, the user has entered a Polaris patron barcode instead of the network
username). A message is displayed: You have entered an invalid ID or password.
Please try again.
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l The ID (username) entered does not match the designated UDF in any patron
record. A message is displayed: Your library account cannot be verified. Please
contact the library for assistance.

l The ID entered matches the designated UDF in more than patron record. A mes-
sage is displayed: Your ID matches more than one library record. Please contact
the library for assistance.

These messages can be edited in Polaris Language Editor (WebAdmin). The language
strings are:

l PACML_ADLOGON_FAILED (invalid ID or password)
l PACML_ADLOGON-NOPATRON (library account cannot be verified)
l PACML_ADLOGON_MULTPATRON (more than one library record)

Set up a privacy statement link (Polaris PowerPAC)

You can display a link to the library’s privacy policy (For more information on our privacy
policy, click here) on the patron self-registration pages and at all patron log-in points
when Single Login is enabled and the patron has not yet logged in.

To display the link in Polaris PowerPAC:

1. In the Administration Explorer tree view, open the Profiles folder for the branch,
and click the PAC tab in the details view.

2. Double-click Patron Access: policy statement hyper text link permitted, and set
the value to Yes.

3. Double-click Patron Access: policy statement hyper text link, and type the com-
plete URL to the Web page for the library privacy policy.

4. Select File, Save.

See the Patron Services Administration Guide.

Displaying Claimed and Lost Items in Patron Accounts in PAC

The PowerPAC and Mobile PAC Navigation: Claimed and Lost profiles are available at
the System, Library, and Branch levels. When a patron logs into the PowerPAC or Mobile
PAC, the profile setting for the patron's registered branch determines whether claimed
and lost items are displayed.
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See also:

l Enable display of claimed and lost items in PowerPAC
l Enable display of claimed and lost items in Mobile PAC

Enable display of claimed and lost items in PowerPAC

To enable claimed and lost items to display in the patron account view in PowerPAC:

1. Select Administration > Explorer.
2. Select the organization (System, Library, or Branch).
3. Select Profiles, and select the PowerPAC tab.
4. Double-click Navigation: Claimed and Lost, and select Yes.

If this profile is set to Yes for the patron's registered branch, when the patron logs
into his or her account in PowerPAC, any claimed or lost items the patron has are
displayed in the Claimed and Lost view. See the example below.
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Enable display of claimed and lost items in Mobile PAC

To enable claimed and lost items to display in the patron account view in Mobile PAC:

1. Select Administration > Explorer.
2. Select the organization (System, Library, or Branch).
3. Select Profiles, and select the Mobile PAC tab.
4. Double-click Navigation: Claimed and Lost, and select Yes.

If this profile is set to Yes for the patron's registered branch, when the patron logs
into Mobile PAC, any items that were claimed or declared lost are displayed on the
Claimed and Lost view. See the example below.
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Editing Messages and Labels

Many messages and labels that appear in Polaris PowerPAC are stored in your
database. You can easily edit these and save your changes in Polaris Administration,
using the PAC profile Multiple language strings. If you have Polaris PowerPAC
Multilingual Version, you can edit the messages for each supported language. Using the
same method, you can also edit and translate the labels for the Narrow and
Related Web parts that are displayed with search results.

Note:
You can also use Polaris WebAdmin (Language Editor) to edit language
strings in Polaris PowerPAC, Mobile PAC, and several other Polaris
products. WebAdmin is installed by default with Polaris Web Server
software. The server must be registered as a workstation in Polaris
Administration, and both the workstation and staff user must have the
System Administration WebAdmin access: Allow permission. Access
WebAdmin through your browser and click Help for more information. See
Customizing Language Strings for details.

Edit PowerPAC messages and labels

You can edit messages on the system, library, or branch level. To edit messages, labels,
and news headings for Polaris PowerPAC:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

2. Double-click Multiple language strings. The Language Strings dialog box appears.
The Field Name column lists the messages and labels. The Display Text column
lists the text that has been defined for each message or label.

Note:
For more information, see PAC Messages and Labels Reference.
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3. If you have Polaris PowerPAC Multilingual Version, select the language you want
to edit in the Choose Language box.

4. Highlight the text you want to change.
5. Open the text box by pressing ENTER or double-clicking the text.
6. Type the text for the message, label, or news heading. You can use letters, num-

bers, and spaces. Polaris PowerPAC can display approximately 150 characters
and spaces in a single line for messages. Text strings work well as plain text. You
can format messages to have up to four lines of text, with up to 250 characters. In
this case, you can use well-formed XML or HTML tags to place bold and italic
formatting in your messages. Use the tag <br/> to designate the start of a new line
in the message. The formatting tags count as characters and there is a 255-char-
acter maximum.

7. To insert a diacritic character, follow these steps:

a. Click Diacritics. The Character Picker dialog box opens.
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b. Select a graphic character set.
c. Select the character, and click Insert. The Character Picker dialog box closes.

8. Press ENTER or select another message.
9. Repeat steps 4-8 for each message you want to edit.

10. Click OK on the dialog box.
11. Select File > Save.

PAC Messages and Labels Reference

You can edit the following messages and labels using the Multiple language strings
PAC profile. See Edit PowerPAC messages and labels.

Field Name Description Default Display
Text

Hours of operation
message

The message you specify here is
displayed on the Polaris PowerPAC
Hours page and the Mobile PAC
Hours & Contact Info page. For

—
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Field Name Description Default Display
Text

more information about the
PowerPAC Hours page, see Set
Polaris PowerPAC features on the
menu bar.

Item availability label: Due
date Due

Item availability text:
Available

Indicates an item is available to
request or check out. This text is
used instead of the circulation
status when you do not display the
detailed item status in the
Availability view.

Requirement: PAC profile settings
Item Availability: Display status 
(Yes); Item Availability: Display
detailed item status (No).

Available

Item availability text: No
items found

Indicates that a title does not have
any items associated with it
anywhere in the entire Polaris
system.

No items
available

Item availability text: No
local items found

Displayed when a selected title
does not have linked items within
the local area. The local area is
defined by branches designated as
local in the Item Availability Display
Order policy table. See Setting Up
Local and System Availability. This
message displays if items do exist
elsewhere in the Polaris system;
otherwise, the message for the
Item Availability text: No items
found message is displayed.

No items
available locally
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Field Name Description Default Display
Text

Item availability text: Non-
circulating

Indicates that an item does not
circulate. Non-circulating

Item availability text: Not
available

Indicates an item is not available
for check-out. This text is used as a
status replacement when you do
not display the detailed item status
in the Availability view.

Requirement: PAC Profile settings
Item Availability: Display status 
(Yes); Item Availability: Display
detailed item status (No).

Not Available

Narrow search dashboard
(Bibliographic): Assigned
branch

The Narrow search dashboard
(Bibliographic) labels apply to the
bibliographic elements that appear
in the Narrow Web part, which can
be displayed with the Polaris
PowerPAC search results pages.
See Setting PowerPAC
Narrow/Related Search Options.

Assigned branch

Narrow search dashboard
(Bibliographic):Authors Authors

Narrow search dashboard
(Bibliographic):Availability Availability

Narrow search dashboard
(Bibliographic):Dashboard
label

Narrow your
search

Narrow search dashboard
(Bibliographic): Database Database

Narrow search dashboard
(Bibliographic): Language Language

Narrow search dashboard
(Bibliographic): Reading
Level

Reading Level

Narrow search dashboard Literary Form
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Field Name Description Default Display
Text

(Bibliographic): Literary
Form

Narrow search dashboard
(Bibliographic): Popularity Popularity

Narrow search dashboard
(Bibliographic): Publication
Date

Publication Date

Narrow search dashboard
(Bibliographic): Record
Owner

Record Owner

Narrow search dashboard
(Bibliographic): Related
Words

Related Words

Narrow search dashboard
(Bibliographic): Series Series

Narrow search dashboard
(Bibliographic): Subjects Subjects

Narrow search dashboard
(Bibliographic): Target
audience

Target Audience

Narrow search dashboard
(Bibliographic): Type of
Material

Type of Material

Narrow search dashboard
(Community): Dashboard
label

The Narrow search dashboard
(Community) labels apply to the
Community Profiles elements that
appear in the Narrow Web part. For
more information, see the
Community Profiles Guide.

Narrow your
search

Narrow search dashboard
(Community):Event date Event Date
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Field Name Description Default Display
Text

Narrow search dashboard
(Community):Primary
Name

Organization
Name

Narrow search dashboard
(Community): Services
Available

Services

Narrow search dashboard
(Community):Subject Subject

Narrow search dashboard
(Community):Type of
organization

Type of
Organization

Patron Access: Patron self-
registration brief instruction

Displayed at the top of the patron
self-registration form in Polaris
PowerPAC. You can use this text to
tell a new patron how to fill out the
form, or include any message
considered important to the self-
registration process.

Please fill in the
fields on this form
and click Submit
to register. Your
online registration
will be forwarded
to the library. You
can pick up your
library card at the
branch you
specify in the
form.

Patron Access: Privacy
message

Confirmation message displayed
when a patron initiates an action
that saves information in
connection with the patron account,
such as saving a search or starting
a reading history.

The feature you
have selected is
associated with
personal data in
your patron
account. Such
data may be
accessed by law
enforcement
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Field Name Description Default Display
Text

personnel without
your consent. Do
you wish to
continue?

Patron Access: Self-
registration
acknowledgment message

Displayed when a patron
successfully completes the self-
registration form.

Thank you! Your
registration has
been recorded.
Your library card
will be ready for
you at the library
you designated in
your registration.

Patron Access: Self-
registration warning
message

Displays when a patron selects
click here to register now on the
PowerPAC patron logon pages.
This message allows the library to
comply with the Children’s Online
Privacy Act.

Requirement: Self-registration
warning message enabled (PAC
profile Patron Access Options)

In compliance
with the
Children\’s Online
Privacy Protection
act, you must be
13 or older in
order to complete
this registration.

Note:
In the default
message, the
apostrophe
character is
preceded by a
backslash \ for
programmatic
purposes. In your
custom text, you
do not need to
use the backslash
before an
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Field Name Description Default Display
Text

apostrophe.

Related search dashboard
(Bibliographic): Authors

The Related search dashboard
(bibliographic) labels apply to the
elements that appear in the Related
Web part for bibliographic records,
which can be displayed with the
Polaris PowerPAC search results
pages. For information about
specifying bibliographic elements
and their labels, see Setting
PowerPAC Narrow/Related Search
Options.

Authors

Related search dashboard
(Bibliographic): Dashboard
label

Related searches

Related search dashboard
(Bibliographic): Other
databases

Other Databases

Related search dashboard
(Bibliographic): Other
searches

Other Searches

Related search dashboard
(Bibliographic):Series Series

Related search dashboard
(Bibliographic):Subjects Subjects

Related search dashboard
(Community): Dashboard
label

The Related search dashboard
(Community) labels apply to the
elements that appear in the Related
Web part for community records.
For more information, the
Community Profiles Guide.

Related Searches

Related search dashboard
(Community): Event Date Event Date

Related search dashboard
(Community): Primary
Name

Organization
Name

Related search dashboard
(Community):Services
Available

Services

Related search dashboard Subject
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Field Name Description Default Display
Text

(Community): Subject

Related search dashboard
(Community): Type of
organization

Organization
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Customizing Language Strings

Polaris WebAdmin (Language Editor) is a web-based tool you can use to customize
English and other licensed language strings in all the parts of Polaris that support
multiple languages, including Polaris PowerPAC, Polaris Mobile PAC, Polaris
ExpressCheck, printed and e-mail notices, telephone notices, and Polaris Phone
Attendant (inbound telephony). You can compare, add, edit and distribute language
strings easily, without editing individual files. Polaris WebAdmin also provides a
language string identifier specifically for Polaris PowerPAC.

You can add or customize language strings at the system, library, and branch levels.
Branch settings override library settings; settings made at the library level override
system-level settings.

When you change Polaris PowerPAC, PowerPAC Children’s Edition, or Mobile PAC
settings in Polaris Administration, or customize language strings with WebAdmin, you
must update page caches to see the effects of your changes. Most cached information
is stored at the application level on the specified web server. You update that
information with the Reload tool in WebAdmin.

For security purposes, Polaris WebAdmin should be installed on a server to which there
is no outside access, but which has access to the Polaris database—for example, the
web portion of the Polaris application server. You can access and use WebAdmin with
most browsers.

You need the Polaris permission WebAdmin access: Allow to use Polaris WebAdmin. In
Polaris Administration, this permission is available at the system level under the System
Administration security node.

To access WebAdmin, open your browser and navigate to the site where WebAdmin is
installed. You must supply your Polaris username, password, and domain to log in. For
detailed information about using WebAdmin, see WebAdmin online help.

Note:
You can also edit certain messages and labels in Polaris Administration.
See Editing Messages and Labels.
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Polaris PowerPAC Children’s Edition

Polaris PowerPAC Children’s Edition is the public access Web interface designed
specifically for children’s use. Children can connect to the library’s catalog and services
from within the library, or from a remote location such as home or school.

Polaris PowerPAC Children’s Edition is available by specific contract to your library. If
your Polaris installation does not include Polaris PowerPAC Children’s Edition, the
features described in this section are not available.

Important:
When you change Polaris PowerPAC Children’s Edition settings, you may
need to update page caches to see the effects of your changes. See
Updating Page Caches.

Note:
Polaris PowerPAC and Polaris PowerPAC Children’s Edition are based on
ASP.NET programming code. All .aspx page files are editable, and other
advanced customizations are available. For more information, see the PAC
Customization Guide.

Note:
Polaris PowerPAC version 5.5 and later features responsive web design
that adapts to the user's device (desktop computer, tablet, or smart
phone). Polaris PowerPAC Children's Edition does not use responsive
design, and is best used from a desktop computer or tablet.

See also:

l Administering PowerPAC Children’s Edition
l Managing Themes
l Managing Children’s Dashboards
l Setting Children’s Search Limits
l Managing Search Categories
l Customizing the Children’s Results Display
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Administering PowerPAC Children’s Edition

Through Polaris Administration settings, you can set up and customize the following
kinds of functions in Polaris PowerPAC Children’s Edition:

l Themes (general appearance of the pages)
l Dashboards, including library-defined lists
l Pre-defined search limits, such as target audience=juvenile and designated col-

lections (for example, children’s periodicals)
l Search categories
l Item availability information
l Feature availability, such as online Help and Events page

An organization’s settings control the features and functions the patron sees when
connected to that organization. You can set most Children’s PAC profiles at the system,
library, and branch levels. If you are making settings unique to an organization, the
Children’s PAC URL must include the organization ID.

Example:
http://library/Polaris/children/default.aspx?SessionOrgID=33

See also:

l Set up Polaris PowerPAC Children’s Edition
l Add text to the children’s Events page

Set up Polaris PowerPAC Children’s Edition

To set basic operating features for Polaris PowerPAC Children’s Edition:

1. Set up the Polaris PowerPAC Web server in Polaris Administration. See the Admin-
istration Guide.

2. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the Children’s PAC tab in the details view.

3. To allow remote connections to Polaris PowerPAC Children’s Edition, double-click
Remote user: Enable, and select Yes. If you use Polaris PowerPAC Children’s Edi-
tion only in the library, and you do not offer remote access, set this profile to No.

4. To allow patrons to select a theme for the Children's PAC interface, double-
click Select theme: Enable, and select Yes.
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Note:
This setting displays theme options in the dashboard area of the Polaris
PowerPAC Children’s Edition pages. If you want to display theme options,
you must also set Dashboards: Enable to Yes. See step 5.

Polaris PowerPAC Children’s Edition includes several default themes, and you can
define your own. For more information, see Managing Themes.

5. To display the dashboard on Polaris PowerPAC Children’s Edition pages, double-
click Dashboards: Enable, and select Yes.

Polaris PowerPAC Children’s Edition includes automated Web parts for
dashboards, and you can define your own. For more information, see Managing
Children’s Dashboards.

6. To allow users to view an events page, double-click Navigation: Events, and select
Yes.

This setting displays the Events link in the upper right portion of the Polaris
PowerPAC Children’s Edition pages. When the user selects the link, the Events
page is displayed. For information about editing this page, see Add text to the
children’s Events page.

7. To allow users to get quick help with searches, double-click Navigation: Help, and
select Yes.

This setting displays the Help bookworm link in the upper right portion of the
Polaris PowerPAC Children’s Edition pages.

Note:
Polaris PowerPAC Children’s Edition uses Did You Mean search
suggestions. See Setting Up Did You Mean Term Checking.

8. To display a link to Polaris PowerPAC on Polaris PowerPAC Children’s Edition
pages, double-click Navigation: PowerPAC, and select Yes.

This setting displays the Go to Polaris link at the bottom left corner of the Polaris
PowerPAC Children’s Edition pages. If the user selects this link on the home page,
the Polaris PowerPAC home page is displayed. If the user selects this link on the
search results page, the same search is launched in Polaris PowerPAC.

9. Select File > Save.
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Related Information

l Themes - You can offer default appearance themes for Polaris PowerPAC Chil-
dren’s Edition pages, or create your own. See Managing Themes.

l Searching - You can set search filters to focus search results for children. See Set-
ting Children’s Search Limits. In addition, categories offer predefined searches or
links. See Managing Search Categories.

l Search performance - Searches with large results sets may decrease performance
if your server capacity is limited. To improve performance, you can adjust the max-
imum number of records to return. The Children’s PAC profile Result set: Max-
imum number of records to return, available at the system, library, and branch
levels, controls this limit.

Note:
If you lower the maximum number of records to return, relevancy ranking
may be less effective.

l Results Display - See Customizing the Children’s Results Display.
l Requests - You set requests options (enable requests, specify whether item-level

requests are offered, and select a default pickup branch) for Polaris PowerPAC
Children’s Edition with the Request parameter Hold options. If the library charges
fees for hold requests, patrons cannot request holds from Polaris PowerPAC Chil-
dren’s Edition.

l Editing text on Polaris PowerPAC Children’s Edition pages - You can edit most of
the text on Polaris PowerPAC Children’s Edition pages, and preserve your changes
from being overwritten if the application is updated and reinstalled. See Cus-
tomizing Language Strings.

Add text to the children’s Events page

The Events page is displayed when a patron selects the Events link on the Polaris
PowerPAC Children’s Edition pages. Since Polaris PowerPAC Children’s Edition uses an
Events page distinct from Polaris PowerPAC, you can focus the page on events
specifically for children.

To add events or other text to the events page:

1. On the Web server, open the file Polaris [version]/PowerPAC/children/events.aspx
in any HTML or text editor.

2. Find the following section:
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SessionObject.GetLanguageString("CPACML_EVENTS_1000")%>:</div>

<p>&nbsp;</p>

<p>&nbsp;</p>

<p>&nbsp;</p>

Each segment <p>&nbsp;</p> creates a separate line on the Events page.

Note:
If you need more than three lines, copy the segment <p>&nbsp;</p> and
paste it after the last segment <p>&nbsp;</p>, pasting once for each
additional line you require.

3. For each line, insert your text between &nbsp; and </p>. You can format the text
with basic HTML tags.

4. Save the file.

Note:
To display the Events link on the Polaris PowerPAC Children’s Edition
pages, set the Children’s PAC profile Navigation: Events to Yes.

Managing Themes

Themes determine the page appearance (background, icons, and other page elements)
of Polaris PowerPAC Children’s Edition. When you enable themes, children can choose a
theme from the options you specify. You can offer some or all the themes that are
shipped with Polaris PowerPAC Children’s Edition, and you can develop your own
themes.
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Themes are developed at the system level, but you can assign them at the system,
library, or branch level, so that each branch can control which (if any) theme options are
available. The default theme—the theme that is displayed when users first connect to
Polaris PowerPAC Children’s Edition—can also be set at the system, library, or branch
level.

Themes are stored in folders that contain sets of image files and a style sheet (.css) file
that controls aspects of general page appearance, such as fonts, links, and colors. Each
theme has a unique folder on the Web server
(Polaris/PowerPAC/children/themes/<language folder>). For example, files for the
default Treasure theme (English) are located in the folder
Polaris/PowerPAC/children/themes/1033/treasure. If you are constructing your own
theme, set up a unique folder for your files on the Web server, in
Polaris/PowerPAC/children/themes/<language folder>.

Note:
Each language is represented by a number. English is represented by
1033, so theme folders for the English version are stored in
Polaris/PowerPAC/children/themes/1033. If you have Polaris PowerPAC
Children’s Edition Multilingual Version, and you want to offer the same
theme in other language versions, place the theme folder in all the
appropriate language folders.

Theme folders also contain the image files specified for category and format icons,
since these images can change when a different theme is chosen. Categories contain
predefined targets, such as searches or Web site URLs. For more information about
setting up categories, see Managing Search Categories. Format icons identify the type
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of material of a title listed in search results, such as a book or a musical sound
recording.

See also:

l Construct a theme
l Assign themes

Construct a Theme

To construct a theme:

1. Set up a unique folder for the theme on the Web server, in Polar-
is/PowerPAC/children/themes/language folder.

2. Create the subfolders categories and formats in the new theme folder (or copy
them from an existing theme folder).

Note:
You may want to copy the style sheet (.css) file from a default theme to
your own theme folder and then edit the file as you wish, rather than
constructing a style sheet from scratch.

3. In the Administration Explorer tree view, open the Profiles folder at the system
level, and select the Children’s PAC tab in the details view.

4. Double-click Theme Construction.The Theme Construction dialog box is dis-
played.
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Note:
The Theme Construction dialog box lists the default themes that are
included with Polaris (Antique, Ocean, and Treasure), and any custom
themes that have already been defined. You cannot edit the default
themes.

Tip:
To use an existing theme as the basis of a new theme, select the theme
and click Copy. Then select the copy and click Edit.

5. Click Add. The Add Theme dialog box is displayed.

6. Type a name for the theme in the Display Name box. The display name identifies
the theme in Polaris Administration profiles and on the Polaris PowerPAC Chil-
dren’s Edition interface.

Note:
The Cursor Type field is not functional.

7. In the appropriate File Name boxes, type the filenames for the page graphic ele-
ments and for the stylesheet, as listed in the Description column.

Note:
The system constructs the appropriate URL. Type only the filename. For
example, for the page background image, you might type the filename
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background.gif. For the style sheet, you might type the filename
stylesheet.css.

8. Type the name of the theme folder you created in step 1 in the Default Image Path
box.

Note:
Type only the folder name. The system constructs the appropriate URL for
the theme files to Polaris/PowerPAC/children/themes/language
folder/your folder on the server, based on the theme folder you specify. All
the files for the theme must be located in the same folder.

9. Click OK on the dialog box. The dialog box closes, and your settings are auto-
matically saved.

Related Information

Making themes available - See Assign themes for information about making the new
theme available for selection in Polaris PowerPAC Children’s Edition.

Assign themes

When you assign themes, you make them available as choices from the Children’s PAC.
You can assign the themes that are provided with Polaris, or your own custom themes
(see Construct a theme). To assign themes at the system, library, or branch level:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the Children’s PAC tab in the details view.

2. Double-click Theme assignment. The Theme Assignment dialog box opens.
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3. To make a theme available for selection in Polaris PowerPAC Children’s Edition,
select the theme in the Unassigned Themes list, and click Assign. The theme is
added to the Assigned Themes list.

4. To designate an assigned theme as the default theme, select the theme in the
Assigned Themes list, and click Assign Default Theme.

5. Click OK on the dialog box. The dialog box closes, and your settings are auto-
matically saved.

Note:
To display the theme options, set the Children’s PAC profiles Select
theme: Enable and Dashboards: Enable to Yes for the organization.

Managing Children’s Dashboards

Web parts on the dashboard can provide links to pre-defined searches or Web sites or
deliver messages or instructions. They are displayed in the dashboard at the side of the
pages in Polaris PowerPAC and Polaris PowerPAC Children’s Edition. Different Web
parts can be displayed on different pages. You set up Web parts at the system level for
use by any or all branches.
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Note:
The Select a Theme Web part is displayed on all pages when the
Children’s PAC profiles Select theme: Enable and Dashboards: Enable are
set to Yes.

Separate Polaris Administration profiles control Web parts for Polaris PowerPAC and
Polaris PowerPAC Children’s Edition, but the process for setting up Web parts is the
same for both PACs (see Defining Web Parts for Dashboards):

l Using the Children’s PAC profile Dashboards: Web Part Construction, you define
limits for automated lists and set up custom Web parts at the system level. See
Create a custom Web part.

l Using the Children’s PAC profile Dashboards: Web Page / Web Part Assignment,
you assign Web parts to specific Children's PAC pages at the branch level. See
Assign Web parts to public pages. For a summary of Polaris PowerPAC Children’s
Edition pages, see Polaris PowerPAC Children's Edition Pages Reference.

Web parts set up for Polaris PowerPAC are available to be assigned to Children's PAC
pages, and Web parts set up for Polaris PowerPAC Children’s Edition are available to be
assigned to Polaris PowerPAC pages. However, the New Titles Web part provided by
Polaris may not be useful for Polaris PowerPAC Children’s Edition, since the New Titles
Web part elements are links that launch searches for recent additions to your catalog,
regardless of the titles’ target audience.
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Setting Children’s Search Limits

In Polaris PowerPAC Children’s Edition, users can search for a title in the library catalog
by typing a word or words and selecting a field to search (Anywhere, Subjects, Titles,
Authors, or Series). You control which of these choices are available. In addition, you
can display Fiction and Non-Fiction buttons that launch subject searches for the search
text, scoped to fiction or non-fiction. See Set children’s search buttons.

You can also filter all searches to make the results more useful for children by setting a
free-text filter (expressed as a Common Query Language search term), by specifying
which collections should be searched, or by using a combination of the two strategies.
See Filter children’s searches.

Note:
Polaris PowerPAC Children’s Edition also offers targets (predefined
searches or Web links), organized in categories and subcategories.
Children can use categories to find information without typing a search
string. See Managing Search Categories.

Important:
In addition to the filtering and scoping options you set, Polaris PowerPAC
Children’s Edition is designed to display item availability information only
if there are items available at the local branch. You can set it so that item
availability information is displayed for items at other branches if there
are no items assigned to the local branch. See Customize the children’s
item availability display.

See also:

l Set children’s search buttons
l Filter children’s searches
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Set Children’s Search Buttons

To set which search buttons are available for text searches in Polaris PowerPAC
Children’s Edition:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the Children’s PAC tab in the details view.

2. Double-click the following profiles and set them to Yes or No:

l Search button visibility: Anywhere button - Launches keyword search in all fields
l Search button visibility: Authors button - Launches keyword search for author
l Search button visibility: Fiction button - Launches search term subject search

scoped to fiction
l Search button visibility: Non-Fiction button - Launches search term subject

search scoped to non-fiction
l Search button visibility: Series button - Launches keyword search for series name
l Search button visibility: Subject button - Launches keyword search for subject
l Search button visibility: Title button - Launches keyword search for title

By default, each is set to Yes (search button is displayed).

If all seven profiles are set to No, the Look for text field remains displayed
although no buttons appear. However, the user can type text in the field and press
ENTER. A keyword search in all fields (Anywhere) is launched. This feature is
available regardless of what buttons are displayed.

3. Select File > Save.

Related Information

Did You Mean - When you enable “did you mean” search term checking, the search
results page includes a suggested alternate search term if one can be identified. You
can click the alternate term to launch a search on that term. The Did You Mean function
applies to quick, keyword, phrase, and exact phrase searches in Polaris PowerPAC, and
to searches typed in the Look for bar in Polaris PowerPAC Children’s Edition when there
are no results. See Setting Up Did You Mean Term Checking.

Filter children’s searches

To set filters on searches from Polaris PowerPAC Children’s Edition, and to allow
subject searches scoped by fiction or non-fiction:
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the Children’s PAC tab in the details view.

2. Double-click Default search limits. The Children’s PAC Default Search Limit dia-
log box opens.

3. To filter searches with a free-text filter, type the Common Query Language com-
mand in the Default free text search limit box, beginning with the Boolean oper-
ator and.

The system constructs the full search command when the user launches a search.
The first part of the command (before and) is determined by the user’s selection in
the interface. Your filter determines the second part. The default filter is AND TA=j,
which limits the results to titles with a juvenile target audience.

Note:
Structure multi-part filters in either of these two ways:
AND TA=j OR TA=a OR TA=b
AND TA={list}j, a, b {/list}
Not valid:
AND TA= j, a, b

4. To limit search results to titles in certain collections, select the collections in the
Collections list.
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Tip:
If you have collections set up for children’s periodicals, this is a good way
to include the periodicals in Children’s PAC search results, since serials
records do not include target audience information. The results include
titles from the collection OR the specified target audience filter.

Combining free-text and collections filters works best if you select only the
collections intended for children. If all collections are selected, and you specify a
free-text filter, the search applies the free-text filter but ignores the collections. If
no free-text filter is specified, all the collections are searched, but records that do
not specify a collection are ignored.

5. Click OK on the dialog box.
6. Select File > Save.

Managing Search Categories

Polaris PowerPAC Children’s Edition offers targets (predefined searches or Web links),
organized in categories and subcategories. Children can use categories to find
information without typing a search string. When the Children’s PAC profile Categories:
Enable is set to Yes, the default page of the Children’s PAC displays the defined search
categories.

Polaris PowerPAC Children’s Edition includes a set of default categories and targets
that you can use as they are, or edit to suit your purposes. You can also set up your own
categories at the system, library, and branch levels. Using the Children’s PAC profile
Category construction, you define the categories and subcategories, and the targets to
include in the categories and subcategories. You can offer the following types of search
targets:
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l Search - Launches a defined search in the Polaris database, and displays the res-
ults.

l Bibliography - Launches a search for titles you specified when you set up the tar-
get.

l URL - Connects to a Web site, which opens in a new browser window. The Polaris
PowerPAC Children’s Edition session is maintained.

Note:
To allow live-link Web targets, set the Children’s PAC profile Web access:
Enable to Yes. If this profile is set to No, the URL targets appear as text
only.

A search target or subcategory can belong to as many categories as you wish. You can
copy and paste search targets and categories to organize them in any way that suits the
needs of your users. If you have Polaris PowerPAC Children’s Edition multilingual
version, you can translate category and target names so that they are displayed in the
language the user has selected.

You can display a category or subcategory as a text link, an image link, or both. When a
category link is selected, all the subcategory and target links are displayed. If icons are
defined for search targets, these are organized in a matrix of links. If no icons are
defined, the search targets are also displayed as a list of text links.

See also:

l Add a new category
l Add a new search target to a category
l Copy a category or target
l Translate a category or target
l Translate all categories and targets

Add a New Category

You can define categories at the system, library, or branch level. To add a category or
subcategory for Children’s PAC searches:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the Children’s PAC tab in the details view.

2. Double-click Category construction. The Children’s PAC Category Configuration
dialog box appears.
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Note:
Existing categories and subcategories are represented by folder icons.
Click the plus sign by a category to display its contents (subcategories
and targets). To view specific characteristics of any category,
subcategory, or target, select the item and click Modify.

3. Select (highlight) the folder to which you want to add a category.

Note:
The top-level Root category is always listed. The link for any category or
target on the next level under Root is displayed directly on the Children’s
PAC home page. If you do not select an existing folder, the category is
added directly under the Root group.

4. Click Add Category. The Add Category dialog box opens.
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5. In the Display Name box, type a category name. The Display Name identifies the
new category in the Category Configuration dialog box and in Children's PAC. If no
category icon is defined, the Display Name is directly displayed as a link on the
Children’s PAC home page. If an icon is defined for the category, the category is
displayed as a link when the icon is selected. (See step 8.)

6. To insert a diacritic character in the display name, follow these steps:

Tip:
If you frequently enter diacritics, you can add Input Method Editor (IME)
keyboards and switch back and forth from the English keyboard to the
international keyboards. See the Cataloging Guide.

a. Click Diacritics. The Character Picker dialog box opens.

b. Select a graphic character set.
c. Select the character, and click Insert. The Character Picker dialog box closes.

7. (Optional) Type any text in the Display Message box that should be displayed
below the category Display Name and above the matrix or list of targets.
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Tip:
You can insert diacritic characters in the display message. See step 6.

8. Type the file name for the category icon graphic in the Icon File Name box. In the
Children’s PAC interface, the patron can click the category icon to see sub-
categories or targets.

Type only the file name. Polaris constructs the appropriate URL to the
categories folder of the theme the patron has selected, or to the default theme if
you do not allow theme selection.

Important:
Be sure to place the category icon graphic file in the categories folder for
each theme you offer. Although the actual image can be different, the
filename must be the same in each theme. For example, if you specify a
category icon graphic file pets.gif, the categories folder for each theme
must contain a graphic file called pets.gif. Otherwise, if a theme is chosen
that does not include the appropriate category icon graphic file, the
interface displays a missing link. For more information about themes, see
Managing Themes.

9. Select or clear the Tooltip Preview checkbox. If the Tooltip Preview box is
checked, targets for this category are displayed when the cursor hovers over the
category link in the Children’s PAC interface. To display tooltip previews, you must
also specify an icon file name for the category (see step 7).

Note:
Use the Children’s PAC profile Number of tooltip entries displayed to set
the maximum number of tooltip entries to display. You must also check
the Preview Search Target box for each target you want to display in the
tooltip. See Add a new search target to a category for more information
about setting up targets.
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10. Click OK on the Add Category dialog box. The Add Category dialog box closes.
The new category is displayed in the Category Configuration dialog box.

11. Click OK on the Category Configuration dialog box.

Note:
To display categories in the Children’s PAC interface, be sure the
Children’s PAC profile Categories: Enable is set to Yes for the
organization.

12. Add targets to the new category. See Add a new search target to a category.

Related Information

l Copy a category - See Copy a category or target.
l Delete a category or subcategory - Select the category, and click Delete.
l Edit the settings for a category - Select the category, and click Modify.
l Translate category names - If your library system has purchased other language

versions of Polaris PowerPAC Children’s Edition, you can translate the category
name or all category names. See Translate a category or target and Translate all
categories and targets.

Add a New Search Target to a Category

Within a category, a target may be displayed as a text link in a list of links, or as a
graphic link in a matrix of target graphics. To set up a new search target of either
display type, and add it to a category:

1. Double-click Category construction on the Children’s PAC Profiles tabbed page for
the organization. The Children’s PAC Category Configuration dialog box appears.

2. Select the category (folder) to which you want to add the new search target.

Note:
You can add a target directly under the Root level. In this case, the target
link displays directly on the home page.

Tip:
You can view the structure of default targets to get ideas about how to set
up targets. Select a default target and click Modify to view the target.

3. Click Add Target. The Add Children’s PAC Search Target dialog box appears.
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4. In the Display Name box, type a target name. The Display Name identifies the new
target in the Category Configuration dialog box and on the Children's PAC home
page.

5. To insert a diacritic character in the display name, follow these steps:

Tip:
If you frequently enter diacritics, you can add Input Method Editor (IME)
keyboards and switch back and forth from the English keyboard to the
international keyboards. See the Cataloging Guide.

a. Click Diacritics. The Character Picker dialog box opens.
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b. Select a graphic character set.
c. Select the character, and click Insert. The Character Picker dialog box closes.

6. If you want this target to be part of a matrix of search targets for the category, do
these steps:

a. Type the name of the target icon file in the Icon File Name box.

The search target icon is displayed in Polaris PowerPAC Children’s Edition as a
link, which you can click to launch the search. All targets with icons in a specific
category are grouped together in the matrix. If you do not specify an icon, the
target is displayed as a simple text link in a list with any other text-link targets.

Important:
Be sure to place the target icon graphic file in the categories folder for
each theme you offer. Although the actual image can be different, the
filename must be the same in each theme. For example, if you specify a
target icon graphic file dogs.gif, the categories folder for each theme
must contain a graphic file called dogs.gif. Otherwise, if a theme is
chosen that does not include the appropriate target icon graphic file, the
interface displays a missing link. For more information about themes, see
Managing Themes.
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b. If you want to display text along with the target icon in the matrix, type the text in
the Icon Display Name box. (If you specify an Icon Display Name, be sure you spe-
cify an Icon File Name.)

Note:
You can insert diacritic characters in the icon display name. See step 5.

7. Select a target type:

l Search - Launches a defined search in the Polaris database. This target type is

identified by a database icon  in the Category Configuration dialog box. If you
select this target type, also do step 8.

Note:
If you want all search targets in this category to be organized in a matrix,
specify both an Icon Display Name and a corresponding Icon File Name
for each search target. Otherwise, the search target is displayed as a text
link.

l Bibliography - Displays a search link. The link launches a search for titles you spe-

cify. This target type is identified by a book icon  in the Category Configuration
dialog box. If you select this target type, also do step 9.

l URL - Displays a text link that connects to a Web site. This target type is identified
by a Web Site icon in the Category Configuration dialog box. If you select this tar-
get type, also do step 10.

8. If you selected Search as the target type, input the search command as a Com-
mon Query Language (CQL) command in the Search box.

If the search string does not begin with FIND, the system automatically adds Find
before the search is launched. For more information about using CQL search
commands, see PAC CQL Commands & Access Points.

Exception: You cannot set up a phrase search with quotation marks in the
Search box; instead, use the AND operator. For example, if you are setting up a
subject search for the subject heading $aAnimals$xAdaptation$vJuvenile films,
type
su=animals AND su=adaptation AND su=juvenile films
(not su= “Animals--Adaptation--Juvenile films”).
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9. If you selected Bibliography as the target type, add titles to the bibliography by fol-
lowing these steps:

a. Click Add next to the Bibliography box.

The Polaris Find Tool is displayed.

b. Use the Find Tool to locate and select the bibliographic record for the title you
want to add to the bibliography.

Note:
When the search is launched in the Children’s PAC, any search filters you
defined in the Children’s PAC profile Default search limits are applied. If a
title you selected does not meet the search filter criteria, it is not
displayed in the search results.

c. Repeat these steps to add each title to the bibliography. You can add up to 120
titles.

You can multi-select records from the Find Tool results.

10. If you selected URL as the target type, input the complete URL for the Web page
search target in the URL box.

To allow live-link Web targets, set the Children’s PAC profile Web access:
Enable to Yes. Libraries where children’s Internet access is a concern should use
lockdown software or set this profile to No. In this case the URL target appears as
text only, and does not allow Web access.
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11. Select or clear the Preview Search Target checkbox.

If you are adding a target directly under the Root level, the Preview Search
Target box is not available, since the interface does not display the preview target
link if it is not associated with a category.

If the Preview Search Target box is checked, the target Display Name is displayed
as a link under the category to which the target belongs.

Note:
The preview search target does not automatically display once the
category is selected. If you want the same target link to be displayed once
the category is selected, set it up again under the appropriate category,
leaving Preview Search Target unchecked. You can copy and edit a
target. See Copy a category or target.

To display preview search targets, you must also specify an icon file name for the
category (see Add a new category).

The illustration shows an example of preview search targets:

Note:
If the Preview Search Target box is checked for a target, the target icon is
displayed with a small red flag in the Category Configuration dialog box.

For example, the search target icon  changes to .

12. Click OK on the Add Children’s PAC Search Target dialog box. The Add Children’s
PAC Search Target dialog box closes. The new target is displayed in the Category
Configuration dialog box.

13. Click OK on the Category Configuration dialog box.

Note:
To display the categories in the Children’s PAC interface, be sure the
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Children’s PAC profile Categories: Enable is set to Yes for the
organization.

Related Information

l Copy a target, and place the copy in another category - See Copy a category or tar-
get.

l Remove a target from a category - In the Category Configuration dialog box, select
the target you want to remove from the category, and click Delete.

l Edit the settings for a target - In the Category Configuration dialog box, select the
target you want to edit, and click Modify.

l Translate categories and targets - If your library system has purchased other lan-
guage versions of Polaris PowerPAC Children’s Edition, you can translate the cat-
egory and target names. See Translate a category or target, and Translate all
categories and targets.

Copy a category or target

You can copy categories and targets you have already defined, and place the copies in
any categories you choose. When you copy a category, you also copy the contents
(subcategories and targets) of the category. To copy a category or target into another
category:

1. Double-click Category construction on the Children’s PAC Profiles tabbed page for
the organization. The Children’s PAC Category Configuration dialog box appears.

Tip:
Click the plus sign by any category folder to display the contents of the
folder.

2. Select the category or target you want to copy.
3. Click Copy.
4. Select the category folder into which you want to place the copy of the category or

target.
5. Click Paste. The copied category or target is displayed in the selected folder.
6. Click OK to save your settings.
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Translate a category or target

If your library system has other language versions of Polaris PowerPAC Children’s
Edition, you can translate the names of categories and targets. To translate categories
or targets one at a time:

1. Double-click Category construction on the Children’s PAC Profiles tabbed page for
the organization. The Children’s PAC Category Configuration dialog box appears.

Tip:
Click the plus sign by any category folder to display the contents of the
folder.

2. Select the category or target you want to translate.
3. Click Modify. If you selected a category, the Edit Category dialog box opens. If you

selected a target, the Edit Children’s PAC Search Target dialog box opens.

4. Click Translate by the name you want to translate.

If you selected a category, you can translate the category name and the display
message, if any (see Add a new category). If you selected a target, you can
translate the display name and the icon display name, if any (see Add a new
search target to a category).

The Language Strings dialog box opens.
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5. Select a language from the Choose Language box. The options are determined by
the language versions of Polaris PowerPac Children’s Edition purchased by your
library system.

6. Click the box in the language column next to the target or category name you want
to translate, and type the translated word in the box.

7. To insert a diacritic character, follow these steps:

Tip:
If you frequently enter diacritics, you can add Input Method Editor (IME)
keyboards and switch back and forth from the English keyboard to the
international keyboards. See the Cataloging Guide.

a. Click Diacritics. The Character Picker dialog box opens.
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b. Select a graphic character set.
c. Select the character, and click Insert. The Character Picker dialog box closes.

8. Click OK on the Language Strings dialog box.
9. Click OK on the Edit dialog box.

10. Click OK on the Children’s PAC Category Configuration dialog box.

Related Information

Translate all categories and targets

Translate all categories and targets

If your library system has purchased other language versions of Polaris PowerPAC
Children’s Edition, you can translate all the names of categories and targets to a
language of your choice. To view and translate categories and targets:

Note:
You must set the translations at the system level.

1. In the Administration Explorer tree view, open the Profiles folder for the system,
and select the Children’s PAC tab in the details view.
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2. Double-click Multiple language strings. The Language Strings dialog box lists all
the category names, category display messages, target display names, and icon
display names defined for your Polaris PowerPAC Children’s Edition.

3. Select a language from the Choose Language box. The options are determined by
the language versions of Polaris PowerPAC Children’s Edition purchased by your
library system.

4. Click the box in the language column next to each name you want to translate, and
type the translated word in the box.

Note:
You can also edit the English names. Click the English word you want to
edit, and type a new word in the space.

5. To insert a diacritic character, follow these steps:

Tip:
If you frequently enter diacritics, you can add Input Method Editor (IME)
keyboards and switch back and forth from the English keyboard to the
international keyboards. See the Cataloging Guide.

a. Click Diacritics. The Character Picker dialog box opens.
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b. Select a graphic character set.
c. Select the character, and click Insert. The Character Picker dialog box closes.

6. Click OK on the Language Strings dialog box.
7. Select File > Save.

Customizing the Children’s Results Display

When a patron selects a title or the More link for a title in the search results, Polaris
PowerPAC Children’s Edition displays detailed information about the title and the items
associated with it.
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Note:
The format/type of material icons in Polaris PowerPAC Children’s Edition
are the same as those used in Polaris PowerPAC. For a list, see Setting Up
Search Filters (Limit By).

Using Children’s PAC profiles, you can specify what information displays about the
associated items, including branch location, collection, shelf location, call number,
status, and material type. You can set these profiles at the system, library, or branch
level.

See also:

l Web Access from Children’s PAC
l Customize the children’s item availability display

Web Access from Children’s PAC

If the title information includes a Web link, you can specify whether children can access
the associated Web site. Web links are indicated by the Web Site icon next to a title, and
by the URL link text in the detailed information for the title. To allow Web access, set the
Children’s PAC profile Web access: Enable to Yes at the system, library, or branch level.
When the patron clicks the Web Site icon, the Web site opens in a new browser window.

Important:
Libraries concerned about children’s Internet access should use lockdown
software or set the profile Web access: Enable to No. If this profile is set
to No, the globe icon and URL links are not “live.”
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Customize the Children’s PAC item availability display

To customize the item availability display in Polaris PowerPAC Children’s Edition:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the Children’s PAC tab in the details view.

2. To display the item’s owning branch, double-click Item Availability: Display branch
location, and select Yes.

Note:
Single-branch libraries may want to set this profile to No to save space in
the availability display.

3. Double-click Item Availability: Display local and system levels to set which items
are shown in the availability display. Select Yes or No:

l Yes - If the logged-on branch is the system, information about items that are des-
ignated to display in PAC and owned throughout the system is displayed. If the
logged-on branch is a local branch, only items held by that branch are displayed. If
none are owned by the local branch, the system-level items are displayed.

l No - If the logged-on branch is the system, information about items owned through-
out the system is displayed. If the logged-on branch is a local branch, only the
local items are displayed. If none are owned by the local branch, no items are dis-
played.

The Item Availability Display Order table determines which branches’ items should
be displayed as “system” and which should be displayed as “local.” See Set up the
local/system item availability display.

4. To display the items’ shelf locations, double-click Item Availability: Display shelf
location, and select Yes.

5. To display the items’ circulation status, double-click Item Availability: Display
status, and select Yes.

6. If you chose to display item status, specify the status text:

l Double-click Item availability text: Available, and type the text that indicates an
item is available. The default is In Library.

l Double-click Item availability text: Not available, and type the text that indicates
an item is not available. The default is Checked Out.
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7. To display item-level call numbers, double-click Item Availability: Display call num-
ber, and select Yes.

8. To display the items’ collection information, double-click Item Availability: Display
collection, and select Yes. If the library does not use collections, you may want to
set this profile to No to save space in the availability display.

9. To display the items’ material types, double-click Item Availability: Display type,
and select Yes.

10. To make public notes from the item record available, double-click Item Avail-
ability: Display notes, and select Yes. This setting displays a note icon for items
whose records include public notes. Users can click the icon to read the note.

11. Select File > Save.
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Setting Up Mobile PAC - Overview

Polaris Mobile PAC is a Web-based public access catalog that has been optimized for
mobile devices, providing simplified access to most of the features available in Polaris
PowerPAC. Any device with a Web browser can access the site, including mobile
devices with browsers optimized for mobile use and computers with standard Web
browsers.

Polaris Mobile PAC works best with mobile devices where users navigate the interface
in either of two ways: with a pointing device, where user touches the desired option or
selects it with a stylus; or with navigation keys, where the user presses keys (such as
arrow keys) on the device key pad to move the focus up or down in a list. Full
functionality may not be available for cell phones without full keyboards or pointing
devices.

Note:
Beginning with Polaris 5.5, Polaris PowerPAC features responsive web
design so users can enjoy the same PowerPAC features regardless of
device (desktop computer screens, tablets, or phones).

Mobile PAC must be installed on a Polaris Web server and the library must have a
current, valid license to make Mobile PAC available. Mobile PAC also offers a
multilingual version, where users can select the display language on any page or set a
language preference that persists from session to session. Polaris Administration
settings control the features available in Mobile PAC. Mobile PAC shares some settings
with Polaris PowerPAC. Other settings apply only to Mobile PAC.

See also:

l Mobile PAC Basics
l Setting Up Mobile PAC Connections
l Setting Up Mobile PAC Library Information
l Setting Up New and Popular Titles in Mobile PAC
l Setting Up Ask Us in Mobile PAC
l Specifying Mobile PAC Search Settings
l Mobile PAC Results Settings
l Saved Searches (Search Agent) in Mobile PAC
l Title Lists in Mobile PAC
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l Patron Registration in Mobile PAC
l Patron Log-In Settings for Mobile PAC
l Patron Account (My Account) in Mobile PAC
l Credit Card Payments from Mobile PAC

Mobile PAC Basics

Polaris Mobile PAC provides a simple interface that has been optimized for mobile
devices. Basic functions are available directly from the home page.

Users can click Preferences to set which links appear on the home page, and other
preferences such as connection organization, language, and display options. These
settings persist from session to session for one year, so that common selections are
already made when the user connects to Mobile PAC.

See also:

l Installation
l Secure Socket Layer (SSL)
l Updating Page Caches
l Analyzing Polaris Mobile PAC Use
l Customizing Mobile PAC
l Mobile PAC Device Compatibility
l Troubleshooting

Installation

You select Mobile PAC for installation when you install Polaris Web Server software. (By
default, Mobile PAC is not selected for installation.)

Secure Socket Layer (SSL)

Mobile PAC works without using SSL protocols (https:) to encrypt data, but personal
data sent over the Internet is exposed to potential interception. If you have the
appropriate site certificate, you can encrypt the entire Mobile PAC site to protect your
patrons’ logon and library account information when they log on to request holds, renew
items, or review their accounts. To enable data encryption, set the SSL: Enable: Mobile
PAC parameter for the web server to Yes. For more information about SSL and Polaris,
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see the Administration Guide. (You can set SSL for Polaris PowerPAC with a separate
parameter.)

Note:
Some older mobile phones do not support SSL.

Updating Page Caches

When you change Polaris Mobile PAC settings, you may need to update page caches to
see the effects of your changes. Most cached information is stored at the application
level on the web server. You can update that information with the Reload tool in Polaris
WebAdmin (Language Editor). For more information, see the WebAdmin online help.

Note:
The Reload function reloads settings only for those organizations whose
settings have already been cached. You may have to do an IIS reset to see
changes applied to other organizations. Hosted customers should
contact Polaris Customer Support to perform an IIS reset.

Analyzing Polaris Mobile PAC Use

Google Analytics is a free tool from Google that allows website administrators to record
and analyze traffic on their sites. Like Polaris PowerPAC, Mobile PAC includes the
JavaScript code for Google Analytics 4 in the page footer. To use this feature, open the
Polaris Administration Mobile PAC profile Mobile PAC Analytics. The profile is available
at the system, library, and branch levels. On the Google tab, select Enable and supply
your Google Analytics 4 measurement ID.

For more information about Google Analytics, and to obtain a measurement ID, go to:
https://analytics.google.com/analytics/.

Note:
If you have already enabled Google Analytics for Polaris PowerPAC, you
can use the same tracking code for Mobile PAC.

Alternatively, you can supply your own JavaScript for site analysis. Open the MobilePAC
Analytics profile. On the Custom tab, select Enable, and type your JavaScript code in the
field provided.

https://analytics.google.com/analytics/
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Note:
Cell phones that do not support JavaScript ignore the JavaScript code, so
these connections are not calculated in your site analysis.

Customizing Mobile PAC

l Text customization - You can edit language strings for Mobile PAC pages in Eng-
lish and any licensed language using Polaris WebAdmin (Language Editor). For
instructions, see the WebAdmin help file.

l Page customization - With appropriate knowledge of XML, you can also customize
Mobile PAC at the program level. For more information, see the
PAC Customization Guide.

Mobile Device Detection

In Polaris version 5.2 and earlier, checks in Polaris code help to ensure that mobile
device users were automatically redirected to the Mobile PAC site if they connected to
the Polaris PowerPAC site.

Beginning with Polaris 5.5, mobile device users are not automatically redirected to the
Mobile PAC site, since PowerPAC features responsive web design that adapts to the
user's device. However, the Polaris PowerPAC page footer still displays a Classic
Mobile Site link if the link has been set up and conditions are met as described in Set
the Mobile PAC Connection URL.

Mobile PAC Device Compatibility

To ensure compatibility with most mobile devices, Mobile PAC does not use any HTML
syntax, such as HTML 5 or CSS3, that requires a more modern browser. Also, unlike
PowerPAC, Mobile PAC's core functionality (searching, accessing the patron account,
etc.) does not rely on JavaScript. Therefore, if a mobile device has JavaScript disabled,
the user should be able to perform the majority of Mobile PAC functions, with the
exception of some third-party products that require JavaScript, specifically NoveList and
Google Maps. In some cases, the mobile device or browser may be too old to support
Mobile PAC.

Troubleshooting

You can get a quick idea of whether Mobile PAC is installed and running properly by
viewing a status page. Go to:
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http://[your PAC site]/mobile/plsstatus

The Mobile PAC status page lists five status items, each with a Success or Failure
status:

l AppCache initialized
l DisplayCache initialized
l Active SQL connection
l Active ERMS connection
l Test Keyword search

If you see a Failure status for any of these five items, check for details in the Mobile
PAC logs in C:\ProgramData. For assistance, contact your Site Manager.

Setting Up Mobile PAC Connections

To set up Mobile PAC connections, define the connection URL that the user enters to
connect to your Mobile PAC; set the link to the full site; and specify whether patrons can
switch branches.

See also:

l Set the connection URL
l Set the Full Site link
l Enable branch switching and set branch display order

Set the Mobile PAC Connection URL

The connection URL is the address the user enters to connect to your Mobile PAC
catalog, the destination address when the mobile device user is automatically re-
directed from Polaris PowerPAC (Polaris version 5.2 and earlier), and the destination
address when the user selects the Class Mobile Site link in the PowerPAC page footer.
To specify the connection URL for Mobile PAC:

1. In the Administration Explorer tree view, open the Server folder and expand the
server for which you want to set Web parameters.

2. Select Parameters under the server. The PAC parameters tabbed page is dis-
played in the details view.

3. Double-click URL of the Mobile PAC’s root and type the full URL.
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The default connection URL is http://[localhost]/mobile, which is the system
organization.

If you plan to disable branch switching (see Enable branch switching and set
branch display order) and you want to specify a connection organization other
than the system organization, add

/org/{orgid}

to the end of the URL. For example, if the organization ID number is 25, type the
URL in this format:

http://[localhost]/mobile/org/25

The organization ID is the number in the title bar of the organization workform. It is
also available on the Properties dialog box - About tabbed page for the
organization, which you can open from the Polaris Administration Explorer.

Note:
If you specify an organization that is suppressed from display in PAC, the
connection organization defaults to the system. The system-level PAC
profile Suppress branches controls which branches are suppressed from
display. This profile also affects Polaris PowerPAC.

4. Select File > Save.

Related Information

l Link from PowerPAC - A Classic Mobile Site link is displayed in the Polaris
PowerPAC footer if Mobile PAC is licensed for your library and you have set a
value for URL of the Mobile PAC’s root in Polaris Administration.

Note:
This feature does not apply to in-house workstations, as defined by the
setting for patron actions in the PowerPAC profile In-house access
definitions. This protects patron privacy if a PowerPAC user on an in-
house workstation follows the Mobile Site link, perhaps logs into the
patron account, and then leaves the workstation in Mobile PAC. (There is
no inactivity timeout in Mobile PAC.) Staff members who need to access
Mobile PAC can enter the URL directly into their workstation browsers. If
you want the Mobile Site link to appear in PowerPAC for staff
workstations, you must set the in-house definition to In-house IP
Addresses Table only, and then make sure that no staff workstations
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appear in the In-House IP Address Table. For more information about in-
house definition settings, see the Administration Guide.

l Connection organization from PowerPAC redirect - When a redirection to Mobile
PAC is made automatically (Polaris version 5.2 and earlier) or with the PowerPAC
footer link, the PowerPAC connection organization is retained for the Mobile PAC
connection. If the PowerPAC connection organization was the system, Mobile PAC
uses the organization saved in the user’s Mobile PAC Preferences settings. See
Enable branch switching and set branch display order.

l Display language from PowerPAC redirect - For multilingual versions, when a
redirection to Mobile PAC is made automatically (Polaris version 5.2 and earlier) or
with the PowerPAC footer link and the PowerPAC display language is not English,
the language setting is retained for the Mobile PAC connection. If the PowerPAC
display language was English, Mobile PAC uses the language saved in the user’s
Mobile PAC Preferences settings.

l Automatic redirection - In Polaris version 5.2 and earlier, PAC users with mobile
devices are automatically redirected to Mobile PAC if they attempt to connect to
Polaris PowerPAC on the home (portal) page, default search page, or patron
account page. This feature accommodates libraries that have direct links from
their library Web sites to search and patron account pages. Beginning with Polaris
5.5, users with mobile devices go directly to the appropriate PowerPAC page,
which is designed to automatically adapt to the user's device.

Set the Mobile PAC Full Site link

The Full Site link on the Mobile PAC home page is the URL specified in the parameter
URL of the PowerPAC’s root for the Web server in Polaris Administration. This
destination is typically your library web site. Do not change this setting unless your
Polaris PowerPAC root URL changes.

The Full Site link retains the user’s preference settings for connection organization and
display language when connecting to Polaris PowerPAC. See Enable branch switching
and set branch display order.

Enable Mobile PAC branch switching and set branch display order

The Mobile PAC home page includes a Preferences link. You can allow Mobile PAC
users to change the connection branch on the Preferences page, and you can set a
display order for the branch names.
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To set up branch switching:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the Mobile PAC tab in the details view.

Note:
Except where noted in this procedure, you can set these profiles at the
system, library, or branch level.

2. Double-click Branch Switching: Enable, and select Yes. This setting allows patrons
to choose branches in the Branch list on the Mobile PAC Preferences page. The
chosen branch’s Mobile PAC settings become effective. If you set this to No, the
patron can connect only to the organization represented by the Mobile PAC con-
nection URL. See Set the Mobile PAC Connection URL.

3. If you set Branch switching: Enable to Yes, set the PAC profile Branch list Order to
determine the display order of the branches:

l Select Yes to display the branch names in ascending alphabetical order by name.
l Select No to display the branch names in ascending numerical order by internal

organization ID.

Important:
This setting also affects Polaris PowerPAC.

With either setting, the system organization is always first. The setting for the
current connection branch is used. The profile also controls the display order of
the list of pick-up branches for requests, but the setting for the patron’s registered
branch is used for the pick-up branch list.

Note:
Use the system-level PAC profile Suppress branches to suppress a
branch from display in the Switch to another branch list. This setting also
affects Polaris PowerPAC.

Related Information

Organization names - Mobile PAC uses the Display Name defined in the organization
record. See the Administration Guide.
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Setting Up Mobile PAC Library Information

The Mobile PAC home page displays a link for library hours and contact information.
When the connection organization is a library or branch, the link opens information
about the current connection organization. When the connection organization is the
system, the link opens a page where the user selects a library or branch to see that
organization’s information.

The specific hours are set in the Patron Services parameter Hours of operation for the
connection organization. The address and telephone number are taken from the
organization record.

Note:
The system-level PAC profile Suppress branches controls whether a
branch is listed in the drop list of organizations. If you choose to suppress
a branch, it is also suppressed from display on the Preferences page. See
Enable Mobile PAC branch switching and set branch display order.

You can choose to display a message in addition to, or instead of, the formatted hours
table. You can also choose to display a link to the library’s Web site along with the
address and telephone number.

To specify the information that should appear on the Library Hours & Contact page:

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the PAC tab in the details view.

2. To display the organization’s hours formatted in a table, set the profile Hours of
operation: Display to Yes.

Note:
This setting also applies to Polaris PowerPAC.

Important:
The hours listed in the table on the Hours & Contact page are controlled
by the settings in the Patron Services parameter Hours of operation. Even
if you do not want to display the table on the Hours & Contact page, you
must set up the organization’s schedule in the Patron Services parameter
Hours of operation, because these settings also affect due dates and
other circulation processes.
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Tip:
The Hours of operation message option below is useful for organizations
with split hours or other conditions that the usual Hours of Operation
table does not accommodate.

3. To specify a message to display on the Hours & Contact page, follow these steps:
a. Double-click the Hours of operation message profile.

Note:
This setting also applies to Polaris PowerPAC.

The Language Strings dialog box opens.

b. Select a language from the list of those licensed for Polaris PowerPAC.
c. Double-click the message field in the Display text column and type the

message (up to 500 characters).

Note:
You can insert diacritic characters in your message. Click Diacritics. In the
Character Picker dialog box, select a graphic character set. Then select
the character, and click Insert.

d. Click OK.

4. To include a link to the library’s Web site along with the address and telephone
number, follow these steps:

a. Open the Profiles folder for the organization, and select the Mobile PAC tab
in the details view.

b. Double-click Navigation: Web site URL and type the complete URL, beginning
with http://

5. Select File > Save.

Related Information

You can also use the PAC profile Multiple language strings to specify the Hours of
Operation message. This method may be more convenient if you have multiple PAC
messages to customize. For more information, see Editing Messages and Labels.
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Setting Up New and Popular Titles in Mobile PAC

The Mobile PAC home page displays a New and Popular Titles link. When the user clicks
this link, New at the Library, On Order Titles, Best Seller, and Popular at the Library
(most circulated) lists are displayed. When the user clicks a link in a list, such as
Books under New at the Library, the appropriate search is launched in the library
catalog.

To set up New and Popular Titles options:

Note:
You can set the New and Popular Titles profile at the system, library, or
branch level. The connection organization’s settings determine the
options available to Mobile PAC users.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and select the Mobile PAC tab in the details view.

2. Double-click New and Popular Titles. The New and Popular Titles dialog box
opens.

3. Select the New at the Library categories to include on the New and Popular page
in Mobile PAC.

When the patron clicks a New at the Library category, the search is launched for
titles in that category that have recently been added to your catalog. This feature
uses the same processing as the New Titles Web part in Polaris PowerPAC. For
details, see Defining Web Parts for Dashboards.

Note:
When the Mobile PAC connection is to a branch, the patron sees only new
titles for that branch. When the Mobile PAC connection is to the system,
the patron sees new titles for the whole system.

4. Select the Best Seller Lists categories to include on the New and Popular page in
Mobile PAC.

When a patron selects a title from one of these lists, a search for the title is
launched in the Polaris database. The lists are updated automatically with content
from IndieBound (formerly Book Sense), using the same process as Polaris
PowerPAC. For details, see Defining Web Parts for Dashboards.
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Important:
If a title in the Best Seller list is not in the catalog, the list item for the title
is not a live link. As best-seller titles are added to the catalog, the links are
updated when MobilePAC is reloaded using the Reload tool in Polaris
Language Editor, or when an IIS reset is performed on the server. Polaris
Hosted customers should contact Polaris Customer Support to perform
an IIS reset.

5. Select the Popular categories to include on the New and Popular page in Mobile
PAC.

These categories use the same processing as the Most Circulated Web part in
Polaris PowerPAC; that is, the Popular links launch searches for popular titles,
authors, or subjects in the Polaris database, based on circulation statistics for the
past 31 days.

6. Select Show on-order items to provide links that launch searches for titles in the
Polaris database that have linked items with a status of On-Order.

This feature uses the same processing as the On-Order Items Web part in Polaris
PowerPAC. For details, see Defining Web Parts for Dashboards.

Setting Up Ask Us in Mobile PAC

As in Polaris PowerPAC, Mobile PAC users can send an “Ask Us” reference question to a
designated library email address. When the user clicks the Ask Us link on the home
page, and the library requires patrons to log on to use this feature, the logon page
appears. Once logged on, the user can type the question and send it to the library.

You set up a receiving email address on the branch level with the PAC profile Patron
access options, then enable the feature specifically for Mobile PAC. As with Polaris
PowerPAC, you can require a patron logon for Ask Us in Mobile PAC, or bypass the
logon and allow anyone to send a question via Ask Us. In this case, a Guest button is
displayed on the logon page.

The Sent From email address on the message to the library is the email address the
user has specified in the Ask Us form, if any. If no address is specified, the user has
logged on as a patron, and the patron account includes an email address, that address
is used. If no email address is specified in the Ask Us form or the patron account, or the
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patron has cleared the address from the form, the Sent From address is that specified in
the PAC profile Email notification: Email address of sender.

Note:
Any email from PAC, including Ask Us messages, requires you to specify
the SMTP server in Polaris Administration. Double-click the PAC profile
Email notification: Server running SMTP service, and type the domain
name of the email SMTP server. This setting applies to all Polaris PAC
applications and is also used by other Polaris processes, such as email
notification.

To set up the Ask Us function in Mobile PAC:

1. In the Administration Explorer tree view, open the Profiles folder for the branch,
and click the PAC tab in the details view.

Important:
These settings also affect Polaris PowerPAC.

2. Double-click Patron Access options. The Patron Access Options dialog box
appears.

3. Click the Ask Us tab.
4. To specify the receiving address for Ask Us email messages, do these steps:

a. Click Add, and use the Find Tool to search for the staff member or members who
should receive the Ask Us messages.

b. Select the names in the results list, right-click the highlighted names, and choose
Select from the context menu. The Patron Access Options dialog box appears,
and the selected names are displayed in the E-mail to list.

5. Click Apply to apply your settings and continue working with Patron Access
options, or click Save to save your settings and close the Patron Access options
dialog box.

6. To make the Ask Us feature available in Mobile PAC, do these steps:

a. Click the MobilePAC tab in the details view of the Explorer.
b. Double-click Navigation: Ask us, and select Yes.
c. To require a patron logon for Ask Us, double-click Ask Us: Require Login, and set

the value to Yes. If this value is set to No, a Guest button is displayed on the Ask
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Us logong page in Mobile PAC. The user can click Guest to send a question
without logging on.

7. Select File > Save.

Set Up and Start Ask Us

To set up the e-mail addresses to receive questions sent by e-mail from the PAC, and to
enable the Ask Us function in Mobile PAC:

1. In the Administration Explorer tree view, open the Profiles folder for the branch,
and click the PAC tab in the details view.

Important:
These settings also affect Polaris PowerPAC.

2. Double-click Patron Access options.

The Patron Access Options dialog box appears.

3. Click the Ask Us tab.
4. Specify the receiving address for Ask Us e-mail messages as follows:

a. Click Add, and use the Find Tool to search for the staff member or members
who should receive the Ask Us messages.

b. Select the names in the results list, right-click the highlighted names, and
choose Select from the context menu. The Patron Access Options dialog
box appears, and the selected names are displayed in the E-mail to list.

c. Click Apply to apply your settings and continue working with Patron Access
options, or click Save to save your settings and close the Patron Access
options dialog box. The Profiles tabbed pages appear in the Administration
Explorer details view.

5. To make the Ask Us feature available in Mobile PAC, do these steps:
a. Click the MobilePAC tab in the details view of the Explorer.
b. Double-click Navigation: Ask us, and select Yes.

6. To require a patron log-in for Ask Us, double-click Ask Us: Require Login, and set
the value to Yes.

If this value is set to No, a Guest button is displayed on the Ask Us login page in
Mobile PAC. The user can click Guest to send a question without logging in.

7. Select File > Save.
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Specifying Mobile PAC Search Settings

Mobile PAC offers a quick search and an advanced search. Both options are keyword
searches.

Quick Searches - When the user clicks Search the Catalog on the main page, the quick
search page opens. In this type of search, the user simply types a search term in the
Search for box and clicks Search. This search uses the search by, limit by, and sort by
settings for quick searches from the PAC profile Search settings defaults. See Set
default search selections. If the Search by setting in Polaris Administration is other than
the default Any Field and the Limit by setting is other than the default All formats
(TOM=*), the settings currently in effect appear below the Search for text box in Mobile
PAC.

Advanced Search - When the user clicks Advanced Search on the Search page, the
advanced search page opens. On this page, users can select the Search by field, the
Limit by filter, and a sort order. The default values for Search by, Limit by, and Sort
by are taken from the advanced search settings in the PAC profile Search settings
defaults. See Set default search selections. The selections in the drop-down list for the
Limit by filter are taken from the PAC Limit by display policy table. The user can also set
the number of titles per page in the search results. The options are 5 (default), 10, 25,
and 50.

The user’s selected search settings are retained until the user closes the browser, clicks
Reset, or reopens the Advanced Search page by selecting the Advanced Search link on
the quick search page. The Reset button resets all controls in the Advanced Search
page to their default values and clears the text from the Search for box.

When search results are displayed, if the user selects the Search link in the bread crumb
trail at the top of the window, the options set for the user’s most recent search are
retained on the Advanced Search page.

To specify the default selections for quick and advanced searches:

Important:
These settings also affect Polaris PowerPAC.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view. Mobile PAC uses the settings for
the user’s current connection branch.
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Note:
For information about allowing branch switching, see Setting Up Mobile
PAC Connections.

2. Double-click Search settings defaults. The Search Settings Defaults dialog box
opens.

3. Set the quick search defaults:

a. Click the Quick tab.
b. Select the default search field in the Search by list. The setting applies to every

quick search. The default is Any Field.
c. Select the default search filter in the Limit by list. The available selections depend

on the organization’s settings in the PAC Limit By Display policy table. The default
selection is All formats (that is, no filter; TOM=*).

Note:
You can change the labels of existing filters and set up custom filters. See
Setting Up Search Filters (Limit By).

d. Select the default sort order for search results in the Sort by list. The setting
applies to every quick search. The default selection is Relevance. This selection
sorts results based on weighted keyword frequency and proximity, so that those
most likely to meet the user’s needs appear first in the list. Most Popular sorts
titles in the search results so that the titles most frequently checked out or reques-
ted over the past 120 days appear first in the list.

Options that include two categories sort results by the first category, then by the
second category. For example, with Author, then Title, the titles are sorted
alphabetically by author then, within each author’s works, alphabetically by title.

4. Set the advanced search defaults:

a. Click the Advanced tab.
b. Select the default search field in the Search by list. The default selection is Any

Field.
c. Select the default search filter in the Limit by list. The default selection is All

formats (that is, no filter; TOM=*).
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Note:
You can change the labels of existing filters and set up custom filters. See
Setting Up Search Filters (Limit By).

d. Select the default sort order for search results in the Sort by - When searching
local databases only list. The default selection is Relevance.

5. Click Save.
6. (Optional) To set automatic subsorting by title for certain sort types, set the PAC

profile Search: Sub-sort-by-title to Yes. This allows patrons to quickly find a
known title in a large results set.

When the profile is set to Yes, the records are first sorted by the selected sort
option and then sorted alphabetically by title, ignoring nonfiling characters
(respecting the value of the 245 second indicator). The setting does not affect
these sort types: relevance, most popular, title, author then title, title then author,
title then publication date, title then format, publication date then title, call number
then title.

Note:
This setting affects both Polaris PowerPAC and Mobile PAC. The profile is
available at the system, library, and branch levels. It is set to No by default;
you may want to leave this setting if you find the automatic subsort
impacts performance.

Related Information

l TOM (Type of Material) - For more information about Type of Material and format
icons in Polaris PAC applications, see the Cataloging Guide and Setting Up Search
Filters (Limit By).

l Community Information - Mobile PAC supports keyword searches for community
information for libraries that use Polaris Community Profiles, a separately licensed
feature. For more information, see the Community Profiles Guide.

Set Default Search Selections

To specify the default selections for quick and advanced searches:

Important:
These settings also affect Polaris PowerPAC.
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1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the PAC tab in the details view.

Mobile PAC uses the settings for the user’s current connection branch.

Note:
For information about allowing branch switching, see Setting Up Mobile
PAC Connections.

2. Double-click Search settings defaults.

The Search Settings Defaults dialog box opens.

3. Click the Quick tab and set the quick search options as follows:
a. Select the default search field in the Search by list. The setting applies to

every quick search. The default is Any Field.
b. Select the default search filter in the Limit by list. The available selections

depend on the organization’s settings in the PAC Limit By Display policy
table. The default selection is All formats (that is, no filter; TOM=*).

Note:
You can change the labels of existing filters and set up custom
filters. See Setting Up Search Filters (Limit By).

c. Select the default sort order for search results in the Sort by list. The
setting applies to every quick search. The default selection is Rel-
evance. This selection sorts results based on weighted keyword fre-
quency and proximity, so that those most likely to meet the user’s
needs appear first in the list. Most Popular sorts titles in the search res-
ults so that the titles most frequently checked out or requested over
the past 120 days appear first in the list.

Options that include two categories sort results by the first category, then by
the second category. For example, with Author, then Title, the titles are
sorted alphabetically by author then, within each author’s works,
alphabetically by title.

4. Click the Advanced tab and set the advanced search options as follows:
a. Select the default search field in the Search by list. The default selection is

Any Field.
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b. Select the default search filter in the Limit by list. The default selection is All
formats (that is, no filter; TOM=*).

Note:
You can change the labels of existing filters and set up custom
filters. See Setting Up Search Filters (Limit By).

c. Select the default sort order for search results in the Sort by - When
searching local databases only list. The default selection is Relevance.

5. Click Save.
6. (Optional) To set automatic subsorting by title for certain sort types, set the PAC

profile Search: Sub-sort-by-title to Yes. This allows patrons to quickly find a
known title in a large results set.

When the profile is set to Yes, the records are first sorted by the selected sort
option and then sorted alphabetically by title, ignoring nonfiling characters
(respecting the value of the 245 second indicator). The setting does not affect
these sort types: relevance, most popular, title, author then title, title then author,
title then publication date, title then format, publication date then title, call number
then title.

Note:
This setting affects both Polaris PowerPAC and Mobile PAC. The profile is
available at the system, library, and branch levels. It is set to No by default;
you may want to leave this setting if you find the automatic subsort
impacts performance.

Related Information

l TOM (Type of Material) - For more information about Type of Material and format
icons in Polaris PAC applications, see the Cataloging Guide and Setting Up Search
Filters (Limit By).

l Community Information - Mobile PAC supports keyword searches for community
information for libraries that use Polaris Community Profiles, a separately licensed
feature. Fro more information, see the Administration Guide.
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Mobile PAC Results Settings

From the search results set, users can locate items, see more bibliographic information,
and place hold requests. The initial search results display is a list of titles, with format
icons and cover images if these are enabled.

Note:
You can configure the title information displayed in this view. See
Configuring the Mobile PAC Title Display.

By default, five titles are displayed per page, but the user can change this number on the
Preferences page. The user can also sort the results list.

The initial search results display also includes links from the 856 MARC tag. The link
text is displayed according to the following logic:

Note:
If there is text in the 856$z, it displays as a note but not as part of the web
link.

l 856$y - Link Text - If the bibliographic record has an 856$y, the text in the first
occurrence of this tag is used for the Web link display instead of the URL in the
856$u.

l 856$3 - Material Specified - If the bibliographic record does not have an 856$y, but
it does have an 856$3, the text in the first occurrence of this tag is used for the
Web link display instead of the URL in the 856$u.

l 856$u - URL - If the bibliographic record does not have an 856$y or an 856$3, the
default web link text is Web Site. You can change the label using the Mobile PAC
profile Title Display: Configure. For more information, see Configuring the Mobile
PAC Title Display.

Mobile PAC supports integrated eContent. For details on this licensed feature, see
EContent Vendors and Polaris.

See also:

l Cover Images
l Title (Product) Page Links
l Title Link: Find It
l Title Link: Details
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l Title Link: Request It
l Title Link: Purchase or Buy It Now
l Title Links: Enriched Content
l Title Link: Map It
l Title Link: Librarian’s (MARC) View
l Set up the Mobile PAC title (product) page
l Configuring the Mobile PAC Title Display
l Polaris Fusion Results

Cover Images

Cover images are displayed according to the connection organization’s settings for the
content provider in the PAC profile Enriched data. For more information, see Enabling
Enriched Data. These settings also affect Polaris PowerPAC.

In Mobile PAC, when cover images are enabled, the user can choose to hide them. The
Hide Covers option appears at the bottom of each search results page. This may
improve the display on certain mobile phones. When cover images are hidden, the title
format (Type of Material, or TOM) is also displayed as text instead of an icon. This
setting is saved on the device until the user chooses to display the images again.

Title (Product) Page Links

Users click a title in the search results list to see more choices related to the individual
title. The following links may be displayed on the title (product) page:

l Find It - View availability information. See Title Link: Find It.
l Details - View bibliographic information. See Title Link: Details.
l Request It - Place a hold request. See Title Link: Request It.
l Purchase - Purchase the title from a vendor’s web site. See Title Link: Purchase or

Buy It Now.
l Enriched content links - View third-party content such as summaries and reviews.

See Title Links: Enriched Content.
l Librarian’s View - Display the MARC view for the title. See Title Link: Librarian’s

(MARC) View.
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Note:
You can configure the title information displayed in this view. See
Configuring the Mobile PAC Title Display.

You can set the order of links on this page. See Set up the Mobile PAC title (product)
page.

Title Link: Find It

This link displays summary availability information for items linked to the title. Like
other Mobile PAC displays, the list uses the branch Display Name defined in the
organization record.

A branch is listed if it is selected for display as a system holding in the Item Availability
Display Order policy table for the connection organization, and the branch is the
Assigned Branch for at least one item linked to the title. Settings in the Item Availability
Display Order policy table also determine the order in which branches are listed. (If at
least one item is In at the branch, the summary availability information also includes the
word In.) For more information about these settings, which are shared with Polaris
PowerPAC, see Setting Up Local and System Availability.

The user can click a branch name to see the call number and other information, if
enabled, for that branch’s items. If item-level or first-available-copy requests are
enabled, a Request It link is also available.

Note:
You can suppress the Find It and Request links for designated types of
material. See Suppressing Request and Availability Options.

Note:
For more information about placing requests from Mobile PAC, see Title
Link: Request It. For information about enabling item-level or first-
available-copy requests, see the Patron Services Administration Guide.

The connection organization’s settings for the following PAC profiles determine what
information is displayed for each item:

Important:
These settings also affect Polaris PowerPAC.
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l Item Availability: Display detailed item status - Set to Yes to display the specific
item circulation status of unavailable items, such as Lost or Bindery. Set to No to
display No items available or your own text for items that are unavailable for cir-
culation for any reason. (You must also set Item Availability: Display status to
Yes.)

l Item Availability: Display due date in detailed item status - If you set Item Avail-
ability: Display detailed item status to Yes, you can set this parameter to display
or suppress the item’s due date. (If you set Item Availability: Display detailed item
status to No, you cannot display the due date.)

l Item Availability: Display status - Set to Yes to display an item’s availability status.
If you set this to Yes, also review the setting for Item Availability: Display detailed
item status.

l Item Availability: Display shelf location - Set to Yes to display an item’s shelf loc-
ation.

l Item Availability: Display type - Set to Yes to display the item’s material type.
l Suppress item display - Specify item circulation statuses that should prevent an

item from being displayed in search results. When a circulation status is selected,
items with this status are not displayed in PAC even when Display in PAC is
checked in the item record.

For more information, see Displaying PAC Search Results.

Text It in Mobile PAC

From the Mobile PAC item availability display, a patron can send an email text message
containing the item call number to his or mobile phone via the mobile phone carrier’s
SMTP email service.

When you enable this feature, a Text It link appears for each item in the item availability
display for Mobile PAC search results. When the patron clicks Text It, the Text It form
opens.

If the user is logged in and the patron record includes a phone number that has been
designated for TXT notification, the Mobile phone number and Carrier fields are already
filled in. If the user is not logged in, or is logged in but does not have a phone number
designated for TXT notification in the patron record, the user enters the mobile phone
number and selects a carrier from the list. The carrier options are set in the system-level
database table Mobile Phone Carriers. When the patron clicks Send, the text message
is sent to the specified mobile phone.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 441

To display the Text It link in Mobile PAC, set the PowerPAC profile Item availability:
“Text it” feature enabled to Yes (the default setting). This setting also controls the
feature in Polaris PowerPAC. For details, see Sending Call Numbers by Text Message.

Title Link: Details

When the user clicks Details for a title, more bibliographic information is displayed.

The connection organization’s settings for the Mobile PAC profile Title display
configure control which bibliographic fields are displayed and their label text. For more
information, see Configuring the Mobile PAC Title Display.

Title Link: Request It

The user clicks Request It for a title to place a title-level hold request.

Note:
You can suppress the Request It link for designated types of material. See
the Public Access Administration Guide.

Hold requests from Mobile PAC are enabled from and use the settings in the Holds
Options Request parameter. For more information about these settings, see the Patron
Services Administration Guide. Rules set for specific patron codes or specific items also
apply to Polaris PowerPAC.

When the patron clicks the Request It link, the logon page appears (see Patron Logon
Settings for Mobile PAC). After logging in, the patron selects a pickup location from a
list of locations. The default location is the patron’s home library (registered branch).

Mobile PAC supports Borrow by Mail requests, and if these are enabled the patron can
opt to have the requested item mailed instead of selecting a pick-up location. For more
information about Borrow by Mail settings, see Setting Up Borrow by Mail Circulation.

Note:
Item-level or first-available-copy requests can be placed from the detailed
item availability page (see Title Link: Find It) if these types of requests are
enabled in the Holds Options Request parameter.

The patron can then submit the request or cancel it. If the patron selects Submit
Request, a hold request is sent to the library and a confirmation message is displayed if
the request is successful. (If the request is not successful, the patron is informed that
request cannot be placed and is advised to contact the library for more information.)
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Title Link: Purchase or Buy It Now

A Purchase link is available in the Title page for a title in Mobile PAC search results.
When the user clicks the link, a search is launched for the title in a specified vendor’s
Web site. As in Polaris PowerPAC, the purchase transaction takes place on the vendor’s
site. For more information, see Setting Up Purchase Links.

Mobile PAC also supports Polaris Bookstore, available by separate contract. Through
Polaris Bookstore and Baker & Taylor Inc., your library can establish an online bookstore
where patrons can purchase materials at a discount comparable to other major online
retailers, and your library receives a portion of the sales as a donation. As in Polaris
PowerPAC, if you enable both links, the Buy It Now link is displayed when the title is
available at the Bookstore. The Purchase link is displayed when the title is unavailable at
the Bookstore and the title has an ISBN. For more information about Polaris Bookstore,
see Setting Up Polaris Bookstore.

To enable the Purchase link, Buy It Now link (if you have a contract), or both, use the
PAC profile Purchase options. Your settings also apply to Polaris PowerPAC. See
Enabling Online Book Purchases.

You can edit the Purchase and Buy It Now link labels using Polaris Language Editor
(WebAdmin). The strings IDs are MP_LBL_SEARCH_PURCHASE and MP_LBL_SEARCH_
BUY_IT_NOW.

Title Links: Enriched Content

Enriched content from third-party sources is available in Mobile PAC search results,
from links in the title (product) page.

Tip:
If you use NoveList or NoveList Select, and you run Mobile PAC in SSL
mode, your NoveList URL must begin with https://.

Mobile PAC shares enriched content settings with Polaris PowerPAC. For more
information about setting up enriched data for PAC use, see Enabling Enriched Data.

Title Link: Map It

Using the JavaScript interface provided by Google Maps™, Mobile PAC offers the Map It
feature (also available in PowerPAC), which provides a visual guide to the location of
items linked to titles in the patron’s search results list. When you enable this feature, the
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Mobile PAC Map It link is available to users who have enabled JavaScript on their
mobile devices.

When the user clicks Map It in the title product page (full display), a map displays bubble
markers for branch locations that have linked items.

The user can place the cursor over a marker bubble to see the branch name, or click the
branch marker to see the branch’s address and hours.

When the user clicks Get Directions in the hours window, directions to the branch are
available from any address. The user enters the address and clicks Go!. (If the user is
logged in, the primary address from the patron record is already filled in for
convenience, but it can be changed.)

As in PowerPAC, the Mobile PAC Map It link is displayed for titles whose # system
items count in the PAC brief display is greater than 0.

Use the PAC profile Google Maps in Polaris Administration; check the Enable in Mobile
PAC box to enable Map It in Mobile PAC. The profile is available at the system, library,
and branch levels.

Mobile PAC and PowerPAC share the same geographic center and zoom level settings.
For detailed information about these settings, see Map It (Google Maps) in PAC.

When you enable Map It for Mobile PAC, the link is automatically enabled for the Mobile
PAC product page and placed by default at the end of the list for the enabled product
page categories. You can change the position of the link on the page using the Mobile
PAC profile Product Page categories: Configure. See Set up the Mobile PAC title
(product) page.

Title Link: Librarian’s (MARC) View

When the user clicks the Librarian’s View link in the Title page for a title in Mobile PAC
search results, the MARC record view is displayed.

You can choose to display or suppress the Librarian’s View link with the PowerPAC
profile Librarians (MARC) view: Enable. (This profile also affects Polaris PowerPAC).
You can edit the Librarian’s View link label using Polaris WebAdmin (Language Editor).
The string IDs is MP_LBL_MARCVIEW_LIBRARIAN_VIEW.

Set up the Mobile PAC title (product) page

To determine the display order of links on the Mobile PAC title page:
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Note:
You need the permission Modify product page categories: Allow to do
this procedure.

1. In the Administration Explorer tree view, open the Profiles folder for the organ-
ization, and click the Mobile PAC tab in the details view.

2. Double-click Product page categories: Configure. The Product Page Categories:
Configure dialog box opens. The top portion lists the categories (features) that
have been enabled for the organization.

3. To change the display order, select the category and click the appropriate arrow at
the side of the dialog box to move the category up or down in the display order.

4. Click OK.

Related Information

l Editing category labels - The Product Page Categories: Configure dialog box lists
the language string ID for each category for use in Polaris WebAdmin (Language
Editor), where you can search for and edit the link labels. For more information,
see WebAdmin online Help.

l Enabling categories - The bottom portion of the Product Page Categories:
Configure dialog box lists the features that are possible to display on the product
page, but have not been enabled for the organization. For information about
setting up the features that can be displayed on the product page, see:

o Enriched content from third parties - Enabling Enriched Data
o Librarian’s View - Set the PowerPAC profile Librarian’s (MARC) View:

Enable to Yes.
o Purchase/Buy It Now - Title Link: Purchase or Buy It Now

Note:
You can also configure the product page for Polaris PowerPAC, using a
separate profile. See Configuring the PowerPAC Product Page.

Configuring the Mobile PAC Title Display

Using the Mobile PAC profile Title Display: Configure, you can do the following:

l Select which data elements (tags, subfields, and indicators) appear in the brief,
summary, and full displays. The brief display is the information shown in initial
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search results. The summary information is displayed on the Mobile PAC product
page for title. The full display appears when the user clicks Details on the product
page.

l Show multiple instances of a single tag in the brief display: for example, multiple
856 $u fields.

l Specify different elements for monographs and serials.
l Edit existing data elements.
l Set the display order of data elements.
l Specify a custom label for each data element, and create translated versions of

the data labels for languages you have licensed.
l Specify additional data elements by selecting the tags, indicator values, and sub-

fields to include in each custom entity.
l Display a "requested" indicator for titles on which the patron has an active,

pending, held, shipped, or located hold request. The indicator is a message: You
requested this on [date]; the system supplies the date. The indicator can be dis-
played to logged-in patrons on the search results page, the title screen, the work-
ing title list, and saved title lists. The Brief and Full configuration view settings in
the profile apply to both search results screens and title lists; that is, when you set
the Requested date indicator to display in search results, it will also display in
working and saved title lists.

Note:
When enabled, the indicator is displayed only for requests that have been
placed in Polaris. The requested indicator does not apply to integrated
eContent titles.

l Copy all these settings from any organization to any other organization.

The system uses the connection organization’s settings for the Mobile PAC profile Title
Display: Configure, but the setup workflow is the same as that for PowerPAC. For
detailed procedures, see Configuring the PowerPAC Title Display.

For libraries that use Polaris Community Profiles, a separate profile controls the Mobile
PAC display of community information results, and a separate set of data elements is
available for your community information displays. For details, see the Community
Profiles Guide.

The tables show the default title display configuration for Mobile PAC bibliographic
search results.
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Mobile PAC Brief Display - Monograph Mobile PAC Brief Display - Serial

Entity Display
Order Label Entity Display

Order Label

Primary Title 1 Title: Primary Title 1 Title:

Primary
Author 2 Author: Primary

Author 2 Author:

Publication
Year 3 Publication

Year:
Publication
Year 3 Publication

Year:

Web Link
(Short) 4 Web Site: Web Link

(Short) 4 Web Site:

Mobile PAC Summary Display - Mono-
graph Mobile PAC Summary Display - Serial

Entity Display
Order Label Entity Display

Order Label

Primary Title 1 Title: Primary Title 1 Title:

Primary
Author 2 Author: Primary

Author 2 Author:

Publication
Year 3 Publication

Year:
Publication
Year 3 Publication

Year:

Web Link
(Short) 4 Web Site: Web Link

(Short) 4 Web Site:

Mobile PAC Full Display - Monograph Mobile PAC Full Display - Serial

Entity Display
Order Label Entity Display

Order Label

Type of
Material 1 Format: Type of

Material 1 Format:
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Mobile PAC Full Display - Monograph Mobile PAC Full Display - Serial

Uniform Title
(Long) 2 Uniform Title: Uniform Title

(Long) 2 Uniform Title:

Author (Long) 3 Author: Author (Long) 3 Author:

Title (Long) 4 Title: Title (Long) 4 Title:

Edition (Long) 5 Edition: Edition (Long) 5 Edition:

Publisher
(Long) 6 Publisher,

Date:
Publisher
(Long) 6 Publisher,

Date:

Description
(Long) 7 Description: Description

(Long) 7 Description:

Summary
(Long) 8 Summary: Summary

(Long) 8 Summary:

Target
Audience Note
(Long)

9
Target
Audience
Note:

Target
Audience Note
(Long)

9
Target
Audience
Note:

Series (Long) 10 Series: Series (Long) 10 Series:

Volume (Long) 11 Volume: Volume (Long) 11 Volume:

Frequency
(Long) 12 Frequency: Frequency

(Long) 12 Frequency:

Subjects 13 Subjects: Subjects 13 Subjects:

Other Author
(Long) 14 Other Author: Other Author

(Long) 14 Other Author:

Other Title
(Long) 15 Other Title: Other Title

(Long) 15 Other Title:

Former Title
(Long) 16 Former Title: Former Title

(Long) 16 Former Title:

Later Title
(Long) 17 Later Title: Later Title

(Long) 17 Later Title:
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Mobile PAC Full Display - Monograph Mobile PAC Full Display - Serial

Web Link
(Long) 18 Web Site: Web Link

(Long) 18 Web Site:

LCCN (Long) 19 LCCN: LCCN (Long) 19 LCCN:

ISBN (Long) 20 ISBN: ISBN (Long) 20 ISBN:

ISSN (Long) 21 ISSN: ISSN (Long) 21 ISSN:

OCLC Control
Number 22 Other

Number:
OCLC Control
Number 22 Other

Number:

STRN (Long) 23 STRN: STRN (Long) 23 STRN:

GPO (Long) 24 GPO Item No.: GPO (Long) 24 GPO Item
No.:

CODEN (Long) 25 CODEN: CODEN (Long) 25 CODEN:

Total System
Item Count 26 System

Availability:
Total System
Item Count 26 System

Availability:

Hold Request
Count 27 Current

Holds:
Hold Request
Count 27 Current

Holds:

Control
Number 28 Control

Number:
Control
Number 28 Control

Number:

Bibliographic
Call Number 29 Call Number: Bibliographic

Call Number 29 Call Number:

Course
Reserve Count 30 Course

Reserves:
Course
Reserve Count 30 Course

Reserves:

Medium
(Long) 31 Medium: Medium

(Long) 31 Medium:

Polaris Fusion Results

Mobile PAC supports Polaris Fusion (digital collection) searches and results. Materials
in the digital collections may include images, video clips, sound files, and text files. To
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limit search results to digital collection materials, the user selects Digital Collection in
the Limit by box on the Advanced search page.

In the search results, the digital collection icon identifies digital collection
materials.

When the user clicks a title, more choices related to the title are displayed. Digital
collection titles with a single linked resource, such as one image, offer a link to that
resource. If there are no access restrictions, the user can click the link to see the
resource.

Note:
Image resources open in the same browser window. Other types of digital
resources open in a new browser window to ease navigation back to
Mobile PAC.

When the user clicks a title with multiple linked resources, the title page displays a Show
Resources link. The user clicks this link to see the attached resources.

If a resource has restricted access, the user can request access by clicking the place
access request link. If purchase is required, the access request page offers a link to the
full library catalog.

When the user clicks the full catalog link, the same search is launched and the title is
displayed in Polaris PowerPAC. Like the Full Site link at the bottom of Mobile PAC
pages, the full library catalog is the address specified in the parameter URL of the
PowerPAC’s root for the Web server in Polaris Administration. See Set the Full Site link.

For more information about setting up and using Polaris Fusion to manage digital
collections, see the Polaris Fusion online Help.

Saved Searches (Search Agent) in Mobile PAC

Registered patrons can save searches in Mobile PAC, and have the saved searches run
automatically either weekly or monthly. Each search run looks for results that are new
since the last run. The results are automatically sent to an e-mail address the patron
specifies. By accessing their patron accounts, patrons can view, edit, and delete saved
searches, or run them manually. (These features are also available in Polaris
PowerPAC).
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To save a search, the patron first searches the catalog using the criteria he wants for
the saved search, then clicks Save Search at the bottom of any page in the search
results.

If the patron has not logged on, the Log On page opens. After the patron logs on, he
names the search, types an optional note, sets the notification criteria and number of
times to run the search, and clicks Save.

All saved searches sent to the same patron email address must be in the same email
format. If the patron specifies a format different from existing saved searches when
saving a new search, a message provides the options to specify a different format for
the new search or to change all the others.

Saved searches are available to delete, edit, or run manually from the patron account.
On the My Account page, the patron clicks Saved Searches to access the list.

On the Saved Searches page, the patron can check searches to delete, or select a
search name to edit the settings or run the search manually.

Note:
As in Polaris PowerPAC, the patron cannot edit the search criteria.
Instead, the patron sets up and saves a new search, and deletes the old
one if necessary.

To allow patrons to save searches in Mobile PAC:

1. Set the PAC profile Search agent: Enable to Yes.
2. Set up the PAC parameter Search agent parameters. See Set up basic operating

features for Polaris PowerPAC. Search agent settings also apply to Polaris Power-
PAC.

You can edit text strings related to Mobile PAC save search functions using Polaris
WebAdmin (Language Editor). For more information about using WebAdmin, see
WebAdmin online Help.

Title Lists in Mobile PAC

Patrons using Mobile PAC can develop and save title lists from search results. From the
working title list, individual title information or the whole list can be sent by email, and
working title lists can be saved to the patron account. Titles can be copied or moved
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among a patron’s title lists, and patrons can place requests and view availability
information and enriched content for titles in a title list.

See also:

l Creating a Working List
l Email Options
l Saving Lists
l Copying and Moving Titles Among Lists
l Title Details
l Requested Indicator
l Setting Up Mobile PAC Title Lists

Creating a Working List

To create a working list, the user taps the Add to my list link for a title returned in search
results. The link is displayed in the initial results list and in the detailed view for a title.
Working title lists are limited to 100 titles. When the user tries to add more, the system
displays a message advising the user to save the list.

After the title has been added, the link changes to Remove, which the user can tap to
remove the title from the working list.

When at least one title has been added to the working list, the bottom of each search
results page displays links to access or clear the working list. The user clicks Working
list to display the working list. You can choose a Sort by option at the top of the page
and tap Go to sort the list according to your selection.

Email Options

From the working list page, the user can check and delete individual titles from the
working list, check individual titles and tap EMail, or tap Email All to send the entire list.
When the user taps Email or Email All, the email page is displayed. Format options
include Brief Bibliographic and Full Bibliographic.

After selecting a format, the user types an email address and taps Email.

Very long emails may exceed system or email service limits that prevent successful
delivery. Very long emails may exceed system or email service limits that prevent
successful delivery. In this case, the system displays an alert message. The user can tap
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OK to close the alert and send the email, or Cancel to return to the title list. The user can
then select a different display format, or select fewer titles.

Saving Lists

Logged on patrons can access the working list and any previously saved lists by clicking
My Lists on the My Account page. The Saved Lists page is displayed.

The working list is available for the current session. To create a new saved list, the
patron taps Create new saved title list. The Create List page opens, where the patron
can name and save the new list.

The new list is saved with no titles in it. Titles can be copied or moved from the working
list or an existing saved list to the new list (or to any other saved list.)

Copying and Moving Titles Among Lists

From the Saved Lists page, the patron opens the list that contains the title to be copied
or moved.

From the list of titles, the patron checks the title or titles and taps Copy or Move. The
Copy or Move page opens.

The patron chooses a destination list from the saved lists in the patron account, and
taps Copy to or Move to. The selected title is copied or moved to the destination list.

Title Details

When the patron taps a title in the title list, the Title Detail page opens.

From the Title Detail page, the patron can select a display format or tap the title link for
further options on the product page; for example, viewing availability information,
viewing detailed bibliographic information, placing a hold request on the title, viewing
enriched data.

Requested Indicator

You can display a "requested" indicator in Polaris PowerPAC and Mobile PAC title lists
for titles on which the patron has an active, pending, held, shipped, or located hold
request. The indicator is a message: You requested this on [date]; the system supplies
the date. See Configuring the PowerPAC Title Display and Configuring the Mobile PAC
Title Display.
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Setting Up Mobile PAC Title Lists

To provide the title list option in Mobile PAC, set the PowerPAC profile Title list: Enable
to Yes in Polaris Administration. To allow patrons to email selected titles or entire lists,
set the PowerPAC profile Title list: Email to Yes. These settings also apply to Polaris
PowerPAC. See Enabling PAC Title Lists.

You can edit text strings related to Mobile PAC title lists using Polaris Language Editor
(WebAdmin). For more information, see WebAdmin online Help.

Patron Registration in Mobile PAC

Mobile PAC supports online self-registration. To make this feature available and set
self-registration options, use the PAC profile Patron access options. (Your settings for
this profile also control self-registration for Polaris PowerPAC.) For more information,
see Set up online patron self-registration.

When online self-registration is enabled and the user taps My Account, a Create one link
is displayed on the log-on page.

Note:
To make the My Account link available, set the Mobile PAC profile
Navigation: Patron account to Yes. See Patron Account (My Account) in
Mobile PAC.

Self-registration in Mobile PAC is similar to Polaris PowerPAC functionality. When the
user taps the registration link, the first screen displays the home library and postal code
page. The user selects a registration branch, enters the postal code, and selects a
country. When the user taps continue, the registration screen appears.

Required fields, verification blocks, recipient’s email address, and other aspects of self-
registration are set in the PAC profile Patron access options. (You can also provide the
option to receive renewal receipts by email, TXT message, or both. See the Patron
Services Administration Guide.

Note:
If the preferred notification method is set to email, an email address must
be supplied. If the preferred method is phone, the patron must indicate the
phone number to use for notification. If the patron chooses TXT
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Messaging, the patron must indicate the phone number to be used for
TXT messages, and select a carrier for that number.

Patron Logon Settings for Mobile PAC

Mobile PAC users must log on to their patron accounts to place a hold request or
access account information.

Note:
To make the My Account link available, set the Mobile PAC profile
Navigation: Patron account to Yes. See Patron Account (My Account) in
Mobile PAC.

Once logged on, the patron stays logged on until he or she deliberately logs off,
disconnects from the Mobile PAC site, or is inactive for 20 minutes. When the patron is
logged on, a Log Out link is available on every page.

When the patron logs off, the Mobile PAC home page is displayed.

User Names

Mobile PAC accepts user names as well as patron account barcodes, if patron user
names are enabled for PAC use in Polaris Administration. For more information, see Set
patron password and user name options. The same PAC setting displays a link on the
logon page to allow patrons who have a barcode and password to set up the user name.

Remember Me

The Remember me checkbox is available on the logon screen by default. When the
patron checks this box and logs on, the user name or barcode the patron entered is
preserved from session to session by a cookie on the patron’s device. The next time the
patron connects to Mobile PAC and chooses to log on, the information is already filled
in. The cookie expires after one month. The patron must always enter the password, and
can choose to clear the Remember me checkbox.

Note:
Some browsers may retain the user name or barcode regardless of the
Mobile PAC Remember me feature, depending on auto-save, auto-fill or
other settings in the browser.
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In Polaris Administration, the Mobile PAC profile Remember me: Enabled controls
whether this feature is available. The profile is available at the system level. If you set
the profile to No, the Remember me checkbox does not appear on the logon screen.

Logon Attempt Limits

You can limit the number of times a patron can attempt to log on before being forced to
wait five minutes. In Polaris Administration, use the system-level PAC profile Login
retries to enable or disable the limit and set the number (5-99) of attempts allowed. By
default, the limit is enabled and five attempts are allowed. These settings also apply to
Polaris PowerPAC.

Forgotten Passwords

Mobile PAC supports a Forgot password? link on the Account Log On page that appears
when the patron selects a feature that requires logon. When the patron selects the link,
a page opens where the patron supplies the username or barcode.

A patron who wishes to create or reset a password can click a link in Mobile PAC and
receive an email message containing a time-sensitive link to a Reset Password page
where the patron can configure a new password. Libraries can use the new Reset
password link timeout duration setting to specify the time period during which the time-
sensitive password reset link remains valid. If no email address is present in the patron
record, the system displays an error message.

Your setting for this feature also applies to Polaris PowerPAC and Polaris
ExpressCheck. For more information, see Set up online patron self-registration.

Active Directory Logon to Mobile PAC

You can allow logon to PAC using Active Directory credentials instead of the Polaris
patron barcode or username and password. This feature is particularly suitable in
academic settings, enabling students to authenticate into Polaris PowerPAC and Mobile
PAC using their campus network credentials established in Active Directory. For details,
see Set Up PAC Active Directory Log On.

Patron Account (My Account) in Mobile PAC

To make the My Account link available, set the Mobile PAC profile Navigation: Patron
account to Yes. This profile is available at the system, library, and branch levels. After
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the patron clicks the My Account link and logs in, the Account Summary screen opens.

The top portion of the screen displays account information: patron name, barcode,
registered branch, account expiration date, telephone number, email address, and any
current blocks on the account. The lower portion displays links to the other patron
account pages if these are enabled: messages, items checked out, hold requests, fines
and fees, saved searches, reading list (reading history), update account information and
preferences, and saved title lists.

Messages

This link appears if you have enabled patron messages in the Polaris staff client. When
the patron taps the Messages link, current messages from the library are listed. The
patron can mark messages as read and delete them.

For more information about setting up patron messaging in Polaris Administration, see
"Setting Up Patron Messages" in the Patron Services Administration Guide. For
information about posting messages to patron accounts, see "Posting Patron
Messages" in the Patron Services Guide.

Items Checked Out

This patron account page lists all items currently checked out to the patron. To make
this page available, set the Mobile PAC profile Navigation: Items out to Yes. This profile
is available at the system, library, and branch levels. The system uses the setting for the
patron’s registered branch.

The patron can renew items by selecting the appropriate checkboxes and tapping

Renew. If there is a charge for renewal, the item is marked with a dollar icon . As in
other Polaris PAC applications, if the renewal is allowed, a message with the new due
date appears. If the renewal fails, an appropriate message appears.

Note:
Mobile PAC shares the Polaris Administration settings for renewals,
renewal charges, and blocks on renewals with Polaris PowerPAC. To
allow renewals, set the PAC profile Patron access: Renewals. To set
charges for renewals, see "Charging for Checkout and Renewal" in the
Patron Services Administration Guide. To set blocks on renewals from
PAC (and ebook circulation), use the Patron Services profile Patron-
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initiated circulation: Blocking conditions. For more information, see the
Patron Services Administration Guide.

When you select an item in the Items Out list, detailed information about the item is
displayed. The patron can also renew the item from this screen if the renewal is allowed.

If the patron has currently checked out overdue items, the Items Out list also offers an
option to estimate overdue fines. The patron taps Estimate Overdue Fines to display a
view with a date option. The patron leaves today’s date or specifies a date in the future
and taps Estimate Overdue Fines. The calculated accrued fines are displayed according
to the specified date. (This feature is also available from the Fines and Fees page).

Note:
If the library has opted to include lost or claimed item overdue amounts in
the estimate, these are included in the calculation. For details about
estimated accrued fines settings, see "Calculating, Blocking for, and
Displaying Estimated Accrued Fines" in the Patron Services Administration
Guide.

Hold Requests

This patron account page lists the patron’s hold requests. To make this page available,
set the Mobile PAC profile Navigation: Requests to Yes. This profile is available at the
system, library, and branch levels. The system uses the setting for the patron’s
registered branch.

The patron can select requests with the appropriate status and cancel, suspend, or
renew them.

When the patron taps a title in the Hold Requests list, detailed information about the
request is displayed. The patron can also cancel, suspend, or reactivate a request with
the appropriate status from this detail page.

All Polaris Administration settings for PAC hold requests apply to Mobile PAC. For more
information, see "Setting Up Hold and ILL Loan Request Processing" in the Patron
Services Administration Guide.

Fines and Fees

This patron account page summarizes fines and fees on the patron account. To make
this page available, set the Mobile PAC profile Navigation: Fines & Fees to Yes. This



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 458

profile is available at the system, library, and branch levels. The system uses the setting
for the patron’s registered branch.

When the patron taps an item in the Fines and Fees List, detailed information about the
transaction is displayed.

If the connection branch and the patron’s registered branch accept credit card
payments for fines and fees, the patron can select and pay charges from the Fines and
Fees page. See Credit Card Payments from Mobile PAC.

If the patron has overdue items, this page offers an option to estimate accrued fines,
also available on the Items Out page. See Items Checked Out.

Claimed and Lost

This patron account page lists the patron's claimed and lost items. To make this page
available, set the Mobile PAC profile Navigation: Claimed and Lost to Yes. See Enable
display of claimed and lost items in Mobile PAC.

Saved Searches

This page shows the patrons’ saved searches, if the Search Agent has been enabled in
Polaris Administration. For details, see Saved Searches (Search Agent) in Mobile PAC.

The patron can select saved searches and delete them from this page. When the patron
taps a search name, details about the saved search are displayed. The patron can edit
the name, notes, notification e-mail address and format, frequency, and number of times
to run the search, and save the settings. (The saved search cannot be run manually from
Mobile PAC.)

Reading History

This page shows the patron’s reading history, if reading histories have been enabled in
Polaris Administration. See "Setting Reading History Options" in the Patron Services
Administration Guide.

Tip:
If you enable reading histories, a patron can start or stop a reading history
on the Update Account and Preferences page. See Update Account and
Preferences. Reading histories are always enabled for Outreach Services
patrons.
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When the patron taps a title in the reading history, detailed information about the title is
displayed.

To allow patrons to remove individual items from the reading history, set the PAC profile
Patrons can remove reading history to Yes. This setting also applies to Polaris
PowerPAC. The system uses the setting for the patron’s registered branch. The patron
can check individual items and click Delete Selected, or click Delete All. When a patron
removes an item from the reading history, the item is also removed from the reading
history list in the staff client (Patron Status workform - Reader Services view).

Saved Lists (Title Lists)

This page is available if you allow patrons to create and save title lists. The patron can
copy or move titles from list to list, see details about and place requests for titles on a
saved list, and e-mail selected titles or entire lists. For details, see Title Lists in Mobile
PAC.

Update Account and Preferences

This page is available if you allow patrons to request updates to their accounts in
Polaris Administration. Set these features with the PAC profile Patron access options
(Update Info tabbed page). Your setting also applies to Polaris PowerPAC. For more
information, see Set up online patron account updates.

The Update Account page also offers a link to update preferences. These options can
include email address, phone numbers, the ability to start and stop the reading history,
email format, preferred language, preferred notification method, and e-receipts
preference.

Note:
If the preferred notification method is set to email, an email address must
be supplied. If the preferred method is phone, the patron must indicate the
phone number to use for notification. If the patron chooses TXT
Messaging or text message e-receipts, the patron must indicate the
phone number to be used for TXT messages, and select a carrier for that
number.
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Credit Card Payments from Mobile PAC

Mobile PAC supports credit card payments for patron account charges and donations,
using the any Polaris-supported gateway (see the Patron Services Administration Guide).
E-commerce for Mobile PAC is a separately licensed feature, but there is no additional
cost for the license.

When credit card payments for fines and fees are enabled, patrons can select charges
to pay and click Pay Fines on the Fines and Fees page of the patron account. The
Payment form opens, where the patron enters and submits billing and credit card
information.

If donations are enabled, the link appears in the footer of Mobile PAC pages and as a
Make a Donation link on the Home page. To display these links, set the Mobile PAC
profile Navigation: Donations to Yes. (The user can choose to display or suppress the
Make a Donation link on the home page from the User Preferences page.)

When the user taps the donation link, the donation form opens. Like Polaris PowerPAC,
the user does not have to log on to make a donation.

The user completes the form and taps Next to open the credit card Payment form,
where the user supplies and submits billing and credit card information.

For detailed information about setting up e-commerce in Polaris, see the Patron Services
Administration Guide. Once you have set up e-commerce, use the Credit Card Payment
parameter Online payments: Configure to set up credit card payments from Mobile
PAC.

Important:
To accept Mobile PAC online payments, you must enable secure socket
layer (SSL) in Polaris Administration. Set the SSL: Enable Mobile
PAC parameter for the Web server to Yes. See the Administration Guide.
Patrons must have SSL protocol enabled for their mobile device Web
browser.
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PAC Administration Profiles Reference

These tables list the PAC, PowerPAC, Mobile PAC, and Children's PAC profiles in Polaris
Administration and the organization level, description, and default setting for each
profile.

l PAC Profiles Reference
l Polaris PowerPAC Profiles Reference
l Mobile PAC Profiles Reference
l Children’s PAC Profiles Reference

Polaris PowerPAC Profiles Reference

These profiles are available on the Profiles > PowerPAC tab in the Administration
Explorer at the listed organizational levels.

Profile Org Levels Description Default Setting

3M PAMS: Enabled
System,
Library,
Branch

Specifies whether 3M™
Public Access
Management System
“smart cards” are used at
public access
workstations in the
library.

Requirement: Set Single
Logon: Enable to Yes in
PowerPAC Profiles. List
workstation with readers
in the In-House IP
Addresses table.

No (no smart card
use)

Aeon item requests
enabled

System,
Library,
Branch

Determines whether
Aeon special collection
item requests are
enabled for the
organization.

No

PAC_Profiles_Reference.htm
https://www.atlas-sys.com/aeon
https://www.atlas-sys.com/aeon
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Profile Org Levels Description Default Setting

Aeon OpenURL
prefix

System,
Library,
Branch

Specifies the Aeon
URL prefix. Polaris uses
this prefix to construct
the URLs that submit
special collection item
requests to Aeon.

Note: 
Contact Innovative to
determine your Aeon
OpenURL prefix.

—

Ask us: Require login
System,
Library,
Branch

Determines whether
users must be registered
patrons to send a
question to the library by
email, using the Ask Us
feature. Search Polaris
online help for "Set up
and start Ask Us."

Yes - Patrons must
log in with a barcode
and password to use
Ask Us. If set to No,
the Ask Us log-in
page displays a
Guest button that
bypasses log-in.

Bookmarking &
Sharing: Enable

System,
Library,
Branch

Enable social
bookmarking for titles in
PowerPAC search
results. Search Polaris
online help for "Social
Bookmarking for Search
Results (AddThis™)."

No

Bookmarking &
Sharing: Profile ID
for AddThis analytics

System,
Library,
Branch

Specify your AddThis
profile ID for social
bookmarking analytics.
Search Polaris online
help for "Social
Bookmarking for Search
Results (AddThis™)."

—

Branch switching: System, Determines whether the Yes - The Switch to

https://www.atlas-sys.com/aeon
https://www.atlas-sys.com/aeon
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Profile Org Levels Description Default Setting

Enable Library,
Branch

Switch to another branch
list is displayed on
Polaris PowerPAC
pages. The Switch to
another branch list
allows patrons to select
another library in the
system. See Setting Up
Polaris PowerPAC.

another branch list
is displayed in
Polaris PowerPAC.

Categorization of
ESource targets

System,
Library,
Branch

Displays the E-Source
Target Categorization
dialog box, which is used
to set up e-sources
(proprietary non-Z39.50
databases) and organize
e-source targets as a
finding aid. Search
Polaris online help for
"Setting Up E-Source
Targets."

—

Cookie
acceptance: Enable System

Determines whether
PowerPAC displays the
cookie policy message.
Search Polaris online
help for "Prompting
PowerPAC Users to
Accept Cookies."

No

Cookie acceptance:
External workstation
retention period

System

Determines how
frequently the cookie
policy message appears
for external patrons.
Search Polaris online
help for "Configuring
How Frequently the

365 (days)
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Profile Org Levels Description Default Setting

Cookie Policy Message
Appears."

Dashboards:
Expanded

System,
Library,
Branch

Sets the default display
of most lists (Web parts)
on the dashboard to
expanded or closed.
Patrons can select the
title bar of any list to
expand or close the list.

Yes - Dashboard
lists are expanded
by default.

Dashboards: Narrow
your search & related
searches

System,
Library,
Branch

Enables and sets up the
Narrow and Related Web
parts settings that are
displayed with search
results. Search Polaris
online help for "Setting
PowerPAC
Narrow/Related Search
Options."

Both web parts are
enabled and all
possible elements
are displayed.

Dashboards: Web
page / web part
assignment

System,
Library,
Branch

Displays the Web Page -
Web Part Configuration
dialog box, to specify
which Web parts display
in the dashboards on
specific Web pages for
each branch. Search
Polaris online help for
"Defining Web Parts for
Dashboards."

Requirement: Define Web
parts at the system level,
using the profile
Dashboards: Web Part
Construction (PowerPAC
profiles).

—
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Profile Org Levels Description Default Setting

Dashboards: Web
part construction System

Displays the Web Part
Editor dialog box, to
create custom Web parts
for dashboards and limit
the number of items on
automated lists in Web
parts. Search Polaris
online help for "Defining
Web Parts for
Dashboards."

Requirement: Assign the
Web parts to specific
Polaris PowerPAC pages
using the profile
Dashboards: Web Page /
Web Part Assignment
(PowerPAC profiles).

—

Did you mean:
Suggestions are to
display even when
hits are returned

System,
Library,
Branch

For Polaris PowerPAC,
specifies whether Did
You Mean search
suggestions are
displayed with search
results (Y), or only when
a search returns no hits
(N). (Profile does not
affect Polaris PowerPAC
Children’s Edition.)
Search Polaris online
help for "Setting Up Did
You Mean Term
Checking."

No - Suggestions are
displayed only when
a search returns no
hits.

Enable logging of
transactions System

Determines whether the
system logs information
about transactions (such

No
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Profile Org Levels Description Default Setting

as hold requests and
self-registration) initiated
in PowerPAC.

Feature It: Screen
display options

System,
Library,
Branch

Enables Feature It
promotions in Polaris
PowerPAC and specifies
the promotion position in
the search results
display. Search Polaris
online help for "Feature It
Promotions."

Note:
Feature It is available by
specific contract to your
library.

—

Google Preview:
Enable on full display

System,
Library,
Branch

Enables the Google
Preview (book viewer)
feature on the product
page for a title in
PowerPAC search
results. Search Polaris
online Help for "Google
Preview for PowerPAC
Search Results."

Yes - Google
Preview button is
displayed for titles
that have previews
in Google Book
Search.

Google Preview:
Enable on search
results pages

System,
Library,
Branch

Enables the Google
Preview (book viewer)
feature on the initial
search results pages.
Search Polaris online
Help for "Google Preview
for PowerPAC Search
Results."

Yes - On the initial
search results page,
the Google Preview
button is displayed
for titles that have
previews in Google
Book Search.

Highlight local items System, Determines whether No - No titles are
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Profile Org Levels Description Default Setting

in matching title view Library,
Branch

titles with at least one
local item are highlighted
in search results. Search
Polaris online help for
"Highlighting Titles with
Local Items
(PowerPAC)."

highlighted.

In-house access
definitions: Setup

System,
Library,
Branch

Controls how a
workstation’s in-house
status is determined for
PAC patron actions
(patron inactivity
timeout, Recently Viewed
Titles) and e-source
access. The system uses
the settings of the
Polaris PowerPAC
connection organization.
If you select In-House IP
Addresses Table only, a
workstation’s IP address
must be included in that
table to be considered in-
house. If you select In-
House IP Addresses
Table AND registered
workstations (default), a
workstation’s IP address
can either be included in
the In-House IP
Addresses table or the
workstation can be
registered in Polaris to
be considered in-house.

—
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Profile Org Levels Description Default Setting

Item availability:
“Text it” feature
enabled

System,
Library,
Branch

Allows patrons to send a
call number by text
message from the item
availability view in
PowerPAC or Mobile
PAC search results.
Search Polaris online
help for "Sending Call
Numbers by Text
Message" and "Text It in
Mobile PAC."

Yes

Item availability:
Display last circ date

System,
Library,
Branch

Specifies whether the
Item Availability display
includes the last
circulation date of the
item.

Yes (displays last
circulation date)

Item availability:
Display local and
system levels

System,
Library,
Branch

Determines whether all
system holdings are
displayed in one list
(setting is No), or local
and system holdings are
displayed in separate
lists (setting is Yes).

Yes

Item availability:
Display notes

System,
Library,
Branch

Offers options for
item/issue public notes
display: hover over icon
to display note text,
display text, or do not
display.

Icon display

Item availability:
Display textual
holdings notes

System,
Library,
Branch

Offers options for
displaying serials textual
holdings notes: hover
over/tap icon to display

Icon display
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Profile Org Levels Description Default Setting

note, display text or do
not display.

Item availability:
Expand non-serial
titles

System,
Library,
Branch

Sets the default item
availability display to
expanded or closed for
non-serial items (those
with no holdings
statement for the
branch). Patrons can
select branch and
collection controls to
expand or close the list
of items under each
branch and collection.

Yes - Branches and
collections in the
item availability
display are
expanded by default.

Item availability:
Expand serial titles

System,
Library,
Branch

Sets the default item
availability display to
expanded or collapsed
for serial items (those
with a holdings
statement for the
branch). Patrons can
select branch and
collection controls to
expand or collapse the
list of items under each
branch and collection.

No - Branches and
collections in the
item availability
display collapsed by
default.

Librarian’s (MARC)
View: Enable

System,
Library,
Branch

Displays (default) or
suppresses the
Librarian’s View (MARC
record view) in PAC
search results when the
patron clicks the format
icon for a title in
PowerPAC, the

Displays
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Profile Org Levels Description Default Setting

Librarian’s View option
on the product page for a
title in PowerPAC, or the
Librarian’s View link for a
title in Mobile PAC
search results.

Local call number
indexed field: Limit
choice

System,
Library,
Branch

Specifies whether
patrons can browse-
search the local (item-
level) call number index
only, or browse-search
the Dewey or LC call
number indexes for
bibliographic records, as
well as the local call
number index.

Yes - Allows patrons
to browse-search
the local item-level
call number index
only, and suppress
the Dewey and LC
bibliographic record
choices. Set at the
system level, when
Polaris PowerPAC
users are connected
to the system
organization, this
setting suppresses
all call number
options for browse
searching.

When set to No,
provides choices for
call number browse
searches: local
(item-level), LC
(bibliographic record
level), and Dewey
(bibliographic record
level). Set at the
system level, when
Polaris PowerPAC
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Profile Org Levels Description Default Setting

users are connected
to the system
organization, this
setting offers the
Dewey and LC
bibliographic record
choices for
browsing call
numbers.

Navigation:
Advanced

System,
Library,
Branch

Specifies whether
patrons can use the
Advanced search dialog
box to create complex
Boolean searches.
Search Polaris online
help for "Setting
Available Search Types."

Yes - The Advanced
option is displayed
on the Search
submenu.

Navigation: Ask us
System,
Library,
Branch

Specifies whether
patrons can send
suggestions, questions,
and comments via email
message to the library.

Yes - The Ask Us
option is displayed
on the Library Info
menu.

Navigation: Boolean
System,
Library,
Branch

Specifies whether
patrons can use the
Common Query
Language (CQL) syntax
to create complex
searches. Search Polaris
online help for "Setting
Available Search Types."

Yes - The Boolean
option is displayed
on the Search menu.

Navigation: Browse
System,
Library,
Branch

Specifies whether
patrons can browse the
heading indexes. Search

Yes - The Browse
option is displayed
on the Search menu.
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Profile Org Levels Description Default Setting

Polaris online help for
"Setting Available Search
Types."

Navigation:
Children’s PAC

System,
Library,
Branch

Specifies whether
patrons can access
PowerPAC Children’s
Edition from PowerPAC.

No - The Kid’s
Catalog link is not
available.

Note:
PowerPAC
Children’s Edition is
available by specific
contract to your
library. If your
Polaris installation
does not include
PowerPAC
Children’s Edition,
this option is not
available.

Navigation: Claimed
and Lost

System,
Library,
Branch

Specifies whether
patrons can see their
claimed and lost items.

No - Claimed and
lost items do not
appear on patron's
account.

If the profile is set to
Yes for the patron's
registered branch,
any claimed or lost
items the patron has
are displayed in their
PowerPAC account.

Navigation: Course
reserves

System,
Library,
Branch

Specifies whether
patrons can search for
course reserve records
and reserve item records.

No - Course reserve
searching is not
available.
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Profile Org Levels Description Default Setting

Note:
Polaris course
reserve functions
are available by
specific contract to
your library. If your
Polaris installation
does not include
Polaris course
reserves, this option
is not available.

Navigation: E-
Sources

System,
Library,
Branch

Specifies whether
patrons can access E-
Sources, which are non-
Z39.50, proprietary
databases that may
require authentication for
use. Search Polaris
online help for "Setting
Up E-Source Targets."

Yes - The E-Sources
option is displayed
on the Search menu.

Navigation: Events
System,
Library,
Branch

Specifies whether
patrons can display the
Events page. For
information about editing
the Events page, search
the Polaris online help
for "Add text to the
Events page."

Yes - The Events
option is displayed
on the Library Info
menu.

Navigation: Exact
System,
Library,
Branch

Specifies whether
patrons can search the
public catalog with the
exact text (including stop
words) shown in the
Search box. Search

Yes - The Exact
option is displayed
on the Search menu.
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Profile Org Levels Description Default Setting

Polaris online help for
"Setting Available Search
Types."

Navigation: Fines &
Fees

System,
Library,
Branch

Specifies whether
patrons can view the
fines and fees
associated with their
library accounts. The
system uses the setting
for the patron’s
registered branch.

Requirement: Set
Navigation: Patron
Account to Yes
(PowerPAC profile).

Yes - The Fines &
Fees option is
displayed on the My
Account menu.

Navigation: Hours
System,
Library,
Branch

Specifies whether
patrons can display the
Hours page. For
information about
specifying information
for the Hours page,
search the Polaris online
help for "Set Polaris
PowerPAC features on
the menu bar."

Yes - The Hours
option is displayed
on the Library Info
menu.

Navigation: Items
out

System,
Library,
Branch

Specifies whether
patrons can view the
items checked out to
their library card. If you
allow renewals from the
PAC, patrons select the
items on this page. The
system uses the setting

Yes - The Items Out
option is displayed
on the My Account
menu.
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Profile Org Levels Description Default Setting

for the patron’s
registered branch.

Requirement: Set
Navigation: Patron
Account to Yes
(PowerPAC profile). To
allow patrons to renew
items, set Patron Access:
Renew permitted to Yes
(PAC profile). You can
block renewals under
certain circumstances.

Navigation: Keyword
System,
Library,
Branch

Specifies whether
patrons can do a
keyword search. Search
the Polaris online help
for "Setting Available
Search Types."

Yes - The Keyword
option is displayed
on the Search menu.

Navigation: My
record

System,
Library,
Branch

Specifies whether
patrons can view their
library account
information. For
example, if you allow
patrons to update their
registration information,
change their passwords
from the PAC, or manage
reading histories, this
page provides the
appropriate links.

Requirement: Set
Navigation: Patron
Account to Yes

Yes - The My Record
option is displayed
on the My Account
menu.
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Profile Org Levels Description Default Setting

(PowerPAC profile). For
information on allowing
patrons to update their
accounts from the PAC,
search Polaris online
help for "Setting Patron
Account Options."

Navigation: PAC help
System,
Library,
Branch)

Specifies whether
patrons can access the
Polaris-supplied Help
page. Search Polaris
online help for "Polaris
PowerPAC Help."

Yes - The Help
option is displayed
on the main menu.

Navigation: Patron
account

System,
Library,
Branch

Specifies whether
patrons can access their
patron accounts. See
Editing Messages and
Labels.

Yes - The My
Account option is
displayed on the
menu bar.

Navigation: Phrase
System,
Library,
Branch

Specifies whether
patrons can search the
public catalog based on
a phrase. Search Polaris
online help for "Setting
Available Search Types."

Yes - The Phrase
option is displayed
on the Search menu.

Navigation: Policies
System,
Library,
Branch)

Specifies whether
patrons can view the
library policy page.
Search Polaris online
help for "Add text to the
Policies page."

Yes - The Policy
option is displayed
on the Library Info
menu.

Navigation: Portal
System,
Library,
Branch)

Specifies whether
patrons can view the

Yes - The Portal
option is displayed
on the Library Info
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Profile Org Levels Description Default Setting

portal page, which may
include the quick search
feature, content
carousels and/or rotating
book jacket, and custom
content. Search Polaris
online help for "Setting
Up Polaris PowerPAC -
Overview."

menu. Select this
option when you are
using Polaris as the
library home page.

Navigation: Requests
System,
Library,
Branch

Specifies whether
patrons can see a list of
their hold/ILL requests,
and cancel or reactivate
requests. The system
uses the setting for the
patron’s registered
branch. You set
conditions for requests
from PAC, and whether
they can be canceled and
reactivated, with the
Requests parameter
Holds options.

Requirement: Set
Navigation: Patron
Account to Yes
(PowerPAC profile).

Yes - The Requests
option is available
on the My Account
menu.

If set to No, patrons
cannot review or
cancel hold/ILL
requests. The
Requests menu
option, summary
information in the
My Account
dashboard, and
option to go to list of
requests when a
request is placed are
suppressed.

Navigation: Web site
System,
Library,
Branch

Specifies whether
patrons can access the
links of interest page
provided by the library in
Polaris PowerPAC.

Yes - The Web Site
option is available
on the Library Info
menu.

Navigation: Web site
URL

System, Specifies an address for blank (empty
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Profile Org Levels Description Default Setting

Library,
Branch

the web page to display
when a patron selects
Web Site on the Library
Info menu.

Requirement: Navigation:
Web Site - Yes
(PowerPAC profiles).

address field) - The
default website.asp
page is displayed if
this field is empty.
The default page
allows you to
provide links to
multiple Web sites.

url (web page
address or path) -
Automatically
displays the page
when Web Site is
selected from the
Library Info
submenu.

OverDrive download:
Enable on in-house
workstations

System,
Library,
Branch

Specifies whether
patrons can access and
download OverDrive
eContent on library
computers designated as
in-house workstations.

No

OverDrive Preview:
Enable on full display

System,
Library,
Branch

Specifies whether the
OverDrive Sample button
appears on the eContent
title's full display in
PowerPAC

Yes

OverDrive Preview:
Enable on search
results pages

System,
Library,
Branch

Specifies whether the
OverDrive Sample button
appears on the search
results page when the
results are eContent
titles from OverDrive.

Yes
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Profile Org Levels Description Default Setting

Page header options
System,
Library,
Branch

Settings to customize
the PowerPAC page
header, including the
logo image, return link
URL for the logo image,
background and branch
name text colors, logo
and branch name
position, and
suppressing the branch
name text. Search
Polaris online help for
"Customize the page
header."

—

Patron inactivity
timeout

System,
Library,
Branch

Sets a period of inactivity
after which a logged-in
patron at a library
workstation is
automatically logged out.

Applies to in-house
workstations only.
Search Polaris online
help for "Set an inactivity
timeout for in-house
workstations."

Also determines how
frequently the cookie
policy message appears
on in-house
workstations. Search
Polaris online help for
"Configuring How
Frequently the Cookie
Policy Message

Not enabled
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Appears."

Perform a new
search if a cross-
reference is selected

System,
Library,
Branch

Determines whether the
location in the headings
display changes to the
cross-reference location
when the cross-reference
is selected.

Yes - Search from
selected cross-
reference, so that
the display is set to
the new location in
the browse headings
index.

Portal custom
content (URL)

System,
Library,
Branch

Specifies the URL for
custom content you want
to include on the
PowerPAC portal page.
Type the complete URL,
beginning with http://.
Search Polaris online
help for "Customizing
Portal Page Features."

—

Portal page content
carousels

System,
Library,
Branch

Sets up content
carousels (rotating
images of library-
specified titles in the
library catalog) for
display on the PowerPAC
portal page. Search
Polaris online help for
"Content Carousels on
the PowerPAC Portal
Page."

Requirement: Navigation:
Portal - Yes (PowerPAC
profiles).

None defined.

PowerPAC Analytics
System,
Library,

Enables Google Analytics
or custom analytics use

No (no page use
analysis)
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Branch

in Polaris PowerPAC.
The same code is also
used in Polaris
PowerPAC Children’s
Edition. See Analyzing
Polaris PowerPAC Use.

Product page
categories:
Configure

System,
Library,
Branch

Sets the default state of
categories (expanded or
collapsed) on the Polaris
PowerPAC product page
for a title in search
results, and determines
the display order of the
categories. Search
Polaris online help for
"Configuring the
PowerPAC Product
Page."

—

Quick search button
configuration

System,
Library,
Branch

These settings enable a
quick search feature with
search option buttons on
the Polaris PowerPAC
portal page. You can
specify which search
option buttons to display
and what type of search
each launches. Search
the Polaris online help
for "Customizing Portal
Page Features" and "Set
up quick search with
search option buttons."

Feature is not
enabled. The default
quick search feature
is used on the portal
page.

Recently viewed
titles

System,
Library,

Enables the Recently
Viewed Titles feature for —
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Branch

in-house workstations,
remote workstations, or
both; sets the maximum
number of titles that can
be displayed. Search
Polaris online help for
"Setting Up Recently
Viewed Titles."

Related words
options

System,
Library,
Branch

Enables the Include
related words feature for
PowerPAC keyword and
phrase search results;
sets the maximum
number of titles that can
compose results lists
and still display the
Included related words
link. Search Polaris
online help for "Related
Words in PowerPAC
Searches."

Yes; 1,000

Remote databases:
Categorization of
target databases

System,
Library,
Branch

Displays the Z39.50
Target Categorization
dialog box, to allow an
organization to group
remote search targets as
a finding aid. See Editing
Messages and Labels for
detailed instructions on
using target categories.

Requirement: Make
remote resources
available for searching.

—
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Remote databases:
Maximum number
that can be searched
at once

System,
Library,
Branch

Set the number of
remote databases that
can be searched at one
time. Search Polaris
online help for
"Maximum Number of
Databases Searchable at
One Time."

—

Remote databases:
Usage settings

System,
Library,
Branch

Set usage conditions for
specific remote
resources, including
authentication
requirements and search
access points. Enable
follow-on searches and
specify follow-on search
targets. Set PAC display
name; specify databases
for Using drop-down list
in PowerPAC search
forms. Search Polaris
online help for "Remote
Database Usage Settings
for PowerPAC."

—

Remote user
PowerPAC: Enable

System,
Library,
Branch

Specifies whether
patrons use Polaris
PowerPAC to access the
library catalog from
remote locations (that is,
from computers that are
not in the library or are
not defined in the In-
House IP Addresses
table).

Yes - Patrons can
use Polaris
PowerPAC from
remote locations.

If set to No, Polaris
PowerPAC access is
available only from
workstations
defined in the In-
House IP Addresses
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database table.

Results set:
Maximum number of
records to return

System,
Library,
Branch

Sets the maximum
number of records that
can be returned in a
results set. If you
experience decreased
performance for
searches with large
results due to limited
server capacity, you can
lower the maximum
number of records to
return. However,
relevancy ranking may be
less effective at lower
maximum value.

100,000 (maximum)

Rotating best seller
jacket on Portal page

System,
Library,
Branch

Displays a random book
jacket image drawn from
best-seller lists on the
portal page. When the
image is selected, a
search is launched for
the title. Search Polaris
online help for "Set up
rotating book jackets."

Requirement: Set up an
enriched data source.
See Polaris Social with
ChiliFresh Connections.

Yes - Book jacket
images are
displayed on the
portal page.

RSS Feeds: Enable
System,
Library,
Branch

Provides RSS feeds from
the New Titles
dashboard list. Search
Polaris online help for

Yes
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"Setting Up RSS
Feeds."When this profile
is set to Yes, an orange
XML icon is displayed by
the elements of the New
Titles list.

RSS Feeds:
Maximum new
releases

System

Specifies how many
titles should be listed in
the RSS feed that the
patron receives. This
profile is available at the
system level only; that is,
it controls the number for
every branch that
enables RSS feeds.

5

Scoping: Use MARC
language scoping
display table

System,
Library,
Branch

Determines whether
catalog searches can be
limited only by certain
languages, or by any
language defined by the
MARC 21 format. This
profile controls the
languages displayed for
selection in the
PowerPAC Search
Options list.

Requirement: Specify
languages in Policy
Tables, MARC Language
Scoping.

Yes - Allow language
scoping by the
languages specified
in the MARC
Language Scoping
Display table.

If set to No, all
languages defined
by the MARC 21
format are displayed
for search scoping.

Search: Display
search criteria in
search box for link-
produced searches

System,
Library,
Branch

Specifies whether search
terms such as an ISBN
are displayed in the

No - Only search
terms actually typed
by the user are
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search box when the
user clicks a link (for
example, in the New
Titles list) to launch a
search.

displayed in the
search box.

Search options: Limit
by collection enabled

System,
Library,
Branch

Specifies whether
collections are available
as a scoping option on
the Polaris PowerPAC
Search Options page.

No - The Collections
list does not appear
as a scoping option.

Single login: Enable
System,
Library,
Branch

Displays a Log In option
on the My Account menu
that allows a patron to
log on once for a PAC
session, instead of each
time the patron selects a
function that requires
identification. Search
Polaris online help for
"Controlling Patron
Account Login &
Access."

Yes - The Login
option is displayed
on the menu.

Text: Headings
count column for
“see from” headings

System,
Library,
Branch

Specifies the text to
display in the number of
titles column of the
headings list when the
headings entry is a SEE
heading.

—

Theme dashboard
position

System,
Library,
Branch

Sets the position of the
dashboard on Polaris
PowerPAC pages. (Does
not affect the dashboard
position on the product

Left
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page, which is always on
the right.) Search the
Polaris online help for
"Setting Polaris
PowerPAC Themes."

Theme selection
System,
Library,
Branch

Specifies the overall
appearance of Polaris
PowerPAC pages by
providing several ready-
made skin choices.
Search the Polaris online
help for "Setting Polaris
PowerPAC Themes."

Classic

Title Display:
Configure

System,
Library,
Branch

Specifies the data
elements that are
displayed in brief, full,
and summary search
results views for a title in
the Polaris PowerPAC.
You can customize and
order the elements you
select, and customize
and translate their labels.
Search Polaris online
help for "Configuring the
PowerPAC Title Display."

—

Title Display:
Number of
characters in the
Summary (Short)

System,
Library,
Branch

Specifies the maximum
number of characters of
the Summary (Short)
field that are displayed in
the brief and full search
results views for a title in
the Polaris PowerPAC.
Enter a value between 0

0 - The number of
characters is not
limited.
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and 4000.

Search Polaris online
help for "Configuring the
PowerPAC Title Display."

Title list: Email
System,
Library,
Branch

Specifies whether
patrons can send their
title list as an email
message from Polaris
PowerPAC or Mobile
PAC.

Requirements: Set Title
List: Enable to Yes
(PowerPAC profiles) and
specify an email address
for sender in Email
Notification: Email
address of sender
(Parameters >
Notifcation).

Yes - Allows patrons
to send their title list
as an email
message.

Title list: Enable
System,
Library,
Branch

Specifies whether
patrons can create a
bibliography of titles they
select from search
results. This profile also
affects Mobile PAC.

Yes - Allows patrons
to add titles to a
bibliography, and
view and modify the
contents of the list.

Title list: Enable bulk
holds

System,
Library,
Branch

Specifies whether
patrons can place
multiple hold requests at
once from PowerPAC
working or saved title
lists. Search Polaris
online help for "Bulk Hold
Requests from Polaris

No - The Place
Request button does
not appear on
PowerPAC working
or saved title lists.
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PowerPAC Title Lists."

Requirement: Set Title
List: Enable to Yes
(PowerPAC profiles).

Title list: Maximum
number of titles to
request in bulk

System,
Library,
Branch

Limits how many titles
from working or saved
title lists can be
requested at once.
Search Polaris online
help for "Bulk Hold
Requests from Polaris
PowerPAC Title Lists."

10

Title list: Print
System,
Library,
Branch

Specifies whether
patrons can print their
title lists.

Requirement: Set Title
List: Enable to Yes
(PowerPAC profiles).

Yes - Allows patrons
to print their title
lists to any printer
available from the
workstation. If set to
No, the printer icon
does not appear.

Title list: Save
System,
Library,
Branch

Specifies whether
patrons can save their
title list to a file.

Requirement: Set Title
List: Enable to Yes
(PowerPAC profiles).

Yes - Allows patrons
to save the contents
of the title list to a
text file. If set to No,
the Save icon does
not appear.

Virtual reference:
Configure

System,
Library,
Branch

If you contract with a
virtual reference service,
use this dialog box to set
up the specific profiles
for that service. For more
information, search
Polaris online help for

—
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"Setting Up Live Virtual
Reference Services."

Requirement: Virtual
reference: Enable - Yes
(PowerPAC profiles)

Virtual reference:
Enable

System,
Library,
Branch

Specifies whether
patrons can use a virtual
reference service from
Polaris PowerPAC. This
feature provides
interactive, online
reference services.
Search Polaris online
help for "Setting Up Live
Virtual Reference
Services."

Yes - The virtual
reference link is
available in Polaris
PowerPAC.

Virtual reference:
Supplier

System,
Library,
Branch

Specifies your virtual
reference service
provider. If you contract
with a virtual reference
service, select the
provider here. Search
Polaris online help for
"Setting Up Live Virtual
Reference Services."

Requirements: Set Virtual
reference: Enable to Yes
(PowerPAC profiles) and
Virtual reference:
Configure - PowerPAC
profile - specific settings
for the provider you
selected.

—
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These profiles are available on the Profiles > PowerPAC tab in the Administration
Explorer at the listed organizational levels.

Profile Org Levels Description Default Setting

3M PAMS: Enabled
System,
Library,
Branch

Specifies whether 3M™
Public Access
Management System
“smart cards” are used at
public access
workstations in the
library.

Requirement: Set Single
Logon: Enable to Yes in
PowerPAC Profiles. List
workstation with readers
in the In-House IP
Addresses table.

No (no smart card
use)

Aeon item requests
enabled

System,
Library,
Branch

Determines whether
Aeon special collection
item requests are
enabled for the
organization.

No

Aeon OpenURL
prefix

System,
Library,
Branch

Specifies the Aeon
URL prefix. Polaris uses
this prefix to construct
the URLs that submit
special collection item
requests to Aeon.

Note: 
Contact Innovative to
determine your Aeon
OpenURL prefix.

—

https://www.atlas-sys.com/aeon
https://www.atlas-sys.com/aeon
https://www.atlas-sys.com/aeon
https://www.atlas-sys.com/aeon
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Ask us: Require login
System,
Library,
Branch

Determines whether
users must be registered
patrons to send a
question to the library by
email, using the Ask Us
feature. Search Polaris
online help for "Set up
and start Ask Us."

Yes - Patrons must
log in with a barcode
and password to use
Ask Us. If set to No,
the Ask Us log-in
page displays a
Guest button that
bypasses log-in.

Bookmarking &
Sharing: Enable

System,
Library,
Branch

Enable social
bookmarking for titles in
PowerPAC search
results. Search Polaris
online help for "Social
Bookmarking for Search
Results (AddThis™)."

No

Bookmarking &
Sharing: Profile ID
for AddThis analytics

System,
Library,
Branch

Specify your AddThis
profile ID for social
bookmarking analytics.
Search Polaris online
help for "Social
Bookmarking for Search
Results (AddThis™)."

—

Branch switching:
Enable

System,
Library,
Branch

Determines whether the
Switch to another branch
list is displayed on
Polaris PowerPAC
pages. The Switch to
another branch list
allows patrons to select
another library in the
system. See Setting Up
Polaris PowerPAC.

Yes - The Switch to
another branch list
is displayed in
Polaris PowerPAC.

Categorization of System, Displays the E-Source —
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ESource targets Library,
Branch

Target Categorization
dialog box, which is used
to set up e-sources
(proprietary non-Z39.50
databases) and organize
e-source targets as a
finding aid. Search
Polaris online help for
"Setting Up E-Source
Targets."

Cookie
acceptance: Enable System

Determines whether
PowerPAC displays the
cookie policy message.
Search Polaris online
help for "Prompting
PowerPAC Users to
Accept Cookies."

No

Cookie acceptance:
External workstation
retention period

System

Determines how
frequently the cookie
policy message appears
for external patrons.
Search Polaris online
help for "Configuring
How Frequently the
Cookie Policy Message
Appears."

365 (days)

Dashboards:
Expanded

System,
Library,
Branch

Sets the default display
of most lists (Web parts)
on the dashboard to
expanded or closed.
Patrons can select the
title bar of any list to
expand or close the list.

Yes - Dashboard
lists are expanded
by default.
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Dashboards: Narrow
your search & related
searches

System,
Library,
Branch

Enables and sets up the
Narrow and Related Web
parts settings that are
displayed with search
results. Search Polaris
online help for "Setting
PowerPAC
Narrow/Related Search
Options."

Both web parts are
enabled and all
possible elements
are displayed.

Dashboards: Web
page / web part
assignment

System,
Library,
Branch

Displays the Web Page -
Web Part Configuration
dialog box, to specify
which Web parts display
in the dashboards on
specific Web pages for
each branch. Search
Polaris online help for
"Defining Web Parts for
Dashboards."

Requirement: Define Web
parts at the system level,
using the profile
Dashboards: Web Part
Construction (PowerPAC
profiles).

—

Dashboards: Web
part construction System

Displays the Web Part
Editor dialog box, to
create custom Web parts
for dashboards and limit
the number of items on
automated lists in Web
parts. Search Polaris
online help for "Defining
Web Parts for

—
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Dashboards."

Requirement: Assign the
Web parts to specific
Polaris PowerPAC pages
using the profile
Dashboards: Web Page /
Web Part Assignment
(PowerPAC profiles).

Did you mean:
Suggestions are to
display even when
hits are returned

System,
Library,
Branch

For Polaris PowerPAC,
specifies whether Did
You Mean search
suggestions are
displayed with search
results (Y), or only when
a search returns no hits
(N). (Profile does not
affect Polaris PowerPAC
Children’s Edition.)
Search Polaris online
help for "Setting Up Did
You Mean Term
Checking."

No - Suggestions are
displayed only when
a search returns no
hits.

Enable logging of
transactions System

Determines whether the
system logs information
about transactions (such
as hold requests and
self-registration) initiated
in PowerPAC.

No

Feature It: Screen
display options

System,
Library,
Branch

Enables Feature It
promotions in Polaris
PowerPAC and specifies
the promotion position in
the search results

—
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display. Search Polaris
online help for "Feature It
Promotions."

Note:
Feature It is available by
specific contract to your
library.

Google Preview:
Enable on full display

System,
Library,
Branch

Enables the Google
Preview (book viewer)
feature on the product
page for a title in
PowerPAC search
results. Search Polaris
online Help for "Google
Preview for PowerPAC
Search Results."

Yes - Google
Preview button is
displayed for titles
that have previews
in Google Book
Search.

Google Preview:
Enable on search
results pages

System,
Library,
Branch

Enables the Google
Preview (book viewer)
feature on the initial
search results pages.
Search Polaris online
Help for "Google Preview
for PowerPAC Search
Results."

Yes - On the initial
search results page,
the Google Preview
button is displayed
for titles that have
previews in Google
Book Search.

Highlight local items
in matching title view

System,
Library,
Branch

Determines whether
titles with at least one
local item are highlighted
in search results. Search
Polaris online help for
"Highlighting Titles with
Local Items
(PowerPAC)."

No - No titles are
highlighted.
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In-house access
definitions: Setup

System,
Library,
Branch

Controls how a
workstation’s in-house
status is determined for
PAC patron actions
(patron inactivity
timeout, Recently Viewed
Titles) and e-source
access. The system uses
the settings of the
Polaris PowerPAC
connection organization.
If you select In-House IP
Addresses Table only, a
workstation’s IP address
must be included in that
table to be considered in-
house. If you select In-
House IP Addresses
Table AND registered
workstations (default), a
workstation’s IP address
can either be included in
the In-House IP
Addresses table or the
workstation can be
registered in Polaris to
be considered in-house.

—

Item availability:
“Text it” feature
enabled

System,
Library,
Branch

Allows patrons to send a
call number by text
message from the item
availability view in
PowerPAC or Mobile
PAC search results.
Search Polaris online
help for "Sending Call

Yes
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Numbers by Text
Message" and "Text It in
Mobile PAC."

Item availability:
Display last circ date

System,
Library,
Branch

Specifies whether the
Item Availability display
includes the last
circulation date of the
item.

Yes (displays last
circulation date)

Item availability:
Display local and
system levels

System,
Library,
Branch

Determines whether all
system holdings are
displayed in one list
(setting is No), or local
and system holdings are
displayed in separate
lists (setting is Yes).

Yes

Item availability:
Display notes

System,
Library,
Branch

Offers options for
item/issue public notes
display: hover over icon
to display note text,
display text, or do not
display.

Icon display

Item availability:
Display textual
holdings notes

System,
Library,
Branch

Offers options for
displaying serials textual
holdings notes: hover
over/tap icon to display
note, display text or do
not display.

Icon display

Item availability:
Expand non-serial
titles

System,
Library,
Branch

Sets the default item
availability display to
expanded or closed for
non-serial items (those
with no holdings
statement for the

Yes - Branches and
collections in the
item availability
display are
expanded by default.
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branch). Patrons can
select branch and
collection controls to
expand or close the list
of items under each
branch and collection.

Item availability:
Expand serial titles

System,
Library,
Branch

Sets the default item
availability display to
expanded or collapsed
for serial items (those
with a holdings
statement for the
branch). Patrons can
select branch and
collection controls to
expand or collapse the
list of items under each
branch and collection.

No - Branches and
collections in the
item availability
display collapsed by
default.

Librarian’s (MARC)
View: Enable

System,
Library,
Branch

Displays (default) or
suppresses the
Librarian’s View (MARC
record view) in PAC
search results when the
patron clicks the format
icon for a title in
PowerPAC, the
Librarian’s View option
on the product page for a
title in PowerPAC, or the
Librarian’s View link for a
title in Mobile PAC
search results.

Displays

Local call number
indexed field: Limit

System,
Library,

Specifies whether
patrons can browse-

Yes - Allows patrons
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choice Branch

search the local (item-
level) call number index
only, or browse-search
the Dewey or LC call
number indexes for
bibliographic records, as
well as the local call
number index.

to browse-search
the local item-level
call number index
only, and suppress
the Dewey and LC
bibliographic record
choices. Set at the
system level, when
Polaris PowerPAC
users are connected
to the system
organization, this
setting suppresses
all call number
options for browse
searching.

When set to No,
provides choices for
call number browse
searches: local
(item-level), LC
(bibliographic record
level), and Dewey
(bibliographic record
level). Set at the
system level, when
Polaris PowerPAC
users are connected
to the system
organization, this
setting offers the
Dewey and LC
bibliographic record
choices for
browsing call
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numbers.

Navigation:
Advanced

System,
Library,
Branch

Specifies whether
patrons can use the
Advanced search dialog
box to create complex
Boolean searches.
Search Polaris online
help for "Setting
Available Search Types."

Yes - The Advanced
option is displayed
on the Search
submenu.

Navigation: Ask us
System,
Library,
Branch

Specifies whether
patrons can send
suggestions, questions,
and comments via email
message to the library.

Yes - The Ask Us
option is displayed
on the Library Info
menu.

Navigation: Boolean
System,
Library,
Branch

Specifies whether
patrons can use the
Common Query
Language (CQL) syntax
to create complex
searches. Search Polaris
online help for "Setting
Available Search Types."

Yes - The Boolean
option is displayed
on the Search menu.

Navigation: Browse
System,
Library,
Branch

Specifies whether
patrons can browse the
heading indexes. Search
Polaris online help for
"Setting Available Search
Types."

Yes - The Browse
option is displayed
on the Search menu.

Navigation:
Children’s PAC

System,
Library,
Branch

Specifies whether
patrons can access
PowerPAC Children’s
Edition from PowerPAC.

No - The Kid’s
Catalog link is not
available.

Note:
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PowerPAC
Children’s Edition is
available by specific
contract to your
library. If your
Polaris installation
does not include
PowerPAC
Children’s Edition,
this option is not
available.

Navigation: Claimed
and Lost

System,
Library,
Branch

Specifies whether
patrons can see their
claimed and lost items.

No - Claimed and
lost items do not
appear on patron's
account.

If the profile is set to
Yes for the patron's
registered branch,
any claimed or lost
items the patron has
are displayed in their
PowerPAC account.

Navigation: Course
reserves

System,
Library,
Branch

Specifies whether
patrons can search for
course reserve records
and reserve item records.

No - Course reserve
searching is not
available.

Note:
Polaris course
reserve functions
are available by
specific contract to
your library. If your
Polaris installation
does not include
Polaris course
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reserves, this option
is not available.

Navigation: E-
Sources

System,
Library,
Branch

Specifies whether
patrons can access E-
Sources, which are non-
Z39.50, proprietary
databases that may
require authentication for
use. Search Polaris
online help for "Setting
Up E-Source Targets."

Yes - The E-Sources
option is displayed
on the Search menu.

Navigation: Events
System,
Library,
Branch

Specifies whether
patrons can display the
Events page. For
information about editing
the Events page, search
the Polaris online help
for "Add text to the
Events page."

Yes - The Events
option is displayed
on the Library Info
menu.

Navigation: Exact
System,
Library,
Branch

Specifies whether
patrons can search the
public catalog with the
exact text (including stop
words) shown in the
Search box. Search
Polaris online help for
"Setting Available Search
Types."

Yes - The Exact
option is displayed
on the Search menu.

Navigation: Fines &
Fees

System,
Library,
Branch

Specifies whether
patrons can view the
fines and fees
associated with their
library accounts. The

Yes - The Fines &
Fees option is
displayed on the My
Account menu.
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system uses the setting
for the patron’s
registered branch.

Requirement: Set
Navigation: Patron
Account to Yes
(PowerPAC profile).

Navigation: Hours
System,
Library,
Branch

Specifies whether
patrons can display the
Hours page. For
information about
specifying information
for the Hours page,
search the Polaris online
help for "Set Polaris
PowerPAC features on
the menu bar."

Yes - The Hours
option is displayed
on the Library Info
menu.

Navigation: Items
out

System,
Library,
Branch

Specifies whether
patrons can view the
items checked out to
their library card. If you
allow renewals from the
PAC, patrons select the
items on this page. The
system uses the setting
for the patron’s
registered branch.

Requirement: Set
Navigation: Patron
Account to Yes
(PowerPAC profile). To
allow patrons to renew
items, set Patron Access:
Renew permitted to Yes

Yes - The Items Out
option is displayed
on the My Account
menu.
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(PAC profile). You can
block renewals under
certain circumstances.

Navigation: Keyword
System,
Library,
Branch

Specifies whether
patrons can do a
keyword search. Search
the Polaris online help
for "Setting Available
Search Types."

Yes - The Keyword
option is displayed
on the Search menu.

Navigation: My
record

System,
Library,
Branch

Specifies whether
patrons can view their
library account
information. For
example, if you allow
patrons to update their
registration information,
change their passwords
from the PAC, or manage
reading histories, this
page provides the
appropriate links.

Requirement: Set
Navigation: Patron
Account to Yes
(PowerPAC profile). For
information on allowing
patrons to update their
accounts from the PAC,
search Polaris online
help for "Setting Patron
Account Options."

Yes - The My Record
option is displayed
on the My Account
menu.

Navigation: PAC help
System,
Library,
Branch)

Specifies whether
patrons can access the

Yes - The Help
option is displayed
on the main menu.
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Polaris-supplied Help
page. Search Polaris
online help for "Polaris
PowerPAC Help."

Navigation: Patron
account

System,
Library,
Branch

Specifies whether
patrons can access their
patron accounts. See
Editing Messages and
Labels.

Yes - The My
Account option is
displayed on the
menu bar.

Navigation: Phrase
System,
Library,
Branch

Specifies whether
patrons can search the
public catalog based on
a phrase. Search Polaris
online help for "Setting
Available Search Types."

Yes - The Phrase
option is displayed
on the Search menu.

Navigation: Policies
System,
Library,
Branch)

Specifies whether
patrons can view the
library policy page.
Search Polaris online
help for "Add text to the
Policies page."

Yes - The Policy
option is displayed
on the Library Info
menu.

Navigation: Portal
System,
Library,
Branch)

Specifies whether
patrons can view the
portal page, which may
include the quick search
feature, content
carousels and/or rotating
book jacket, and custom
content. Search Polaris
online help for "Setting
Up Polaris PowerPAC -
Overview."

Yes - The Portal
option is displayed
on the Library Info
menu. Select this
option when you are
using Polaris as the
library home page.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 507

Profile Org Levels Description Default Setting

Navigation: Requests
System,
Library,
Branch

Specifies whether
patrons can see a list of
their hold/ILL requests,
and cancel or reactivate
requests. The system
uses the setting for the
patron’s registered
branch. You set
conditions for requests
from PAC, and whether
they can be canceled and
reactivated, with the
Requests parameter
Holds options.

Requirement: Set
Navigation: Patron
Account to Yes
(PowerPAC profile).

Yes - The Requests
option is available
on the My Account
menu.

If set to No, patrons
cannot review or
cancel hold/ILL
requests. The
Requests menu
option, summary
information in the
My Account
dashboard, and
option to go to list of
requests when a
request is placed are
suppressed.

Navigation: Web site
System,
Library,
Branch

Specifies whether
patrons can access the
links of interest page
provided by the library in
Polaris PowerPAC.

Yes - The Web Site
option is available
on the Library Info
menu.

Navigation: Web site
URL

System,
Library,
Branch

Specifies an address for
the web page to display
when a patron selects
Web Site on the Library
Info menu.

Requirement: Navigation:
Web Site - Yes
(PowerPAC profiles).

blank (empty
address field) - The
default website.asp
page is displayed if
this field is empty.
The default page
allows you to
provide links to
multiple Web sites.

url (web page



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 508

Profile Org Levels Description Default Setting

address or path) -
Automatically
displays the page
when Web Site is
selected from the
Library Info
submenu.

OverDrive download:
Enable on in-house
workstations

System,
Library,
Branch

Specifies whether
patrons can access and
download OverDrive
eContent on library
computers designated as
in-house workstations.

No

OverDrive Preview:
Enable on full display

System,
Library,
Branch

Specifies whether the
OverDrive Sample button
appears on the eContent
title's full display in
PowerPAC

Yes

OverDrive Preview:
Enable on search
results pages

System,
Library,
Branch

Specifies whether the
OverDrive Sample button
appears on the search
results page when the
results are eContent
titles from OverDrive.

Yes

Page header options
System,
Library,
Branch

Settings to customize
the PowerPAC page
header, including the
logo image, return link
URL for the logo image,
background and branch
name text colors, logo
and branch name
position, and

—
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suppressing the branch
name text. Search
Polaris online help for
"Customize the page
header."

Patron inactivity
timeout

System,
Library,
Branch

Sets a period of inactivity
after which a logged-in
patron at a library
workstation is
automatically logged out.

Applies to in-house
workstations only.
Search Polaris online
help for "Set an inactivity
timeout for in-house
workstations."

Also determines how
frequently the cookie
policy message appears
on in-house
workstations. Search
Polaris online help for
"Configuring How
Frequently the Cookie
Policy Message
Appears."

Not enabled

Perform a new
search if a cross-
reference is selected

System,
Library,
Branch

Determines whether the
location in the headings
display changes to the
cross-reference location
when the cross-reference
is selected.

Yes - Search from
selected cross-
reference, so that
the display is set to
the new location in
the browse headings
index.
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Portal custom
content (URL)

System,
Library,
Branch

Specifies the URL for
custom content you want
to include on the
PowerPAC portal page.
Type the complete URL,
beginning with http://.
Search Polaris online
help for "Customizing
Portal Page Features."

—

Portal page content
carousels

System,
Library,
Branch

Sets up content
carousels (rotating
images of library-
specified titles in the
library catalog) for
display on the PowerPAC
portal page. Search
Polaris online help for
"Content Carousels on
the PowerPAC Portal
Page."

Requirement: Navigation:
Portal - Yes (PowerPAC
profiles).

None defined.

PowerPAC Analytics
System,
Library,
Branch

Enables Google Analytics
or custom analytics use
in Polaris PowerPAC.
The same code is also
used in Polaris
PowerPAC Children’s
Edition. See Analyzing
Polaris PowerPAC Use.

No (no page use
analysis)

Product page
categories:
Configure

System,
Library,
Branch

Sets the default state of
categories (expanded or —
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collapsed) on the Polaris
PowerPAC product page
for a title in search
results, and determines
the display order of the
categories. Search
Polaris online help for
"Configuring the
PowerPAC Product
Page."

Quick search button
configuration

System,
Library,
Branch

These settings enable a
quick search feature with
search option buttons on
the Polaris PowerPAC
portal page. You can
specify which search
option buttons to display
and what type of search
each launches. Search
the Polaris online help
for "Customizing Portal
Page Features" and "Set
up quick search with
search option buttons."

Feature is not
enabled. The default
quick search feature
is used on the portal
page.

Recently viewed
titles

System,
Library,
Branch

Enables the Recently
Viewed Titles feature for
in-house workstations,
remote workstations, or
both; sets the maximum
number of titles that can
be displayed. Search
Polaris online help for
"Setting Up Recently
Viewed Titles."

—
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Related words
options

System,
Library,
Branch

Enables the Include
related words feature for
PowerPAC keyword and
phrase search results;
sets the maximum
number of titles that can
compose results lists
and still display the
Included related words
link. Search Polaris
online help for "Related
Words in PowerPAC
Searches."

Yes; 1,000

Remote databases:
Categorization of
target databases

System,
Library,
Branch

Displays the Z39.50
Target Categorization
dialog box, to allow an
organization to group
remote search targets as
a finding aid. See Editing
Messages and Labels for
detailed instructions on
using target categories.

Requirement: Make
remote resources
available for searching.

—

Remote databases:
Maximum number
that can be searched
at once

System,
Library,
Branch

Set the number of
remote databases that
can be searched at one
time. Search Polaris
online help for
"Maximum Number of
Databases Searchable at
One Time."

—



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 513

Profile Org Levels Description Default Setting

Remote databases:
Usage settings

System,
Library,
Branch

Set usage conditions for
specific remote
resources, including
authentication
requirements and search
access points. Enable
follow-on searches and
specify follow-on search
targets. Set PAC display
name; specify databases
for Using drop-down list
in PowerPAC search
forms. Search Polaris
online help for "Remote
Database Usage Settings
for PowerPAC."

—

Remote user
PowerPAC: Enable

System,
Library,
Branch

Specifies whether
patrons use Polaris
PowerPAC to access the
library catalog from
remote locations (that is,
from computers that are
not in the library or are
not defined in the In-
House IP Addresses
table).

Yes - Patrons can
use Polaris
PowerPAC from
remote locations.

If set to No, Polaris
PowerPAC access is
available only from
workstations
defined in the In-
House IP Addresses
database table.

Results set:
Maximum number of
records to return

System,
Library,
Branch

Sets the maximum
number of records that
can be returned in a
results set. If you
experience decreased
performance for
searches with large

100,000 (maximum)
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results due to limited
server capacity, you can
lower the maximum
number of records to
return. However,
relevancy ranking may be
less effective at lower
maximum value.

Rotating best seller
jacket on Portal page

System,
Library,
Branch

Displays a random book
jacket image drawn from
best-seller lists on the
portal page. When the
image is selected, a
search is launched for
the title. Search Polaris
online help for "Set up
rotating book jackets."

Requirement: Set up an
enriched data source.
See Polaris Social with
ChiliFresh Connections.

Yes - Book jacket
images are
displayed on the
portal page.

RSS Feeds: Enable
System,
Library,
Branch

Provides RSS feeds from
the New Titles
dashboard list. Search
Polaris online help for
"Setting Up RSS
Feeds."When this profile
is set to Yes, an orange
XML icon is displayed by
the elements of the New
Titles list.

Yes

RSS Feeds:
Maximum new
releases

System
Specifies how many
titles should be listed in 5
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the RSS feed that the
patron receives. This
profile is available at the
system level only; that is,
it controls the number for
every branch that
enables RSS feeds.

Scoping: Use MARC
language scoping
display table

System,
Library,
Branch

Determines whether
catalog searches can be
limited only by certain
languages, or by any
language defined by the
MARC 21 format. This
profile controls the
languages displayed for
selection in the
PowerPAC Search
Options list.

Requirement: Specify
languages in Policy
Tables, MARC Language
Scoping.

Yes - Allow language
scoping by the
languages specified
in the MARC
Language Scoping
Display table.

If set to No, all
languages defined
by the MARC 21
format are displayed
for search scoping.

Search: Display
search criteria in
search box for link-
produced searches

System,
Library,
Branch

Specifies whether search
terms such as an ISBN
are displayed in the
search box when the
user clicks a link (for
example, in the New
Titles list) to launch a
search.

No - Only search
terms actually typed
by the user are
displayed in the
search box.

Search options: Limit
by collection enabled

System,
Library,
Branch

Specifies whether
collections are available
as a scoping option on

No - The Collections
list does not appear
as a scoping option.
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the Polaris PowerPAC
Search Options page.

Single login: Enable
System,
Library,
Branch

Displays a Log In option
on the My Account menu
that allows a patron to
log on once for a PAC
session, instead of each
time the patron selects a
function that requires
identification. Search
Polaris online help for
"Controlling Patron
Account Login &
Access."

Yes - The Login
option is displayed
on the menu.

Text: Headings
count column for
“see from” headings

System,
Library,
Branch

Specifies the text to
display in the number of
titles column of the
headings list when the
headings entry is a SEE
heading.

—

Theme dashboard
position

System,
Library,
Branch

Sets the position of the
dashboard on Polaris
PowerPAC pages. (Does
not affect the dashboard
position on the product
page, which is always on
the right.) Search the
Polaris online help for
"Setting Polaris
PowerPAC Themes."

Left

Theme selection
System,
Library,
Branch

Specifies the overall
appearance of Polaris
PowerPAC pages by

Classic
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providing several ready-
made skin choices.
Search the Polaris online
help for "Setting Polaris
PowerPAC Themes."

Title Display:
Configure

System,
Library,
Branch

Specifies the data
elements that are
displayed in brief, full,
and summary search
results views for a title in
the Polaris PowerPAC.
You can customize and
order the elements you
select, and customize
and translate their labels.
Search Polaris online
help for "Configuring the
PowerPAC Title Display."

—

Title Display:
Number of
characters in the
Summary (Short)

System,
Library,
Branch

Specifies the maximum
number of characters of
the Summary (Short)
field that are displayed in
the brief and full search
results views for a title in
the Polaris PowerPAC.
Enter a value between 0
and 4000.

Search Polaris online
help for "Configuring the
PowerPAC Title Display."

0 - The number of
characters is not
limited.

Title list: Email
System,
Library,
Branch

Specifies whether
patrons can send their
title list as an email

Yes - Allows patrons
to send their title list
as an email
message.



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 518

Profile Org Levels Description Default Setting

message from Polaris
PowerPAC or Mobile
PAC.

Requirements: Set Title
List: Enable to Yes
(PowerPAC profiles) and
specify an email address
for sender in Email
Notification: Email
address of sender
(Parameters >
Notifcation).

Title list: Enable
System,
Library,
Branch

Specifies whether
patrons can create a
bibliography of titles they
select from search
results. This profile also
affects Mobile PAC.

Yes - Allows patrons
to add titles to a
bibliography, and
view and modify the
contents of the list.

Title list: Enable bulk
holds

System,
Library,
Branch

Specifies whether
patrons can place
multiple hold requests at
once from PowerPAC
working or saved title
lists. Search Polaris
online help for "Bulk Hold
Requests from Polaris
PowerPAC Title Lists."

Requirement: Set Title
List: Enable to Yes
(PowerPAC profiles).

No - The Place
Request button does
not appear on
PowerPAC working
or saved title lists.

Title list: Maximum
number of titles to
request in bulk

System,
Library,
Branch

Limits how many titles
from working or saved
title lists can be

10
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requested at once.
Search Polaris online
help for "Bulk Hold
Requests from Polaris
PowerPAC Title Lists."

Title list: Print
System,
Library,
Branch

Specifies whether
patrons can print their
title lists.

Requirement: Set Title
List: Enable to Yes
(PowerPAC profiles).

Yes - Allows patrons
to print their title
lists to any printer
available from the
workstation. If set to
No, the printer icon
does not appear.

Title list: Save
System,
Library,
Branch

Specifies whether
patrons can save their
title list to a file.

Requirement: Set Title
List: Enable to Yes
(PowerPAC profiles).

Yes - Allows patrons
to save the contents
of the title list to a
text file. If set to No,
the Save icon does
not appear.

Virtual reference:
Configure

System,
Library,
Branch

If you contract with a
virtual reference service,
use this dialog box to set
up the specific profiles
for that service. For more
information, search
Polaris online help for
"Setting Up Live Virtual
Reference Services."

Requirement: Virtual
reference: Enable - Yes
(PowerPAC profiles)

—

Virtual reference:
Enable

System,
Library,
Branch

Specifies whether
patrons can use a virtual

Yes - The virtual
reference link is
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reference service from
Polaris PowerPAC. This
feature provides
interactive, online
reference services.
Search Polaris online
help for "Setting Up Live
Virtual Reference
Services."

available in Polaris
PowerPAC.

Virtual reference:
Supplier

System,
Library,
Branch

Specifies your virtual
reference service
provider. If you contract
with a virtual reference
service, select the
provider here. Search
Polaris online help for
"Setting Up Live Virtual
Reference Services."

Requirements: Set Virtual
reference: Enable to Yes
(PowerPAC profiles) and
Virtual reference:
Configure - PowerPAC
profile - specific settings
for the provider you
selected.

—

Mobile PAC Profiles Reference

These profiles are available on the Profiles, Mobile PAC tabbed page on the
Administration Explorer, at the listed organizational levels.
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Ask us:
Require login

l System
l Library
l Branch

Determines whether users
must be registered patrons
to send a question to the
library by e-mail, using the
Ask Us feature. Search
Polaris online help for
"Setting Up Ask Us in
Mobile PAC."

Yes - Patrons must log
in with a barcode and
password to use Ask
Us.

If set to No, the Ask Us
log-in page displays a
Guest button that
bypasses log-in.

Branch
switching:
Enable

l System
l Library
l Branch

Allows users to change
connection branches.
Search Polaris online help
for "Setting Up Mobile PAC
Connections."

Yes

Mobile PAC
Analytics

l System
l Library
l Branch

Specify Google Analytics
or custom coding to track
site usage. Search Polaris
online help for "Analyzing
Polaris Mobile PAC Use."

Navigation:
Ask us

l System
l Library
l Branch

Places the Ask Us link on
the Mobile PAC home
page. Search Polaris online
help for "Setting Up Ask Us
in Mobile PAC."

Yes

Navigation:
Claimed and
Lost

l System
l Library
l Branch

Specifies whether claimed
and lost items are
displayed in the patron's
Mobile PAC account.

Navigation:
Donations

l System
l Library
l Branch

Places the Donations link
on Mobile PAC pages. The
system uses the setting for
the patron’s registered
branch. Search Polaris

No
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online help for "Credit Card
Payments from Mobile
PAC."

Navigation:
Fines & fees

l System
l Library
l Branch

Places the Fines and
Fees link on the Patron
Account page. The system
uses the setting for the
patron’s registered branch.
Search Polaris online help
for "Patron Account (My
Account) in Mobile PAC."

Yes

Navigation:
Items out

l System
l Library
l Branch

Places the Items checked
out link on the Patron
Account page. The system
uses the setting for the
patron’s registered branch.
Search Polaris online help
for "Patron Account (My
Account) in Mobile PAC."

Yes

Navigation:
Patron
account

l System
l Library
l Branch

Places the My Account link
on the Mobile PAC home
page. Search Polaris online
help for "Patron Account
(My Account) in Mobile
PAC."

Yes

Navigation:
Requests

l System
l Library
l Branch

Places the Hold
requests link on the Patron
Account page. The system
uses the setting for the
patron’s registered branch.
Search Polaris online help
for "Patron Account (My
Account) in Mobile PAC."

Yes
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Navigation:
Web site URL

l System
l Library
l Branch

Displays the organization’s
Web site address on the
Hours and Contact page.
Search Polaris online help
for "Setting Up Mobile PAC
Library Information."

New and
Popular Titles

l System
l Library
l Branch

Displays the New and
Popular link on the home
page, and sets up the lists
of new, best seller, on-
order, and most circulated
(popular) titles. Search
Polaris online help for
"New & Popular Titles in
Mobile PAC."

Product page
categories:
Configure

l System
l Library
l Branch

Determines the display
order of links on the
Mobile PAC product page
for a title in search results.
Search Polaris online help
for "Set up the Mobile PAC
title (product) page."

Remember
me: Enable

l System

Displays the Remember
me checkbox on the
patron login page. Search
Polaris online help for
"Patron Log-In Settings for
Mobile PAC."

Yes

Title Display:
Configure

l System
l Library
l Branch

Specify the data elements
that appear in the brief, full,
and summary results for
Mobile PAC bibliographic
searches. You can
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customize and order the
elements you select, and
customize and translate
their labels. Search Polaris
online help for
"Configuring the Mobile
PAC Title Display."

Children’s PAC Profiles Reference

These profiles are available on the Profiles, Children’s PAC tabbed page on the
Administration Explorer, at the listed organizational levels.

Profile Org Levels Description Default Setting

Allow hold
requests if
charging for
holds

System,
Library,
Branch

Determines whether
hold requests are
allowed from Children’s
PAC if the system
charges for holds. If set
to Yes, hold requests
are allowed and a
message concerning
the charge is displayed
when the request is
placed. The patron can
continue or cancel the
request.

No (hold requests
cannot be placed from
Children’s PAC if the
system charges for hold
requests)

Categories:
Enable

System,
Library,
Branch

Determines whether
library-defined
categories are available
for searching. See
Managing Search
Categories.

Yes

Requirement: If yes,
define categories with
the profile Category
construction
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Category
construction

System,
Library,
Branch

Displays the Category
Construction dialog
box. Set up subject
categories, define
search targets within
the categories, and edit
existing categories and
targets. See Managing
Search Categories.

Polaris PowerPAC
Children’s Edition
includes a set of default
categories.

Requirement: Set
Categories: Enable to
Yes (Children’s PAC
profiles)

Dashboards:
Enable

System,
Library,
Branch

Determines whether
library-defined
elements and theme
choices are displayed
in lists on the left
portion (“dashboard”)
of the Children’s PAC
interface. See
Managing Children’s
Dashboards, and
Managing Themes.

Yes

Dashboards:
Webpage/web
part assignment

System,
Library,
Branch

Displays the Web Page
- Web Part
Configuration dialog
box. Specify which Web
parts to display in the
dashboard on specific
Web pages for the
Children’s PAC at each
branch. See Managing
Children’s Dashboards.

Requirements:

Define Web parts at the
system level, using the
profile Dashboards:
Web part construction
(Children’s PAC
profiles).

Set Dashboards:
Enable to Yes
(Children’s
PAC profiles) to display
dashboards in the
Children’s PAC.
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Dashboards:
Web part
construction

System

Displays the Web Part
Editor dialog box.
Create custom Web
parts (title searches,
URLs, free text, and
polls), and limit the
number of items on
automated Web parts.
See Managing
Children’s Dashboards.

Requirements:

Assign the Web parts to
specific Children’s PAC
pages using the profile
Dashboards: Web page
/ web part assignment
(Children’s PAC
profiles).

Set Dashboards:
Enable to Yes
(Children’s
PAC profiles) to display
dashboards in the
Children’s PAC.

Default search
limits

System,
Library,
Branch

Displays the Children’s
PAC Default Search
Limit dialog box.
Specify a search filter,
expressed as a
Common Query
Language search term,
in the free text search
limit box. In addition,
you can specify which
collections defined in
the system should be
included in Children’s
PAC search results. See
Setting Children’s
Search Limits.

AND TA=j (limits results
to records where the
target audience is
juvenile); no collections
selected

Item availability
text: Available

System,
Library,
Branch

Specifies the text that
indicates an item is
available.

In Library

Requirement: Set Item
Availability: Display
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status to Yes
(Children’s PAC
profiles)

Item availability
text: Not
available

System,
Library,
Branch

Specifies the text that
indicates an item is not
available.

Checked Out

Requirement: Set Item
Availability: Display
status to Yes
(Children’s PAC
profiles)

Item availability:
Display branch
location

System,
Library,
Branch

Determines whether the
item’s assigned branch
is displayed.

Yes

Item availability:
Display call
number

System,
Library,
Branch

Determines whether to
show the call number
from the item record in
the Availability view.

Yes

Item availability:
Display
collections

System,
Library,
Branch

Determines whether the
collection information
from the item record is
displayed.

Yes

Item availability:
Display local and
system levels

System,
Library,
Branch

Determines which
items are included in
search results
availability information.
See Customize the
children’s item
availability display.

Yes. If the logged-on
branch is the system,
information about items
that are designated to
display in PAC and
owned throughout the
system is displayed. If
the logged-on branch is
a local branch, only
items held by that
branch are displayed. If
none are owned by the
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local branch, the
system-level items are
displayed.

If set to No, if the
logged-on branch is the
system, information
about items owned
throughout the system
is displayed. If the
logged-on branch is a
local branch, only the
local items are
displayed. If none are
owned by the local
branch, no items are
displayed.

Item availability:
Display notes

System,
Library,
Branch

Determines whether a
note icon is displayed
for items that include
public notes. Patrons
can click the icon to
read the note.

Yes

Item availability:
Display shelf
location

System,
Library,
Branch

Determines whether the
item’s shelf location is
displayed.

Yes

Item availability:
Display status

System,
Library,
Branch

Determines whether the
circulation status of an
item is displayed in the
item information.

Yes

Item availability:
Display type

System,
Library,
Branch

Determines whether the
material type
(information about
physical format from

Yes
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the item record) is
displayed in the item
information.

Multiple
language strings System

Displays a dialog box
that allows you to
specify a language and
translate all search
categories and targets
from English to the
language of your
choice. Other
languages are available
in this dialog box only if
your library system has
purchased other
language versions of
Polaris PowerPAC
Children’s Edition. You
can also edit the
English names. See
Translate all categories
and targets.

No translations (lists
English categories and
targets only)

Navigation:
Events

System,
Library,
Branch

Determines whether the
Children’s PAC
interface includes the
Events button, which is
used to access a
library-maintained
Events page. See Add
text to the children’s
Events page.

Yes

Navigation: Help
System,
Library,
Branch

Determines whether the
Children’s PAC
interface includes the

Yes
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Help button, which is
used to access online
Help for the Children’s
PAC.

Navigation:
PowerPAC

System,
Library,
Branch

Determines whether a
link to Polaris
PowerPAC is displayed
in the Children’s PAC
interface.

Yes

Number of
tooltip entries
displayed

System,
Library,
Branch

For categories, defines
the number of targets
that display in a tooltip
when the cursor hovers
over the category link.
See Managing Search
Categories.

5

Requirements:

Use the profile Category
construction (Children’s
PAC profiles) to set up
search categories.

Set the profile
Categories: Enable to
Yes (Children’s
PAC profiles) to display
the defined search
categories in the
Children’s PAC.

Remote user:
Enable

System,
Library,
Branch

Allows access to the
Children’s PAC from
workstations outside
the library.

Yes. Remote users can
access the Children's
PAC interface.

If set to No, Children’s
PAC access is available
only from workstations
defined in the In-House
IP Addresses database
table.
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Results set:
Maximum
number of
records to return

System,
Library,
Branch

Sets the maximum
number of records that
can be returned in a
results set. If you
experience decreased
performance for
searches with large
results due to limited
server capacity, you can
lower the maximum
number of records to
return. However,
relevancy ranking may
be less effective at
lower maximum values.

1,000 (maximum =
10,000)

Results set: Do
not sort if it
contains more
than this many
records

System,
Library,
Branch

Sets the maximum
number of records that
a record set can
contain and still be
sorted. If you
experience decreased
performance for
searches with large
results due to limited
server capacity, you can
lower the maximum
number of records that
can be sorted.

1,000 (maximum)

Search button
visibility:
Anywhere button

System,
Library,
Branch

Displays a search
button that launches a
keyword search in all
fields. See Set
children’s search
buttons.

Yes
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Search button
visibility: Authors
button

System,
Library,
Branch

Displays a search
button that launches a
keyword search for
author. See Set
children’s search
buttons.

Yes

Search button
visibility: Fiction
button

System,
Library,
Branch

Displays a search
button that launches a
keyword subject search
scoped to fiction. See
Set children’s search
buttons.

Yes

Search button
visibility: Non-
Fiction button

System,
Library,
Branch

Displays a search
button that launches a
keyword subject search
scoped to non-fiction.
See Set children’s
search buttons.

Yes

Search button
visibility: Series
button

System,
Library,
Branch

Displays a search
button that launches a
keyword search for
series name. See Set
children’s search
buttons.

Yes

Search button
visibility:
Subjects button

System,
Library,
Branch

Displays a search
button that launches a
keyword search for
subject. See Set
children’s search
buttons.

Yes

Search button
visibility: Titles
button

System,
Library,
Branch

Displays a search
button that launches a
keyword search for

Yes
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title. See Set children’s
search buttons.

Select theme:
Enable

System,
Library,
Branch

Allows users of
Children’s PAC to select
an interface theme
from choices you
specify. See Managing
Themes.

Yes

Requirements:

Specify which themes
are available as choices
with the profile Theme
assignment (Children’s
PAC profiles).

Set Dashboards:
Enable to Yes
(Children’s
PAC profiles), because
the theme options are
displayed in the
dashboard.

Theme
assignment

System,
Library,
Branch

Displays the Theme
Assignment dialog box,
where you can specify
which library-defined or
system-provided
interface themes are
available as choices
from the Children’s
PAC. You can also set a
default theme here. See
Managing Themes for
more information.

Requirements:

Set up and edit themes
at the system level, with
the Children’s PAC
profile Theme
construction (Children’s
PAC profiles).

Set the profile Select
theme: Enable to Yes
(Children’s
PAC profiles) to display
the assigned themes in
the Children’s PAC

Set Dashboards:
Enable to Yes
(Children’s
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PAC profiles) for the
organization, because
the theme options are
displayed in the
dashboard.

Theme
construction System

Displays the Theme
Construction dialog
box. Set up and edit
themes for the
Children’s PAC
interface. See
Managing Themes for
more information

Requirement: Specify
which themes are
available to specific
organizations using the
Children’s PAC profile
Theme assignment.

Web access:
Enable

System,
Library,
Branch

Allows live Web links in
Children’s PAC search
results. See
Customizing the
Children’s Results
Display.

No - Web links are text-
only, and do not allow
Internet access.

If set to Yes, users can
click the Web Site icon
or a web link to view the
site.
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Standard PAC Pages Reference

This topic lists the Polaris PowerPAC and Children’s Edition pages and when they are
displayed. You can use this information to decide which, if any, Web parts should be
assigned to the dashboard for a specific page (see the Public Access Administration
PDF Guide, Defining Web Parts for Dashboards - Overview), or to edit the pages as part
of customizing Polaris PowerPAC for your library.

See also:

l Polaris PowerPAC Pages Reference
l Polaris PowerPAC Children's Edition Pages Reference

Web Page IDs for User-Defined Pages

Polaris PowerPAC and Polaris PowerPAC Children’s Edition are based on ASP.NET
programming. All .aspx and .ascx files are directly editable, but you should back up your
changes to preserve them from being overwritten when the application is updated and
reinstalled. For more information, see the PAC Customization Guide.

If you create a custom page with the user-defined template /Custom/CustomPage-
template.aspx, you may want to set the PageID value so that the appropriate Web parts
are displayed in the dashboard. The default value is 1, which means that your custom
page will display the same Web parts as the default PowerPAC portal page
(default.aspx). To get a different set of Web parts on your custom page, you change the
default PageID value to that of an existing standard page. Simply search your custom
file for PageID and change the value at each occurrence.

Example:
You have created a new Web page for a patron account function. If you
want the Web parts that normally display on the default patron account
page to be displayed on your new custom page, change the webpageid
value to 9.
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Polaris PowerPAC Pages Reference

These files are located in the default root folder C:\Program Files\Polaris\
[version]\PowerPAC on your Polaris PowerPAC server and in subfolders as noted.

Page PageID Function

bookrequest.aspx 49

Request page displayed
when a rotating book jacket
image is clicked on the portal
page.

default.aspx 1

First page to appear when
Polaris PowerPAC is
accessed if the portal page
is enabled. If you add
custom html content to this
page, be sure that it is
responsive.

help\default.aspx 7 Displayed when All topics is
selected on the Help menu.

help\tutorials.aspx 8 Obsolete

library\askus.aspx 2

Displayed when Ask Us on
the Library Info menu is
selected and the patron logs
on. The page allows patrons
to send an e-mail message
to the library staff.

library\events.aspx 3

Displayed when Events on
the Library Info menu is
selected. The Events page is
where you can show
information about upcoming
library and community
programs. If you add custom
html content to this page, be
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sure that it is responsive. For
information about editing the
Events page, see Add text to
the Events page.

library\hours.aspx 4

Displayed when Hours on the
Library Info menu is
selected. The Hours page is
where you can list the times
when the library is open to
the public.

library\policies.aspx 5

Displayed when Policies on
the Library Info menu is
selected. The Policies page
is where you can list the
lending and usage policies. If
you add custom html content
to this page, be sure that it is
responsive. See Add text to
the Policies page.

library\vrquestion.aspx 43

Displayed after a patron
selects the virtual reference
link and logs on. This page
allows the patron to send a
question to the virtual
reference service.

library\website.aspx 6

Displayed when Web Site on
the Library Info menu is
selected. The Web Site page
is where you can list links to
library-selected Web pages
in the library or on the
Internet. If you add custom
html content to this page, be
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sure that it is responsive.

logon.aspx 17

Displayed when any function
is selected that requires the
patron to log in. Patrons use
this page to supply the
patron account number or
username and password.

message.aspx 29

Notifies the patron that
something has been done,
such as changing a
password or address, or
displays a message when a
problem occurs.

patronaccount\claimedandlost.aspx 69

Displayed when Claimed and
Lost is selected on the My
Account menu. This page
displays the patrons claimed
and lost items.

patronaccount\coursereserves.aspx 58

Displayed when Courses is
selected on the My Account
menu and the patron is an
instructor for an active
course. The page reports
circulation statistics for
reserved course materials.

patronaccount\default.aspx 9

Displayed when the patron
selects My Record on the My
Account menu. This page
displays the patron’s basic
registration information.

patronaccount\finesfees.aspx 14
Displayed when Fines & Fees
is selected on the My
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Account menu. The Fines
page lists the fines and fees
the patron owes.

patronaccount\itemsout.aspx 16

Displayed when Items Out is
selected on the My Account
menu. The Items Out page
shows the items currently
checked out by the patron.

patronaccount\patroncommunity.aspx 64

Licensed feature. Displayed
when an organization
representative selects
Community on the My
Account menu.

patronaccount\readinghistory.aspx 31

Displayed when Reading
History is selected on the My
Account menu. The Reading
History page displays a list
of the items the patron has
checked out since the
reading history began.

patronaccount\registerconnections.aspx 67

Polaris Social. Displayed
when a patron clicks the
appropriate link on the
PowerPAC log-on page. This
page provides options for
setting up a new ChiliFresh
account or linking an existing
account to the patron’s
library account.

patronaccount\requests.aspx 18

Displayed when Requests is
selected on the My Account
menu. The Request page
lists the hold and interlibrary
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loan requests the patron has
made.

patronaccount\searchagent.aspx 40

Displayed when Saved
Searches is selected on the
My Account menu. The
Saved Searches page lists
information about saved
(automatic) searches and
provides links for editing and
deleting the searches.

patronaccount\selfregister.aspx 20

Displayed when click here to
register on any log-on page
is selected. The Self Register
page allows patrons to
register for a library card.

patronaccount\shoppingcart.aspx 57

Displayed when My Shopping
Cart is selected on the My
Account menu. This page
displays a list of digital
materials a patron has
placed in the shopping cart
for purchase. Used with
Polaris Fusion, a separately
licensed product.

patronaccount\social.aspx 66

Polaris Social. Available to
logged-in patrons from the
PowerPAC patron account;
displayed when the patron
clicks Connections in the
dashboard or the menu bar.

patronaccount\virtualreference.aspx 33
Displayed when Virtual
Reference is selected on the
My Account menu. The
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Virtual Reference page
provides access to
transcripts of the patron’s
interaction with a virtual
reference service, if the
service provides this feature.

search\browse.aspx 52

Displayed in response to a
Browse search. This page
allows patrons to browse the
appropriate index headings.

search\changedatabases.aspx 50

Displayed when the Select
Databases link is chosen on
a search page. This is the
Other Databases page,
where patrons can select
Z39.50 databases to search
simultaneously with the
library catalog.

search\communityinformation.aspx 61

Licensed feature. Displayed
when the user selects
Community Keyword on the
Community menu.

search\communityinformationbrowse.asp
x 62

Licensed feature. Displayed
when the user selects
Community Browse on the
Community menu.

search\communityinformationfull.aspx 63

Licensed feature. Displayed
when the user selects a
community entry in the
community search results list.

search\communitylist.aspx 65
Licensed feature. The initial
search results list for a
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community information
search.

search\default.aspx?type=Advanced
(before search) 24

Displayed when Advanced is
selected from the Search
menu. You set up and launch
an advanced search from
this page.

search\default.aspx?type=Boolean (before
search) 25

Displayed when Boolean is
selected from the Search
menu. You set up and launch
a Boolean (command)
search from this page.

search\default.aspx?type=Browse (before
search) 22

Displayed when Browse is
selected from the Search
menu. You set up and launch
a browse search from this
page

search\default.aspx?type=Course (before
search) 48

Displayed when Course
Reserves is selected from
the Search menu. You set up
and launch a search for
course reserve records from
this page.

search\default.aspx?type=Exact (before
search) 30

Displayed when Exact is
selected from the Search
menu.

search\default.aspxtype=Keyword (before
search) 21

Displayed when Keyword is
selected from the Search
menu. You set up and launch
a keyword search from this
page.
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search\default.aspx?type=Phrase (before
search) 23

Displayed when Phrase is
selected from the Search
menu. You set up and launch
a phrase search from this
page.

search\misc\dictionary.aspx N/A search\misc\dictionary.aspx

search\misc\esources.aspx 34

Displayed when E-Sources is
selected from the Search
menu. The e-Sources page
provides links to the
proprietary, non-Z39.50
databases available for
patron searches.

search\misc\thesaurus.aspx N/A Obsolete

search\newreleases.aspx 35

Displayed when you click a
category in the New Titles
Web part on the dashboard.
The page displays title links
for new library acquisitions.

search\related.aspx 53

Displayed when you click
More in the Related Web part
on the dashboard for the
search results page.

search\searchresults.aspx 51
Displays the initial bib search
results list (brief
information).

search\title.aspx 54

Displays the title product
page when a title listed in
search results is selected for
full display.

search\titlelist.aspx 56 Title list page, displayed
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when you click My Lists in
the Search menu.

social\profile.aspx 68

Read-only page that displays
the public profile of any of
the “social” users in
PowerPAC (as opposed to
the
patronaccount/social.aspx
page which is the patron’s
own profile page).

Polaris PowerPAC Children's Edition Pages Reference

These files are located in the default root folder C:\Program Files\Polaris\
[version]\PowerPAC on your Polaris PowerPAC server in the Children subfolder as
noted.

Page PageID Function

children\default.aspx 44

The default page appears when
you connect to the Children’s
Edition, and when you click the
banner graphic to clear search
results.

children\events.aspx 45

The events page appears when
you click the Events link on any
Children’s Edition page. The page
lists events specified by the library

children\fulldisplay.aspx 47

The full display page appears
when you click the More
Information link for a title, or the
title name itself, in a search results
list. The page displays detailed
bibliographic and location
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information for the selected title.

children\searchresults.aspx 46

The search results page displays
the results of a search as a list of
titles, with brief information about
each title.
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Glossary

0

006 field
Fixed-length Data Elements - Additional Material Characteristics: This field con-
tains 18 character positions (00-17) that provide for coding information about
special aspects of the item being cataloged that cannot be coded in field 008
(Fixed-Length Data Elements). It is used in cases when an item has multiple char-
acteristics. It is also used to record the coded serial aspects of nontextual con-
tinuing resources. The field has a tree structure, whereby the code given in
006/00 (Form of material) determines the data elements defined for subsequent
character positions. Except for code s (Serial/Integrating resource), the codes in
field 006/00 correspond to those in Leader/06 (Type of record). For each occur-
rence of field 006, the codes defined for character positions 01-17 will be the
same as those defined in the corresponding field 008, character positions 18-34.
Configurations of field 006 are given in the following order: books, computer
files/electronic resources, maps, music, continuing resources, visual materials,
and mixed materials.

007 field
Physical Description, Fixed Field - This field contains special information about
the physical characteristics in a coded form. The information may represent the
whole item or parts of an item such as accompanying material. The data ele-
ments in field 007 are positionally defined and the number of character positions
in field 007 depends upon the code contained in 007/00. Character position 00
contains a code that identifies the category of material. The fill character (|) is
not allowed in this position. The fill character may be used in any other character
position when the cataloging agency makes no attempt to code the position.
The categories of material for which field 007 is applicable in bibliographic
records are presented in the following order in the field description: map, elec-
tronic resource, globe, tactile material, projected graphic, microform, non-
projected graphic, motion picture, kit, notated music, remote-sensing image,
sound recording, text, videorecording, and unspecified.
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008 field
Fixed-length Data Elements - General Information This field contains 40 char-
acter positions (00-39) that provide coded information about the record as a
whole and about special bibliographic aspects of the item being cataloged.
These coded data elements are potentially useful for retrieval and data man-
agement purposes. The data elements are positionally defined. Character pos-
itions that are not defined contain a blank (#). All defined character positions
must contain a defined code; for some field 008 positions, this may be the fill
character (|). The fill character may be used (in certain character positions) when
a cataloging organization makes no attempt to code the character position. The
fill character is not allowed in field 008 positions 00-05 (Date entered on file). Its
use is discouraged in positions 07-10 (Date 1), 15-17 (Place of publication, pro-
duction, or execution), and the 008 position defined for Form of item (either pos-
ition 23 or 29 depending upon the 008 configuration). Character positions 00-17
and 35-39 are defined the same across all types of material, with special con-
sideration for position 06. The definition of character positions 18-34 was done
independently for each type of material, although certain data elements are
defined the same in the specifications for more than one type of material. When
similar data elements are defined for inclusion in field 008 for different types of
material, they occupy the same field 008 character positions.

A

added entry
A secondary entry to the main entry in a MARC record.

approval plan
An arrangement with a publisher or vendor to send materials automatically. With
an approval plan, it is not necessary for the library to order each title individually,
and titles that are not considered appropriate may be returned by the library. An
approval plan with a vendor is usually an agreement that the library will receive
current imprints selected for the library on the basis of a detailed profile.

ASN (Advanced Shipping Notice)
An advance shipping notice or advance ship notice (ASN) is an electronic noti-
fication of pending shipments that is provided by a supplier after an EDI order is
received and processed. If the supplier has the capability to produce ASNs (X12
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transaction set 856), the Polaris EDIAgent utility retrieves the shipment inform-
ation, and loads the data into Polaris. This enables users to receive materials in
Polaris by scanning the tracking barcode on the outside of the carton.

B

blanket plan
A blanket plan (also called a blanket order) is most commonly used for ordering
all materials or a specific subset of materials that are published by an organ-
ization. In contrast with approval plans, blanket plans do not generally allow
return privileges with simple deductions from the invoice. With blanket plans,
quality is less important than comprehensiveness of coverage. Blanket plans
can be as narrow as a specific publisher’s series or as broad as a request to
send all material of a particular type or on a particular subject.

blind reference
1) An authority link (see or see also - 4xx and 5xx respectively) which points to
an authority heading that does not exist in the database. 2) An authority heading
(1xx) to which no bibliographic records are linked.

C

cataloging source
A code stored in tag 040 $a that tells who created the record. These codes are
governed by the MARC code list for libraries.

chronology
The date(s) used by the publisher on a serially-issued bibliographic unit to help
identify or indicate when it was published. The chronology may reflect the dates
of coverage, publication, or printing.

content designators
Tags, indicators, and subfield codes in a MARC record.
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D

delimiter
A separate character used in conjunction with a subfield code and introduces
each subfield in a variable field.

deposit account
A deposit account is an account with a vendor that allows customers to pay all
or a portion of the estimated annual billing in advance. Depending on the amount
prepaid, the typical discount is from 1.5% to 4.5% more than with a regular plan,
where invoices are paid after the receipt of titles.

diacritical mark
Any of various marks, such as a macron or cedilla, added to a letter or symbol to
indicate its pronunciation or to distinguish it in some way.

E

enumeration
The designation reflecting the alphabetic or numeric scheme used by the pub-
lisher on an item or assigned when the holdings statement is created to identify
the individual bibliographic or physical parts and to show the relationship of each
unit to the unit as a whole.

express registration
Entering patron information during the check-out process as a service to new,
unregistered patrons.

F

first available copy requests
Hold requests for specific issues of a serial title (such as the May 2015 issue of
Horticulture Magazine ) or specific parts of a multi-part title (such as the first sea-
son of a television series on DVD).
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form subdivision
A division of a subject heading which brings out the form of the work. For
example, in the headings: Internet (Computer network) - Periodicals Library tech-
nicians - Bibliography

free days
A value applied at normal and bulk check-in, renewal, and offline that allows you
to omit a specified number of days from the overdue fine calculation.

G

geographic qualifier
The name of a larger geographic entity added to a local place name. For
example, in the headings: Cambridge (Mass.) Toledo (Spain)

geographic subdivision
A subdivision which limits a topical subject heading to a specific geographic loc-
ation. For example, in the headings: Women - Peru Libraries - New York (State)

M

monographic series
A group of monographs with a collective title in addition to their individual titles.
The individual titles may or may not be numbered. The collective title is generally
found on the title page or the cover of each monograph.

N

non-integrated serial
A non-integrated serial is an item that is linked to a bibliographic record with a
MARC bibliographic level entry of S , but is not linked to a Serial Issue Record cre-
ated through the Polaris Serials Module.
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R

RTF
Requests-To-Fill or RTF processing sends hold requests to designated libraries
in a specified order. A library chooses to fill or deny the request. The request is
routed until it is filled, it expires, or every library denies it.

RTF routing cycle
The request-to-fill (RTF) routing cycle includes a primary and a secondary cycle
defined by the Holds Routing Tables. You can enter a number of branches as
responder branches, beginning with the requestor (your) branch. The cycle tries
to fill a hold at the same branch first, and then tries to fill the hold at the next
branch listed in the primary routing table. After a preset amount of time, the
branches in the secondary table try to fill the hold, each in turn.

S

SICI
The colloquial name for Serial Item and Contribution Identifier. The SICI is the
SISAC bar code. The SICI incorporates the ISSN and is used on scholarly, tech-
nical, medical and other subscription based serials.

SISAC
Serials Industry Systems Advisory Committee. This committee was instrumental
in creating the supporting documentation for the NISO z39.56 standard.

standing order
An order placed with a vendor or the publisher directly for all publications in a
series, all volumes in a set, or all publications of a single publisher.

T

trapped
An item is said to be trapped for a hold when an item that fills a request is
scanned at circulation and the system links the item to a specific request, either
automatically or by displaying a message that prompts you for a decision.
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Index

3

3M Public Access Management System

enabling in Polaris PowerPAC 11

A

accessibility

Polaris PowerPAC 7

Active Directory logon

in PAC, setup 368

AddThis (Share)

in PowerPAC search results, described 240

in PowerPAC search results, setup 242

advanced searches (PAC)

in Mobile PAC, described 432

setting options 67

Almost overdue and Auto-renew reminders

allowing patrons to opt out 350

Ask Us

displaying Mobile PAC option 430-431

displaying Polaris PowerPAC option 18

in Mobile PAC, described 429

overview 338, 358

Sent From address 358, 429

setting up e-mail addresses for 359
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associated patrons

set the patron account display 353

auto-renew

allowing patrons to opt out of receiving reminders 350

auto-suggest

in PAC 103

Secure Socket Layer (https) settings 104

AutoComplete forms

disabling for Polaris PowerPAC 6

automatic renewal 350

availability

See item availability display 202

setting PAC search filter for 77

suppressing for TOMs (PAC) - overview 196

suppressing for TOMS (PAC) - procedure 198

B

Baker & Taylor

overview (PAC) 312

Polaris Bookstore 330

setting up access in PAC 313

bibliographic record sets

PAC search access points 105

birth date

PAC self-registration duplicate checking 342

requiring for self-registration 342
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book jacket images

in Mobile PAC 438

in PAC search results 310

on PowerPAC portal page 26

Book Sense

Web parts in dashboards 37

bookmarking and sharing (PowerPAC)

described 240

setup 242

bound-with groups

configure title display in PAC 141

branch display order

in Polaris PowerPAC 9

branch locations, item

displaying in PowerPAC Children’s Edition 416

branch names

display name in Mobile PAC 425

branch switching

display order (Polaris PowerPAC) 9

enabling (Polaris PowerPAC) 9

setting for Mobile PAC 424

browse search by call number

setting for PowerPAC 73

bulk hold requests in PAC

enabling 239

overview 231
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placing 232

processing 239

C

cache, page

updating for Mobile PAC 420

updating for PowerPAC 3, 5

call numbers (PAC)

browse searching for 73

item level in Children’s Edition 417

text messaging from Mobile PAC 440

text messaging from PowerPAC 208

Categories (children’s search)

adding targets to 403

constructing 399

copying 409

overview 398

translating 410, 412

checking out eContent in PAC

requiring format selection 252

Children’s PAC

see Polaris PowerPAC Children’s Edition 385

Children’s PAC profiles

reference list 524

ChiliFresh Connections

exporting records for Polaris Social 296

patron account features for Polaris Social 298
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patron log-in for Polaris Social 296

Polaris Social integration, overview 295

search results features for Polaris Social 303

setup for Polaris Social 309

ChiliFresh reviews and ratings

overview 320

setting up access in PAC 322

circulation status

displaying in PAC 170, 204

displaying in PowerPAC Children’s Edition 416

suppressing items from results display 174, 210

claimed and lost items

displaying in patron's PowerPAC account 371

enabling display in PowerPAC account 371

claimed and lost items (PAC)

in Mobile PAC patron account 458

collapsed serials holdings

display in PAC 173, 207

collections

displaying in PowerPAC Children’s Edition 417

scoping PAC searches by 81

connection URL

setting for Mobile PAC 422

constituent links (bound-with groups)

displaying in PAC 141
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contact information

displaying in Mobile PAC 426

Content Cafe

setup 310

content carousels

on PowerPAC portal page 28

setting up for PowerPAC portal page 31

cover images

enabling Syndetics 318

in Mobile PAC 438

in PAC search results 310

on PowerPAC portal page 26

CQL

access points for PAC bibliographic information 113

credit card payments

Mobile PAC 460

PowerPAC 361

cross-references (PowerPAC)

labels, editing 201

labels, overview 200

new search on selection 201

title count text for See entries 201

Cross Reference Display Constants table

editing 201

overview 200
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customizing PowerPAC

page header 12

D

dashboard position (Polaris PowerPAC)

setting 22

dashboards

enabling in Children’s Edition 386

overview 35

See also Web parts (PAC) 35

databases

setting up PAC access, overview 254

databases, remote

See also e-sources 276

deep links

PAC search URLs 108

Details for titles (Mobile PAC)

setting bibliographic display information 441

Did You Mean

PAC search suggestions 99, 396

setting up 100

Did You Mean Overrides table

adding entries 100

changing entries 103

digital collections

display in PAC 79

in Mobile PAC search results 448
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disabling self-registration 340

display name

setting for organizations in Mobile PAC 425

donations

credit card in PowerPAC 37

Polaris Bookstore 330

drawers

title display in PAC 167

E

E-Commerce

Mobile PAC 460

PowerPAC 361

E-Source

report 294

e-sources

authentication 277

connection requirements 276

copying categories 293

copying targets 293

deleting targets 293

displaying in Polaris PowerPAC 18

in-house access 279

links from Web locations 291

logging transactions 294

organizing 292

organizing categories 292
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overview 276

remote access 280

report 294

restrictions 277

revert to system settings 278

unlinking targets 293

Ebsco

see NoveList 315

eContent 251

changing the loaning branch 251

managing 250

prevent or allow OverDrive downloads on in-house workstations 252

requiring format selection in PAC 252

tracking by the item’s branch 251

EContent

modifying the Restricted button hover text 250

eContent PAC display

patron account Requests view 253

product page display 247

suppressing availability 245

email

Ask Us option in Mobile PAC 429

Ask Us option in PowerPAC 18

purchase requests from Polaris PowerPAC 27

sending address 11

SMTP server 11
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specifying server for PAC Ask Us 338, 359

title lists from Polaris PowerPAC 230

enabling for Mobile PAC 453

enriched content

Mobile PAC 442

enriched data

Baker & Taylor 313

ChiliFresh 322

Content Cafe 312

LibraryThing 325

overview 310

PAC port access requirements 310

secure sites 310

Syndetics 318

events page

editing for PowerPAC 20

editing for PowerPAC Children’s Edition 387

enabling in PowerPAC 18

enabling in PowerPAC Children’s Edition 386

F

facets

for PAC search results 181

Feature It (PowerPAC)

promotions display in Polaris PowerPAC 176

setup 178
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federated searching

MuseGlobal 254

setting up for the PAC 254

fiction/non-fiction scoping

in PowerPAC Children’s Edition 396

in PowerPAC quick search 25

Find It title link (Mobile PAC)

described 439

fines and fees (PAC)

in Mobile PAC patron account 457

setting access 361

suppressing history 361

follow-on searches

designating database for 269

enabling in PowerPAC 268

Full Display, PowerPAC

configuring 167

Full Site link, Mobile PAC

setting 424

G

Google Analytics

in Mobile PAC 420

in Polaris PowerPAC 8

Google Maps

in PAC, overview 215

in PAC, setting up 218
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Google Preview

in PowerPAC search results 221

H

header, Polaris PowerPAC

customizing 12

help

customizing on PowerPAC dashboard 59

displaying option in Polaris PowerPAC 18

with searches, PowerPAC Children’s Edition 386

hold requests

bulk, from PAC 231

holds queue

displaying in PAC 336, 362

host links (bound-with groups)

displaying in PAC 141

Hours page

displaying in Mobile PAC 426

displaying in Polaris PowerPAC 18

displaying message 19, 427

displaying organization schedule 19

setting for Mobile PAC (procedure) 426

I

ILL

enable for remote databases 267
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in-house workstations

preventing OverDrive eContent downloads by patrons 252

item availability display (PAC)

Assigned Branch setting (item record) 202

branch display order 171, 204

branch locations (Children’s Edition) 416

call numbers (Children’s Edition) 417

circulation status 170, 204

circulation status (Children’s Edition) 416

collections (Children’s Edition) 417

default order 202

detailed status 170, 203

Display in PAC setting (item record) 202

due date 170, 204

last circulation date 169, 203

local & system views 169, 203

local and system levels (Children’s Edition) 416

material type 171, 204

material type (Children’s Edition) 417

Mobile PAC, described 439

Mobile PAC, setting details 439

overview 202

Polaris PowerPAC default 173, 207

public notes 170, 203

public notes (Children’s Edition) 417

reordering 172, 206
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setup 169, 202

setup (Children’s Edition) 416

shelf locations 170, 204

shelf locations (Children’s Edition) 416

summary count (PowerPAC) 173, 207

text message call numbers (Mobile PAC) 440

text message call numbers (PowerPAC) 208

textual holdings notes 170, 203

Item Availability Display Order table

setting 171, 204

items out (PAC)

displaying in patron account 362

in Mobile PAC patron account 456

integrated eContent 253

J

JavaScript

message in Polaris PowerPAC 6

L

Language Strings dialog box

messages reference 375

languages

editing multilingual messages (PowerPAC) 373

PAC search scoping, allowing 82

translating all children’s categories 412

translating children’s categories, targets 410
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translating related searches dashboard labels (PowerPAC) 195

last circulation date

displaying in PAC 169, 203

Librarian’s View (MARC record)

displaying in Mobile PAC 443

library schedule

displaying in Mobile PAC 426

displaying in PowerPAC 18

LibraryThing

features in Polaris PowerPAC 323

reviews and ratings, setting up in PAC 325

Limit by options

availability (Polaris PowerPAC) 77

ebooks and electronic resources (PAC) 81

Mobile PAC advanced search settings 432

Mobile PAC quick search settings 432

setting default (Polaris PowerPAC) 81

setting up (PAC) 78

setting up (Polaris PowerPAC) 79

suppressing (Polaris PowerPAC) 79

limit by search filters in PAC

applying to remote databases 77

links

from Mobile PAC to PowerPAC 424

from Polaris PowerPAC to Mobile PAC 423
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loaning branch

changing for eContent 251

local availability

in PowerPAC Children’s Edition 416

locations, item

displaying in PAC 172, 206

See also item availability display (PAC) 172, 206

log-in attempt limits, PAC

setting 364

logging on (PAC)

Active Directory logon setup 368

from Mobile PAC 454

limiting attempts in Mobile PAC 455

single log-on in Polaris PowerPAC 10

single log-on, overview 334

logo link, Polaris PowerPAC

setting 12

logo, Polaris PowerPAC

setting 12

lost items

enabling display in PowerPAC 371

M

Make a Donation Web part

overview 37

Map It

in Mobile PAC 442
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in PAC, overview 215

in PAC, setting up 218

Material Types

displaying in PAC 171, 204

displaying in PowerPAC Children’s Edition 417

merged results

in Polaris PowerPAC 255

messages

apostrophes and backslashes in 380

editing PAC 373

editing with Polaris WebAdmin (Language Editor) 383

in Mobile PAC patron account 456

in PAC patron account 363

PAC reference list 375

mobile devices

detecting 421

Mobile PAC

analytics 420

as search target (deep links) 112

Ask Us 429

branch display names 425

branch switching 424

Buy It Now link 442

connection URL 422

cover images 438

credit card payments 460



Public Access Administration Guide

© 2023 Innovative (Part of Clarivate)
Page 569

deep links 112

Details 441

enriched content 442

Find It 439

Full site link 424

interface 419

Librarian’s View link 443

Library Hours & Contact page 426

link order on title (product) page 443

log on attempt limits 455

Map It link 442

messages 456

mobile device compatibility 421

mobile device detection 421

New and Popular Titles 428

overview 418

passwords, forgotten 455

patron account features 455

patron log on 454

patron registration 453

patron user names 454

Polaris Fusion results 448

Purchase link 442

redirection from PowerPAC 423

Remember Me 454

Request it 441
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saved searches (Search Agent) 449

search results 437

search results display, bibliographic elements 444

searches 432

secure socket layer (SSL) 419

Text It (call numbers) 440

title lists 450

trouble-shooting 421

update patron account, preferences 459

Mobile PAC patron account

displaying claimed and lost items 458

Mobile PAC profiles

reference list 520

Mobile PAC redirection

automatic, from PowerPAC 424

connection organization, from PowerPAC 424

display language, from PowerPAC 424

Most Circulated Web part

in PAC dashboard, overview 36

most popular

sort order (PAC) 67

most popular sort

adjusting level of relevance 75

multilingual messages

editing PAC 373
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MuseGlobal

federated search databases 254

music and video profiles

enabling Syndetics 318

My Record (PAC)

see also patron account (PAC) 362

setting access 362

N

Narrow Web part (Polaris PowerPAC)

setting element display order 191

setting up 189

New and Popular Titles (Mobile PAC)

overview 428

setup 428

New Titles Web part

in PAC dashboard, overview 36

RSS feeds from PAC 48

notices, reminders

allowing patrons to opt out via their PAC account 350

NoveList

overview (PAC) 315

updating library holdings for NoveList Select 315

O

On-Order Items Web part

in PAC dashboard, overview 36
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OverDrive eContent

prevent or allow downloads on in-house workstations 252

P

PAC Availability

suppressing display for integrated eContent 245

PAC eContent circulations

managing 250

require format selection 252

PAC Limit by Display table

settings 78

PAC options 339

PAC patron account 353

page cache

updating Mobile PAC 420

updating PowerPAC 3

parameters

setting public access 2

passwords, patron

forgotten, e-mail from Mobile PAC 455

forgotten, e-mail from PowerPAC 347

numeric 347

online change set up 347

staff override 347

Patron Access Options dialog box

set the associations display 353
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patron account (PAC)

access from Polaris PowerPAC 18

allowing patrons to opt out of reminder notices 350

claimed and lost (Mobile PAC) 458

e-mail to staff on updates 353

fines and fees (Mobile PAC) 457

hold requests (Mobile PAC) 457

items out (Mobile PAC) 456

messages (Mobile PAC) 456

Mobile PAC features 455

patron access options, overview 337

patron access options, setting 361

reading history (Mobile PAC) 458

saved searches (Mobile PAC) 458

set association display 353

specifying the patron updates allowed 350

updates from Mobile PAC 459

patron associations 353

set PAC account display 353

patron custom data

displaying in PAC self-registration 341

patron privacy

disabling Autocomplete 6

privacy message 379

self-registration warning 380
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phone validation

enable for PAC patron account update 352

pickup branch

display order in Polaris PowerPAC 10

Polaris Bookstore

in Mobile PAC 442

overview 330

setting up 331

Polaris Fusion

digital records display in Mobile PAC 448

digital records display in PAC 79

Polaris PowerPAC 128

accessibility 7

as search target (deep links) 108

Ask Us option, displaying 18

basic set-up 8

branch display order 9

branch switching, enabling 9

collections, scoping PAC searches by 81

connection branch 9

dashboard position 22

dashboards 35

deep links 108

e-sources, enabling 18

events page, enabling 18

Google Preview in search results 221
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help 18

help on dashboard 59

help, overview 52

Hours page, enabling 18

language strings, editing 383

link to Children’s PAC 11

link to Mobile PAC 421

main menu bar features, setting 16

managing remote search targets, overview 254

page header customization 12

patron account access 18

patron privacy 6

Polaris Bookstore 330

policies page, enabling 18

portal page, enabling 9

Purchase links 328

Recently Viewed Titles (PowerPAC)

overview 175

related words in searches 91

remote users 9

results set size 74

rotating book jackets 26

RSS feeds 48

search settings, default 66

search types 89

setting up 4
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single log-on 10

site analytics 8

themes 22

titles with local items highlighted 214

transaction logging, enabling 10

virtual reference services 49

Web site page, enabling 9

Polaris PowerPAC Children’s Edition

availability display, overview 414

basic set-up 385

Categories (children’s search) 398

dashboards, displaying 386

events page, editing 387

events page, enabling 386

filtering searches 396

help with searches, enabling 386

link from Polaris PowerPAC 11

link to Polaris PowerPAC 386

remote users 385

results set size 387

search buttons 396

search filters 395

searching, overview 395

setting up 385

themes, enabling 385

themes, setting up 390
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Web parts in dashboard 393

Polaris PowerPAC Multilingual Version

messages 11

translating children’s categories & targets 410, 412

translating in Polaris WebAdmin 383

translating PAC messages 373

translating related searches dashboard labels 195

Polaris Social

exporting records to ChiliFresh 296

overview 295

patron account features 298

patron log-in 296

search results features 303

setup 309

Polaris WebAdmin (Language Editor

editing PAC language strings 383

policies page (Polaris PowerPAC)

editing 21

enabling 18

popularity

search results facet (Narrow your search Web part) 183

sorting by most popular (PAC) 67

popularity sort

adjusting relevancy ranking 75

portal page (PowerPAC)

book jacket images 26
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content carousels, described 28

content carousels, setting up 31

enabling access 9

overview 23

Web parts in 35

power searching

access points for PAC bibliographic information 113

PowerPAC

product page 167

See Polaris PowerPAC 4

PowerPAC link

in Mobile PAC 424

in Polaris PowerPAC Children’s Edition 386

PowerPAC profiles

enabling display of claimed and lost items in PowerPAC 371

reference list 461, 491

PowerPAC, administration

overview 4

PowerPAC, patron account

displaying claimed and lost items 371

preferences, Mobile PAC

Preferences page 419

updating patron 459

privacy policy statement

displaying link in PAC 370
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product page

Mobile PAC setup 443

PowerPAC setup 167

profiles

Children’s PAC reference list 524

Mobile PAC reference list 520

PowerPAC reference list 461, 491

setting public access 2

promotions

display in PAC 176

promotions (PowerPAC)

setup 178

public notes

displaying in PAC 170, 203

displaying in PowerPAC Children’s Edition 417

purchase requests

from rotating book jackets 27

purchases from PAC

Mobile PAC 442

Polaris Bookstore 330

Purchase links 328

setting up Purchase links, Polaris PowerPAC 329

Q

quick search (Mobile PAC)

described 432
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quick search (PowerPAC)

default, overview 23

fiction and nonfiction search option buttons 25

with option buttons, overview 24

with search option buttons, setup 25

R

reading history

in Mobile PAC patron account 458

Reading Level

search results facet (Narrow your search Web part) 184

reading lists

publishing link in PAC 105

Recently Viewed Titles

setting up for PowerPAC 175

Recently Viewed Titles (PowerPAC)

setup 175

record sets

publishing link in PAC 105

registration, patron

disabling self-registration 340

enabling for Mobile PAC 453

PAC options 339

Related (PAC dashboard)

setup 192

Related Web part (Polaris PowerPAC)

setting element display order 194
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Related words

enabling in PowerPAC 94

in PowerPAC searches 91

relevance

sort order (PAC) 67

reloading Mobile PAC

updating page caches 420

reloading Polaris PowerPAC

updating page caches 3

Remember Me

Mobile PAC log-on 454

reminder notices

allowing patrons to opt out via their PAC account 350

remote databases

default for PowerPAC searches 267

enable ILL requests 267

limit by filters in PAC 77

setting up log in requirements 271

remote resources

display in PAC, overview 258

follow-on search display in PAC 266

in-house and remote use (PAC) 272

making available for PAC searching 261

max searchable at one time 265

organizing 261

PAC display name 269
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search access points (PAC) 274

See also Z39.50 targets 261

setting authentication requirements (PAC) 271

setting up PAC access, overview 254

setting usage conditions for pAC 267

usage settings for PAC, overview 265

remote users

allowing in Polaris PowerPAC 9

allowing in PowerPAC Children’s Edition 385

e-sources access 280

renewals (PAC)

allowing 363

reports

e-sources 294

requested date indicator

displaying in Mobile PAC 444

displaying in PowerPAC 128

requests

holds queue position in PAC 362

in Mobile PAC patron account 457

PAC patron account 362

PAC patron account, eContent 253

Polaris PowerPAC Children’s Edition 387

Request It (Mobile PAC) 441

requested date indicator, Mobile PAC 444

requested date indicator, PowerPAC 128
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summary in Polaris PowerPAC search results 173, 207

suppressing for TOMs (PAC) - overview 196

Restricted button in PAC

modifying the hover text 250

Results set

Do not sort if it contains more than this many records

Children’s PAC profile reference 531

reverting

title configuration to parent orgnization 139

rotating book jackets

placing on PowerPAC portal page 26

RSS feeds

Polaris PowerPAC setup 48

S

Save Search

in Mobile PAC 449

see also search agent (PAC) 95

setting up for PAC 95

saved searches

in Mobile PAC patron account 458

SDI

See search agent 95

search

setting defaults in PowerPAC 67

search agent

in Mobile PAC 449
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search agent (PAC)

book jacket images in results 98

displaying searches in the dashboard 98

overview 95

patron e-mail format 98

setting up 97

Search by options

customizing labels 124

search filters (PAC)

availability (Polaris PowerPAC) 77

collections, scoping by 81

ebooks and electronic resources 81

fiction and non-fiction 25

setting default 67

setting in PowerPAC Children’s Edition 396

setting up 78

search results (PAC)

adjusting relevancy in most popular sort 75

configuring bibliographic display 128

copying bibliographic display configurations 151

creating custom bibliographic display entities 150

displaying in Children’s Edition 414

editing bibliographic element labels 133

editing bibliographic entity definitions 146

highlight titles with local items (PowerPAC) 214

including and suppressing items 210
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maximum results set 74

maximum results set (Children’s Edition) 387

Mobile PAC 437

Narrow Web part, overview 181

Recently Viewed Titles (PowerPAC) 175

related search features, overview 180

Related Web part, overview 188

requested date indicator, Mobile PAC 444

requested date indicator, PowerPAC 128

selecting bibliographic elements for display 133

setting display order for bibliographic elements 145

subsort by title 74

search results display, bibliographic elements 128

search settings

setting defaults in Mobile PAC 432, 434

search term suggestions

automatic, in PowerPAC 103

search types

setting in Polaris PowerPAC 90

searching (Mobile PAC)

advanced 432

default search settings 432, 434

overview 432

results 437

searching (PAC)

collections, scoping by 81
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default search settings 67

default settings 66

filters overview, Children’s Edition 395

Mobile PAC 432

PowerPAC search types 89

quick search 23

Related words in PowerPAC searches 91

secure socket layer (SSL)

ChiliFresh enriched data 322

enriched data 310

setting for Mobile PAC 419

SEE and SEE ALSO

editing cross-reference labels (PowerPAC) 201

Select Databases (PowerPAC)

lightbox display 259

self-registration (PAC)

notification preference 347

registered branch 347

setting up 339

serial holdings

expanded display in PAC 173, 207

Share (AddThis)

in PowerPAC search results, described 240

in PowerPAC search results, setup 242

shelf locations

displaying in Children’s Edition 416
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displaying in PAC 211

overview 211

setting up 212

Shelf Locations table

adding entries 212

modifying entries 213

overview 211

single log-on

in Mobile PAC 454

in PAC 334

setting in Polaris PowerPAC 10

site analytics

setting up for Mobile PAC 420

setting up for Polaris PowerPAC 8

smart cards

enabling in Polaris PowerPAC 11

SMTP server

specifying for e-mail notices 11

specifying for PAC Ask Us 338, 359

social bookmarking

PowerPAC search results, described 240

PowerPAC search results, setup 242

sort by (PAC)

default sort order for search results 67

subsort by title 74
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sorting search results (PAC)

adjusting level of relevance in most popular sort 75

specify PAC display 353

subscription databases

See e-sources 276

Switch to another branch

Polaris PowerPAC settings 9

Syndetics Solutions

setting up enriched content 318

T

Text It

report 210

text message call numbers, Mobile PAC 440

text message call numbers, PowerPAC 208

textual holdings notes

displaying in PAC 170, 203

themes (Polaris PowerPAC Children’s Edition)

assigning 392

constructing 390

enabling 385

overview 388

themes (Polaris PowerPAC)

overview 22

selecting 22

timeout, PAC

setting 365
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title display configuration (PAC)

copying bibliographic display configurations 151

creating custom bibliographic display entities 150

editing bibliographic element labels 133

editing bibliographic entity definitions 146

Mobile PAC 441

overview 128

reverting to parent organization 139

selecting bibliographic elements for display 133

selecting host and constituent links for display in PAC 141

setting display order for bibliographic elements 145

suppressing entities from small screen display 139

title links (Mobile PAC)

Details (bibliographic information) 441

Find It (availability) 439

title lists

enabling in Polaris PowerPAC 223

in Mobile PAC 450

transaction branch

set for eContent circulation from PAC 251

Transaction Logging

enabling for Polaris PowerPAC 10

trouble-shooting, Mobile PAC

viewing status page 421

type of material

PAC icons list 83
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setting Limit by options (Polaris PowerPAC) 78

suppressing requests and availability (PAC) - overview 196

suppressing requests and availability (PAC) - procedure 198

U

URL

custom content, PowerPAC portal page 27

custom Web part links (Polaris PowerPAC) 37

e-source target 277

library Web site from PowerPAC portal page 9

Mobile PAC connection 422

purchase link (Polaris PowerPAC) 330

QuestionPoint settings 51

record set link in PAC 105

social bookmarking 240

SSL and enriched data vendors 310

Tutor.com settings 51

user-defined fields

displaying in PAC self-registration 341

user names, patron

enabling 347

format 349

in Mobile PAC 454

Using list (PowerPAC)

selecting databases for 270
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video game profiles

enabling Syndetics 318

virtual reference

overview 49

See also Ask Us 338, 358

setting up 50

transcripts, availability in PAC 50

W

Web access

securing in PowerPAC Children’s Edition 415

Web links (856 tag)

display in Mobile PAC results 437

Web page caches

updating 3

Web parts

See also dashboards 393

Web parts (PAC)

assigning to pages (overview) 43

assigning to pages (procedure) 44

Book Sense 37

choosing 35

custom, creating 38

custom, overview 37

default display, setting 47
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editing 43

in Polaris PowerPAC 35

in Polaris PowerPAC Children’s Edition 393

limiting items in 47

Make a Donation 37

Most Circulated 36

Narrow, overview 181

New Titles 36

On-Order Items 36

Related, overview 188

URL, context after timeout 42

Web site page

enabling in Polaris PowerPAC 9

Z

Z39.50 targets 254

grouping 261

making available for PAC searching 261

max searchable at one time 265
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